


Of mice and men

Robert Sovereign-Smith, Editor

Every month, from
here on, in the form of
Digit TV we’re going
to give you as much
video content as we
can, and try and share
the knowledge and
expertise that we are
privileged to receive

t around this time every year,

the festival season rolls around.

Starting in October and running a

little into the new year, these few

months see an increase in activity

by vendors and manufacturers.
Everywhere you go you're bombarded with
discounts, special offers, and other catchy and
innovative alliterations that all basically say the
same thing — buy me.

The consumer electronic and personal
technology segment specifically, sees entire
product ranges being refreshed, older stock
being sold off at rock bottom prices and
buzzwords flying about like nobody’s business.
For the everyday buyer, this amounts to being
stuck in a maze of choices, with no clear
indication of what's good, what’s value for
money, and what isn’t.

You and I alike, spend the few precious
holidays we get with our families at the local
electronic mall, gawking at all the goodies,
listening to all the sales pitches that every mall
employee is only too eager to subject you to,
getting more confused by the minute about which
<insert product category here> to buy.

So how do we go from feeling like the little
white mice that are made to run mazes in labs,
to informed customers? Reading and surfing
helps, but everything you'll find online is usually
outdated in months, and sometimes weeks or
days during festival season. All of us can Google
for reviews and comparisons, visit sites like
thinkdigit.com, or read magazines like Digit for
information, but is that all we need?

Although we offer you the best information
possible by rigorously testing products, to help
you get value from every last Rupee you spend,; it’s
still not enough. As I said last month in this space,
we're not as committed to imparting information
as we are to sharing knowledge. It’s the same
reason why today’s newspaper is tomorrow’s
cupboard lining, but this issue of Digit will
command a long shelf life in your home.

Over the past few years we’ve seen
video become the desired form of, not just
entertainment, but learning as well — the spike in
video content online is testament to this. Some
of you will have noticed that we’ve been carrying
videos that have been made completely in-house
by Digit over the past few months. Although this
is still in a teething phase, and know we have a
long way to go, we decided to launch “Digit TV”.
This is another in a long lists of “Firsts” that Digit
has done over the years.

For those of you don’t remember, Digit’s other
firsts include the first magazine in India to include
DVDs, and later the first to dual-layer; we were

the first tech magazine (in the world, probably) to
give away Hollywood blockbusters on DVD, the
first to offer a CD magazine, and the first to start
including a free book (Fast Track).

Every month, from here on, in the form
of Digit TV we're going to give you as much
video content as we can, and try and share the
knowledge and expertise that we are privileged
to receive. Like Digit 3.0, Digit TV will also
evolve based on your feedback, so make sure to
send us some.

This month, Digit TV is dedicated to buying
guides, across multiple categories, to help you get
out of the confusing maze and make informed
decisions because you actually understand the
underlying technology, instead of just parroting
what people tell you. Plus, since it’s a video DVD,
you don’t need a PC to view it — just pop it into
any DVD player.

We also have a web exclusive, in the form of a
PMP test online at thinkdigit.com, so we haven’t
forgotten our online patrons either.

With three more DVDs (Work, Play and
Learn), all of you should have enough multimedia
content for every aspect of your life that
technology covers. There are a tonne of prizes to
be won everyday of October, so make sure to find
the contest page inside.

Last month, our career webinar generated
a lot of interest, so we're going to make sure
you get more of the same from here on — again,
details inside.

I want to stress, however, that all of this
comes to naught if you don’t share feedback
with us about the initiatives we’re taking. There
are two things I'd like to make sure of: one, that
we continue to share knowledge, and two that
we stay relevant by understanding your needs.
So make sure you write in whenever you have
something to say. Fl

editor@thinkdigit.com
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Products reviewed this month

Bazaar.. .48
Cooler Master Elite 334 ATi
Radeon Edition Cabinet
Sony Walkman NWz-w202
2GB

A-DATA Nobility NH92 250GB
External Hard Drive

Acer F900 Smart-phone
Seagate Barracuda LP
ST32000542AS 2TB
Western Digital Scorpio Blue
500GB

APC Back-UPS RS 550
CoolerMaster NotePal Color
Infinite

Epson Stylus TX550W
ASUS SDRW-08D1S-U
Linksys WRT320N
Samsung Jet

Samsung Marine

Acer Aspire Revo R3600
Philips GoGear Mix 2 GB
Apacer AU380 MP3 player
SatGuide P360

VU 40-inch Intelligent TV
LTV-40i

Gigabyte GK-KM7500

iPod Shuffle

Sony A330 DSLR camera
Laptop test....ccceeeeneene62
Acer Aspire 3810T

Acer Aspire 4736

Acer Aspire 5536

Acer Aspire 5738G

Acer Aspire 57382

Acer Aspire 5810T
Alienware M17x

Apple Machook Air

Apple Machook Pro 13”
Apple Machook Pro 15"
Apple Machook Pro 17”
ASUS F82Q

ASUS G50

ASUS K401J

ASUS K501J

ASUS U6 Bamboo

ASUS UX30

Dell Adamo

Dell Studio XPS 1340

Dell Studio XPS 1640
Gateway ID 5801

Gateway NV48

HCL 7239

HP EliteBook 2530P

HP ProBook 4410S

Lenovo IdeaPad Y550
Lenovo IdeaPad Y650

MSI GX620X

MSI X400

Sony Vaio VGN-SR46GD
Sony Vaio VGN-Z48GD
Digital Camera test.....80
Canon Digital IXUS 100 IS
Canon Digital IXUS 110 IS
Canon Digital IXUS 95 IS
Canon PowerShot A1100 IS
Canon PowerShot A480
Canon PowerShot SX120 IS
Canon PowerShot SX200 IS
Fujifilm Finepix A170
Fujifilm FinePix F200EXR
Fujifilm FinePix J27
Fujifilm Finepix S1500
Nikon Coolpix L20

Nikon Coolpix P90

Nikon Coolpix S220
Samsung ES55
Motherboard test........ 90
ASUS M4A78-HTPC/RC
ASUS M4A785TD-M EVO
ASUS M4A785TD-V EVO
Asus M4A79T Deluxe
ASUS Maximus Il Gene
ASUS P5Q Premium

ASUS P5Q3 Deluxe WiFi @n
ASUS P6T Deluxe

ASUS Rampage Il Extreme
ASUS Rampage Il Gene
ASUS Striker 11 NSE
Biostar G41D-M7

Biostar TA785GE 128M
Biostar TA790GX A3+
Biostar TPOWER 145
Biostar Tpower X58

DFI UT X58 Lanparty

ECS A785GM-M

ECS A790GXM-A

ECS G41T-M2

Gigabyte EP43T-UD3L
Gigabyte EP45-UD3R
Gigabyte EX58-Extreme
Gigabyte EX58-UD3R
GIGABYTE EX58-UD5
Gigabyte MA785GM-US2H
Gigabyte MA785GPMT-UD2H
Gigabyte MA790FXT-UD5P
Gigabyte MA790GP-UD4H
Intel DX48BT2

Intel DX5850

Jetway HAO7 Ultra
Jetway 143GM1-HG
Jetway PN78VM2-LF

MSI 790GX-G65

MSI G43M2

MSI K9N2 Diamond

MSI K9N2 SLI Platinum
MSI KA780G

MSI P43 Neo3

MSI P45 Diamond

MSI P45 Neo2

MSI X48C Platinum

MSI X58 PRO

MSI X58M

XFX 790i Ultra

XFX X58i

Zotac GeForce 8200
Zotac 790i Ultra SLI
Zotac nForce 780i SLI
ZOTAC X58
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Welcome to Gizmoland

Find your way through all the product
releases, offers and discounts this Diwali
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8 Inbox

Readers’ Letters

12 Industry Connect
Bala Parthasarathy, MD (APAC) - Snapfish

14 Buzz

HP’s DreamScreen, Microsoft’s open source
initiative and more

Connections
24 Web Watch

From anonymous browsing to Monopoly,
insights into your world online

Digital Life
32 Drool maal

36 Tech Treats
Groovy gifting ideas for Diwali

Sci Tech

40 How stuff Works

Flash drives and their working principle
explained

44 How stuff Works

Get to know how LCD panels and the newer
LED TVs work

Toolbox
Workshops

106 Anonymous Browsing

108 Backup your drive using Paragon Drive
Backup

110 Make your own font using your

handwriting



113 Tips and Tricks

Microsoft Office 2007
«Ultra Explorer
*YouTube

*Google Cheat sheet
*Windows 7

and more...

16

page
Special

130Q & A

Your questions, our answers

Street smart

138 Agent 001
The best gaming and HTPC casing and power

supply options
142 Price watch

The latest prices for your reference

ESC
146 Pimp my gadget

Personalise your precious gadgets
Game Reviews:

150 Batman: Arkham Asylum
152 TRINE

154 G.l. Joe: The Rlse of Cobra
156 Unwind

158 Community

Tried and Tested
120 products tested

48 Bazaar

Acer F900

A-DATA Nobility NH92
250 GB

Epson Stylus TX550
And many more...

Contents

62 Laptops

Dell Alienware Mx17
ASUS Bamboo U6V
MacBook Pro

And many more...

80 Digital Cameras
A total of 16 digital cameras were
tested in the Digit labs this month

Young Indian Innovators

Enter
18 The smallest

of innovations pile
up today to create

tomorrow’s world.
| (]

90 Motherboards
More than 50 motherboads
benchmarked from all
categories
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DVD Contents

Music

« Universica

«CIA

« Last Spring

« Looking for a Way Out
< Namouche

« Occidente

« Galaxy

« 100 per cent Rush
* Mind Asylum

« Nights and Days

« 7 Improvisations

* Quiet Life Vol 3

« Binary Mind

« Art & Copy

« Inception

« Legion

« The Blind Side

« The Fourth Kind
« The Wolfman

« Lego Star Wars
Experience the Star Wars uni-
verse in lego animation

* 6 Days

« Gumbasia

« Neurosonics Audiomedical Labs
« Piece

« Tanzanian love story

« The Crossing Guard

« The Forest
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Video Games

« Anarchy Online
A Sci-Fi MMORPG

* Ashes 2009

« Darkest of Days

* Mini Ninjas

* F1Racing 3.2

« Assassin’s Creed Il

* DIRT 2

« Kingdom Under Fire Il
* Mini Ninjas

* Spore Hero

« Orbital Snake
As an intelligent robotic “snake-
ship”, pick your way through
abandoned space stations,
feasting on scraps of debris

« Candy World Adventure The
Fate of Lillians Tome | 1.01

« Creatrix

* Draw Fire 1.0

* Duck Dodgers 1.0

* Fire And Ice 1.0

 Germy Roundup 1.0

* HangARo0 2.052

* Mario Remix 1.0

* Mystery Island Il

« Orbital Snake 2.0

- Ultimate Sonic 1.0

* Yetisports Gore 1.0

« Zelda Forever 1

* Free Fire Screensaver

« The Matrix Screen Saver 1.11

» Amazing Bubbles 3D Screen-
saver 1.2

» Licking Dog Screen Cleaner
Screen Saver 2.0

« Don’t Touch My Computer Epi-
sode 21.22

« Sim Aquarium FreeTank 2.6

* Matrix Trilogy 3D Code Screen-
saver 3.4

« Distant Suns - Grand Tour 3D
Screensaver

« Digital Talking Parrot

« The Amazing Spider-Man 3D
Screensaver

« The Space Travel Screensaver 1.0

« Super Mario World Screensaver 1

« Super Mario Kart Screensaver 1

« Flight over sea 3D

* Aquarium

« Dolphins and Whales

+ Batman Begins 3D

« Electric Sheep 2.6.6

« Rain Cast 2.0

« gPhotoShow 1.6.3

* Moonlight City 1

« Living Marine Aquarium

* Dream Aquarium 3D

* Pac-Man

« Perfect Runaway 1

3Dstudio Max

« Counter Strike

» DVDFlick

* Foohar2000

« Pictomio

* Quake3 Arena

» Windows Movie Maker

Tips & Tricks

* Last.fm Scrobbler

« Subtitle Workshop4
 ManicTime

« Productivity Meter

» TimeSnapper Professional

« Stellarium 0.10.2

» Advanced Pathway Painter
« Asynx Planetarium 2.5

* BoneLab 1.0.2.46

* DeadLine 2.36

* Flash Card Factory 1.0

* FreeMind 0.8.1

- Geometry 2.8.2

- GraphCalc 4.0.1

* Guitar Chords 2.2
 MaxType Lite Typing Tutor
 MB Brain Teasers 1.10

* Power Tab Editor 1.7

* Rapid Typing Tutor 2.9.6

« Science Data Reference System
« Scratch

* The MagicBook 7.0

« Virtual Morse Key 2.5.39
*Voca4.3

» WordWeb 5.52

» World Wind 1.4.0

« WorldWide Telescope 2.2

« Zero Spelling 5.0

TED
« Adjustable liquid eyeglasses
« Happy design

* Nature’s designs

* Digging up dinosaurs

* Engineering and evolution

« Militant atheism

« “Mathemagic”

» How technology evolves

« The world’s deepest caves

« Wiring a web for global good
« Wireless electricity

« Faux nostalgia

Astronomy 160

» Omega and the End of the
Universe

« Dark Matter

« Dark Energy, the Accelerating
Universe and the Big Rip

Introduction to

Computer Science

« Binary Numbers, Programming
Languages, Working in Linux,
and Programming in C

- Secure File Transfer, Variable
Types, and Arithmetic Operators

« Standard Input Functions,
Boolean Expressions, and Loops

Game Theory

« Introduction to Game Theory

« Putting Yourselves into Other
People’s Shoes

- Iterative Deletion and the
Median-Voter Theorem

Aircraft Systems

Engineering

« The Origins of the Space Shuttle
« Space Shuttle History

« Orbiter Sub-System Design

Qimo

Qimo is a desktop operating
system designed for kids. Based
on Ubuntu, Qimo comes pre-
installed with educational games
for children aged 3 to 60



DVD Contents

Tools

Multimedia

ArcSoft Total Media 3.5

A media hub that combines TV,
video recording, photo editing,
and media conversion in one
easy-to-use program. You can
watch and record TV shows, edit
photos or video, listen to music,
rip CDs to MP3 and much more.
It’s everything you need packed
in one versatile and easy-to-use
application

« ZWCAD 2009i

« Jamstix 2.5.2

« PDF Studio 6.0

« Delcam Exchange 6.0

* 0SG Composer CAD 1.2.1

* DV Mixer Pro 1.5

« Photo Pos Pro 1.72

« Real-Draw Pro 5.2.3

« Flash Effect Site Builder Platinum
12.06

« Pazera Video Converters Suite

« PhotoShine 3.2

« Avant Media Player 3.4

« JetAudio Basic 7.5.4

Internet

* LuckyWire 1.0.0.2

* TomTom Home 2.7.0.1785

« CoffeeCup Photo Gallery

« Hermes P2P 3.0

« P2P Rocket 1.4

< SmartFTP Client 3.0.1043

«DAP 9.6

 TVTrigger 1.1

« Memeo Send 1.0

 Advanced OPC Data Logger

* Meteor Share 2.3

« FrostWire 4.18.1

« TubeMaster++ 1.2

* Hulu Downloader 2.3.8.21

« TurboFTP 6.00.735

« Web Site Maestro 7.6

« Email File Transfer Protocol
Server 1.0.1.3

« BookmarkAssistPro 1.2.2

« VDownloader 1.0

System

« OPTIsend Print 2.6.1

« CrashPlan 7.27.20009

* Hulbee Desktop Standard
« SilverFast Ai Epson 4870
« eWriterPro 2.0

« SilverFast Ai - Minolta

« eDocPrinter PDF Pro 6.48
» MooO RightClicker 1.31

« Photocopier Expert 6.59

Productivity

Enterprise

Go-00 3.1-10

Go-00 is an

OpenOffice.

org fork that

features

faster load

and response times, and several

features not included in the

standard version of 000

- Corel WordPerfect Office X4

« Express Accounts 2.08

* Orange HRM

« Microsoft Office Accounting
Express 2009

« BillQuick Lite 2009

« PortableApps Suite

« inFlow Inventory Software
Free Edition 1.2.3

- OpenOffice.org Portable

« Microsoft OneNote 2003

 Adempiere ERP

* SmartDraw 2009 52

« OroTimesheet 6.12

« OrgPlus Professional 8.0

« EasyBilling 2.6.1

* SurveyGold 8.0

« 4ASoft Agenda 9.01

* Label Flow 4.3

« Nitro PDF Professional

« OneStep Accounting Standard
Edition 4.0

« ProShow Producer

» PDF-XChange Viewer

« Proteus Lite 6.7

* PDFCreator 0.9.6

- Ultimate Business Plan

« Business Functions 1.52

« Project Engine Personal

« Ultra Hal Text-to-Speech
Reader 1.0.5

« 35S Accounting 3.2

* ReadPlease 2003 1.1

« Microsoft Project 2000 Update
SR-19.0

« RationalPlan Project Viewer
3. 1581

« Netpas Distance 2.5 build

« Fleet Maintenance Pro Deluxe
11.0.0.21

« Volutive Free Invoicing &
Inventory 1.3

« Health and Safety Manager Lite
Edition

« Speak 1.8.84

« CyberCafePro Client

« Buyertools Reminder

 Smartworks - Project
Planner Reader 1

*FreeOCR1

» OmniFormat 7.9

« Auction Sentry Standard

* PPPCD 1.51

« Abdio PDF Reader 5.4

« Label Designer Plus Deluxe
9.5.0.1

* 101 Clips 9.02

« Digital Dictation 7.5

 DoneEx XCell Compiler

» Atlantis Word Processor

« Text Suite Pro with M
Player 1.1 3.5.5530

* PolyEdit Lite 5.4

«Jarte 3.3

* CrossLoop 2.51

- Effective Meetings 1.7.5.4

* EZ-Format for Excel 7.2

Developer

* Bat To Exe Converter 1.5
* WinPenPack Flash Web

* Open Xava

* 3D Developer Studio

* Web CEO Free Edition

» Silverfrost FTN95 5.30
*B*Gallery 3.2.1

« PersonalWebkit 3.3

« ActivePerl (Windows) 5.1
* JAlbum 8.4.1

* PHPTriad 2.2

» MoreMotion Web Express
* AceHTML Freeware build
* Bloodshed Dev-Pascal

» KompoZer 0.7.10Nvu 1

* PageBreeze HTML Editor
* Ghost Installer Free

* CSE HTML Validator Lite
 Web Dwarf 2.5
 MyGeneration 1.3.0.3

* Hex Edit Free 3.0F

« JCreator LE 4.50.010

« Source Edit 4.0 revision 3
- SiteGenWiz 1.5

* XMLBuddy 2.0.72

* Notepad++5.4.5

» HTML-Kit Build 292

* PHP Designer 2007

« Install Creator 2 build 28
* WordPress 2.8.4

Mac

Artlantis Studio

Artlantis Studio is the fastest
stand-alone 3D rendering
application developed
especially for architects and
designers

* NeoOffice 3.0 Patch 7

* Google Sketchup

* MacJournal 5.1.4

« Blender 2.49b

« Cenon 3.9

* Hoecker-Plot 0.8.1

* Art of lllusion 2.7.2

« Paintbrush 2.0.1

*Geo3D 2.5.8

Operating Systems
* React 0S

- Ultimate Boot CD

* Back Track

DIGITTV
10 Visual Buying

Guides

* Mobile Phones

e HDTVs

« Cameras

* PMPs

« External Storage
« Laptops

* Netbooks

« Camcorders
 Graphic Cards

* Motherboards & CPUs
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Catching more fish
Bala Parthasarathy, MD - 1
Europe and APAC, Snapfish

Microsoft going open source?
To find out more, read Buzz for technology
news doing the rounds

¢ I have been reading Digit

for the past 3 years but

this is the first time I am

writing to you. You are doing

a great feat by publishing

this magazine every month.

I heartily appreciate your

efforts. Yours is the best tech

magazine in India. I have read
other magazines, but I find

yours the most fascinating. 1

have a few complaints and I

hope you would take care of

them:

1. Your idea of providing
Unboxing Videos is very
good. But the videos
themselves look very
amateurish. Sometimes the
camera goes out of focus.
Sometimes the presenter’s
face is visible reflecting on
the polished surfaces of
the products. Sometimes
the video gets blurred and
it gets unstable. I didn’t
expect such quality from

you professionals!

2. Please change the DVD

interface. It is boring.

3. Please provide a stable
version of Digit Software
Archive as soon as possible
(one like the 2006
version).

4. In the Price Watch
section, the pictures
of the components are
mismatched with the text
in the previous versions.
Please take care of that.

5. And finally, I want to know
the name of the person
who deals with the Agent
001 section. I want to
congratulate him for those
brilliant recommendations.
Keep up the good work.

L. Chandrahas

Fl Thanks for the feedback. |
hope you’ll like the ones we've
given this month, and we will
continue to improve.

Robert

£=J The September issue was
really great right beginning
from the Editorial strongly
supporting “Understanding
comes from challenges not
the ease offered by info at
fingertips” was excellent
and the cover story about
“Web awards 2009” also
remarkable. As a reader

of five years I have few
suggestions such as please
provide big fonts and make
the fonts darker and I beg
you to do this because the
font now is making too
stressful to read the article
and when referring “readers
letters section” in Digit for
past few months I noticed
complaints about fonts to
be changed but the problem
still persists! I suggest you
to provide fonts as in August
2008 issue...
I also want you to

bring back sections like
“crossword” and “take a
crack” which are really Digit’s
unique features and it makes
zero cost to bring back in
Digit. I was shocked to see
Digit Reader’s Meet held at
Coimbatore because since my
hometown is Kangayam for
past five years. I'm studying
in Coimbatore only. I also
registered at “Digit reader’s
meeting at SMSGUPSHUP
referring coimbatore only”
but the meeting was held
without mel!

Sathiya Moorthy

Fl we are constantly striving
to improve our content, and

how it is presented. If you
like tech contests, flip over to
page 141 for a chance to win
loads of prizes over the course
of this month. You will have
to answer one tech question
a day. There must have been
some freak mix-up with the
database, and you are the first
and only casualty thus far.
Medic!

Robert

=4 T bought the latest
September 2009 issue. I
had the DVD containing
Graphics Applications Pack
virus checked through Avast
and it reported the presence
of a Virus in your DVD. I am
sorry to inform you about
this Virus. Your DVDs were of
use till now. Now I am afraid
of them. Please render service
to society by providing Virus-
free software.

N.S.

Fl The “Customization” section
in the DVD is responsible
for the virus alert. Some of
the software (eg: bbclean)
are explorer.exe shell
replacements for Windows.
As many viruses start by
disabling explorer.exe,
some anti-virus
applications flag
the software as
a virus. This is
known as a false
positive. Anti-
Virus software
with very
sensitive heuristic
scanning will
flag a number of
viruses on the
DVD. The other

DVD with the virus updates
is another source for false
positives. Anti-Virus software
with poor registry matching
mechanisms, is liable to flag
perfectly innocent software as
being infected. This is likely to
happen when any source with
a large number of software
interfaces with the computer.
We download the contents of
the DVD on secure machines,
from reputable web sites,
and scan the contents before
burning. We suggest that you
report the false positives to
your Anti-Virus provider.
Aditya

t«d Thanks for this issue.
I think of ‘more’ you guys
provide ‘more and more’.
Web awards just made
surfing more easier. Face
recognition technologies
just stole my heart. CPUs
were good priced, better
performing and best tested.
Thanks for Tips and Tricks
on Browers. Netbooks were
awesome and cheap. I agree
with Editor’s view on WWW.
It just gave all information
but made everyone lazy.
It just like spoon feeding.
Thanks for reviews on
Wolfenstien. Digit has
tested almost everything. I
think it is time to go bigger.
Can you guys test different
OSes please? Please can
you provide Fasttrack on
languages like Fortran,Cobol
etc. Can you please revist the
Gaming Special issue? I will
eagerly wait for next issue.
Mayur Gaikwad

El The Fast Track to Freeware
had a big comparison of the
different distros. Testing
OSes does not make sense
because of the suitability
for each of these OSes. Each
OS is meant for particular
purposes, and it is not
really an apples to apples
comparison. We do include
developer related content
in the magazine, try out the
Developer section on the
Work DVD.

Rossi

5= In June 2006 I got my
first Digit only by accident.
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Young Indian Innovators

A Digit initiative, and platform to recognise
the contribution of innovative Indians in the
field of technology

Feedback

Let us know your feedback at
www.thinkdigit.com/d/oct09

Since then I never missed any
issue. At that time I didn’t
have PC at home. In 2007 I
brought PC and then as you
said somewhere in Digit Fast
Track, installed Windows
XP as its Free in India just
like Linux. T used all those
great softwares (free in India
only), many cracks, tricks.
But during that time Digit
was only magazine who
made me to use freeware
and stop using those other
Free softwares, by giving
alternatives to all proprietary
softwares, and telling the
importance to use of it.

Finally in June 2009, three
years after my first Digit, I
completely removed Win XP,
Photoshop, CorelDraw, Media
encoders and many others from
my hard disk and also from
backup CD and installed Linux
MINT 7 GLORIA from June
09 DVD. Credit is only yours.
Thanks a Lot. Last month it
was a great issue for new bee
like me in the world of Linux.
I was very happy. But what
about this issue. Completely
disappointing. Nothing is there.
Not a single software, or even a
article related to Linux. I know
you'll say there is gOS, Moblin
but in 16 GB it’s nothing. You
are again tempting me to try
all that 16 GB software stuff
by installing Windows xp. I
am thinking that do I made
mistake by shifting to Linux. I
don’t have internet connection
at home. Its very difficult to
install any new software and
update system. What about
the “Digit Software archive”.
Please give it, the original not
V2. Sun Virtual Box was also
for windows platform and
what about me. I think you
are biased about OSes. Please
give some more space to Open
peoples also. BTW you are
great. All the best.

Pravin Vibhute

Bl 1 am yet another fan of
Digit. One thing I like most
about Digit is diversity in
content. With each issue you
get information about lots of
things. Your september issue
is awesome. Content in the
DVD is also great. I think
you wasted a lot of pages in

Bsd 1 am a long time admirer and reader of

Digit and am glad to say a very satisfied one

at that. Over the years I have seen Digit evolve
in accordance with the current technologies,
the specific needs of the existing scenarios and
most importantly the views of its readers. This
has made Digit my (and I am sure many others)
best choice for a complete and satisfying

technological review.

LETTER OF THE MONTH

big fan.

The introduction of Fast Track was another
milestone innovation from Digit. Comprehensive
and Compact, it gave us readers an in-depth

knowledge of a particular topic every month.
By far, for me, Digit has always been in the

forefront of its genre with Fast Track backing

it up adequately. Digit has continued to

deliver the goods this month too, especially
the Web Awards and the articles on various
web browsers, but this month'’s Fast track

was absolutely fabulous. The “Fast Track to
Wireless Technologies” blew my mind away. It
has answered every question I ever had about
wireless technologies especially mobile phones.
It was very helpful and informative, and it most

the web awards. I am using
Windows Vista home basic.
Now i want to use Linux. As

[ am new to all this can you
just help me out. I want to
use both Linux and Vista
simultaneously. Can I install
Linux over Vista? Please
provide sufficient information
along with setup for Linux.

I also faced problems in
using distros such as Moblin
and Android. I dont know
how to use them. I think you
should provide sufficient
literature to use softwares
you provide with DVD. 1
also want to make partition
in my hard disk. Is there
any software like partition
magic for Vista. Please cover
wireless mobile bradband
services in your issue. I am
still waiting for a detailed
article on windows 7.

I want to thank team digit
from bottom of my heart for
doing great work. There is
no doubt that you guys are
amazing. [ am very excited
about October issue. Fast track
is superb and is of great help
to ones with non-technical
backgrounds. I am very
impressed by your fight against
piracy. I am doing my level
best to promote it. Keep it up.

Rohit Tripathi
Kanpur

[l First burn the contents of
a .iso file to a CD in case of
a live distro such as Moblin,
Android, or in this month’s
case, ReactOS, BackTrack or
Qimo. Place the CD in the DVD
drive, restart the computer
and hit [F12] to load the Live
CD. The distro should boot in,
and usually you can install the
distro if you like it using a GUI
installer from the desktop. To
dual boot a distro, go to Start
> Run > discmgmt.msc
on your Vista system, and
use the GUI to create around
2 GB of free space - more if
you plan to use the Linux
distro regularly. Then, when
selecting a target partition for
the Linux installation, choose
the partition you just created.
The last issue’s Tips and Tricks
section has a detailed feature
walkthrough of Moblin. Thanks
for writing in.

Aditya

5 [ have a few complaints:
1.You have stopped printing
Month of Publication on
DIGIT Cover. Is there any
reason for that ? This gives

a chance to the sellers to
dupe a customer. (The
culture of troubling and
cheating each other in
round robin fashion is
rampent now a days in

definitely going into my all time favorites. It
was prepared and presently in such a manner
that even a novice like me could get the most
from it. I would like to extend my heartfelt
gratitude to the entire team at Digit for a job
superbly done.

I wish the entire team best of luck for the
future and keep up the fantastic work. I'm a

Syed Faheemuddin

Il Thanks for the vote of confidence; it’s always
nice to get positive feedback.

Robert

Indian culture and it is
still thriving.) Please print
the Month of publication
in Big fonts at a particular
location, say at the right
top corner and print it
there itself at this fixed
place for every issue. Make
the life simple and reduce
time wastage .

. Bring back the old Digit

Archive search, the job

of a novice is not worth
finding a place in your
SW. Have you not tried
before offering theis to
your readers? Readers are
finding it useless.

3. Avoid printing in too
small a font size. Those
who wear specs or having
visual impairments find it
difficult to read.

Thank God, you have
discontinued printig Digit on
glossy paper.

It is surprising how these
escaped consideration of a
person of Information society.

RS Bhattacharya

N

El Digit should be bought
when relevant, regardless of
the month. The archive is
on it’s way back, and we’ve
made some changes in the
font. Hope youwll notice the
differences.

Robert
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Web awards

Read Digit’s September 2009
issue for options on photo printing
and all the best web sites around

DreamsScreen

HP’s latest photoframe with social
networking capabilities, internet radio and
media player

Catching
more fish

We spoke to Bala Parthasarathy, Managing
Director - Europe and APAC, Snapfish, Hewlett-
Packard on its plans for the Indian market.

Nash David
nash.david@thinkdigit.com

What has Snapfish planned for India in the near future?
Anyone who has been keeping a close watch on the online
photography space in India would acknowledge that Snapfish
has etched out an enviable success story within its inaugural
year in India. With a robust economy despite the meltdown,
an unprecedented internet penetration rate and the express
globalisation of the Indian consumer, Snapfish had always
envisioned an all-digital-photography landscape for India. We
indeed have ambitious growth plans for the Indian market that
comprises business alliances, interesting product integrations
and emphasis on product innovation in order to deliver
distinguished service to our customers.

We have recently launched the Snapfish application on two
of the latest imaging phones by Sony Ericsson - C903 and
C510 Cyber-shot. Both the phones come with the pre-installed
Snapfish application, which allows users to click pictures
and directly upload them on www.snapfish.in from the phone.
Moreover, the application also allows users to order prints of
their pictures and get them delivered at their doorstep. We
have also partnered with eBay India, the leading eCommerce
marketplace in the country, in our attempt to enrich the
user experience of the online shoppers by offering them the
convenience of uploading and sharing their memories as well as
creating personalised products instantly.

Tell us more about your print labs and how you deliver
prints to the end user?

We have state of the art photo printing labs that house HP’s
Indigo, Design Jet and RPS printers. We have tied up with
leading logistics companies to have the orders shipped to
anywhere in India.

Is the model for Snapfish India specific to India or does
it follow the global HP network?

Snapfish follows the same business model globally.

What do consumers do if they are not pleased with the
print quality?

As part of the HP family, impeccable print quality is in the
Snapfish DNA. All the photos at Snapfish are printed using
printers and have a shelf life of over 100 years if kept exposed
and over 200 years if they are kept protected in an album or in
a glass-protected photo frame. However, consumer feedback is
very valuable to us as it gives us an opportunity to continually

upgrade and enhance our product and service offerings. Hence,
we have a mechanism on our web site through which customers
can share their feedback.

What is unique about Snapfish that you expect users
to be drawn? Especially with Google Picasa and Yahoo
Flickr for storage and numerous others allowing print,
what is Snapfish’s USP?

Being one of the early players in the industry, Snapfish has been
an integral part of the industry evolution for over a decade.
Hence, Snapfish is in the best position to understand and
address the needs of the digital consumer today and is therefore
the leading player in the online photography space globally.
Further, operating under the aegis of HP we have been able to
scale down our costs considerably. We don’t anticipate any
major competition since we offer the best quality products at
the best price and also have the largest array of products in the
online photography space comprising over 25 photo products.
Some of our popular products include greeting cards, canvas
prints, collage posters, photobooks, collage photo mug and
photo calendars.

Tell us some interesting consumer trends in the recent
past. How do you see consumers responding in the near
future?

Never relying on the crystal ball, Snapfish has always taken
cues from consumer and market research data in order to
predict future trends. With the handset industry witnessing a
mega pixel explosion, camera phones are becoming the digital
cameras of the future and the number of people relying on their
camera phones to click spontaneous pictures is bewildering.
Moreover, the basic premise of our business is to help people
share, print and store their photos no matter what type of
gadgets they use to click pictures. Hence, we have already
started work in this direction, initiating interesting partnerships
with handset manufacturers such as Sony Ericsson for

Snapfish application integration into their phones. This would
address the needs of the digital consumers who have already
started looking for ways to integrate the click, share and print
phenomenon into a single device. El
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Pehle aap

The internet is buzzing with rumors
that the Sony Ericsson Xperia 3 will be
available in January 2010, and might

be out before even the Xperia 2

Small is beautiful

LG has introduced a new nettop - XPION
X30 which is based on the NVIDIA ION
platform and is priced very competitively
at approximately Rs. 23,500

HP DreamScreen

brings Facebook, wireless media and Pandora to

any corner of your home

P has launched a

new PC-companion

media player, the

DreamScreen,
which connects easily to a
wireless or wired network to
bring photos, music and video
into any area of the home. The
screen also transforms social
media and web information
into consumable, bite-sized
pieces.

Before moving on into the
press release, here’s our own
bite-sized piece of what you need
to know: It comes in two models
with 10-inch and 13-inch screens
respectively, has 2 GB of builtin
memory, touch-sensitive controls
on the frame, Wi-Fi connectivity,
USB ports, memory card reader,
builtin speakers, a 3.5-mm
audio jack, and a remote control.
The software available includes
Snapfish for photos, Pandora for
internet radio, Facebook, a media
player and a clock as well.

Without further ado, here’s
the full press release from
HP:

People now can stay current
with Facebook friends and
photos, listen to Pandora
Internet radio, share Snapfish
personal photos and enjoy their
music and pictures from home
networked PCs(1) with a new
category of connected screens
from HP. The HP DreamScreen,
a companion to the PC, connects
easily to a wireless or wired
network to bring photos,

music and video into any area

of the home. The screen also
transforms social media and web
information into consumable,
bite-sized pieces.

“Constant, always-on access
to friends, information and
entertainment is a common
expectation today,” said Satjiv
S. Chabhil, senior vice president,
worldwide marketing, Personal

HP’s DreamScreen

Systems Group, HP. “With HP
DreamScreen, social media,
web services and digital
entertainment can be enjoyed in
more areas of the home.”

The HP DreamScreen features

a piano-black design with a
vibrant, flush glass widescreen
display. The DreamScreen 100
(measuring 10.2 inches) was
designed to fit perfectly on a
nightstand or dresser. The HP
DreamScreen 130 (measuring
13.3 inches) is ideal for kitchen
counters and coffee tables.

To read the complete story visit

http://thinkdigit.com/d/67432/

Pricing and
availability

The 10-inch HP DreamScreen
100 is available today in the
United States for $249 (Rs.
12,000 approx), while the
13-inch DreamScreen 130 is
expected to be broadly available
later this year for $299 (Rs.
14,500 approx).

Google acquires
reCAPTCHA
reCAPTCHA, another one of
the internet’s most innovative
projects in now in Google’s
grasp.

Not only is eCAPTCHA
an effective device for security
against spam, it also manages
to accomplish a mission, to
convert a large volume of printed
literature to text.

While most such services
automatically generate distorted
letters, making them difficult for
anyone but a human to discern,
reCAPTCHA goes about it
differently.

With reCAPTCHA, every time
you prove that you are a human
you are effectively helping the
process of digitising printed
documents. Instead of using
better and better algorithms
to generate better distortions
which can only be recognised
by humans, reCAPTCHA
instead uses portions of scanned
documents which failed to
get recognised by the OCR
(Optical Character Recognition)
algorithms used to digitise it.
Many times these can easily be
recognised by humans.

With the support and
resources of Google behind
reCAPTCHA, it is possible for the
project to reach an even higher
gear. With all Google services
using reCAPTCHA, and with
more resources from Google to
make reCAPTCHA more easily
available and implementable, it
is bound to see an increase in
adoption.

Projects such as Google
Books and Google News Search
already use reCAPTCHA to help
in digitising a great volume of
scans of old books, magazines
and newspapers. Word by word,
reCAPTCHA aims to digitise a
large part of past documents
which right now only exist in
print, making more and more of
our history indexable, searchable,
and accessible to a greater public.

Microsoft unyeils new
open-source initiative
If you can’t beat them, join
them!

Seems to be the new Microsoft
strategy. After coming to the
spotlight recently for donating
around 20,000 lines of code to
the open source community, (to
help Windows run on Linux
virtualisation platforms), they
have now started a new open
source foundation CodePlex, not
to be confused with their open
source code sharing web site of
the same name.

To read the complete story visit

http://thinkdigit.com/d/15767/

Their new foundation it
seems is an effort to get more
commercial companies to
participate in open source
ventures. As they state on their
FAQ page:

“We believe that commercial
software companies and the
developers that work for them
under-participate in open source
projects.”

Sounds familiar. Isn’t that
exactly what Microsoft did with
its own open source submission?
As taken from the blog of a
Linux kernel developer about
Microsoft’s Hyper-V kernel
drivers code submission:

“Over 200 patches make
up the massive cleanup effort
needed to just get this code
into a semi-sane kernel coding
style (someone owes me a bit
bottle of rum for that work!)
Unfortunately the Microsoft
developers seem to have
disappeared, and no one is
answering my emails. If they do
not show back up to claim this
driver soon, it will be removed in
the 2.6.33 release. So sad...”

The open source community
is one of instant feedback and
continuous change, where
projects continually get forked
and die out. Microsoft just
jumped into the deep end of the
pool.

Their new foundation is
aimed to be an organisation
much like Mozilla, Gnome and
KDE, however one which caters
to a much broader spectrum of
software projects.

Another citation from their
FAQ, which seems almost
satirical, Poe’s law could have
come in here:

“Specifically we aim to work
with particular projects that can
serve as best practice exemplars
of how commercial software
companies and open source
communities can effectively
collaborate.”

The cojones! While the
foundation does include
members of the open source
community, it is questionable
how much experience Microsoft
could possibly have gained about
collaborating with open source
communities during its singular
code dump which it failed to
maintain.

The new Samsung Omni PRO B7330 will come with Windows Mobile 6.5 0S EI The Samsung Star $5233w will launch in India with WiFi; will cost around Rs. 12,000
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A new hope

Star Ocean: The Last Hope was a game that was
launched for the Xbox 360, but will now see the
light of day on the PS3 in Feb 2010, as it was
announced by Square Enix, the developers

The affordable quad

AMD has released the first of its kind sub $100
quad core processors. The Athlon Il X4 620
and 630 are 45nm manufactured quad-core
processor, previously codenamed Propus

Indian EOVt plans

to block all Internet
telephony for security
purposes

Cheap international calls over
VolIP (Voice Over Internet
Protocol) may soon be a

thing of the past for Indians

as the Intelligence Bureau has
asked the premier telecom
body, the Department of
Telecommunications (DoT), to
block all Internet telephony until
security systems to trace the
same are in place.

The Intelligence Bureau is
of the view that currently, India
does not have the capabilities to
track internet telephony calls -
both domestic & international
—and had asked the DoT find an
“early solution to this issue in the
interest of national security”.

The ‘recommendation’ comes
in the wake of last year’s 26/11
attacks in Mumbai, where the
terrorists used this medium for
communication.

“The terrorists used net
telephony as they were aware
that India did not have the
technological capabilities to do
a live trace of such calls,” Cyber
security expert Vijay Mukhi told
Economic Times. “In the US and
Europe, all players who offer

VOIP services have provisions
that allow governments to track
these calls. Many of them have
also installed equipment at their
premises to monitor VOIP calls
upon orders from governments.”

According to a report
by telecom regulator TRAI,
consumers used over 130 million
minutes of Internet telephony
in the January-March quarter
of this year. This report also
adds that 34 ISPs in India offer
net telephony services in India
legally.

“This is a good move and
it will also make the ISPs
compliant to law,” Mukhi told
rediff.com. “We cannot obviously
stop all the players as there are
thousands of them but it can
help to a large extent by blocking
all the main players.”

“This will hit consumers
very badly. Not only are the calls
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cheaper, the sound quality is also
much better. The government
could work out an agreement
with the main players in this
regard. Consumers should not
suffer as a result of government’s
inaction,” Mukhi added.

The jury is still out on the
necessity of such an extreme
step. On the one hand, the
important of security cannot
be taken lightly any more
in the light of recent events
across the world; on the other
hand, curbing advances in
technology that enable better
communications do not benefit
anyone. What's your take?

It’s official: Indians
love Google, Gmail,
Orkut, Google Maps,
YouTube and Blogger
Here at Digit, we are all
absolutely addicted to Google
products. Everyone uses Gmail
as their default client, Google
Maps is the default mapping
engine for us and let’s not even
get into the realms of actual
search and video-sharing. We all
know who dominates there!

So it doesn’t come
as a huge surprise to us
when ComScore says that
Google and its product constitute

Post your comments at
http://thinkdigit.com/d/98531/

an amazing 28.9 per cent of the
share of total time that Indians
spend online. Apparently, of
the total 21,799 minutes that
Indians (aged over 15) spent on
the Internet (at work or home)
in July 2009, 6,294 of those were
used on navigating Google sites.

Google accounted for
88.4 per cent of all searches
conducted, and had
commanding share of time
spent in social networking with
Orkut (68.2 per cent), maps with
Google Maps (63.9 per cent) and
multimedia with YouTube (82.8
per cent). It also commanded
slightly less than half of all time
spent in the blogs category with
Blogger (47.6 per cent) and email
with Gmail (46.8 per cent).

The one disappointment for
Google would be the fact that
its photo-sharing service Picasa
has simply not taken off in India,

with it accounting for a mere
16.2 per cent.

Out of all the statistics, the
only one which caught us off
guard was how dominant Orkut
was. We had no doubt that it
would be the market leader, but
the amount of share it has is
staggering, considering how few
people we know who prefer it to
Facebook now.

Apart from India, only Brazil
shares such high Google usage,
with it topping the list at 29.8 per
cent of all Internet usage in that
country.

So why is Google so
popular in these two emerging
economies? ComScore has a
possible explanation.

“As it turns out, there are
interesting similarities between
Brazil and India as emerging
Internet markets,” Alex Banks,
managing director of comScore
Latin America. “Google’s
prevalence in these markets can
perhaps best be explained by
the fact that the time at which
these markets really began to
develop and flourish was around
the same time that Google was
becoming a major player in the
search landscape. As a result,
Google became the dominant
Internet brand in these markets
and its success appears to have
bled from search into other
areas of the Web like social
networking.”

It’s Go time for PSP Go

The guys at GameSpot UK
got their hands on the new
PlayStation Portable Go - the
latest version of the handheld
console from Sony - and have
just posted a detailed unboxing
video of the same on their site.
A couple of things stand
out in the video, with the most
promising new feature being the
inclusion of the ability to pause
your game. In the old PSP-3000
and all previous versions, the
best you could do was quit the
game if you wanted to perform
some other task, such as
watching a video. But in the new
PSP Go, you can simply pause
the game (although it takes a lot
of time to do s0), go back to the

XrossMediaBar and head over
to the videos section to watch a
movie.

This feature could be
especially handy for games with
checkpoints that are too far and
few in-between. We have also
found ourselves sometimes
wishing for a feature like this
when travelling in a crowded
train. As playing the game
becomes impossible, the option
of pausing it to listen to music
and then resume the game
later, right where we left off, is
absolutely fantastic in our books.
Round of applause here, please?

Apart from that, the other
big change is that the PSP Go
comes with a proprietary cable
now. Gone are the days of using
just any micro-USB cable you
have handy with your PSP; Sony

is back to its ‘use our cables and
make us rich’ nonsense again.

Part of the reason for this
might be the fact that the PSP
Go does not come with a TV-out
port like the older versions. The
GameSpot reviewers surmised
that the new proprietary port
might double up as a TV-out
port — with another proprietary
cable that you will have to buy,
of course.

Both the reviewers were also
impressed with the build quality
of the PSP Go, noting that the
slider mechanism feels good, the
analog nub has more resistance,
the chrome buttons on the edge
feel better than the plastic ones
of old, and overall, the console
has a ‘solid, but lighter’ feel to it.

One line in the review did
bother us though: Apparently the
PSP Go can be synced up to only
PCs and not Macs. Is this Sony’s
way of welcoming the iPod
Touch to the world of handheld
video game consoles? Fl

Check out the PSP Go video at
http://thinkdigit.com/d/47687/

Nokia N86 to get face detection firmware upgrade El Palm has decided to do away with Windows Mobile 0S and work towards their own Palm Web0S in the future El



Thinkdigit.com Exclusive

The best PMPs reviewed this Diwali. Go to
thinkdigit.com/d/pmp_test and read the

exclusive test online

TED Talks

Watch videos on exciting and

innovative ideas on Digit DVDs

ith the advent
of the internet,
the very concept
of freedom is
something that has undergone
significant change. Concepts
such as open source software,
and copy-left licences are
certainly no invention of the
internet, yet without it, their
very model becomes infeasible.
Today, most popular web sites,
be it Wikipedia, Flickr, YouTube
or even Twitter, are populated
with user-generated content.
Technology advances
freedom and nurtures it.
Your computer alone can be
the source of information,
entertainment, and even
income. Yet, we are still
constrained by the physical
world we live in, and even
the best internet connections
cannot assuage a hostile
government.
In August, this year,
we celebrated the 62nd
anniversary of our
Independence Day. To
commemorate this occasion,
we decided to compile a list
of some of India’s youngest
innovators. Some of India’s
brightest and youngest minds,
who have unveiled innovations
that are bound to influence the
shape of things to come.
Our goal was to introduce
to you (our readers), some of

the brightest minds from this
country and to garner your
opinion on the most influential
innovation. As such, we
conducted a poll at http://www.
thinkdigit.com/yii, allowing you
to browse through profiles, and
vote for your most deserving
candidate.

No innovation is
insignificant; in today’s world,
the inventor of the socket is as
responsible for our computers
switching on, as the one who
discovered the transistor. The
smallest of innovations pile
up today to create tomorrow’s
world.

Here are some of the
participants:

Anand Agarawala

As operating systems progress,
we tend to see a move towards
interfaces that emulate the
real world. Anand’s software
BumpTop takes it several
steps forward in this regard,
and turns your desktop into a
realistic 3D physical-desktop-
like environment.

We are used to interpreting
the reality around us as physical
objects, and by displaying
objects inside your computer.
BumpTop removes extraneous
layers of interpretation. Objects
on your BumpTop desktop
obey similar rules of placement,
and interaction, by allowing

Anand Agarawala

stacking of objects, and tossing
documents to a printer, or USB
drive; commonly used files can
even grow in size, making them
easier to find.

Agarawala’s application, created
as a Masters’ project, has even
been presented at TED Talks
and has significantly evolved
ever since.

Farinaz Koushanfar
With rampant piracy brewing
around us, it’s quite easy to
duplicate software — with
or without the internet. Yet,
hardware piracy, although a
lesser-known phenomenon,
can be perhaps much more
damaging. ICs could be used
anywhere from innocent video
players to high grade weapons.
Koushanfar’s technique
uses a unique ID to lock each
chip so that it cannot be used
without either a redesign, or
a code from the designer of
the circuit, making hardware
piracy a tough nut to crack.
Her method uses inherent
manufacturing imperfections,
as a base for creating the

unique code. Tiny deviations in
the circuit, which have no effect
on the device otherwise are
encoded as a binary sequence
(1s and 0s) and makes each IC
unique.

Priti Ranadive

Even as the number of
computing cores increase,
software applications are slow
to catch up. With dual and
quad-core computers becoming
commonplace, a lot of thought
and effort needs to be put into
designing a software to take full
advantage of the performance
increases which come with
parallelism.

Ranadive’s tool enables
software to keep up with the
multi-core revolution. This
automatic parallelization tool
helps convert legacy source
code to parallel code and
exploit the advantages offered

Farinaz Koushanfar

Priti Ranadive

by multi-cores. Arguably, this
this tool’s best feature is that
it requires little or no manual
effort, and stands to offer great
performance gains and reduce
the execution time of the
code. This can be successfully
implemented in the field of
bioinformatics in applications
such as protein folding, weather
prediction, mathematical
simulations among others.
Such fields stand to gain a lot
by being optimised for parallel
processing.

The young Indian innovator
with the most innovative and
influential creation is...

Pranav Mistry

This young innovator has
already garnered much fame
and attention around the world
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SixthSense in Digit
Read the May 2009 issue of Digit to
know how Mistry’s SixthSense works

MC9500
Motorola’s recently launched
handheld computer

Our other candidates

Trilokya and Champak Bora

Transmitting music signals through normal house wiring.

Sudhakar Sah

Efficient load-balancing of phases in 3-phase power supply units.

Mansukh Prajapati

“Mitti Cool”, a refrigerator made entirely of clay.

Sendhil Mullianathan

A new model of economics based on consumer psychology.

Tanzeem Choudhury

Device for analysing an automatic social networking connection by
recording and interpreting data from multiple sensors.

Sumeet Singh

Better heuristic detection of viruses based on how they spread.

Prithwish Basu

Algorithms for decentralised (“ad hoc”) networks that can operate without
the need for a base station.

Anurag Dod

Founder of first Indian crawler based search engine: guruji.com

Sanjit Biswas

Cheap Wi-Fi routers that can adjust to changing network environments for
best performance.

Prem Singh

Automated remote-controlled robot called “BSF Robot” that can help in
search and rescue operations.

Tapan Parikh

Information services for small business owners that are centred around
mobile phones instead of computers.

Krishnan Kutty

Solutions to make driving safer using multiple sensors.

Vijay Krishnan

Founder of Infoaxe, a web memory search engine that allows you to
make your web browsing history (and thus your habits) accessible and
searchable across computers.

Sundar lyer

Cheaper and better caching solutions for routers.

Anand Raghunathan

A mobile security co-processor to make data and communication on mobile
phones safer.

Harimohan and Manoj Saini

Optimised car designs eliminating differential gears by adding a fifth
wheel.

Ashok Maliakal

Next generation, low-powered flexible displays.

Master Moxad Pinakin Thaker

Model for utilising waste sewage for useful purposes such as generating
electricity.

Shetal Shah Safer ambulances and military transport vehicles for people with head
trauma.

T. Sony Roy Cheque authentication system using ‘inkless’ fingerprint; ErPaper, erasable
and reusable paper; Cool imager, instant photograph development device
for use in photo-vending machines.

Suhas V. Shinde A novel new architecture of delay line resulting in 95 per cent power saving

and 65 per cent area saving.

for “SixthSense” which he calls
a “wearable gestural interface.”
Some of the most brilliant
innovations we see today
have to do with changing
the way we interact with
devices. As technology
becomes a larger part of
life, and gets a larger share
of our income, it becomes
even more important how
we interact with technology,
as we now do so more
often.
In this respect,

SixthSense takes a backwards
approach. A previously
mentioned innovation,
BumpTop tries to mimic the

way we interact with physical

objects, making it easier for

people to adjust to a computer

interface. ‘SixthSense’ on the
other hand turns your
physical world into one
large interactive entity,
redefining not only the way
we interact with technology,
but with everything.

While technology has
entered every field of our life,
many tasks such as acquiring
daily-use consumables,
for example, still need to

Pranav Mistry

be done in person. While the
internet may be teeming with
the latest information, it’s often
beyond reach. Whether you are
shopping at a store, or on the
way home, there are many times
when the plentiful information
on the internet can be of real use,
but it’s just not available.

The ‘SixthSense’ device,
aims to make everything you
see around you an intractable
interface. When you pick up
a carton of milk at a store, it
can tell you its fat content, and
how well it'll go with your diet,
or when you pick up a book
at the store, it will project its
rating from Amazon, along with
comments, and references. If
you're on vacation and need to
snap a picture, you need not
worty, just form the right gesture
and it will take a photograph.
Draw an ‘@’ symbol in the air
and check your email. The best
part is that the device would not
cost much more than a mobile
phone in the future.

In most demonstrations
of amalgamated reality, we
see artefacts superimposed
and blended with the live
world. Pranav’s vision takes
augmentation to the world
outside computers. We
see many films depicting a
future where every device is a
computer embedded, where
newspapers show flexible
displays, and your retina is
the key to your entire life.
This vision in comparison is
much more real. Why wrap
every toilet paper in an OLED
touch-screen when instead the
gestures can be recognised by a
computer with a camera? Why
upgrade the world when you
can upgrade yourself? El
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Your web
From anonymous browsing, Bing to
Monopoly, insights into your world

Track your digital life
Get to know where you spent all your time,
from web sites visited, applications used, to

online

the games you played

Opera Mini v5
released

More than 30 million people
use Opera Mini as the mobile
browser of their choice to
browse more than 12 billion
web pages. Undoubtedly,

if there is an award in this
category, it would go to this
browser. Opera Mini offers
anear desktop browsing
experience and is taking this
a step further with its latest
version that includes a variety

Tabbed browsing now on your mobhile
phone
of features, including tabbed
browsing and speed dial.
Version 5 beta also has some
interesting Ul improvements.
The overall look and feel of
Opera Mini has changed quite
a bit and is now optimised
for both keypads as well as
touchscreens. We tried the
browser on the Samsung Jet
(S8000) touch phone and
were impressed with the
browsing experience. You'll
find a Google search bar next
to the navigation bar which
is convenient. The speed
dial and tabbed browsing
work fabulously well and the
response of the on-screen
QWERTY keyboard was
impressive too. Web pages are
rendered quite well and only
require a double tap to zoom in.
The cursor was a little buggy; it
appeared one character before
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the actual point of typing,

a minor irritant. To get the
browser on your phone, simply
direct your phone’s existing
web browser to http://m.opera.
com/next to download Opera
Mini 5 beta.

HTC’s Hero debuts
The most promising Android
handset, the HTC Hero has

finally arrived. Considering
the recent hike in taxes,
you'll have to dig deeper
into your pocket to get

one, especially if you're in

Maharashtra. While it will be

priced at Rs. 31,990 across

India, Maharashtra users will

have to shell out Rs. 34,600

(that's an extra Rs. 2,600).

If you're not on Airtel’s
network and you're in

Maharashtra, it would be

a double blow to know

that Airtel is offering

its subscribers 100 MB

download free of charge for

six months. Services such
as portfolio manager, hello
tunes, weather channel
and mobshare will also be
available to the users of HTC
Hero on the Airtel network.

The phone features
bevelled edges with an angled
bottom and is contoured to
fit comfortably in your hand.
It’s designed to ensure a
convenient conversation too.
It fits perfectly along your face.
The HTC Hero is built to last
and has an anti-fingerprint
screen coating for improved
smudge resistance and a longer
lasting, clearer display. The
white HTC Hero includes an
industry-first, Teflon coating,
resulting in an improved,
durable white surface.

With its 3.2-inch HVGA
display, the HTC Hero is
optimised for web, multimedia
and other content while
maintaining a small size and
weight. It also boasts a broad
variety of hardware features

For a feature tour, go to

To read more on the Hero, go to
http://www.thinkdigit.com/d/hero/

HTC’s Hero powered by Android

including A-GPS, gravity-sensor,
3.5-mm stereo headset jack,

a 5-MP autofocus camera and
expandable microSD memory.

locate people in your contact
list, find emails in your inbox
or search in any other area

in Hero. Its SenseUl focuses

on three primary principles:
Make it Mine, Stay Close and
Discover the Unexpected.
That’s just R&D fluff for widget
customisation and easy access.

Camera or phone?
We've seen many ridiculous
specifications in our time.

Add to that another one. Why
anyone would need a 12-MP
camera in the first place, and
that too in a phone, is well
beyond us. Understandable, if
i's a DSLR, but in a point-and-
shoot or a cellphone, it’s just an
overkill. Yet, here we have the
new Samsung M8910 Pixon 12,
all ready to dazzle the Indian
audience.

“Speedy access to the
camera mode, fast shutter
speed and quick browsing, face
tag and photo tag sorting are
some of the key factors that
consumers are looking for in
their mobile phone cameras.
Samsung Pixon 12 holds
the answer to these pressing
consumer needs and more,”

For more on the Samsung Pixon, go to
http://www.thinkdigit.com/d/pixon/

HTC Hero also includes a
dedicated Search button that
goes beyond basic search,
providing you with a more
natural, contextual search
experience that enables you
to search through Twitter,

http://www.thinkdigit.com/d/opera5/ a camera you can call from

said Sunil Dutt, Country Head,
Samsung Telecom Division.
The 12-MP CMOS sensor is
ably supported by a 28-mm
wide-angle lens with autofocus,
xenon flash and power LED
flash. Almost every feature you

Facebook’s user base now swells to 300 million; reportedly the web site is making money for the first time El Crasher Squirrel on its way to becoming an internet meme El



DLDC

Nokia-Siemens Networks’ Downlink dual carrier
upgrade gives upto 0.6 Mbps transfer rates on
existing EDGE connections

Statutory warning
Tech addiction ‘harms’ learning, according to
researchers at Cranfield School of Management

can think of is thrown into this
lot, including tracking touch
autofocus, geo-tagging, wide
dynamic range, Smart Auto
mode, image stabilisation,
Beauty Shot, and face, smile
and blink detection. It can’t
cook your meals yet, but a little
training should get it there

too. As for video recording,

LG’s GW620 powered by Android

the Pixon 12 can handle 720
x 480 pixels at 30 frames per
second. All of this data can

be stored onto a microSD

card of up to 16 GB. The
screen is another impressive
aspect of the phone: The
3.1-inch AMOLED resistive
touchscreen renders 16
million colours at a resolution
of 480 x 800 pixels and comes
with an accelerometer for
auto-rotation purposes. The
‘resistive’ part is a bit of a put-
off, but Samsung’s TouchWiz
2.0 Ul does run pretty well on
those. Overall, for a price of
Rs. 29,990, this one seems like
a good camera with a phone
attached to it.

LG marries Android in
a Win Mo hangover
It’s been a long time coming,
but LG’s love for Windows
Mobile phones has finally
waned enough for it to feel
the itch and stray to Google’s
Android OS. The company
has officially debuted its

first Android-based mobile
phone, the GW620, which
comes with a touchscreen
and slider keyboard. The
phone will be released soon,
but the price has not been

indicated. Funnily, the

press release talked a lot
about what the company

is doing with Windows
Mobile, given the occasion!
But first, the new phone: The
LG-GW620 features a 3-inch
resistive touchscreen (320

x 480 pixels, 256k colours)
and slide-out QWERTY

keypad to meet the growing
needs of consumers who rely
on their mobile phones for
more than just making calls.
The device benefits from an

Watch an exciting video on the twitter phone at
http://www.thinkdigit.com/d/twitphone/

statement, for instance: “The
announcement of LG’s first
Android-powered smartphones
comes only a week after the
world’s third largest mobile
phone company announced
that it would be introducing
three new Windows Mobile
smartphones in the next few
weeks. These developments
underscore LG’s commitment
to offering greater consumer
choice in the expanding
smartphone category”.

Twitter Calls

Twitter has managed to garner
significant publicity in recent
times. If India’s junta didn’t
know what Twitter is, Shashi
Tharoor did let them know.
Move over 140 characters,
you'll soon be able to talk
over Twitter, that too without
spending a fortune. On

one hand where the Indian
government plans to block
all internet telephony for
security purposes, a telecom
service provider in the US is

Follow this story at
http://www.thinkdigit.com/d/LGGW620/

operating system that was
created from the ground
up to take advantage of the
many mobile applications
and services developed by
search leader Google. “The

LG-GW620 will appeal to first-

time smartphone customers

by offering a new and different

kind of user experience,”
said Dr. Skott Ahn, President
and CEO of LG Electronics
Mobile Communications
Company. “Our objective is
to provide a wide selection
of smartphones to satisfy the
diverse preferences of today’s
consumers. This Android
phone is just one of many
smartphone models we plan
to introduce worldwide in
the years ahead.” And this

stress on diversity throughout

the press release makes us

wonder why LG is so adamant

on making sure people know
it still loves MS. Take this

busy bringing phone calls to
Twitter. A new beta service
being launched by Jajah - a

US telco could soon allow
users to call each other over
Twitter. “Twitter’s popularity
demonstrates that people are
looking for simple, short ways
to connect globally.

Now in beta, Jajah’s new
@Call service allows you to
tweet your way to a call,” wrote
Jajah’s Hadara in a blog post.
To initiate a call, you simply
tweet a reply to the person
you want to talk with and
add the @call. For example,
if you would like to call @
username, tweet: @call @
username. Make sure there is
a space between the two user
names and that no additional
text is added to your message.
Jajah will call you and your
friend and connect the call.
The @Call service is currently
restricted only to US numbers
and requires users to be
eligible for the Beta. To check
if you're one of them, log in to
your Jajah account. Under ‘My
Services’ in ‘My Account’ page,
you will see ‘“Twitter Calls’. If
this doesn’t appear, and you
would like an invitation, send
an email to twitter@jajah.com.
The service has maintained the
twitter shorty spirit here too by
imposing a 2-minute talk limit
on the @Call service. El

e-book readership increases by 53 per cent this year El Google feels the heat for digitising books El Microsoft sues parties responsible for ads filled with malicious code El

Digit | October 2009 | www.thinkdigit.com [23



Rememberthemilk.com

An Adode Air notifier and an effective to-do list. It
works in sync with various mobile platforms and
Google Calendar

Twitter Granny
104-year old Ivy Bean from the
UK has over 45,000 followers on
Twitter!

A curious case for
anonymity

Traditionally darknets have
always been regarded as

the dark underbelly of the
internet, but now it seems

as if accessing a darknet will
be as simple as having a web
browser. HP researchers
recently demonstrated a
darknet - essentially a closed
private network - that can be
accessed through a browser.
Some earlier darknets such as
Freenet, Tor and WASTE have
gained notoriety for having
all sorts of objectionable
content supported by the veil
of anonymity they provide.
These darknets need a client
to access them. Finding such
clients installed on laptops
would often raise alarm bells
for security authorities as
they can be used for virtually
untraceable communication
aiding even terrorists.

The HP researchers however
say darknets have their
legitimate uses. Their creation
aptly named ‘Veiled’ can be
used for anonymous whistle
blowing and will also bring
anonymous communication
to the mainstream. Darknets
maintain anonymity by
scattering files as fragments
across thousands of servers.
They also use something
known as onion routing
that tunnels communication
through a network of relays
so web sites can’t determine
your location. In a podcast with
Security Wire Weekly, Matt
Wood one of the developers of
Veiled said, “We’re leveraging
what browsers have become
lately, to access some of
the functionality offered by
darknets”.

A simple PHP file is
supposed to connect the client
to the rest of the darknet. The
user on the other hand has to
just go to a URL. The PHP file
downloads Javascript code into
the browser. To understand
this concept imagine a whole
bunch of servers with this
one PHP file on them. All
of these PHP files together
create the infrastructure for
the Veiled darknet. Clients
will then connect to each
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one of those nodes. The PHP
files act as repeaters to all the
Javascript clients out there. The
Javascript is the one doing all
the communication between
clients. If, for instance, a chat
were to be sent out, it would
be dispersed among the
darknet users. There is

going to be encryption
involved too. The best

part is once you close

your browser, your

footprint vanishes

instantly. It should be
interesting to keep an

eye on this to see if any
productive applications

do come out of it.

People research
simplified

An interesting Firefox
extension we came across

a while back was Identity
whose description is at

once scary and promising;
depending on which side

of the fence you look at it.

The extension is a social media
marketer or compulsive social
networker’s dream come true.
But this means it may be a cyber
stalker’s punching bag as well.
The extension can amazingly
track identities of individuals
across various social network /
media sites and create a profile

about just about anyone.
Consider you access a
random Twitter profile. After
installing the add-on, all you
need to dois hit [CtrI] + [1]

and it will build a detailed profile

comprising various identities

Identify using ‘me’ links to track profiles

of that person on other social

networking web sites. How does

it do this? It uses two APIs. The
first is the Google Social Graph
APIL. This Google project started
more than a year ago identifies
pages that form profiles of
people and tracks linkages
between pages connected to a

single person. The Yahoo Query
Language APl manages the
extension’s data backend.
Identify is therefore
programmed to look up info
for any page that has the
rel="me” code in the source.
The ‘me’ annotation is
part of the XFN (XHTML
Friends Network) and
FOAF (Friend of a Friend)
markups, which are
crawled by the Google
Social Graph API. The tool
can be very useful to learn
more about people and
their trademark internet
handles. Running it on
your own profile can be
shocking or perhaps even
disappointing if it fails to
get the lowdown on you.
This way, it helps you fine
tune your profile if you
want a more integrated
web presence. Or help
people in disassociating
profiles that they don’t
want linked together. The
only hitch is that it requires
some work by the developers
and doesn’t work really well
currently.

Monopoly in the sky
No, we're not talking about
Airline Moguls. We're talking
about one of the world’s most

Monopoly city streets

The feud between YouTube and Warner Music is slowly reaching an end EFiles created with Google docs are soon to be searchable, only for the ones with the option



Webapp for making charts
Head over to lovelycharts.com and make
everything from flowcharts, process diagrams,
mind maps, network diagrams or just about any
kind of chart

since it launched to the world
in that unexpected comic

book format. To celebrate the
occasion - albeit two weeks late

popular board games has

been virtually recreated into
amega-sized masterpiece as
Google and Hasbro teamed

For more Bing’s visual search feature, go to
www.thinkdigit.com/d/bing

up to launch Monopoly City
Streets. The game allows users
to compete in a live, worldwide
version of the popular game,
creating the biggest Monopoly
tournament ever played. And
yes, you can theoretically
buy any street in the world!
However within the first few
days of launch (on September
9) there were hardly any
streets available for us to buy.
Anew player will start off
with a whopping three million
Monopoly dollars - it seems
like inflation has caught on in
the board games too. With this,
you can initially buy a street or
make an offer to a street owner
to buy it off him. The huge
money to start off obviously
means that the streets will cost
a lot too: Downing Street in the
UK will cost 231,000 Monopoly
Dollars, while Pennsylvania
Avenue will cost 2 million.
Pedder Road an upmarket
Mumbai road was last valued at
400,000. Yikes! Of course, you
can always offset those prices
by collecting rent from hotels,
football stadiums, skyscrapers,
castles, etc.

There is a bit of a weird
rule thrown in, though,
where if someone makes you
an offer and you don’t reply
within seven days, the offer
is automatically accepted
no matter how low it is. So
potentially, you will have
to log in every day and if
someone spams you with a
lot of offers, you might just
stand to lose your property.
Hopefully, there will be a fix
or some workaround for this.
The interface too is buggy, but
thousands are already addicted.
So go ahead and join the game
that has turned the globe into
one giant game board!

Chrome 3 in one year
On September 2, Google
Chrome finished a whole year
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- Google has unveiled the new
stable version of their browser,
Chrome 3.0. The version
numbers seem to be ticking
by faster than we can report
them, with Chrome 2.0 being

launched just four months ago;

still, who’s complaining?

According to StatsCounter,
the browser already has 7.39
per cent of the market share
in India, making it a force to
reckon with. So what does the
new version have in store for
us? Google Chrome Product
Manager Anthony Laforge
wrote a long post on of the
official blog about the same,
and here are the salient points:
Faster browsing: This new
release of Google Chrome is
faster than ever,

address-cum-search bar
‘Omnibox’ of Google Chrome
has gotten a much-needed tweak
to help users distinguish a search
result from a Wiki page and a site
you entered from a bookmark

in its drop-down menu. The
solution? A simple little icon at
the start of the URL. The one big
disappointment, of course, is the
lack of extensions in this new
release. Looks like Google still
has some creases to iron out.

Bing goes visual
Microsoft has launched a new
feature in Bing that couldn’t
have come at a better time. We
were trying hard to remember
the name of a movie about an
African-American cop who is

Silverlight installed. What you
are presented with first is a list
of different categories such as
movies, cars and US presidents.
In our case, we went for ‘Greatest
Movies” and were taken to the
next page. Here, we were shown
a grid of 9-columned thumbnails
of various movie posters. It’s

got a nice CoverFlow kind of
feel to it and feels very Apple

in most ways. The scroll bar,
funnily, starts at the bottom

and you have to scroll upwards,
where the columns are fading
into. Scrolling upwards, felt

a bit like scrolling albums on
HTC’s TouchFLO interface or
Win+Tabbing through Windows
Aero, where you can see the
current item clearly and check

improving by
more than 150 per
cent in Javascript
performance since
the very first beta,
and by more than
25 per cent since
the most recent
stable release.
New Tab Page:
The speed-dial

on the New Tab
page of Google
Chrome has been
one of its most
popular features
and now it’s more
customisable

too. You can

now rearrange
thumbnails of
your most-visited

Searching for
unfamiliar terms
is easy with Bing’s
Visual Search

websites by simply
clicking and dragging your
mouse.

Additionally, you can pin
thumbnails to a spot so they
don’t disappear even if your
browsing habits change. What's
more, you can hide parts of the
page you don’t want to see, or
even opt for a simple list view of
all your most visited web sites.
Omnibox gets icons: The

For more on the browser, go to
www.thinkdigit.com/d/21123

sent to investigate a murder in

a racist town, but couldn’t even
remember who the actor was.
Visual Search basically puts up
a whole bunch of images related
to different categories, making it
easy for you to locate those ‘It’s
on the tip of my tongue’ things
that you just can’t recall. The
feature has not been activated
for Indian users yet, but if you
just change your location to

US (top right corner), you will
be able to access it for now at
www.bing.com/visualsearch.
And yes, make sure you have

out obscured previews of the
upcoming items. Pretty soon,
we found what we were looking
for: In The Heat Of The Night.
Hovering the cursor over it

and at the top of the page -
under the search bar — gave the
related info: name, genre, rating
and release date. One click

and the regular search results
page for the movie opened up.
Pretty impressive. The same
kind of visual search is possible
for various other things, such
as products search, books and
carsEl

‘Publish as a Web page’ El According to research firm Forward Concepts, besides appealing to the power traveller, small, low-cost netbooks benefitted from the economic slump El



Feature

SlifeLabs.com

Has a paid time tracking software
for Mac, but comes with several
limitations

Slimtimer.com

A nice alternative to time sheets,
it lets you create tasks and even

share them with your coworkers
and those you report to

Imaging: Shrikrishna Patkar

rack your digital life

Find out how you spend your time in the digital sphere - the web sites you visit, your computer usage
pattern, the applications you used most

Siddharth Parwatay
siddharth.parwatay@thinkdigit.com

o0 one can debate the fact that most
of us spend half our lives in front
of a computer screen. We play,
socialise, interact and occasionally
do a bit of work among other things in the
digital world. But often at the end of the day
we find ourselves complaining “where has all
the time gone?” When you rewind your day it
literally seems like you got up, got some work
done, read some stuff and suddenly. Before
you realize, it’s 10 pm!
What happens when our pastimes

start eating into our mainstay? There is a
tremendous loss of productivity that happens
due to unstructured time management.
Whether you are a student, blogger, tech
enthusiast, or a professional who works from
home, knowing where you spend your time is
very important.

Time Tracking

You can now keep track of your time by using
a host of applications and online services.
These applications sit in the background and
keep track of your activities. The applications
will generate contextual reports comprising
graphs and tags to help you get a handle on
how you spend your time.

Fruitful Time Productivity Meter

The Productivity Meter application stores
information locally as opposed to Rescue
Time which sends info to remote servers -
suitable if you want your data to be close at
hand. The reports are generated on a local
server at http://127.0.0.1:7885 and the
interface can be accessed through a web
browser. The software lets you track data

for different users on the same computer.
Most of us browse as part of our work, and
so just knowing that a browser was running
for a specified time doesn’t really tell you
much. With tagging domains, you can tell
productivity meter that the thinkdigit.com
and Intel.com domains are for “research” on
processors. Apart from domains, you can tag
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Mylntervals.com

An ideal tool for small businesses that bill by
the hour, it’s a powerful web-based project
management tool that combines time tracking
and task management with powerful reporting

Klok

This nice little app built on the Adobe
Air platform works as a great time
tracking tool for project management

ManicTime in action

specific programmes and even window titles.
The interface is pretty simple and lets you
view your activity by time periods ranging
from a day to a month. You can even choose
to view activities within a specified selection
within each day, say 9 am to 8 pm. This way
you'll know the active and idle time (overall
and per hour), time distribution between
applications and web sites, and lastly tagged
time data. To try the application head over to
fruitfultime.com.

Rescue Time solo

Rescue Time has a cloud based interface. Its
client is called the Data collector, so users

who are touchy about their data being sent to
remote servers will cringe at this one. Unlike
other applications, this one is certainly easy to
set up. While configuring your profile, you can
specify productive and distractive activities. It
also lets you set goals. For instance, “I should

mouse over any of the fragments in the
timeline a more detailed note pops up.
However, you need to keep tagging the
activities in the tags timeline to make any sense
of how your time was spent. You also have the
option to Tag away time, which is interesting
as it lets you track time spent on taking calls
or going for lunch. All tweaking such as how
much time idle should be considered away etc.
can be done in the Tools & Settings tabs. The
statistics tab allows for pulling up a wide range
of custom stats.

The software
consumed around
30 MB of memory
even while running in the background, which
was considerably higher than any of the other
tools. You can download ManicTime from
manictime.com, or find it on this month’s
DVD.

Games Tracking

For many a large part of “playtime”
consists of playing games. Two
popular applications to track

your gaming pattern are Xfire and
Gamespy Comrade and perform

a host of different functions. You
can keep tab of games you play on
your PC and also other associated
information. The software creates
auto-generated profile codes that

Rescue Time being nosey about what you were upto

spend more than 4 hours per weekday on
very productive time. If I exceed 4 hours, send
me an email at the end of the day”. One of the
advantages of having your data sent across

is the ability for rankings and comparisons
with other users, which can be fun. Rescue
time will tell you where you stand in terms of
efficiency when compared to average users.
The tool can also be configured to ask you
what you were up to in your idle time.

Manic Time

Manic Time has all the functionality with a
decent interface. One drawback is that the
application depends heavily on user input.
ManicTime’s interface is broken up into
four time lines viz. Browsing, Application,
Computer Usage and Tags. By rolling the

show of your gaming hours, rig

config, and other stats that you can
embed into signatures on gaming forums.
Since Xfire has a community associated with
it, the application can be used not only to
view your statistics, you can see interesting
stats about your friend network, your favourite
servers, uploaded screenshots, friend’s game
play statistics, private messages from Xfire’s

Want to find out how many keystrokes you
make in a day? We found this impressive app
that lets you do exactly that. Head over to
http://www.thinkdigit.com/d/debuggable/.
The application rests in your taskbar and
shows you a little pop-up of how many
keystrokes you make in a day. If this gets
annoying, simply turn off notifications. Turn
notifications on when you want to keep track!

)

Make a movie of your day’s activities
With Time Snapper Professional, you can
take automated periodic screen captures of
your activity all day. The software runs in the
background and keeps taking screenshots
at intervals which you specify. The default
is every 10 seconds. During playback,
TimeSnapper even allows you to flag notes
for certain patches of activity. You can choose
to filter by certain programmes such as
Winamp or Firefox. The software also tells
you how productive you have been. To do
this, specify the applications, domains and
window titles you consider productive. So, if
you tag Wikipedia.org as productive, it will
calculate the percentage of time spent on
Wikipedia as your productivity. But the most
fun part is watching your day unfold in video.
Go try it out!

forums, top games being played on Xfire and
top downloads.

Games for Windows Live (GIWL) also lets
you follow your game trend. If you're an Xbox

Send your feedback at
www.thinkdigit.com/d/oct09

360 gamer and want to port your GamerCard
data to forum signatures, you can use
mygamercard.net or similar other services.

Music Tracking

If you're one of those who listens to an
obscene amount of music, you probably know
what the value of music tracking software

is. Those of you who don’t, well then it’s
about time you discover. With music tracking
software such as scribbler from Last.fm,
you'll know details of your listening habits.
The application will tell your favourite artists
and tracks among other things. The data can
be sliced and diced further to show overall
charts or by specific time periods such as last
three months or last one week. So the next
time someone asks you what your favourite
song is, all you have to do is look up which
track has the highest play count. The only
catch is that you need to register with the
web site before you can begin scrobbling your
music tastes. Still, registering has its own
benefits like the aspects of social networking
that are found on the web site. If you have
been using a dedicated music player for
listening to your music, the scrobbler will
pick up your listening history instantly

and post it on your profile. Apart from just
tracking, the web interface will give you useful
recommendations for music based on the
songs you scrobble. Many of the generated
charts can be embedded on other web pages.
Also there is the option of doing fun stuff
with the RSS feed of your music listening for
example putting the feed onto your blog or
twitter account. El
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Tech Treats
Reach out to your geeky and not-so-
geeky friends this Diwali

Nokia N900

The Nokia N900 is designed to
bringing mobile and desktop
computers closer, in terms of

experience. One of the primary

focuses in this device is the ability
to heavily multi-task, so the device
does not slow down if you get

a call while surfing the internet

and want to dig into the contacts
you have to message. There is a
touchscreen interface, as well as a
full QWERTY keyboard that slides
out. Under the hood is an ARM
Cortex-A8 processor, 32 GB of RAM
with 768 MB of virtual memory
that essentially gives applications
over 1 GB of memory to work with.
The device will use a customised
version of the Linux OS called
Maemo, on the heels of Google's
adoption of Android, another
Linux-based mobile OS. The device
is available at around €500 (Rs.
35,200)

Surface Tension

The Surface Tension Arcade Table is an innovative approach to furniture.
Surface Tension manufactures tables with a large touch screen interface, and
a computer built in to the table itself. The Arcade edition of this coffee table
has two set of full arcade controls and comes with over 60 retro games, and
any game that is compatible with MAME can be installed later on. Windows
XP is used on the machine, so you can install any software you want and use
the table as a regular computer. Additionally, you can play movies, browse
through photos and surf the internet all with a great 1200 by 700 mm touch
interface. The Arcade edition is available for £2,999 or Rs. 2,39,690 from www.
surfacetension.net
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Give us your feedback at
www.thinkdigit.com/d/oct09/

Canon Powershot SX20IS

The Canon PowerShot SX20 IS is a follow up on the well recieved Canon
Powershot SX10, which they released last year. The camera brings pro
features to the point and shoot domain, with easy to use functionality, but
leaving the option for a pro to manipulate settings manually. The camera
packs in a 1 by 2.3 inch sensor with a 12.1 MP count, a staggering 20X
optical zoom, 1280 x 720 full HD movie recording, and an continuous shoot
feature that let's you shoot till you fill up the card. The camera is priced at
$400 (Rs. 19,300)

Fender 57 Champ Custom

Fender is bringing back an old classic amp, that would put any buyer in the
same league as the best of rock legends. Eric Clapton, no less, used this
particular model to record Layla. The materials used for the amp are the
same used when the amp was originally made, and the entire piece is hand-
wired. This is not an imitation, or a mass-produced abomination, you can
own an authentic piece of rock history for $1,000 (Rs. 48,500)

Samsung LN65B650

This astonishingly large (65-inch) CCFL backlit LCD TV from Samsung is sure
to give those large Plasma screens a run for their money. The TV boasts of a
propriety Auto Motion Plus 120Hz refresh rate and a 4 millisecond response
time, with a full HD 1080p resolution. This reduces blur during the action
scenes of a movie, but users can customize the blur settings. The Medi@2.0
suite can stream wireless content, or play clips off YouTube, among other
connectivity options. What is really appealing is the power consumption, as
the device meets the latest Energy Star standards, something that not too
many Plasma screens can claim. The TV is available for $6,000 (Rs. 29,300)
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Zune update

Next generation Wii Microsoft recently released the Zune
Rumoured to have HD graphics and 4.0 software update that features
a brand new motion controller quickplay and smart DJ

GigaPan EEic 100

The GigaPan is a set of robotic systems that lets users take astoundingly
large images using an automated robot. The device is a mount with a clicker
that carefully moves a camera, and takes as many shots as the user specifies,
in a grid, and stitches the photos together resulting in large, very detailed
panoramas, with tremendously large megapixel counts (called GigaPixel

by the site). GigaPan systems was teasing the world with some amazingly
detailed shots put up on their website, and a product is finally out in the
market. The GigaPan Epic 100 is available for $449 (Rs. 21,720)

PSPGo

Sony’s rationale for making the PSP Go seems to be to make a smaller, more
compact and lighter device for pocket gaming. The PSP Go, which has hit
the American markets early this month, sports a 16GB flash drive instead of
the UMD memory, and a screen that slides up to reveal the controls beneath.
The only means of distribution of games however, is the official PSP store, a
new mini-game section of which has opened along with the launch of the
PSP Go. The PSP Go sells for $250 (Rs. 12,130)

(F‘Pam%oeﬁﬁl Cielo Meteorite

Meteoritemarket.com sells a lot of space rock fragments. Most of the pieces
for sale are tiny slices of a rock, that have been cut out from bigger stones.
While those may be rare, hard to find and therefore expensive, if you just
want to show off a big chunk of space rock, pick the Campo del Cielo
fragments, which don't look like they have been cut out from a larger piece,
and there are pretty big pieces on sale too. This is a particularly large piece
(over 5 KG) that is available for $700 (Rs. 33,980)
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Blood-powered lamp

A mysterious blood-powered lamp that debuted on Solar Bluetooth
the internet requires you to break off its top, and let A solar Bluetooth head set released by
few drops of blood trickle to emit an eerie glow Brando, stays on standby for infinity

JVC LT-32WX50

JVCis debuting in the backlit LCD market and how. The LT-32WX50

is just 7 mm thin at it's thickest point, and goes down to 64mm at it's
thinnest. This particular screen wouldn't look ugly or intrude into space
when mounted on a wall. The screen weights just around 5 KG. The
LT-32EX50 offers full 1080p HD resolution, a 4000:1 contrast ratio, and
displays 90% of Adobe’s RGB colour space. Be prepared to shell out
US $ 3,000 (Rs. 1,45,711) though

Leica M9

The Leica M9 is a spectacular piece of craftsmanship. The M series has a
long history, and this is one of the world's smallest rangefinder cameras.
Although the body is tiny, at 139x37x80 mm, the Leica M( manages to
pack in a large 24x36mm sensor. The large and chunky dials make it easy
for photographers to adjust the settings, and the M9 has a dial just for the
ISO settings. The Leica M9 includes a license for Adobe Lightroom in the
package. You can pick one up for £4,850 (Rs. 3,93,300)
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iPod Nano

The latest iPod Nano has
aradio, video camera
and microphone

Nokia Netbooks

The Nokia Booklet 3G will sell for less than
$500, have a 10-inch screen and built in
GPS navigation chip

Tech Trea

Groovy gifting ideas for Diwali

Madhusudan Mukerjee

readersletters@thinkdigit.com

Us that time of the year when the air is

filled with festivities. Come Diwali, and

you're bombarded with discounts and

offers. So, if you have geeks for friends
who prefer gadgets to sweets, here’s a list
of technological thingamajigs categorised
according to your buying power.

Starters (Less than Rs. 1,000)

USB pen drives

Flash drives start from Rs. 200 (1 GB) all the
way to Rs. 4,000 (32 GB) and above. They
are bare necessity and can be stuff to show
around. One that stands out makes for a cool
gift. The recently launched JetFlash V70 by
Transcend, with eco-friendly rubber makes it

Rubber drives are trendy and almost indestructible

highly durable, shock-resistant and dust and
water-proof. These are available in different
colours too — 4 GB (Purple), 8 GB (Orange)
and 16 GB (Red) - and, best of all the prices
are highly competitive - Rs. 600, Rs. 900 and
Rs. 1,600 respectively.

Pop-Up Toaster

Here’s one for

the kitchen and
whether your
mom works

or not, it'll be

a welcome
convenience.
Usha Lexus
toasters come

for Rs. 900
or less while
Inalsa ones
hover around the Rs. 1,000-mark. In fact,
considering that it is not just moms who toast
bread, you can gift your dad one.

Get your daily bread faster

Battery operated mobile charger

An emergency cell phone charger is what
travellers always need. You can get one for less
than Rs. 160 in time for the Diwali holiday
travel. These are pocket-sized, lightweight

and use 4 AAA batteries/pencil cells and are
compatible with most cell phone brands. Visit
your local mobile store for the best deals on
this one.

Electric Kettle

It's amazing how cheap

kitchen accessories have

got. The Bajaj Cordless

Electric Kettle comes

between Rs. 799 to 899.

Plug it in and you can

make tea, boil milk or

water in a moment. Give

your mom one, and then  settle for a Kettle
proceed to show her

what a refreshing cup of tea you can make.

Hair Dryer

There was a time

when hair dryers

were only meant for

women. Although

you can still gift

your sister one,

these days, even

males sporting

long hair use them.

Hair dryers are way

within budget - The Philips HP 4823 even
while the Philips HP  comes in feminine colours
4823 is less than Rs.

700, Panasonic and Remington hair dryers are
a little below Rs. 1000.

TV Video Game

If you're on a shoestring budget and you want
to please kids less than age 12 this Diwali,

gift them the good old TV video game that
you get at every local toy shop. It comes with
joysticks, a ‘gun’ and lots of games that can be
played on the television - all for less than Rs.
500. Just pray that the kid hasn’t heard of the
Xbox or PlayStation yet.

Getting your wallet
(Rs. 1,000 to Rs. 2,500)

MP3/MP4 Player
Every time you think
everyone’s got one,
just remind yourself
that everyone who has
already got one usually
wants another, better
one. Innumerable
brands - Chinese

et al. - clutter the
market and spoil you
for choice. Some of these are even below Rs.
1,000. And then there’s the quintessential
iPod. The 1 GB iPod Shuffle is priced below
the Rs. 2,500 threshold and is going to make
your friends flip. You can even change the
skin to the stereotypical pink for your sister or
girl friend. Or get it for your younger siblings
to finally let them have their own private
listening device. Cheaper players are available
for much less, if you're not fussy about brands.

The Shuffle still rules

Cell Phone

If there’s someone
who hasn’t got a
mobile phone yet,
or has an old style
one - give him/her
a colour screen cell
phone. The Nokia
1209 (Rs. 1,500)
and the Nokia
1650 (Rs. 1,765)
not only have
colour screens, but

Cell phones for starters
offer other features

Five things to remember when going hunting for gadget gifts

1. Make a List: First thing you could do is
make a list of exactly how many people
you would like to gift something this
Diwali — and who they are.

. Choose the right Gift: Everyone in your list
will probably have different tastes. If you
like something, it doesn’t mean the one
you are gifting would like it.

. Budget: Make a total of how much money
you are going to spend on gifts—in fact it
would help if you came up with a
definite figure for how much you
are definitely not going to spend
this season. Don't forget Christmas
and New Year are fast approaching
and credit card interest rates are still
nasty in our country.

N

w

4. Finding the best prices: This is the toughest
part. The most obvious thing to do would
be to leg it to a dozen shops and compare
them for discounts and competitive prices.
But then, not all shops have everything.
Something more sensible would be to check
the various internet shopping sites. Check
out online shopping portals.

5. Wrap them up: This may sound inane but
the truth is that gifts often lose their effect

when not wrapped up — or not
wrapped up well enough. And for
some reason, we tend to gift gadgets
as we buy them — in shopping mall
plastic bags. Don't lose out on the
element of surprise — cover it up and
watch them brighten up as it unravels.
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cafegadgets.in
An online shopping web site with
gadgets you could gift. Besides,

shipping is free

Smartphone radiation

Arecent study on smartphone radiation found that
T-Mobile’s MyTouch 3G, an HTC smartphone topped
the list of the worst radiation offenders. The Nokia

9300i was found to be the least guilty of the lot

such as FM radio, speaker phone and a

torch light. Samsung even has a flip phone
with colour, radio and Bluetooth (E1310)
that comes for a little less than Rs. 2,500.
Sony Ericsson has some economical models
too and the best buy is the K330i (for Rs.
2,499) that has features such as MP3 player,
Bluetooth, FM and a camera! Don't forget to
check out the new Nokia Xpress Radio 5030,
which looks great and costs just Rs. 2,300.

Portable DVD Player

DVD players are now priced way below the
Rs. 2,000 mark and if you don’t want to gift
one of those, there are a variety of portable
DVD players that play MP3, MP4 - and even
have USB slots provided. A definite asset for
the teens and tweens who are active on the
party circuit.

Emptying your wallet
(Rs. 2,500 to Rs. 5,000)

Wearable MP3 Player

Music players you can wear are all the rage
these days. Two years

ago, Sandisk launched

the Sansa Clip - a

wearable MP3 player

in 1 GBand 2 GB

sizes and in a variety

of different colours.

Sony’s NWZ - W202

is an MP3 player

built into the headset,

with 13.5mm EX No dangling wires, no
Headphones and soft ~ Bjuetooth contraptions
silicon ear buds. Two

features make it special:

* Zappin - You can zap through songs really
fast, listening to 4 to 10-second-clips to check
out if there’s a song you want to hear.

* Jog Dial - Once you reach an interesting
track, just press the Jog’ button and you'll be
able to hear the full song.

It supports various audio formats, has a
capacity of 2 GB and can be charged within
3 minutes. Here’s one gift that cuts across all
ages and genders — and is priced at Rs. 4,999.

Digital Photo Frame

Why put everything on Flickr? Why not show
off all the dozens of pictures you took of your
favourite people, your last pleasure trip and
your treasured memories up for display in
your own home? Digital photo frames make
great gifts for
shutterbugs.
Transcend’s
T-Photo 710C
7-inch digital
photo frame
costs Rs. 4,399,
has a 7-inch TFT
display, 1 GB
memory and

This Diwali, gift them with
digital memories

even plays MP3 tracks. You can plug it into
your PC, hang it on a wall or mountiton a
shelf. This makes a good family gift; especially,
your mom, dad and grandparents.

Food Processor

A good food processor can work like a

charm to make kitchen work less tedious.
Homemakers would always welcome a
multi-purpose chopper, grinder, mixer, juicer
and slicer. Fortunately, they've all become
remarkably economical. The Bajaj Platina PX
80F, for example, does all these and costs just
Rs. 4,990. Another brand, Kenstar sells theirs
for less Rs. 4,580 — and this one even has an
atta kneader.

Need the ATM?
(Rs. 5,000 to Rs. 10,000)

Digital Camera

Kodak has a couple of great cams up for grabs
- the Kodak Easyshare C140 (8.2 Megapixel,
3x optical zoom with face detection) and

the Kodak Easyshare C160 (9.2 Megapixel,
3x optical zoom, face detection and a 2 GB
memory card) for Rs.

5,490 and Rs. 6,590

respectively. Sony’s

S930 is pretty good

too, at Rs. 7,800. Turn

to page number 80 for

the Digital Camera test For people to remember
where you can find ~ you better

even more options.

Digital Photo Printer

Save your friends and family the task of
lugging their cameras to the nearest studio.
Buy them a photo printer that gives them
studio-quality prints right in the comfort of
their homes. Two great options in the market
today are the Sony DPP-FP67 which gives
you 4x6 digital

quality prints

with auto red-

eye correction,

exposure

correction and

a2.5inch LCD

preview screen

for Rs. 6,990. A

cheaper version

of the same is For amateur photographers who
Sony’s DPP-FP65 can't wait for their prints

for Rs. 5,990.

Canon photo printers such as the Pixma
IP1200 comes for as less as Rs. 1,855 while
the better Canon CP 760 comes for Rs. 5,390.

Sony PlayStation 2

So what if the PS3 is out. The Sony PlayStation
is guaranteed to send kids and teenagers into
throes of happiness. It is now available in less
than Rs. 7,000 and is great for a first taste of
what gaming is really all about.

Indulge... (Rs. 10,000 and above)
3G Phone

Since the

government is

ushering in the

3G erainto India,

there’s nothing

better than giving

your loved ones a

3G enabled phone,  sjnce you can’t afford a
packed with all their ps3 yet

favourite features.

The Nokia 5630

(for Rs. 13,000), Nokia 5800 Xpress Music
(at Rs. 14,350), the Sony Ericsson W995 (for
about Rs. 25,000), the Samsung F480 (at Rs.
15,200) - all give you great value for your
money and are gifts to be remembered by.

Gaming Console

If you've got deep pockets — and they're

all full - the Sony

PlayStation 3 (at less

than Rs. 25,000) and

the Microsoft Xbox 360

(between Rs. 12,000

and Rs. 15,000 as the

rates have recently been

slashed) are awesome

gifts for your game-crazy

cousins and friends. Put 1y air vacation will fly by
in a few games with it
and they’ll never forget
the Diwali.

once they get hooked on
to one of these

Netbook

Smaller and more convenient than a laptop
yet a netbook is packed with all the features
of alaptop and
more. For almost
anyone today,
whether student
or professional,
young or old,
male or female,
anetbook could
be a life-changing
gift. The Dell
Studio 14 (for
Rs. 41,970), the
Samsung NC10
(for Rs. 25,249),
the ASUS S101H (for Rs. 30,500), the Acer
Aspire at Rs. 21,820 - these are only some of
the options you could choose from. The HP
Mini 1129TU is another cool one for just Rs.
24,700. For a detailed evaluation of the pros
and cons of netbooks available in the market
today, just pick up the September edition

of Digit Magazine and you'll know exactly
which one to buy for your significant other.
One great thing about buying gadgets that
are a little expensive is that almost everybody
allows payment in equated monthly
instalments these days. El

Acer, Asus and HP rule the
Netbook market in terms of
worldwide
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Sci-Tech

How stuff works

How LCD panels work
An in-depth look at how LCD and LED
backlighting technologies work

Flash Forays

Madhusudan Mukerjee

readersletters@thinkdigit.com

n 1984, Dr. Fujio Masuoka of Toshiba

announced flash to the world. Today,

flash memory is everywhere - pen

drives, thumb drives, MP3/MP4
players, digital cameras, PDAs, and virtually
all portable electronic devices that need to
store data. In fact, they’re slated to replace
hard disk drives pretty soon.

Inside a flash drive

Flash drives basically store data on an
electronically erasable programmable read
only memory (EEPROM) chip. This has

a lattice of columns (bitlines) and rows
(wordlines). Each point of intersection is a
cell. A typical flash chip contains billions of
such cells. Each cell is made of a transistor

Peeking into a Flash Drive

—a MOSFET, to be precise - which has an
additional gate called a ‘floating’ gate added
on to it.

MOSFETSs

AMOSFET (Metal Oxide Semiconductor
Field Effect Transistor) is midway between
a diode (two p and n type semiconductor
layers) and a transistor (sandwiched
layers of p-type and n-type semiconductor
layers). An n-type semiconductor releases
electrons more readily, while and p-type
semiconductors allow electrons to flown
into them easily. The MOSFET, however,
is set up a little differently from the typical
bipolar diode with a base coated with

a layer of metal and oxide. The holes

in the p-type layer prevent the excess
electrons from passing from one n-type
semiconductor (source) to the other
(drain). But if we just let a positive voltage
flow in from the gate, this creates an electric
field. Now electrons start moving through

Source Gate Drain
—— Metal
— Oxide
— Semi conductor
p-type silicon
n-type silicon
OFF

Positive Charge

Source Gate Drain
——— Metal
— Oxide
— Semi conductor
p-type silicon
n-type silicon
ON

How MOSFETSs work

the channel from the source to the drain.
This makes it unipolar because a single
electric charge is enough to get the electrons
moving,.

The difference between the flash memory
transistor and the typical MOSFET is the
floating gate. Flash drives use FGMOS cells
(Floating Gate Metal Oxide Semiconductor
FETs) that are basically MOSFETs with
an additional gate. This is an electrically
isolated gate, with one or more secondary
gates deposited above it, also electrically
isolated from it. This floating gate is
surrounded by resistive material. This way it
is difficult for electrons to pass into the gate.
Once they have entered, it also ensures they
stay trapped until the bias is reversed. If

you apply a positive potential to the control
gate, electrons (being negatively charged)
are thrust through the layer of oxide
(usually silicon dioxide) between the p-type
substrate. Some of these are pushed into
the floating gate and the electrons are then
trapped there until forced out again.

The electrons enter the floating gate in
two ways:
® TFowler-Nordhein Tunneling: This
is a phenomenon where electrons are
emitted from a semiconductor into a
dielectric or a vacuum when persuaded
by a powerful electric field. Unlike other
forms of emission, electrons pass through
a barrier - instead of working around
it - because it has not yet lost its wave

Word line

Control gate

Floating gate
Bit line
n-source n-drain

p-substrate

function and, decaying into the barrier,
thus heightening the probability of it
emerging on the other side.

® Hot Carrier Injection: If an electron
or a ‘hole’ ( an absent electron) in a
semiconductor can be made to gain
sufficient kinetic energy to pass through
a barrier, the process is known as ‘Hot
Carrier Injection’.

NAND and NOR flash
Memory

The two most common kinds of flash

Parts of an FGMOS transistor

memory are NAND and NOR. The
terms are from Boolean logic and

HOW TO PROTECT YOUR FLASH DRIVE pu—

Never lost your pen drive or got a virus infection
in it? You're kidding me. Given that they're
featherweight and getting tinier by the day,
chances of your flash memory device getting
into the wrong hands are increasing day by
day. And everybody knows how the ‘Autoplay’
function in Windows gets trojans and worms
into the works. Here are a few tips to safeguard
your flash data:

1. Buy a wire protected flash drive: Once
a flash drive is write protected, data will
only get written if you disable the ‘write
protect’ function.

2. Put in a password: There's plenty of
freeware on the web which allows you to
password protect your flash drive, thus
ensuring that only you have access to the
data in it.

3. Encrypt the data: If you do this, even
after somebody cracks your password, the
data will only look like gobbledygook to
him.

4. Anti-virus: Clean your flash drive of
malicious software every time you plug it
into a computer, using reliable anti-virus
software.
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Brave
Jennifer Lopez’s new album titled
Brave will be sold on a chick-

looking 1-GB flash drive
NAND NOR
IN IN ouT IN IN ouT
0 0 1 0 0 1
0 1 1 0 1 0
1 0 1 1 0 0
1 1 0 1 1 0

NAND and NOR functions permit a variety of
Boolean operations

are immensely useful for the creation of
universal Boolean operations.
NAND - which is short for ‘Not AND’
refers to the Boolean logic operation
that says that if any one input is false,
the conclusion is true. Since computers
only understand zeroes and ones, in the
language of electronics, if any one input is a
0 (zero), the output must be a 1 (one). NOR
(short for ‘Not OR’) is a Boolean which is
true if none of the inputs are true - ie. if
any - or both - of the two inputs is a one
(1), the result is a zero. Both of these can
be used to make NOT, AND, OR XOR or
XNOR, and so they’re called “‘Universal
Gates’ — and that's what makes them useful.
NAND and NOR gates are so designed as
to function in the above manner. As you can
see in the figure, the Control Gate in every

NOR and NAND gates

cell is connected to the horizontal “Word
Line’ (WL). The ‘Bit Line’ (BL) connects all
the drains together — which is actually the
data bus of the chip. The Source Line (SL)
connects all the sources to the ground.

NAND vs NOR

NAND and NOR basically differ in
architecture and they both have their pros
and cons. NAND has its cells arranged in a
series — like a NAND gate — and therefore
lets you erase and write data faster, uses less
space (about 60 per cent of a NOR flash)
because it doesn’t need so many ‘grounds’,
cuts down on costs and is more robust
than a NOR flash. NOR-flash memory, on
the other hand, has every cell connected
to the ground in parallel to the bit lines
and another end to a bit line. This parallel
connection is an advantage as every byte
can be addressed individually. Yet, NOR is
slower in writing and erasing but quicker
than NAND in reading data. NAND flash
requires that you read, erase or write data

NAND mass production
Toshiba and SanDisk plan to mass
produce NAND flash chips on 20nm-
class process technology

on a block wise basis, where a collection
of bytes makes a ‘page’ and a collection

of pages makes a ‘block’. Actions are
performed in chunks and therefore NAND
is unsuitable as a replacement for the ROM
in your PC which needs random access at
the byte level.

How flash drives work

Any data storage device must be able to
perform the three basic actions of Write,
Read and Erase. Whether it's NAND

or NOR, reading, writing or erasing are

all controlled entirely by the voltage
combination applied to the WL and the
BL. In the case of flash drives, it’s all about
setting the status of a cell to ‘charged’ or
‘not charged’ - or alternatively, sensing
whether the floating gate in individual

cells is set to 0 or 1. If a floating gate has
electrons, it hinders the flow of electrons
through the transistor (from the control gate
to the silicon element), thereby allowing
less than 50 per cent of the current to pass
through — implying a zero (0). Similarly, if
there is no negative charge in the Floating
Gate impeding the flow of current, more
than 50 per cent is allowed to pass

through - indicating a one (1). This can

be controlled by deliberately manipulating
the voltage applied at the Source, Drain or
Control gate to change the delta value If
the drive hasn’t been used at all - or if it’s
blank - all the cells are set to ‘1’ because
the flow of electrons is unhindered. Thus
the state of the flash cell is determined by
whether or not the Floating Gate contains
electrons or not. If it does it’s programmed,
if it doesn’t, it’s erased or blank. The
changing voltage at every cell is measured
by a flash Memory Sense Amplifiers which
use a differential amplifier to measure the
disparity between the voltage generated by
a particular cell current (the flash Bit line
voltage) and a reference voltage value. If the
Bit Line voltage is higher, it implies that the
‘Data Out’ signal is pulled to a logic high
(binary digit 1) and conversely, if it is lower,
the ‘Data Out’ signal is pulled to a logic low
(binary digit 0). Having understood this,

How stuff works

let’s figure out how flash drives perform
their individual tasks.

Erasing

Since none of the Floating Gates (FG)
contain negative charge to begin with, all
the bits will be set to ‘1". Ergo, if you want
to erase a programmed cell, you'll need

to set it back to ‘1’ - or rather, compel the
FG to empty itself of electrons. Applying a
voltage (between about 9V and 12V) from
the source to the control gate along a Word
Line would cause the electrons trapped in
the Floating Gate to break out and ‘tunnel’
to the Source and the p-type substrate. The
Floating Gate is now free of electrons and
set again to ‘1.

Programming

Given that all the cells are already at ‘1’,
programming a blank flash memory device
becomes restricted to setting a cell to the
binary ‘0’ value. To write into a flash drive,
then, a high voltage (about 7V) is applied
to the Bit Line (the Drain) and a higher
one (around 12V) to the Word Line (the
Source). Electrons will now flow from the
Source to the Drain. Typically, some over-
excited electrons will jump and tumble
into the FG (remember the ‘Hot Carrier
Injection’ process?), getting trapped there,
giving a negative charge. Turn the power
off and the electrons still stay there, thanks
to the insulation of the oxide around the
FG. Thus, entire blocks of cells can be
programmed into millions of sequences of
zeroes and ones, literally, at the speed of
light.

Reading

When a current is passed from the Control
Gate (about 5V) to the Drain (about 1V),
the current begins to flow between the
two. The voltage is not high enough to
bump electrons into the FG if it is not
negatively charged but high enough to
detect insulation or conduction at every
cell. The cell sensor tracks the current
flow and identifies whether a particular
cell is conducting or remains insulating.
Accordingly, it arrives at a

Word line

Thin Oxide Layer

Current flow

Bit line

Negatively charged electrons

Control Gate

Floating Gate

Drain Source

binary code of ones (1s)
for every conducting cell
and zeroes (0s) for every
insulating one.

Types of flash
drives

When it comes to flash
storage devices these
days, NOR flash takes a
back seat and it seems to
NAND all the way. Two
basic forms of NAND
are the preferred form

This one is set to zero

of storage in solid state
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Wafer thin

Kingmax unveils the world’s
smallest flash drive with a
maximum capacity of 4 GB

Say hello to mSATA

The new standard geared towards
near wafer-thin drives, it will support
1.5 Gbps and 3.0 Gbps transfer rates

devices today: Single-Level Cells (SLC) and
Multi-Level Cells (MLC).

Single-Level Cells

An SLC flash is so designed as to store only
one bit-value per cell. So, for example, if
the memory is being read, each cell can
provide either of two values, depending

on the voltage level - 0 (zero) if the cell is
programmed or 1 (one) if the cell is blank
or erased. Thus, the cell sensor in SLCs has
only two voltage levels to bother about.

Reference points

1 0

Distribution of cells

1.0V 25V 4.0V 55V

Vt

6.0V

The SLC Flash detects a zero or a one based on the
Threshold Voltage of the cell

Multi-Level Cells
Manufacturers, like Intel, use the same
transistors for their SLC and MLC flash. The
difference is in how data is stored or read. In
the case of a Multi-Level Cell, every cell can
represent four states:

a) 00 (two zeroes) indicate that the cell is
fully programmed

b) 01 (a zero and a one) represent a
partially programmed cell

¢) 10 (a one and a zero) show that the
cell is partly erased

d) 11(two ones) indicate that the cell is
fully erased

In short, an MLC can store two bits
of information with no difference in
requirements of space or power. While
the minimum and maximum voltage stay
the same in SLCs and MLCs, there are
more gradations between the two voltage
levels, making the drive sensitive to smaller
variations in voltage, allowing it to register
two bits per cell. This, of course, would
entail better programming algorithms,
exact placement of charge and better charge
sensing to detect the amount of charge
on the floating gate more precisely. In an

MLC, it is even possible

to store more bits than

two in a single cell. As

the sensitivity to voltage

deltas gets better, the flash drive simply
needs to be able to detect 2N states in the
cell (where N = the number of desired per
cell). So, for example, if you want each
cell to hold 4 bits, you'll need to be able to
identify 24 (or sixteen) voltage states in the
cell = viz. 0000, 0001, 0010, 0011, 0100,
0101, 0110, 0111, 1000, 1001, 1010, 1011,
1100, 1101, 1110, 1111.

SLCs vs. MLCs
Let’s take a better look at the differences
between SLC and MLC flash drives.

MLCs take longer time to read and write
data because it needs to track more minute
gradations. SLCs can read and write data
much faster. However, an MLC flash can
hold double the number of transistors
on the same walfer size as compared to an
SLC flash. This allows greater density and
thus, more memory on the same size chip
bringing down the cost per MB. Cheap
thumb drives or pen drives, therefore,
prefer MLC.

SLCs,
however, score
on one parameter
- lifespan. Every
flash drive
has a limited
number of erase/
programme
cycles. This is
because the
silicon oxide
material that is
used to separate
the Floating Gate from other parts of the
cell suffers wear and tear with the repeated
‘tunnelling’ of electrons during erasure
or programming. By and by, the material
dissipates and electrons don’t move about
the way they should. Note that reading does
not reduce life of the flash memory because
the process does not involve the passage of
electrons through the oxide, only detection
of voltage difference.

All SSDs erase in blocks (groups of
pages) and write in pages (groups of cells).

Distribution of cells

1 10

15V 35V

4.0V

Reference points

01 00
Vt

55V 6.5V

MLCs give you two bits for the price of one

Send your feedback at
www.thinkdigit.com/d/oct09

At the rate we go about juggling data in our
flash drives, the average drive should wear
out really fast. Luckily, SLC flash drives
deteriorate only after about 100,000 write/
erase cycles — which could last decades,
unless you insist on rewriting all day and
night for several years at a stretch (MLCs
last for only about 10,000 such cycles).
Deleting data is different. When you erase
data, the drive doesn’t really erase it, but
only marks a set of pages as ‘invalid’ and
stops showing them up when you open the
drive folder on your screen. It then waits
until you write in some data, removes the
data from the ‘erased’ cells and puts the
new bit values into them. This reduces the
wear and tear and increases the lifespan of
the drive.

Of course, not all drives delete the
same way. Some poorly built flash drives
have high Write Amplification factors -
which is a technical way of talking about
how much ‘writing’ actually happens.
Therefore, if you
want to change just
a few pages of data,
the drive will erase
the entire block
that contains those
pages, make the
changes and write
the new block in,
thus increasing the
number of times
‘tunnelling’ happens.
This reduces the
lifespan of the drive.

To put it briefly, MLCs have a high density
and can hold more data at cheaper costs and
smaller sizes, while SLCs need less power, are
more durable and allow faster writing and
erasing of data. Choice a particular kind of
drive would depend on your requirements.

Flash memory is not without
its drawbacks. Some cells get
unintentionally programmed while
programming other adjacent ones ( a
phenomenon called ‘Program Disturb’).
Sometimes the threshold value is misread
and a ‘1’ is recorded instead of a ‘0’
(called ‘Read Disturb’). Charge may leak
out of the FG, affecting data retention.
Some question the ability of flash drives
to store information when it comes to
less than 30 nanometres. Manufacturers
all over the world are working to better
the existing technology and eliminate
the drawbacks of both, MLCs as well as
SLCs. For all practical purposes, NAND
will do for the average consumer for
the next few years at least. Flash is the
future. Fl
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A 4-inch flexible OLED display of QVGA
resolution with a curvature radius of 2
inches was showcased at CES

Ennova announced a USB flash drive
that packs a OLED screen which also
doubles up as a fingerprint scanner

Terry Relph-Knight

readersletters@thinkdigit.com

iquid Crystal Displays (LCDs)
have their advantages for both
TVs and computer monitors.
However, there are two things
they haven’t done as well as CRT; high
contrast and colour depth/accuracy.

This however is set to change with the
introduction of LED back-lights. To see
why requires a look at how ‘traditional’
LCDs work.

LCD panels use the variable polarisation
of electronically controlled liquid crystal
cells to vary the amount of polarised light
that will pass through the panel. In other
words, an LCD panel is composed of a
large number (a typical 1,600 by 1,200
computer monitor has 5,760,000 cells) of
tiny, voltage controlled, light valves. The cells
themselves are neutral density; they pass or
block all frequencies of visible light more
or less equally. To provide the sensation of
variable colour each pixel consists of three
of these cells, with individual red, green and
blue filters placed in front of each group of
three cells. A wide range of colours can be
produced by varying the relative amounts

RGB LED backlights deliver
brighter, darker and more
colourful displays

of light passing through each of the three
cells making up a pixel. Ambient light can
be reflected from a plate behind the cells,
or a back-light can be used for a brighter,
emissive, display. Most displays used these
days have a back-light and until recently
this would have been a Cold Cathode
Fluorescent Lamp (CCFL)

One of the weaknesses of LCDs is low
contrast. When the liquid crystal cells are
fully open (in the off state with no voltage
applied), they do not transmit all of the
light from the back-light, for one thing the
light passes through a polarising filter, so

How LCD panels work

at least half of the original
light from the back-light is
blocked. However, more
significantly, when the cells
are closed they do not block
all of the light. The ratio of
light passed, between the

on and off state defines the
displays contrast ratio (note -
contrast is always a ratio, not
an absolute measurement). In
the older type of LCD panel
the CCFL back-light remains
on at a fixed brightness all the

time (it may turn off during
power saving) and has no
effect on the contrast ratio,
which is determined entirely
by the on/off ratio of the liquid crystal
panel (ignoring the effect of ambient light
reflected from the internal structure of the
LCD for the moment).

The Fluorescent lamp

Fluorescent lamps for general lighting were
introduced commercially in 1938 and were
first used in large quantities to light factories
during the Second World War (commercial
LEDs became available in 1968 and blue
LEDs were not introduced until the late
1990’s). Fluorescent lamps are significantly
more efficient than incandescent lamps and
small fluorescent lamps (Compact Florescent
Lamps with electronic ballasts - CFL) have
been heavily marketed in recent years as
‘energy saving’ lamps. Conversion efficiency
of electrical power to radiant power varies
between 17 and 21 per cent compared to less
than 5 per cent for the filament incandescent
lamp. The luminous efficiency of CFL
sources is typically 60 to 72 lumens per watt,
compared to 8 to 17 lumens per watt for
incandescent lamps.

In back-light applications, efficiency
(regardless of the type of light source) is low
because a lot of light is lost passing through
the diffusers, polarisers and colour filters,
perhaps only 5 per cent of the light from the

Photomicrograph’s of two pixels from two LCD panels from different manufacturers. The images are
blurred because they are shot through the anti-glare front diffuser. Nevertheless it is still possible to see

that the two panels use different cell geometries

Spectral plot of a CCFL back-light taken from the manufacturers
brochure. The light output is extremely uneven with large spikes at
various frequencies

back-light reaches the viewer.

Very recently there has been something
of a backlash against fluorescent lamps
since they contain mercury, which is
poisonous and tends to get released into the
environment when old lamps are thrown
away.

Fluorescent lamps work by ionising
a column of low pressure gas (mercury
vapour) causing it to glow with ultra-violet
light. The inside of the glass tube containing
the gas is coated with a mixture of
phosphors that react to the ultra-violet light
by emitting light in the visible spectrum.
Various mixtures of phosphors are used in
the tubes to give an approximation of ‘white’
light with some variation. For example
“Warm White” tubes have more red while
“Cool White” tubes have more blue. The
spectral output of a fluorescent lamp is
surprisingly uneven.

The CCF lamps used for LCD back-lights
use a high voltage to start the ionisation
of the gas while the tubes used for general
lighting run at lower voltages and use a
momentary heating coil. As far as the colour
range or gamut of LCDs is concerned, it
is the uneven spectral response and the
range of light frequencies emitted by the
tube phosphors that limit performance.
Early CCFLs used similar phosphors to the

Jargon Buster

« Polarization - a property of waves that describes
the orientation of their oscillations.

« Ionization - is the physical process of con-
verting an atom or molecule into an ion by
adding or removing charged particles such as
electrons or other ions.

« Dead pixels - They could occur on LCDs when
the screen is damaged or put under pressure.
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BenQ monitors in India

To read more about BenQ’s LED monitors,
go to www.thinkdigit.com/d/60724/

Flexible displays
LG showcased a 11.5-inch sheet
of flexible e-paper

phosphor formulations used on the tubes
used for general lighting. Recently CCFLs
have appeared with modified phosphors to
give a greater display gamut, for example
Sony’s Wide Color Gamut - CCFL (WCG-
CCFL) with a claimed gamut 30 per cent
larger than a conventional CCFL, but it looks
like these are going to be eclipsed by the new
RGB LED back-lights, at least in part because
using LED back-lights reduces the amount of
mercury released into the environment.

By comparing the spectral output graphs
of the two types of back-light it is easy to
see that RGB LED produces higher peaks
for red, green and blue and covers more
of the visible spectrum. This results in a
considerable improvement in gamut can be
seen from looking at the gamut area plots.

RGB back-lights save the
planet

RGB LED back-lights offer great
advantages in terms of power saving and
a longer service life than CCFL. According
to Sharp, for example, their RGB displays
consume 40 per cent less power and offer
a back-light service life of 100,000 hours,
about two thirds longer than regular LCD

This diagram shows the various gamuts of
different display types plotted as 2D areas
using the XYZ colour space

TVs. To put this in perspective — if the
display is turned on for 5 hours a day, this
is 20,000 days or over 57 years.

Back-light layout

The older panel designs with fluorescent
back-lights normally use edge lighting where
a CCFL is mounted near one edge of the
display. Light from the lamp is guided and
spread across the back of the display using
anarrow wedge shaped light-guide. The
light is further disbursed using a translucent
diffusion panel and a prismatic panel that
helps reflected light to bounce around.
Some displays may use two CCFLs top and
bottom, or even on large displays a number

of tubes may be mounted in parallel behind
the panel.

There are several ways to arrange and
drive the LEDs in a LED back-light and these
are known as OD, 1D and 2D.

0D simply uses a number of LEDs and a
diffuser system to evenly back-light the entire
LCD panel, a direct replacement of the CCFL
without any added functionality.

In a 1D back-light the LEDs are arranged
in horizontal rows behind the panel and can
be brightness modulated to achieve a crude
degree of contrast enhancement.

Lastly, in a 2D back-light the LEDs can
be arranged in groups (for an RGB back-
light also in sub-groups of red, green and
blue) that can be individually brightness
modulated, an improvement in contrast
over different areas of the display (as shown
in the two photographs of an RGB back lit
television display).

Colour temperature

Previously the only way to adjust display
colour temperature was to adjust the
individual gain of the red, green and blue
colour channels driving the display. RGB
back-lights provide the opportunity to
change the colour temperature of the back-
light itself. In other words, the shade of the

back-lights. LED brightness modulation is
usually performed by driving them with a
square wave and modulating the duty ratio
of the wave (pulse width modulation). This
technique does introduce its own problems
of RF radiation and the difficulty of actually
transitioning to a true off state.

Of course, if a small high resolution panel
could be made with a set of RGB LEDs at
every pixel, the LCD panel would not be
needed since the image could be reproduced
entirely by brightness modulated LEDs.
Large LED-only displays, where each group
of three LEDs is small compared to the
overall display size, do exist and are used for
applications such as advertising hoardings.
However, at the moment it isn’t practical to
produce smaller high resolution displays
in this way, so the LCD panel is retained to
provide the required resolution and LED
back-lights are used to enhance the contrast
(and improve the colour gamut). This is
achieved by dividing the display up into
quite low resolution segments, typically
around 128 segments may be used. Within
each of these segments, contrast may be
enhanced by modulating the brightness
of all the LEDs in that segment. This does
mean there is some light spill or haloing
in the areas where the image on the LCD

Two photographs of identical LCD back lit televisions driven with the same signal. On the left the
LCD as well as the modulated 2D back-light is being driven with the image signal while on the right

only the LED back-light is brightness modulated

‘white’ light provided by the back-light can
easily be varied, for example from a ‘warmer’
reddish white - 5,000K, to a ‘cooler’ blue-
white - 9,300K.

Contrast improvement using
LED back-lights
LCD panel contrast can be hugely improved
by turning the back-light off. In this case the
idea of representing contrast as a ratio gets
a bit silly because the ratio of - some light -
to - no light - is infinite. However this really
only applies in a completely dark room. In
practice there is often a high level of ambient
light, which is reflected by the internal
structure of the display, degrading contrast.
LED back-lights can be turned on and off
very rapidly and they can also be brightness
modulated over a wide range, neither
of which can easily be done with CCFL

changes abruptly from light to dark. Using
more segments will result in smoother
contrast changes across an image. At the
moment, the marketing departments of most
display manufacturers are keeping quite
about the exact details of their RGB backlit
displays, Sony for example will not say

how many LEDs they use or in how many
segments. Sony do say they use 2 green with
1 red and 1 blue LED in their LED clusters.
This compensates for the generally lower
light output of green LEDs compared to red
and blue.

With computer monitors that are used
primarily to display business graphics its
debatable that there is any advantage in
using the area based back-light dimming that
is being employed in the current crop of LED
back-light TV’s for contrast enhancement.
This really only comes in to its own for photo
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LG’s Jazz

LG adds Jazz Theatre
and Jazz Atom its Jazz
series LCD TVs

OLED screens
Samsung reports around half the
world’s cellphones will have OLED

How stuff works

screens in the next five years

realistic images where there are large areas of
light and shade.

Contrast measurement - the
specification game

Marketing people love numbers they can
stretch or misrepresent to make their
products look better and for displays,
contrast ratio is one of those numbers. It
would seem that measuring contrast should
be straight forward, as mentioned contrast
is the ratio between peak white and black.
However, as the ‘black’ level falls to lower
and lower amounts of light it becomes more
and more difficult to measure accurately. It is
possible to claim huge contrast ratios simply
by measuring black levels in a very dark
room with the display or at least the back-
light, literally turned off.

Measuring with a checker board pattern
of black and white rather than with the
entire screen black and white, allows for
internal screen reflection and produces a
more realistic result. As does measuring with
a known amount of ambient light.

Typical contrast ratios for LCD panels are
on the order of 200 to 400 to 1, although
more recent developments in PVA (Patterned
Vertical Alignment) and S-PVA (Super
Patterned Vertical Alignment) panels provide
claimed contrast ratios of over 3,000 to 1 (i.e.
better black levels). The old CRTs provided
good contrast because, when properly
adjusted, black level means the display emits
no light.

Colour stability and .
temperature compensation
All colour displays have suffered from colour
instability due to temperature change. With
CRT and the CCFL back lit LCD panels the
approach, certainly before colour calibrating
a display, was to leave the display switched
on and displaying an image for between half
an hour, to an hour, to allow it to ‘warm up’
and for the colour to stabilise. There was no
attempt in these designs to apply corrective
feedback for colour/temperature changes.
The light output of LEDs does vary
markedly with ambient temperature and
in an RGB LED back-light this can result in

shows as a sharp
spike with a much
lower broader
yellow peak.
Consequently the
light from this type
of ‘white’ LED is
characteristically

a hard blue-white
light, due to the
high blue peak.

Spectral plot of an RGB back lit display compared to a white LED back lit
display. The RGB plot shows clear peaks for red, green and blue while the

Just to confuse
things, Samsung
refer to the

white LED plot has a sharp peak at around 450nM and a lower, broader, peak LED backlight

from 500 to 600nM - i.e. blue and yellow

colour drift as the temperature characteristics
of red, green and blue LEDs do differ.

White LED back-lights and
comparative gamuts
Perhaps an obvious and relatively simple
step in display design evolution is to take a
conventional LCD panel and simply replace
the Cold Cathode back-light with a white-
light, LED back-light system. The advantage
of doing this is that the electronics are
simplified because the high voltage converter
required by the CCFL isn’t needed and the
environmental impact is at least modified
because LEDs don’t contain mercury.
White LED back-light displays often

technology they
use as LED-BLU
where BLU stands for Back Light Unit.

Typically, a blue plus yellow phosphor
LED back-light will only manage a 71.6
per cent comparative gamut (relative to
NTSC). Experiments have also been done
using a blue LED with distinct red and
green phosphors. When this LED design is
combined with the typical LCD filter sets and
colour matching functions, a reasonably wide
gamut of 91.9 per cent of the NTSC standard
gamut is obtained.

In comparison manufacturers using
back-light designs with discrete red, green
and blue LEDs are claiming gamuts as
large as 123 per cent compared to the
NTSC standard.

Give us your feedback at www.thinkdigit.com/d/oct09

do not provide the best in wide gamut
photo-realism. This is because the spectral
output of the the “white” light from the
LEDs is not very smooth and does not
provide sufficient energy over a wide range
of frequencies. Most white LEDs are blue,
or ultra-violet light LEDs, with the addition
of a yellow phosphor in the lens cap, which
converts some of the blue light into light
at other frequencies, in the same way that
a fluorescent tube phosphor converts the
ultra-violet wavelengths into visible light.
This is evident in the spectral plot (see -
white LED spectral plot) where the blue

Unfortunately, companies offering LED
back-light displays use different designs
and don’t want to reveal exactly how
their products work, it may be difficult for
the consumer to tell with certainty what
the differences are between the various
products available in order to make sensible
choices. There is for example the significant
difference between a ‘white’ LED back-light
and an RGB backlight. A display may even
use an RGB LED back-light and as a result
offer a better colour gamut, but not apply
segmented brightness control to provide the
improvement in contrast. El
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Laps, notes and books 80

Something for everyone

Shooting Stars

16 cameras tested.
Capture more smiles this Diwali

Cooler Master Elite 334
ATI Radeon Edition Cabinet

A standard cabinet with fancy stickers!

Contact

Cooler Master

Phone: +91-9422501592

Email:
Tanmay_L@coolermaster.com
Web site: www.coolermaster.com
Price: Rs. 5,650

Specifications
Dimensions: 485 (L) x 187 (W) x
421 (H) mm

Weight: 6 kg

5.25-inch Drive Bays: 4
3.5-inch Drive Bays: 7

1/0 Panel: USB 2.0 x 2, 3.5mm
audio in/out (HD Audio supported)
Expansion Slots: 7

Power Supply: Cooler Master
RS500-PCARA3 (500W)

n one side of

Cooler Master’s

Elite cabinet, we

have Ruby - a
character many will associate
with. On the other side, we
have a semi-transparent red
acrylic sheet.

Like many Cooler Master
cabinets, there’s a meshed
grill with a dust filter on the
front, which can be easily
removed. The build quality
is above average. Oddly, only
one side panel has a screwless
design. On the inside, there
are screwless panels with

B RATINGS gy

FEatures ......ceececeerencnc 7
Performance...........6.5
Build quality............6.5
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Acer Tempo FO00

Acer’s entry into the émartphone market

he FO00 marks Acer’s
entry into India’s
smartphone market
with a somewhat

utilitarian look. Its most striking

feature is the 3.8-inch

480 x 800 resolution

screen. It works fine

under sunlight, but

isn’t very accurate

when used with

fingers. It takes some

time getting used to.

Its touch-sensitive

buttons at the

bottom give a nice

vibrating feedback.

The phone won’t

easily fit into any

pocket owing to its

large dimensions.
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Acer’s implementation

of their custom interface on

Windows Mobile 6.1 has a

somewhat hit-and-miss affair.

Itisn’t very responsive and
multi-tasking with
more than three
applications can make
it sluggish. There were
a few occassions where
the operating system
locked up. Internet
Explorer is simply
unusable to browse
full fledged web sites.
The accelerometer
is not very accurate
either. The on-board
GPS chip works well
with Google Maps. The
audio quality using

knobs to keep the
drives in place, but
in vain. There’s a
120-mm fan placed
in the front, but none
at the rear - alittle
disappointing. The
cabinet is bundled
with a 500-W power
supply from Cooler
Master’s eXtreme
series, that is
known as a cheaper
alternative to their
Real Power series
of power supplies.
Even then, this
power supply should
be able to handle a
power mid-ranged
graphics card such as
a GeForce 9800 GTX
easily.
It sells for Rs. 5,650, which
is a little over the top in our
opinion. If you are the kind

the bundled earphones was
about average, but we missed a
3.5-mm audio jack. The 3.2-MP
camera gives decent results of
photos shot in day light.

The call quality is average.
The high capacity battery belts
out a decent life of a day and a
half with moderate usage. At Rs.
30,000, the FO0O0 has nothing
substantial other than the large
screen.

Build quality.....
Value for money......5
overall......ccccceeeeeeeee. 6

Photographs: Manas Parekh, Jiten Gandhi

of person who just wants

a cabinet to show off, this
could be your pick. If you are
meticulous about your power
supply, look elsewhere.

Contact

Acer India Pvt Ltd.

Phone: +91-9818316575
Email: charu.mishra@vdpl.in
Web site: www.acer.co.in
Price: Rs. 29,995

Specifications

Network: Quad-band GSM,
HSDPA at 7.2 Mbps

Screen: 3.8-inch 480 x 800 pixel
Processor: Samsung S3C 6410 533
MHz processor

Memory: 128MB RAM, 256MB ROM
0S: Windows Mobile 6.1
Professional

Connecitivty: Wi-Fi 802.11 b/g,
Bluetooth 2.0, HSDPA, A-GPS
Camera: 3.2 Megapixel

Battery: 1530 mAh

Dimensions: 117.5 X 63.5 X 129 mm
Weight: 150 g

Palm announces first quarter results: $164.5m net loss, 823k phones sold. Palm also said that it will stop developing Windows Mobile handsets from now, and just make



Return to the mothership
9 More than 50 motherboards tested for
you. Get to know the board of your choice

Apple makes their Grand Central
Dispatch multi-core processor
handling tool open source

Bazaar

Seagate Barracuda LP

A eco-friendly drive with mammoth capacity

he Seagate Barracuda
LP is a regular 3.5-inch
desktop hard drive
that packs a punch
with its 2 TB of space. It spins
atan odd 5900 rpm, which is a
lot slower than the typical 7200
rpm desktop drives. This slower
speed should mean better
power efficiency and also better

HDTach 32MB file
Average Read (MBps) 95.6
Average Write (MBps) 85.7
CPU Utilization (%) 5
Random Access Time (ms) 14.8
Read Burst Speed (MBps) 224.2
Sisoft Sandra 2008
Drive Index, Read (MBps) 90.05
Access Time, Read (ms) 14
Drive Index, Write (MBps) 81.19
Access Time, Write (ms) 5
Contact
Sony India
Phone: 1800-11-11-88
Email:

sonyindia.care@ap.sony.com
Web site: www.sony.co.in
Price: Rs. 4,990

Specifications

Capacity: 2 GB

Device Interface: USB 2.0 (mini-
USB port on player)

Weight: 35 g

File Format support: MP3,
WMA, AAC
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reliability. Seagate positions this
drive to for low-power PCs for
home use and office networks
as an internal storage solution.

We observed no difference
in vibration on this drive
as compared to the Seagate
Barracuda 7200.11 drive.

The noise levels were under
acceptable range.

In real world tests, the drive
took 43 seconds to copy a 4 GB
file and 57 seconds to copy an
assorted 4 GB folder. It took
the same 43 seconds to read
the 4 GB file from the drive.

But a 4 GB assorted file was
read slowly at 90 seconds. The
drive did not perform really
well in the internal file copy test
- which means copying data
from one partition to another
on the same drive. It logged 197
seconds for a single file and 259

seconds for a 4 GB
folder of assorted
files.

The Seagate
ST32000542AS
drive sells for
Rs. 16,700. A 2
TB drive from
Western Digital
costs a few thousand rupees
less. This drive probably will
help you save in the long run
on electricity bills, but you'll be
shelling out quite a sum to buy
it now.

B RATINGS oy
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Sony Walkman
NWZ-W202 2GB

Sony’s wireless formula to their audio players

ony recently
introduced the
NWZ-W202.
Advertised as the
“Walkman Unwired”, it’s a
music player designed like
a stereo bluetooth headset.
Looks-wise, it’s surely a head-
turner. The player is controlled
by means of a ‘jog-dial-esque
clickable roller. The dial is
pretty tactile.

We observed what we
think might be a flaw, while
using it in motion. The in-
earphones would tend to
slip out of their ‘sweet-spot’
position; thus increasing
ambient noise. Hence, we kept
adjusting the player back in
its place from time to time.
Secondly, swiping the jog-dial
repetitively is irritating while

skipping through many songs.

The ‘Zappin’ feature helps

by automatically shuffling

through song clips, but you'll

have to be patient since each

clip plays for 5-7 seconds.
The sound quality of this

player is decent. The highs and

mids were pretty clear. The
bass wasn’t very impressive.
The output isn’t as good as
higher-end Walkmans, but
very acceptable. Data transfer
rates via the PC are average. It

surpassed its specified 12-hour

continuous playback mark
by almost two hours - a good
thing in our opinion.

At Rs. 4,990, the W202
is definitely expensive when
compared to other screen-less
players. The new 4 GB iPod
Shuffle sells for around that

Contact

Fortune Marketing

Phone: +91-11-26414468
Email:

sales@fortune-it.com

Web site: www.fortune-it.com
Price: Rs. 16,700

Specifications

Capacity: 2 TB

Size: 3.5-inch

Rotational Speed: 5900 rpm
Buffer Size: 32 MB

Interface: SATA 3.0 Gb/s
Dimensions: 147 x 102 x 26.1 mm
Weight: 655 g

price, or a Samsung S2 2GB
sells for half of that price. And
with the flaws mentioned
above, we really don’t feel like
recommending this one over
the latter two.

their own WebOS based phones El HTC Leo runs a new version of TouchFLO Ul over Windows Mobile 6.5. It sports a multi-touch capacitive 4.3-inch large display El
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ASUS introduces P7P55D
series motherboards for the
Core i5 and i7 processors

ASUS launches the SVIT
skype videophone with wi-fi
and a touchscreen

Contact

Samsung India Electronics Pvt
Ltd

Phone: +91-22-41511234

Email: sarfraz.s@samsung.com
Web site: www.samsungmobile.
com

Price: Rs. 24,150

Specifications

Network: Quad-band GSM,
HSDPA at 3.6 Mbps

Screen: 3.1-inch (480 x 800 pixel
AMOLED)

Processor: Qualcomm MSM6246
800Mhz

Memory: 2 GB internal, microSD
card slot (up to 16GB)

0S: Samsung Proprietary 0S
Connecitivty: Wi-Fi 802.11 b/g,
Bluetooth 2.1, HSDPA, A-GPS,
UusB 2.0

Camera: 5 mega-pixel auto-focus
with LED flash, Video at 720x480
resolution @ 15 fps

Battery: 1100 mAh
Dimensions/Weight: 108.8 x
535x119mm/110g
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Samsung Jet

A multimedia powerhouse

he Jet is Samsung’s
attempt at enticing
people enthused
about getting a
multimedia touch phone. At
first sight, the Jet looks very
cool in its black avatar and
holographic back panel. Its
shape and size make it quite
comfortable to hold as well
as to slip into the pocket.
Unlike many metal-bodied
Samsung phones, this one
does not give that feel of
toughness; it feels somewhat
delicate. The phone has a
vibrant 3.1-inch AMOLED
display. The pixel-packed 480
x 800 pixel resolution makes
the content played on it look
crisp. Although the display is
of resistive nature, the OS is
optimized to be used entirely
by fingers. There’s no stylus
provided with the package.
The display’s vibrance suffers
under direct sunlight; you
can just about read the text
on the screen. The front bears
call answer/end keys and
an odd hexagonal three-way
button. It oddly does not help
navigate through menus but
rather, it is used to switch
between running applications.
The buttons on the phone
are tactile. The phone gives
a vibrating feedback to every

press registered on the display.

The phone runs Samsung’s
proprietary TouchWiz 2.0
OS. Its interface design is
quite attractive. The interface
performs flawlessly thanks to
the Jet's fast processor. The
home screen bears many pre-
installed widgets like world
clock, calendar, Facebook
etc. that can be customised
further. Multiple widgets can
be placed across three home
screen windows. The Internet
browser renders full-blown
websites quite nicely. The
browser gets sluggish at times
lag at times depending on
the site you visit. There isn’t a
cut-copy-paste functionality.
The high resolution screen
can be disadvantageous at

times. For example, while
using Google Maps, the text
appeared very small. The touch
interfacing system works well
and has fewer hits-and-misses
than other touch devices.

The phone is quite narrow,

so Samsung chose to fita

full QWERTY keyboard only
in landscape mode. It takes
time to get typing quickly

and accurately on it. There’s
also handwriting recognition,
but we doubt anybody would
want to use their fingernails to
scribble characters. At the end
of the day, the Samsung Jet is
not a smartphone. Installing
applications is only limited

to Java applications. People
who would like to extend the
functionality of their phone by
installing a lot of third-party
programs will be put off by
this.

The call quality was pretty
clear and signal reception
good. Audio delivered by
the bundled in-earphones is
satisfactory. Better ones can
be connected to the 3.5mm

headphone jack. The phone
also plays back DivX and XviD
files. We transferred some
standard resolution AVI files
without any downscaling and
they played flawlessly. The
video quality is also quite
nice; this phone can easily
double up as a good portable
video player. The loudspeaker
is quite audible as well. The
onboard camera takes pretty
good snaps. Smile detection
works as advertised. It can
also record video at a DVD-
like resolution. Recording
high resolution video can be
a problem as the file size for

a minute of video is roughly
12 MB.

At Rs. 24,150, the Samsung
Jetis priced a lot above our
liking. At this price, one would
get a phone with an advanced
and highly configurable OS
than the Jet’s. The phone
handles multimedia tasks
rather well and we would have
definitely recommended it
if the price was closer to Rs.
15,000 to Rs. 17,000.

Intel's i7-820 QM Mobile CPU running at 1.73 GHz for laptops gets benchmarked and apparently, its very fast El If various stores on the internet like Amazon, Best Buy and



CM Storm introduces

Sentinel Advance gaming
mouse with an OLED display

Creative launches the Zen
Mozaic EZ300 media player
in 4 GB and 8 GB capacities

Bazaar

CoolerMaster NotePal Color Infinite

A breath of fresh air

he ‘color infinite’ name
tag probably refers to
the variety of colours
this notebook cooler
is available in. From sober greys
to a pastel pink; the colours
add much of the style element
to this sleek notebook cooler.
We got a golden mat finish
piece which was certainly nice
looking. To see how effective it
was at cooling, we used one of
the slightly more hotter running
laptops. We let 3DMark06 run to
heat up the system and gauged
temperatures with and without
the cooler. The laptop chassis
definitely was less hot while on
the cooler. The groove pattern
visible through the mesh is
designed for optimum air flow.
The fan takes in air through
the back intake and pushes it
through the mesh. The pattern
is such that you get a smooth
flow of cool air underneath
your palms. The fan runs very
silent and sans vibrations on all

Contact

Elizabeth Jacob

Phone: +91-80-39872000
Email:
elizabeth.jacob@apcc.com
Web site: www.apc.com
Price: Rs. 2,475

Specifications

Battery: 12V, 40 Watts/5min
Frequency: 45-65 Hz
Dimensions: 18.55 x 11.5 x 31.3 cm
Surge protection: 160 Joules
Weight: 5.1 kg
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three speed settings. It draws
power through a USB port and
compensates for it by providing
another one on the cooler body.
Additional features include
hooks on the back panel of

the cooler to manage wires as
well as guide grooves on the
bottom for the same. In terms
of usage scenarios, you can use
this on your lap, bed as well

as on a desk. The mesh has
stoppers to prevent slipping and
in fact the whole aluminium
body is anti skid. The cooler’s

angle perfectly compensates

for the downward gradient of
normal sitting posture. The four
rubberised knobs the bottom
however can get irritating, Its
footprint is quite large (as much
as a 17-inch notebook) but it’s
quite lightweight; weighing in

at 700 grams. Laptop coolers
are certainly a niche line of
products and so can command
that inflated pricing. At Rs. 2,300
this one may still be worth a buy
but a little cheaper and buying it
would’ve been a no brainer.

APC Back-UPS RS

Small fry

his is a UPS that is
positioned as a battery
backup and surge
protection solution
for business desktops. It has a
rating of 550 VA which comes
out to an output capacity of 300
Watts. Therefore it can easily
handle basic home or office
systems. Gaming systems are
slightly out of reach for this UPS
since gaming rigs would require
amore beefier output capacity.
To test the UPS we ran it on a
standard office set up to check
runtime on battery and also to
check if the switch to battery is
seamless. The documentation
boasted of a 36 minute backup
time, but it delivered 7 minutes.
The two output ports available
are standard 3-pin (India) 64;

both have surge protection. In
terms of features there aren’t
many as compared to some UPSs
nowadays that come with an
LCD screen to display status and
change settings. There is however
aresettable circuit breaker in
case the UPS shuts down due

to an overload. There’s an alarm
when output is on battery and a
distinctive low battery alarm. The
UPS has three sensitivity settings
which can be used in case you
find it switching to battery
power too often. Sensitivity
settings can also be used specific
to the equipment connected

to it. For instance equipment
that cannot handle even minor
voltage waveform distortions

can be put on the ‘high’ setting
which operates between a

Contact

Cooler Master

Phone: +91-94225-01592
Email:
Tanmay_L@coolermaster.com
Web site:
www.coolermaster.com
Warranty: 1 Year Replacement
Price: Rs. 2,300

Specifications
Dimension: 380 x 300 x 10~50
mm

Weight: 700 g

Fan Dimension: 90 x 90 x 25 mm
Max Fan Speed: 2000 rpm
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550

limited spectrum of 165 to 270V.
However switching between the
sensitivity settings is difficult
since you need to operate with
just one button. Still, at Rs. 2,475,
it’s not extremely expensive

and as an utility that gives you
enough backup time to save all
your work, it’s well worth the
money.

Newegq are to be believed, the Microsoft Zune HD is a major sellout El Even as India waits for major private operators to roll-out basic 3G services, in America, T-Mobile
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Google’s Android 1.6 a.k.a
Donut has CDMA support,
Quicksearch and a text-to-

speech API

Gyration launches the Air Mouse
Elite that senses wrist movements
performed in the air

A-DATA Nobility
NH92 250GB

A slim drive with an eye-catching design

-DATA’s Nobility

NHO2 is a portable

hard drive with a USP

o brag. According to

their website, it is the ‘slimmest’
drive in the market today
and the ‘lightest’ drive in an
aluminum case. It looks very
sleek; at 12mm, its thickness is
on-par with many of the slender
mobile-phones available today.
Itis also quite light-weight and
weighs a little more than 150
grams. Its dimensions allow it
to be carried easily in a cargo
pocket or a purse. The feel of
the texture reminds us of the
etched backplate of the Nokia
E71. Aluminum also gives it a
decently sturdy feel; better than
the plastic casings found on

Contact

Priya Ltd.

Email: sales@priyagroup.com
Web site: www.gigabyte.com.tw
Phone: +91-22-42203100

Price: Rs. 2,199

Specifications
Frequency : 2.4 GHz RF
Dimensions: 463 x 160 X 20 mm
(keyboard), 100 x 60 x 36.5 mm
(mouse)

Weight: 700 g

FEALUIES...eecreererssosessees 2.5
Build Quality ...
Performance.......
Value for money.......6.5
OVerall ..ceeceeeneencecnneasec?
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drives by other manufacturers.
Itis available in three metallic
shades.

The drive we've got for test
was sized at 250 GB. A 320 GB
and 500 GB version is available
too. The drive has a widely-used
miniUSB port, which ensures
that a replacement cable will be
easy to find, in case you lose the
original. After putting it through
the tests, it is shown that the
drive performs at par with other
drives in its segment.

AtRs. 3,300, the A-DATA
NH-92 has a very fair pricing.
too. If you're looking for a sleek
portable drive, then this drive
will fit your needs.

Contact

A-DATA

Phone: +91-33-40105500
Email: jerry lu@adata.com.tw
Web site: www.
technocratinfotech.com
Price: Rs. 3,300

Real world tests

Specifications

File Write 4 GB Single File 173
(sec)

Capacity: 250 GB
Device Interface: USB 2.0

File Write Assorted 4GB files | 217
(sec)

HDD Interface: 2.5” SATA
Dimensions: 114 x 75.8 x 12 mm

File Read Test 4GB Single 126
File (sec)

Weight: 152 g

File Read Test Assorted 4GB | 132
Files (sec)

Emmm RATINGS sy

Internal File Read Test Single | 331
4GB File (sec)
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Internal File Read Test As- 312
sorted 4GB Files (sec)

Build quality............Z.5

Photoshop CS2 Image Load 88
(1GB File) (Sec)

Value for money......6.5
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Gigabyte GK-KM-7500

Surprisingly decent kit...

igabyte’s been
known for its
motherboard and
graphics cards and
recently, they’ve entered the
peripheral market with cases.
This wireless keyboard
mouse combo are powered by
AA batteries and come with
no charging dock. The design
of the keyboard is good - it’s
thin and light-weight. So, if
you're using it while sitting
on a couch away from the
display or TV, you can easily
rest it on your lap without any
hassles. The mouse with the
AA battery feels pretty light but
the performance and range of
the keyboard is slightly better
than the mouse. The keyboard
works fine through some
obstacles in between it and
the PC but the mouse is more

problematic. With a direct line
of sight, we were easily able to
use the keyboard and mouse at
a distance of some 10 ft.

The keys don’t have a
particularly nice feedback
and have little travel. There
are multimedia buttons at the
top of the the keyboard and
a volume control dial on the
right top. These kind of features

are makes us believe that this
product makes good sense for
those with HTPCs. The battery
ran perfectly fine for well over
two weeks with average use of
some three hours a day.

AtRs. 2,199, it’s a tiny bit
expensive for a basic wireless
keyboard and mouse. Still, if
you spend on it anyway, you
won’t regret it.

began rolling out HSPA+ 3G service in Philadelphia at the insane speeds of 21 Mbps El Rumors are afloat that HP, Dell and Acer might soon be releasing laptops with displays



Kingston’s 2,133 MHz HyperX
memory for Intel’s Core i5 runs

atalow1.65V

Microsoft’s Bluetooth Mobile
Keyboard 6000 is the thinnest
mobile keyboard till date
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Western Digital Scorpio
Blue 500GB

High-capacity storage coupled with a high price-tag!

estern Digital

joins the race

of the ever-

expanding
portable notebook hard drives
with its Scorpio Blue 500 GB.
All this space is packed into a
9.5 mm height body; making
it compatible with most of the
laptops. It uses WD’s anti-shock
protection measures to reduce
chances of damage. During the
testing, the drive ran silently
and vibrations were at a bare
minimum.

It took the drive just 50
seconds to write a 4 GB single
file and 61 seconds for a 4 GB
folder with assorted files. It read
a4 GB file at 75 seconds and
the 4 GB assorted folder at 81
seconds. In the internal file copy

Contact

ASUS Technology Pvt. Ltd.
Phone: +91-22-67668800
Email: media_india@asus.com
Web site: www.asus.in

Price: Rs. 3,500

Specifications
Maximum Write speed:

8x (DVD), 24x (CD)

Data Buffer: 2 MB
Dimensions: 156.4 x 140.8 x 21
mm

Weight: 412 g
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that support 3D technology for games and movies. El Dell's Latitude Z is rumored to be the first laptop to incorporate ‘Wireless charging'. Its actual implementation yet

test, it took 186 seconds and
204 seconds for a 4 GB single
file and 4 GB assorted folder
respectively. Comparing it to
the Seagate Momentus 5400.6
500GB drive, there are tests
where both of them have. But
in general, the performances

HDTach 32mMB

Average Read (MBps) 67.9
Average Write (MBps) 63.3
CPU Utilization (%) 4

Random Access Time (ms) | 16.1
Read Burst Speed (MBps) 228.3

Sisoft Sandra 2008 Engi-
neer’s Edition

Drive Index, Read (MBps) 63.8

Access Time, Read (ms) 14 Value for money..........4
Drive Index, Write (MBps) | 64.41 overall ........cceeeeeeneeenees 6.5
Access Time, Write (ms) 5

of these drives aren’t
drastically different.

We were almost shocked to
find that maximum retail price
of this drive is a whopping Rs.
10,950. The Seagate Momentus
5400.6 in comparison is for
nearly half that price. The
Scorpio Blue may be a decent
performer but the difference in
price difference doesn’t make
very good sense.

. RATINGS oy
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Contact

Western Digital Corporation
Email: Amarjeet.singh@wdc.com
Web site: www.wdc.com

Phone: +91-93210 29204

Price: Rs. 10,950

Specifications

Capacity: 500GB

Size: 2.5 inches

Rotational Speed: 5400 RPM
Buffer Size: 8 MB

Interface: SATA

Dimensions: 100 X 69.85 X 9.5 mm
Weight: 117 g

ASUS SDRW-08D15-U

Optical companion

he Asus SDRW-
08D1S-Uis aslim,
portable external DVD-
writer. It comes in a two
cool looking colours - black and
white. It compliments the look of
Asus’s Eee PC netbooks. Because
ofits thin profile, it can be slid
into a side-pocket of a bag. The
build quality is pretty decent and
the eject button is tactile. Closing
the tray gave a firm affirmation
of our action. The drive can
be used either horizontally
or mounted vertically on the
provided mounting stand. It has
aminiUSB port at the back and
is supplied with a Y-type USB
cable. The drive comes bundled
with Cyberlink’s CD authoring
software; it is not the full-blown
version though. It will let you

for your netbook

write only data discs and rip

audio CDs to MP3 - nothing that
freely available software out there

can’t do.

To test it, we burnt a single 4.3

GB file onto a DVD which took
eleven-and-a-half minutes. Then,
we copied an assortment of files
amounting to 4.3 GB. It took
almost exactly the same time as
the single file. According to our
read tests, it took take around
ten minutes to copy an entire
4.3 GB DVD onto the test PCs
hard drive. Being a laptop optical
drive on the inside, an average
performance from this device is
expected and that's what we got.
AtRs. 3,500, the drive’s price is
somewhat okay. This product
can be handy for people owning
netbooks or nettops where

no DVD writers are provided.

It might also work for HTPCs
where the case doesn’t have
enough space to hold a large
DVD drive. It’s not very easy to
find something this compact
either. We give it our thumbs up.
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MSI Wind U210 featuring an
AMD Athlon Neo processor
starts shipping in the US

MSI’s ultra-slim X410 swaps out an
Intel CULV for AMD’s Athlon Neo
processor with ATI Radeon X1250 GPU

Contact

SatNav Technologies

Phone: +91-92233 87281

Email: jayaprakash@satnavtech.
com

Web site: www.satguide.in
Price: Rs. 19,999 for India maps
and international regions

Specifications

CPU: Samsung 2443 400Mhz
GPS Chipset: SiRF Star IlI
Display Resolution - 320x240
Dimension: 17.8 x 72 x 115 mm
Weight: 170 g
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SatGuide P360

Find your way

he mapping software
on this GPS navigation
device is created by
SatGuide while the
underlying device is the Mio
P360 Digiwalker. The device
is compact enough to easily fit
into a pocket while the build
quality is solid. It sure looks
sleek with a large 3.5-inch
touch screen and metal body.
Now lets get on to the software
which is essentially what makes
this PDA a GPS navigator.
The software navigation is
not very intuitive and takes a
bit of getting used to. Finger
touch is fine but we noticed
that in many cases the stylus
works out better. Searching for
locations is via browsing POls
(points of interest) or searching
for streets. The search function
is painful as each time, it asks
for city and then drills down

further. A seperate category for
‘locality’ would’ve been nice.
Once you've selected a POI

or Street it opens the maps to
chart out the route. The turn-
by-turn directions are voice
assisted and work quite well in
both pedestrian and car mode.
The voice over is available

in several Indian languages.
However, the POI database was
not very impressive in some

of the categories; particularly
ATMs. The QWERTY keyboard
is not available by default

and needs to be activated

from settings; but is not at all
comfortable to type on since
one button carries two keys
requiring a double tap. The
interface is not very smooth
when it comes to zooming or
scrolling the maps. The lag is
surprising high considering

it has a fairly powered CPU.

Apacer Steno AU330

An average pocket-friendly player

he Apacer AU380 is a
spartan feature MP3
player. Its dimensions
are comparable to a
small matchbox. The plastic
body has a decent build and a
detachable clip allows you to
hang the player on you like a
pen. Its looks aren’t anything
to talk about; the copper-black
color combination will not
appeal to some. The front bears
a tiny, non-bright 1.1-inch color
screen that feels just a bit too
small for say, viewing long
song titles. Navigation isn’t
very intuitive and the UT design
isn’t going to win any awards.
There’s no categorisation of
music according to artist,
genre, album etc. Audio quality
using the provided earphones
is pretty good for a player
in this price range. The FM
reception is pretty good. A
miniUSB port on the player
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allows for connectivity to a PC.
Transferring songs from the
PC to the player is realy simple
and requires no proprietary
software. It also supports
viewing photos, but we really
doubt anybody would want to
do that on such a tiny screen.
There’s a direct voice recording
button on the player itself, but
it also records a lot of unwanted

noise while using this feature.
Bottom line, the player has
acceptable sound quality but
one does not get the feel-good
factor from this player. At the
selling price of Rs. 2,999 for
this one, there are many other
worthwhile players out there
which you can go for instead of
this one.

Accessories include a car
charger and a windscreen
suction car stand. Overall it’s
a robust GPS Navigator that
will take you from point A

to point B but the database
could certainly use some
improvements.

Contact

Apacer Technologies Pvt Ltd
Phone: +91-80-41529061
Email: india@apacer.com
Web site: www.apacer.com
Price: Rs. 1,999

Specifications

Screen: 1.1-inch CSTN color
Audio Formats: MP3, WAV, WMA
Photo formats: JPEG , BMP
Built-in memory: 2 GB

Other features: FM Radio, Voice
Recorder, FM recording
Playtime on internal battery:
Up to 25 hours
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Nokia N86 update to bring
face and smile detection
features to its camera

0CZ packs 256 GB, 512 GB and 1 TB worth

space on their Z-Drive SSDs that connect to
a PC via the PCle slot

Acer Aspire Revo

An Intel Atom nettop with NVIDIA firepower

he Acer Aspire Revo
R3600 is the first
nettop, i.e. a small, low-
power PC to include
NVIDIA’s ion platform on board.
That means its got an Intel
Atom paired with a moderately
powerful GeForce 9400M
graphics. The diamond-shaped
casing looks really cool and is
portable. The build quality’s just
about decent.
The Revo bundle includes
a wireless keyboard-mouse
set that’s pretty comfortable
to use. The 2 GB RAM is just
about sufficient, since it runs
the resource-hungry Windows
Vista. In our use, the OS ran
smoothly as long as it wasn’t put
under heavy load. We would not
reckon using this machine for
heavy multi-tasking or running
processor intensive applications.
Running Doom 3 at medium
detail on a low resolution gave
playable frame-rates. But the

Philips GoGear Mix MP3 p.

Atom processor will serve as a
bottleneck — so forget playing the
latest games in full glory.

The Revo’s main intention of
high-definition movie playback
isn’t as simple as ‘plug-and-play’.

You'll need to use a media player

that supports GPU acceleration
for videos. A 1080p WMV file

Shaped like a pen drive

Contact

Philips Electronics India Ltd.
Phone: 1860-1801111

Email: customercare.India@
philips.com

Web site: www.india.philips.com
Price: Rs. 2,999

Specifications

Screen: 128 x 64 pixel, 4 line LCD
Audio Format: MP3, WAV, WMA
Built-in memory: 2 GB

Other features: FM Radio, Voice
Recorder, FM recording
Playtime on internal battery:
Up to 25 hours
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he Philips GoGear

Mix is a digital audio

player that’s shaped

like a flash drive. The
tiny dimensions makes it easy
to carry it around. It is built
well and looks neat. The front
face of the player bears a screen
that could prove to be a bit
small for some. The navigation
buttons are fairly tactile but felt
a bit flimsy. A dedicated volume
control and hold switch lie to
the side. A switch to the other
side brings out the seemingly
delicate USB head.

The user interface has a
simple look-and-feel. Songs are
categorized according to artist,
album and play-list. There is
also a folder view available.
The Ul is pretty swift to
operate. The audio quality
from the bundled earphones

under Windows Media Player
played quite smoothly. The
cute-looking web-cam delivers
a pretty decent video quality. It
would have been nice if the Revo
had an optical drive built in.

At Rs. 23,000, the Revo is a

little expensive. If you're looking

for a compact, power-saving
download rig that supports full
HD, the Revo could fit your
requirements.

PC Marko5

CPU Score 1370
Memory Score 2352
Graphics Score 2060
HDD 4426
Overall 1919
3D Mark 2006

CPU Score 492
Overall Score 1312
Doom 3 640x480, medium 26.6
detail (fps)

DivX to VOB video conversion | 1097
(secs)

Contact

Acer India Pvt Ltd.

Phone: +91-80-40708700
Email: dinesh_nair@acer.co.in
Price: Rs. 22,999

Web-site: www.acer.co.in

Specifications
Processor: Intel Atom 230
RAM: 2GB DDR2

Hard Disk: 160GB

Graphics: nvidia GeForce 9400
Ports: 6 USB, 1 e-SATA, Card
reader, VGA, HDMI

Power supply: 65 W adapter
with power cord

Dimensions: 180 x 180 x 30 mm

B RATINGS popy
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can be described as average.
Audio quality is decent.The
the expected punch from the
bass is missing. There are a
couple of equalizer presets

as well as the ability to have
your custom setting. The data
transfer rates from the PC to
the player ranged at a pretty
decent 3.5 MB/s. FM reception
is pretty decent. It supports
FM recording for a maximum
of about two hours in the
player’s memory.

At Rs. 2,999, the GoGear
Mix is priced in range. But
similarly designed players like
the Samsung YP-U5Q offer
everything that this can, with
better audio quality and at the
same price. This player does
not offer anything that’s really
out of the box for us to go
ahead and recommend it.

Aircel starts selling select Blackberry handsets and their services across major cities EI Christophe Ducommun, developer of MovieGate application



Seagate launches world’s first
6 Gbps SATA hard drive, the

Barracuda XT

Bazaar

Sony Ericsson’s MH907 headsets
automatically play when worn, and

pause when one earbud is removed

Epson Stylus TX550W

For those not willing to spend the least.

n the world of mult-

functionality devices,

probably one of the

best marriages of two
individual devices have to be
the printer and the scanner.
The Epson Stylus TX550W
represents the latest breed of
such MFDs. The device looks
a lot like ‘office furniture’ due
to its black colored plasticky
body. Its not very heavy
to carry around, but has
somewhat large dimensions
as compared to competitor
models. To point out some of
its USPs, it has a adequately-
sized 2.5-inch LCD screen that
tilts to an easily viewable angle.
It also accepts multi-format
memory cards. Other than the
typical USB connectivity, you
also have wireless connectivity.
This will make it very easy to
use this MFD with portable
devices such as laptops.

The bundled software makes
configuration over wireless
very simple. After printing
a variety of test pages in the

Contact

Samsung India Electronics Pvt
Ltd.

Phone: +91-22-41511234

Email:

kunal.a@samsung.com

Web site: www.samsungmobile.
com

Price: Rs. 7,030

Specifications

Band: Quad band GSM
Dimensions: 113 x 489 x 17.4
mm

Display: 120 x 160 pixels, 1.77-
inch, 256K Colors TFT
Connectivity: EDGE, Bluetooth
2.1 with A2DP, USB

Camera: 1.3 mega-pixel

Emmm RATINGS gy
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economy mode, we think that
pages appear too faint. While
they appear pretty decent in
quality under normal mode.
Under high quality, the photo
prints came out fairly well.
Colors seemed natural and the
level of detail was pretty good.
Scanning an image revealed
that the image quality, although
slightly washed out, is pretty
decent overall.

Samsung

Tough nut to crack

he Samsung B2100

Marine is a tough

phone with a

spartan feature set.
A completely rubberised body
gives a feeling of solidity and
grip. The back panel stays in
place thanks to a circular lock
and can’t be easily pulled out
like most phones.

The buttons, aside from
being slightly hard to press,
have a tactile feel. At just over
a 100 grams, the phone is
quite light-weight. The phone
conforms to the IP57 industry
standard for robustness and is
water, dust and shock resistant.
Overall, the phone does feel as
tough as it is advertised.

While the meager feature
set is acceptable, some of the

At Rs. 9000, the TX550W
is on par with the HP
Photosmart C4588 MFD in
terms of price. This model
is quite easy to use, delivers
decent results and has nifty
features like the LCD screen
and Wi-Fi. If you're looking
for an MFD under the 10k
range, the TX550W can
definitely be considered
worth buying.

Marine

inferior components used in
the phone are a put-off. The
B2100 has a low resolution
display that’s low for our
liking. It has unsatisfying
sunlight legibility and the
camera is pretty bad. It uses
ayesteryear 1.3 mega-pixel
sensor. The on board torch is
pretty powerful for a phone.
The 1000 mAh battery gives
a pretty decent up-time.
During calls, there were
problems of not proper
transmission of audio.
Other than that, the network
reception was pretty decent.
AtRs. 7,030, the phone is a
little overpriced. The fact that
it does not have modern-day
features like GPS or a fitness
application will probably not

Contact

Epson India

Phone: +91-80-30515000
Email: think@eid.epson.co.in
Web-site: www.epson.co.in
Price: Rs. 8,999

Specifications

Printing Method: On-demand
ink jet (Piezoelectric)
Maximum resolution: 5760 x
1440 dpi

Scanner type: A4 Flatbed Colour
Image Scanner, CIS type sensor,
2400 x 2400 dpi resolution
Display: 2.5 TFT Colour LCD
Memory card slots: CF Type

11, Memory Stick, SD/MMC, xD-
Picture Card

Interface: USB 2.0, Ethernet,
Wi-Fi 802.11b/g

Emmm RATINGS sy
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entice the elite adventurer. But
for people who have a habit
of dropping their phone by
mistake and damaging it, this
might be for you.

for the Mac, claimed that the performance improvements in Mac 0S X 10.6 Snow Leopard has made his application run up to 50 percent faster EIHP
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The latest 8-GB iPod Nano
with a built-in camera is

Once released, Windows Mobile 6.5
will be found on Samsung’s Omnia

priced at Rs. 9,400 series of smartphones
A futuristic looking dual-band router
he Linksys acted as the server and the terms of performance. The
WRT320N router is router was connected to it by range and reception isn’t that Contact
part of the modern wire. Two separate zones were great either. Linksys Corporation

design series that

parent company Cisco
envisioned. The WRT320N
maintains the slim profile of
its predecessor, the WRT310N,
as well as the futuristic styling.
The build is sturdy yet it
looks great.This is one of the
few routers available today
that comes without antennas
protruding. It supports the
latest Draft-N Wi-Fi standard.
The main difference in this
revised model is the addition
of a dual band - which
operates at 2.4 GHz and 5 GHz
as well. The router has a easy-
to-use firmware interface. It
supports automatic bandwidth
allocation depending on the
application being used.

Coming to the performance,
we connected a Dell XPS
Studio 13 wirelessly to the
router. A dedicated system

Contact

Apple India

Phone: 1800-425-0744
Email: indiasales@mac.com
Web site: www.apple.co.in
Price: Rs. 4,900

Specifications

Capacity: 4 GB

Weight: 10.7 g

Frequency response: 20 Hz to
20 KHz

Audio formats: AAC, MP3, WAV,
ALAC, AIFF

setup - one where the laptop
was placed right next to the
router and the other where
the laptop was placed some
25ft away. From the tests we
ran, we could conclude that
the router is above average in

At Rs. 8,999, it’s an
expensive router. Other than
the sleek design, it does not
bring any unique features to
the table that could interest
the casual user such as USB
support for example.

Zone 1 (100 MB File transfer)

Signal Strength in Zone 1 (Wireless Mon 3.0, %) 70
Sequential (MBps) 4
Assorted files (MBps) 2.08
Zone 2 (50 MB File transfer)

Signal Strength in Zone 2 (Wireless Mon 3.0, %) 40
Sequential (MBps) 5
Assorted files (MBps) 4.77
Zone 3 (50 MB File transfer)

Signal Strength in Zone 3 (Wireless Mon 3.0, %) 5
Sequential (MBps) N/A
Assorted files (MBps) N/A
Passmark Performance Test Zone 1/ Zone 2 54.32 / 20.86
Video Streaming (HD 1080p) Zone 1/ Zone 2 9/8
Video Streaming (DVD) Zone 1/ Zone 2 9/9

Apple iPod Shuttle

Shuffling around

t’s that time again and new

apples are beginning to

fall from, well, Apple trees.

This one is really compact
and elongated, whereas the
previous one was square. The
full metal body has an anodised
finish and the belt clip is
rugged. Gone are the controls
on the body and there’s just one
power switch that doubles as a

mmm_RATINGS gy

FEAtUres ......ccoeeereeeec6
Performance...........Z.5
Build quality............8.5
Value for money......6.5
(0)1=1 =1 | I

track shuffle. Sadly Apple has
moved the volume controls to
the earphone cord so you can
kiss using other headphones
goodbye - in our opinion this
borders on arm-twisting users
to use only Apples earphones.
There’s a nifty voice based
navigation feature that can tell
you the name of your playlist
and can also tell you the name
of the artist or the title of a song
while it’s playing — neat and
obviously meant to make up for
the lack of a screen. However
you need to download a voice
over pack for this via iTunes.
Because of the controls being
on the earphones it's impossible
to test the device with any other

Phone: +91-98204 29532
Email:

jdabrai@cisco.com

Web site: www.linksysbycisco.
com

Price: Rs. 8,999

Specifications

LAN ports: WAN x 1, LAN x 4
RJ-45

Frequency: 2.4 GHz or 5 GHz
Standards: Draft 802.11n v2.0,
802.11g, 802.11h, 802.3, 802.3u,
802.3ab

Size: 202 x 34 x 160 mm
Weight: 300 g

B RATINGS sy
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headphones and quite frankly
Apples own headphones are
not for purists. However, the
earphones do belt out a pretty
high volume. At Rs. 4,900, the
new iPod Shutffle 4 GB is for
someone looking for a really
tiny MP3 player for music and
nothing else.

claims that the Envy 15 is the “fastest consumer notebook” that it has ever made; running Core i7 processors with ATl Mobility Redeon HD 4830
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The Asus Eee PC 1201n is their
first NVIDIA ion based netbook

Samsung’s 12 mega-pixel
Pixon12 camera phone
comes to India at Rs. 30,000

Bazaar

Sony Alpha 330L

The Alpha...and the Omega? We think not..

ony’s hold over

the camera market

extends to the DSLR

side of things. Sony
cameras are finding a home
in the Indian market and
already the A200 has been a
hit among those who always
wanted a cheaper DSLR. Sony
brings a mid-ranged camera
for those who want to take it
a step ahead.

The body isn’t as robust
as some of Canon and
Nikon’s costlier offerings but
it’s still a big step up from
the Sony Alpha 200. It feels
pretty light even though it’s
a slightly larger camera than
the Alpha 200. The lens still
has a somewhat loose feel
like the A200. Other makes
prefer to use a heavier-feel
zoom ring. The handgrip
isn’t particularly great either.
The little finger slips under
the handgrip and you'll find
it getting sore after spending
some time with it.

The user interface looks
similar to the ones in other
DSLRs from Sony. It looks a
bit more professional than
the Cyber-Shot range of
point-and-shoot cameras.
Still, it doesn’t feel like it’s
geared towards serious
photographers but just

1GB graphics, 166B of DDR3 RAM and 2 separate solid state drives (SSDs), running in Raid0 configuration EI Samsung to introduce powerful and efficient

photography enthusiasts. The
live view feature means you
can focus using the 2.7-inch
screen instead of having to
use the optical viewfinder.
There’s one jogdial which
means you're left to depend
on the buttons to navigate
and access some of the
functions.

Image quality is very good
with little grain in well-lit
scenes.. There’s a visible
difference in image quality
when you go from an Alpha
200 to something like this.
The detail is crisp and colours
a tiny bit emphasised are
good for the most part. There
is fine noticeable noise with
ISO sensitivity set to 800 and
above especially against dark
surfaces. The stock lens kit
can be used for decent macro
photography with a little bit
of zoom. The stock lens is
an 18-55mm which is more
or less 3x of optical zoom in
layman terms.

Sony products and many
of their DSLRs use the
Memory Stick format but
fortunately, this one can
use both MS and also SD
memory cards. There’s a
small toggle switch which one
you want to use in the bay.

Some things haven’t

changed. Sony still uses the
traditional Minolta mount for
flash so you can’t purchase
any flash unit and fix it to

the camera. The flash on this
camera raises well above the
camera so you won't ever
have the problem of the
shadow of the lens barrel
falling on your photos.

Until now, we've
recommended the Nikon
D60 as a solid DSLR for
a budget over Rs. 30,000.
Those who willing to push
that budget close to Rs.
40,000 can be given an easy
recommendation. The Sony
Alpha 330 can be bought for
Rs. 39,990.

Contact

Sony India

Phone: 1800-11-11-88

Email:
sonyindia.care@ap.sony.com
Web site: www.sonystyle.com
Price: Rs. 39,990

Specifications

Sensor resolution: 10.2 MP,
APS-C size sensor -23.5x15.7
mm, 2.7-inch LCD display, 18-
55mm lens, Memory Stick/SD/
SDHC memory cards supported
Dimensions: 128 x 97 x 71.4 mm
Weight: 491 g
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The NEC’s xHCI host controller

becomes the world’s first
certified USB 3.0 product

Corei7

Intel announces Core i7
Extreme and Core i7 processors

for laptops

VU Intelligent TV LTV-40i

HDTV with a built-in PC!

’s LTV-40i
Intelligent TV is
like any other 40-
inch VU TV model
but this one comes with
with a PC integrated within
it. The system specifications
are similar to net tops or
low-power computers.
There is no internal Wi-Fi
module on that computer.
The display adapter is
connected to the TV using
a VGA port. The onboard
GMA950 graphics solution
can’t handle HD content
and the VGA link won’t
let you use the TV’s native
resolution of 1920x1080
on the computer. A much
lower resolution has to be
used. Even then, with that
resolution, content on the
panel is readable when you
sit at a distance.
Benchmarks show the
performance of the PC to
be in the same range as
an Atom based netbook.
Its a shame that the PC
can’t handle HD content.
The bundled iBall wireless
keyboard-mouse combo gets
the job done.
To judge the panel, we
tried playing high-definition
content on the TV. We

also used the Spyder3Elite
colorimeter to measure the
TV’s luminance and contrast
ratio, and got a result of
403.5 cd/m2 and 975.65:1
respectively. This panel is just
about decent but nothing
spectacular.

At Rs. 69,990, the TVisa
little too expensive. A 40-inch
VU TV can be bought for
roughly Rs. 50,000. The built-
in PCis good enough for for
basic computing needs such
as working on documents,
browsing the internet and
downloading. For anything
more, we suggest purchasing
a HDTV and then setting up
your own HTPC. It would be
a cheaper proposition.

B RATINGS

VU TV Benchmarks

PC Mark05

CPU Score 1497
Memory Score 2408
Graphics Score 671
HDD 4799
Overall 1628
3D Mark 2006

CPU Score 491
Overall Score 92
WinRAR benchmark 376

Contact
VU Technologies Pvt. Ltd.
Phone: +91-22-28377300

Email: manjari@technologies.vu

Web site: www.technologies.vu
Price: Rs. 69,990

Specifications

TV Resolution: 1920x1080
(1080p)

Aspect Ratio: 16:9

Contrast Ratio: Native - 8,000:1

Dynamic - 50,000:1
Brightness: 500 cd/m2
Colours: 16.7 million
Viewing Angle (Horizontal &
Vertical): 178°/178°
Response Time: 5 ms

Ports: 2 HDMI, 1 S-video, 1 D-sub

(VGA), coaxial, component,
composite ports.

PC Specs: Intel Atom N230
1.6GHz, 1GB RAM, 160GB HDD, 4
USB, Windows XP Home edition

Features .......ccceeeeee. 6
Performance............6.5
Build Quality ...........6
Value for money......6.5
overall......c.ceeeeeeeeee.6

processors, cameras and chipsets for mobile devices in early 2010 El Intel unveils Light Peak 10Gbps optical interconnect for mobile devices El
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Laptop test Where’s the mouse?

Logitech’s Lapdesk N315 has a
nifty slide-out mouse pad

Dell going 2
Dell’s new line of high-end Latitude Z
notebooks to feature wireless charging

Michael Browne
michael. browne@thinkdigit.com

f anything, our notebook
test this year is testament
to change — an evolution of
sorts, we're the reason. Not
us as in Digit, but every one
of us users. Notebooks have
walked the product life cycle
in this country, from being
playthings of the rich, to the
drool-worthy devices of the new
millennium to what they are
today. Their design ethos has
evolved — jack-of-all-trades no
longer. Manufacturers no longer
try to get cover every possible

usage pattern when they create
anotebook. Different product
lines have spawned catering to
the needs of a specific faction of
people. Corporate users, college
goers, gamers, road warriors,
entertainment junkies — there’s
a unique fix for everyone. And
this is a good thing — for one
you have a plethora of choices.
Secondly, you get exactly

what you want. A handful of
vendors also offer custom
configurations these days

and this is, perhaps, the most
significant telling point of the
change of market focus from
producer to consumer. Sure

Notebooks have emerged from the shroud of generality and
become more specialised towards specific purposes. In short they've
evolved to become about as varied as the human beings using them.

The adage ‘something for everyone”is an understatement
as manufacturers rush to provide tailor-made solutions

Imaging: Vijay Padaya
Photographs: Manas Parekh

people in the US have been
enjoying their custom Dells for
a long time, but for a choice
deprived nation we’re new to all
this and we're gleefully happy
to report an ever increasing
user base hopping aboard this
bandwagon.

This time we also awarded
two Best Performers, which
is unusual. However, we felt
that the gaming notebooks
deserved a Best Performer
award of their own since the
testing parameters and weights
assigned were quite different
from the other notebooks.

There were quite a few

S, NOLES

DOOKS

brands that could not / did not
participate in this test such as
Samsung, LG, Fujitsu, Toshiba
and Zenith for a variety of
reasons. Despite this we got a
good number of models — 31 in
all — and as unique a bunch as
we’'d hope to get. From David
to Goliath, from the proverbial
tortoise to the hare, from
Playboy Playmate-grade stuff
to the mundane, there’s truly
something for everyone.

DESKTOP
REPLACEMENTS UP TO
RS. 40,000:

Buy me, I’'m better than
your desktop...really!
Most people buying a laptop
look to spend around Rs.
35,000 to Rs. 40,000. This is
where the bulk of the shopping
happens; volume games are
always fun for manufacturers
and competition is fierce. There
is diversity to be had as well;
some notebooks have basic
builds and mediocre looks

but better, more powerful
components under the hood
and vice versa. If you're looking
for an affordable stunner Acers
Aspire 5810T might be down
your alley — a superb looking
notebook from Acers new Travel
Line series of notebooks with
brushed aluminium livered

in silver-gray. It’s slim and the
exteriors are exceptionally well
built. It has a nice, large, matte-
finished, 15.6-inch display
that has nice brightness levels
but poor viewing angles. Acer
uses Intel’s Laminar Wall Jet
cooling technology that claims
to keep your lap cool, note

we said your lap and not the
notebook. This system uses
parallel layers of jets of air,

and is the same concept used
to keep the outer walls of a jet
engine cool. Since its processor



Healthy Li-ion

Laptop makes advice users to
not constantly keep their laptops
plugged to keep battery healthy

Dual-display notebooks
gScreen plans to produce high-end
laptops with two 15.4-inch displays that
cost approximately 1.5 lakh rupees

13”, 15” MacBook Pro Owners Still Plagued

Laptop test

with SATA Il Issues, and can only avail of

performance

speeds up to 1.5 Gbps which equates to SATA 1

is pretty basic we don’t figure
it'll heat up much anyways. The
floating keypad is good with
nice feedback and a positive feel
to keystrokes but the keypad
itself was uneven and in the
centre — there was something
of a wave. This is probably

due to misalignment of the
material below the keypad on
which it rests. Key spacing is
absolutely spot-on. The other
three Acer Aspire notebooks
share a common design — a
nice glossy blue covered lid
with matte black on the inside.
Quite frankly Acer has upped
their game since the last time
we tested their notebooks — the
current crop of models have
good looking, well-finished lids
and the floating keypads which
although delicate (judging

by an incident where a key

got detached for no apparent
reason) are very comfortable

to use. Ergonomics is also

very good. The Aspire 5536
and the 5738Z have 15.6-inch
LED displays while the Aspire
4736 makes do with a 14-inch
display. This also makes its lid
feel sturdier i.e. smaller size,
less flex. This also means

the shortcut buttons
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Acer Aspire 57387

placed above the keypad of
the two larger models is now
placed on the right side of the
keypad on the Aspire 4736. The
Aspire 4736 also has a good
CPU although all notebooks
other than the Acer Aspire
5536 (Radeon 3200) lack a
dedicated graphics
solution.

ASUS’ K40
and K501J sport
identical lid finishes

and the dark grey colour
along with the graphics on
the lid looks neat. Sadly their
trackpads are some of the worst
you will come across — poor
feedback, poor tracking and
the dimples on the surface are
abrasive to the pads of ones
fingers. It was good to see every
notebook in this category with
a healthy 320 GB of storage
— plenty of space. We were
also pleased to see at least
three USB ports on all
notebook, some
had as many as
four — plenty
of connectivity
options for add-on
peripherals. As
expected only the
Acer Aspire 5536
makes a splash in any
of the graphics tests
with its ATi Radeon
video solution. The
Aspire 5810T loses out
here. It’s combination
of integrated graphics and
a Core 2 Solo U3500 CPU
is  not enough for it to

Illustrations: Chaitanya Surpur

handle many multimedia heavy
tasks and we see it lagging in
the video encoding test where
all the other dual core options
outshine it. It does have an ace
up its sleeve however, when it
comes to the battery test —a
15.6-inch display that can play
videos for 273 minutes is pretty
much unheard of in this price
segment — obviously power
consumption figures are
very low, especially since
its sleekness belies a
large battery pack.

When it comes

DESKTOP
REPLACEMENTS
BETWEEN RS. 40,001
AND RS. 60,000:

For the upwardly mobile
When one spends more than
Rs. 40,000 on a notebook
certain things are a given —
lasting build quality, faster and
more powerful components,
good usability as well as
reasonable compactness. That’s
not to say that one should
have lower expectations from
cheaper notebooks but lets
face it — you get exactly what
you pay for and a higher price
gives the manufacturer more
leeway to play with internal
components, chassis materials
and so on. A generic desktop
notebook is generally between
14 and 16 inches in size,
anything smaller and it can
qualify as an ultra compact. Of
course the distinguishing line
is thin.

Gateway is a new entrant
to our market courtesy Acer
who acquired Gateway and all
its assets. Their NV48 and ID
5801 are two very

OCTOBER 2009

to bang for buck,

however, nobody could

hold a candle to the

Acer Aspire 57387, its

great combination of
performance, features and
battery backup means it wins
our Digit Best Buy award in

this category. If you're looking
for a powerful notebook with

a good mix of features we
reckon the 5738Z is a great
deal at Rs. 30,999. If you're
looking for something really
attractive looking and sleek for
under Rs. 40,000 check out the
Aspire 5810T — at Rs. 38,401
it’s stylish enough to make an
impression in any company. If
you want something for playing
HD movies without skipping

a beat look at the Acer Aspire
5536 —not only is it

the cheapest notebook in our
test (Rs. 29,099) but its Radeon
HD 3200 solution packs a
decent punch.

Acer Aspire 5738G

different beasts — one is built
on traditional compact lines
meant as a generic desktop
replacement while the ID5801
comes across as a notebook
for the multimedia fan; that

is other than the gamer. The
NV48 is built well looks good
with a nice steel-grey coloured
lid with a glossy finish but

is slightly heavy. Inside the
keypad is good and has nice
feedback while being well laid
out. Gateway did a splendid
job on the trackpad — just the
right mix of feedback and grip
or rather slip — great tracking —

Acer Aspire 5810T
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Screens

accurate and fast. The left-click
and right-click buttons are well
placed and long therefore you
can use them with thumb and
little finger while your index
finger is on the trackpad. The
S/PDIF and audio out share a
single smart detect port. The
ID 5801 is larger, with a 15.6-
inch display and has a very
sleek, contoured profile when
viewed from the side owing to
the speaker being incorporated
inside a casing that starts
from the top of the keypad
and slopes upwards with a
gentle curve till it runs into the
display. On a negative design
note the bezel is wide and
looks ugly compared to the rest
of this beauty. Finished in navy
blue with chrome trimming she
is a beauty. Brawny too! - in
every respect. A tank like build
and great quality of materials
on the exterior coupled with
a fast Core 2 Duo processor,
4 GB of RAM and an NVIDIA
GeForce G105M GPU mean the
ID5801 has enough grunt to
tackle anything, well almost
anything.
The keys are nicely laid
out and the keypad feels
very comfortable
to use. Key
travel and
feedback is
also excellent
albeit soft and we
really liked its design.
The trackpad is very
responsive and tracks quite
accurately. The mouse buttons
feel a bit clicky. Shortcut keys
are red LED backlit and work
well, they’re also ultra legible.
The slot loading optical
drive has a neat eject button
on the edge of the notebook
face. A shocking omission is the
exclusion of a dedicated Wi-Fi
switch, although a keypad
shortcut does exist. Acer’s
Aspire 5738G is identical in
terms of looks, to its siblings
in the previous category.
Obviously this similarity is
only skin-deep and its innards
include a potent NVIDIA
GeForce G105M and 4 GB
of main memory. Once again
the keypad is identical in look
and feel, excellent! Like the
other Aspire notebooks the

trackpad lock button is an
annoyance preventer of sorts,
especially since the trackpad is
not recessed; meaning it gets
activated easily while typing
causing typos.

HCLs Z39 made us do a
double take when we saw
the amount of RAM — 8 GB
is virtually unheard of on
desktops, let alone notebooks.
It has a nice surface finish and
is well built and sturdy. Looks
wise its very plain looking,.

Lack of shortcut keys and
such prevent it from being too
usable. The Function key on the
outer portion of the keypad
means any shortcuts involving
use of the Crtl key are going to
be a royal pain. The keys have
a slightly firm feedback; people
used to squishy Sony keypad
beware!

However keypad feedback

is good as is

the feel. The
trackpad is
glossy and
due to
this
fingers
tend to
stick on
the surface
coating,
meaning
tracking is not
accurate. The lack
of a hard Bluetooth
switch on this notebook
is a glaring omission. The
Lenovo Y550 has a nice onyx
colour with a matte finish on
the outer body but the inside
is a glossy grey that is as
unappealing as the outer part is
attractive.

The trackpad is textured and
this imparts good feedback,
but tracking accuracy is not as
good as the best, courtesy
some much unwanted
lag. The trackpad is also
small and this may pose
an issue for some people.

The mouse buttons are
nice and large and soft to
press. The keypad feels
like hard rubber with solid
feedback. Key spacing

is minimal and layout is
good, most people will

be up and running with
this keypad — we had no

Gateway 1D5801

3D notebook screens?
Acer, Dell, HP, Lenovo and Sony to look
forward to notebooks with Stereo 3D

GT300 fab issues
NVIDIA receives first test samples of next-
generation chip the GT300 family. But fab yields

could be as low as 20 percent

issues. Lenovo has used good
speakers for the Y550 and for
the first time the beginnings of
bass are audible, although the
speakers on the costlier Lenovo
Y650 are much better.

The Lenovo Y550 also has
the distinction of having the
most powerful GPU from
amongst all the notebooks here
barring the gaming laptops —
the NVIDIA GeForce GT130M
is a powerful solution and
we reckon this model can
just as easily substitute for
a gaming notebook. A fully
featured Media Centre remote
unit is also bundled and this
works well in conjunction
with Windows Vista — a sweet
addition and the unit itself is
pretty compact.

When it comes to value
one cannot deny the appeal of
the solid Acer Aspire 5738G,

a good mix of features, build
and performance for a down

to earth price — Rs. 40,999. It
topped the Best Value charts in
this segment and we're duly
awarding it. HCLs Z39 is a little
too costly for the features on
offer and its plain looks will put
many people looking to spend
this much off. If you’re looking
at spending around Rs. 50,000
the Lenovo Y550 warrants
mention — great build quality
and powerful components, just
live with the mediocre colour
combination used.

HIGH-END DESKTOP
REPLACEMENTS ABOVE
RS. 60,000:_

Big bang, big bucks
This is a category created

for high-end, non-compact

Dell Studio XPS 1640

OCTOBER 2009

notebooks that are not

meant for hardcore gamers.
Notebooks in this category
are for power users who want
power sans portability. That's
not to say you cannot heft
one of these around. It’s just
that a wonderful large screen
cannot be incorporated into

a small notebook. If you are
shopping for a notebook
priced at above Rs. 60,000 for
home use you are somewhat
of a rare breed and of course
you expect a lot more as well
— great components with the
possibility of customisation, a
great screen suitable for video
and gaming, support for HDMI
in order to hook your notebook
up to an HDTV.

This duo are miles apart
in terms of their personas
and also the user base they
will appeal to. Enter the Dell
Studio XPS 1640 — classy
build quality including glossy
finished fibre and genuine
leather. It’s built like a tank and
has blatantly muscular looks.
There is none of the loose
panels that custom assembled
notebook assemblers (like
Dell) are known for. Superb
build quality and a superb
RGB-LED display as an option
along with high-performance
components make the Studio
XPS 1640 a standout in any
crowd. Add to that a very well
designed pseudo-segregated
keypad and dedicated ATi
graphics in the form of the
Radeon 3670 and you have a
recipe capable of feeding nearly
every want except one — the
hardcore gamer. The Lenovo
Y650 is a very different beast
—it’s very slim and compact
for its massive 16-inch screen
and the notebook feels very

light thanks to the use
of carbon fibre in the
construction. The
notebook is obviously
meant for enthusiast
multimedia users and
the integrated Blu-Ray
writer is testament

to this. The graphics
solution is also very
respectable (NVIDIA
GeForce GT 105M). A
pity the screen doesn’t
support a higher
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SSD good or bad

Despite their very high read and high
write performance scores SSDs are still
not as reliable as hard drives and when
heavily fragmented their performance
drops drastically

Intel ULV CPUs

An acronym for ultra low voltage, Intel’s ULVs are
the latest darling of compact, slim, netbook-like
notebooks. They offer reduced performance with
extra battery life

Laptop test

resolution like 1440 x 900
pixels, but a measly 1366 x 768
pixels is all you get. The screen
has good brightness levels and
great colour. Viewing angles are
better than the Y550. The outer
lid of the Y650 is textured and
looks classy while the inside

is a shockingly attractive pearl
white. A media centre remote
unit and built in TV tuner adds
to the package. All in all a very
feature rich, powerful solution
that is lightweight and slim
despite its large screen. Speaker
quality is very good (for a
laptop) and the bass is pretty
decent. The price will make
you flinch — Rs. 1,03,990 —
pretty steep and in our opinion
a little hard to justify, the
carbon fibre not withstanding.
For this reason alone the Dell
Studio XPS 1640 gets the nod
ahead of the Y650 — its more
powerful, and costs less with
the configuration we received
amounting to Rs. 65,900
without taxes, add another Rs.
7,000 to 12,000 depending on
which part of India you reside
in. Of course the Studio XPS
1640 can be configured to cost
well over a lakh with suitably
powerful components — it all
depends on what you want.

It wins our Best Buy award for
its blend of style, performance
and features.

GAMING NOTEBOOKS:,
Identity Crysis? Crisis
wars?

The term ‘gaming notebook’

is kind of paradoxical simply
because in our opinion gaming
on a notebook is somewhat of a
neutered thrill compared to the
full experience of gaming on a
high-end PC. After all, what can
replace a fast Core 17 processor,
GeForce GTX 285 and 27-inch
LCD monitor? — Nothing really,
not even a PS3 or an X360, and
if you're a hardcore computer-
based gamer not even a gaming
notebook. Obviously there is

a downfall — lugging around

a huge cabinet, LCD monitor
and other paraphernalia is

not everyone’s cup of tea.
Portability matters to many
people and LAN-party goers
will give up processing grunt
for something smaller. Enter

the gaming laptop — a rare
breed but one that is slowly
catching on in India. Obviously
a gaming notebook needs

to be powerful in every way
since modern games are the
most demanding applications
available so if a notebook can
play games well, it'll surely do
other software without even
breaking a sweat.

MSI GX620X

Gaming on a budget

MSI's GX620X comes. Decked
in fire engine red (on the lid
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MSI GX620X

and the outer trim) and
brushed black aluminium
on the palmrest; this is
one good-looking bad
boy. It’s heavy and owing
to the all-metal lid feels
extremely sturdy. This
colour scheme is much
better than ASUS’ colour
scheme that involves
orange — not the most
attractive of colours
though it sure looks loud.
The GX620X doesn’t,
rather it manages to
convey an air of class.

1t’s reasonably slim

for a gaming notebook
and looks sleek from

all angles. The lid has

a magnetic closing
assembly that clicks shut
with a nice positive feel.
The touch buttons look a
little too bright but work
well. There is a touch key
for selecting between eco

and turbo mode. The screen

resolution is a little low for

anotebook in this category,

we’d like a resolution of 1440

x 900 pixels for this screen

size but all we got was 1280

x 800 pixels. The trackpad

although smooth imparts a

very sticky feel to ones fingers

and this prevents comfortable

use. The keypad is well laid

out though and works well.
When it comes to

performance especially gaming

performance the GX620X

is not exactly a heavy hitter,

obviously because all it has

under the hood is a GeForce

9600GT and we're sorry to say

that NVIDIAs mobility versions

of their desktop GPUs are not

as powerful. Of course

this is also the case

with ATi — those

of you who think

the same GPU in

desktop and notebook

avatars will offer similar

performance, think

again. So while you will

be able to play most

games forget about the

latest games like Crysis

and Clear Sky — especially

if you like playing at higher
resolutions. Priced at Rs.
73,000 the MSI GX620X is a
powerful gaming notebook
for those looking for playing
slightly older, less taxing
games at LAN parties and it is
reasonably portable. However,
if you are looking to play the
latest games at high resolutions
please ignore this notebook.

ASUS G50V

Can I play too?

At first glance this looks a
little weird with its orange
bodywork. However, the body
is sculpted well and colour

ASUS G50V




Palm losing on Windows
Mobile

Palm to stop making WinMo devices,
reports big loss

Microsoft woos students
Microsoft offers college students
Windows 7 Pro at Snow Leopard prices
until January 2010

Laptop test

aside the G50V looks good.
Hinge build quality so-so. Open
her up and the screen is matte.
Thankfully the resolution is

an ideal 1440 x 900 pixels;
ideal for a 15.4-inch notebook.
The screen bezel is a little too
thick and spoils the look while
adding bulk. The keypad is neat
and similar in design to Dell
laptops with slight impressions
on the top of each key for your
finger. The number keypad

is a plus. The backlit, touch-
based buttons shortcut keys
work well and look nice. A blue
monochrome LCD displays
certain system parameters

and some might find this
intrusive — thankfully it can be
disabled. The trackpad surface
is good and has a nice blend
of feedback and tracking. And
best of all its pretty responsive,
our only grouse is that it’s
small. Of course the fact that
it’s recessed into the body is
good since your palm or wrist
will not accidently activate it
while using the keypad. All in
all, it’s miles ahead of the MSI
GX620X’s trackpad. Viewing
angles on the display are so-so
although brightness levels are
pretty good. One of the USB
ports is placed on the rear —
good for USB printers and
such. The E-SATA and HDMI
ports are located conveniently
and on the side.

The GeForce 9700M GPU
is reasonably powerful and will
play most games other than
the more demanding ones
like Crysis and Clear Sky albeit

at lower levels of detail. The
mighty Logitech MX518 mouse
is bundled with this notebook,
of course its got ASUS branding
on it. You also get a funky

bag, in fact the laptop ships
inside the bag and not some
ugly carton. ASUS is obviously
selling this one marked to
gamers on the basis of its
exclusiveness, but at a price tag
of Rs. 1,15,000 the G50V is a
little to hard to swallow and its
going to take more than some
fancy lighting and packaging to
make us even consider shelling
out so much.

Alienware M17x
Totally clichéd but ‘here
comes the game’

This is the first Alienware
notebook we've laid our grubby
paws on this year and quite
frankly we're impressed. Forget
about a weapon for gamers, the
M17x is a weapon incognito

— its amazingly sturdy
construction and ponderous
bulk means it can be used to
bludgeon just about any living
being to oblivion and that
includes a woolly mammoth!
And it’s attractive looking too,
with a black coloured, matte
finish all over the body and the
lid. The body is very thick; no
wonder given it’s innards. The
front slopes forward giving it

a very aggressive sports car
bonnet like look and grilles
embedded into the front light
up with embedded red LEDs.
The lid closes with a nice
positive snap. The 17-inch
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Alienware M17x

display is really clear and

crisp with a high resolution of
1920 x 1200 pixels. Viewing
angles are good. The integrated
speaker is one of the best we've
seen on a notebook — good
bass, a great mid-range and
extended highs. This notebook
had the best speaker from this
years bunch.

The Alienware branding is
boldly illuminated in pink,
however some of us found this
too feminine a colour for an
obviously masculine product.
The keypad is well laid out
and really good, suitable for
a lot of office work (not that
you would want to do that on
this notebook anyway) and
ergonomics is top class. The
trackpad is a let down — it
lags and tracking accuracy is
rubbish — really a shame and
the only blemish on a near
perfect report card.

This freak has got premium
innards to go with its menacing
profile — a quad core processor
— something unheard of for a
notebook and not one, but two,
GeForce GTX 260 GPUs in
SLI. A massive 2 GB of GDDR3
video memory (1 GB per card)

should be sufficient
for most games. The
220-odd frames per
second in Doom 3 and
45 frames per second
in Crysis was enough
to convince us that this
notebook can indeed be
used by a gamer. And guess
what — this is Dells cheapest
configuration for the Alienware
M17x, which can be configured
with dual GTX 280 GPUs —
pretty mean. Sadly this won’t
stand up to a really fast desktop
in terms of performance but
then if you want the best,
fastest notebook out there
be prepared to shell out Rs.
1,39,000 for it or Rs. 2,25,000
for the highest configuration
— either way you won'’t find as
powerful a notebook. It wins
our Digit Best Performance
award for the best gaming
notebook around and the most
powerful configuration.

APPLE NOTEBOOKS:
Hi-yo Silver...away!

Apples notebooks are called
Macbooks for those who
didn’t know. Not only do these
notebooks run Apples’ own
OS called “Leopard” or OS

X but they’re pretty different
compared to other Windows-
based notebooks. Whether
this is good or bad depends
on whether you're a fanboy

or a hater. Needless to say our
Windows-based benchmarks
do not work with OS X,
however the hardware used by
these notebooks is the same.

ave you always
wondered just how
good a gaming
notebook is at
gaming? We receive hundreds
of mails a month from readers
wanting to buy a notebook
for gaming. We typically ask
them their budgets and if that
is anything under Rs. 75,000
(which it usually is) we suggest
a desktop instead. If you're one
of those readers, this is for you.
It's no mystery that gaming
notebooks are never going
to be as powerful as desktop
counterparts simply because its
not possible to shrink powerful
components to a notebook-

worthy size without reducing
their performance. So a
GeForce 9600GT graphics card
will be will be more powerful
than a GeForce 9600GT M

(for mobility) notebook
graphics solution. Just to see
what happens we tested the
Alienware M17x alongside a
powerful PC.

The PC specs were as
follows:

Intel Q9650 CPU, 2 x 2 GB

1066 MHz DDR2 RAM, ZOTAC
GeForce GTX 285 GPU and 1 TB
WD Black Edition HDD.

Here are the scores:

PC Marko05

Overall

CPU Score

Memory Score

Graphics Score

HDD

3D Mark 2006 CPU Score

3D Mark 2006 Overall Score
Maxxon CineBench R10 (CPU Score)
DivX Encode 7.0 (.VOB to .Divx) *

File transfer Test (4 GB test file-sequential) (Sec)
File transfer Test (4 GB test file-assorted) (Sec)
Doom 3 (fps) (1024 x 768, Ultra Details)
Company Of Heroes (Tales Of Valor)

STALKER Clear Sky (1024 x 768, Max, DX10)
Crysis (1024 x 768, DX10, medium detail)

* Less is better

Alienware M17x High-end PC
8589 9783
8059 9557
5496 6258
14086 13539
5308 5618
3722 4623
13637 15627
9914 10967
42 38.5
2394 34.68
2096 25.13
220.4 260.4
1039 167.3
52.1 67.6
45 50
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Toshiba’s new notebook

beast
Toshiba recently launched their 500 GB,
7,200 rpm notebook 2.5-inch drive

Snow Leopard on the hunt Laptop test

Snow Leopard outsells predecessors in
opening weeks of availability

People who use Apple-based
products are mainly designers
and image-editing professionals
who swear by the usability,
interface and performance of
these products. However, this
doesn’t mean someone wanting
a regular notebook cannot

buy a Macbook. There are a
few people in office who use
Macbooks and quite frankly
they’re as usable as a regular
notebook. Obviously a few
shortcut keys differ and the
interface is unique, but the
learning curve is relatively flat
— Macbooks are designed to

be pretty idiot-proof. An added
advantage (and kudos to Apple
for including this) is BootCamp
— an addition to the
Leopard OS that

allows Windows XP

to be installed in a

dual boot.

The Macbook Air is
unique at first glance.
Designed to be really slim
and sleek and lightweight
the Macbook Air is built
like a tank courtesy its all
aluminium structure
which is built out of

performance available. Whether
it is the anaemic components
or the lack of even a very basic
RJ45 connect and a mediocre
screen the Macbook Air will not
impress anyone not looking for
superficiality. And that’s what
itis — a superficial gem and
priced at Rs. 1,12000, it doesn’t
deliver as expected.
All the Macbook Pros

look sleek as well, remember
they come in three sizes —
13.3-inches, 15.4-inches and
17-inches. The all-aluminium
body and the super slim
profile means they just attract
attention in any company. The
17-inch and 15-inch models

are as slim as the

OCTOBER 2009

Apple Machook Pro 13 inch

NVIDIA’s GeForce 9400M
integrated video solution
that is acclaimed to be as
powerful as many
discrete

graphics
solutions. One

of the only gripes
with the Macbook
Pro 13-inch in
comparison to

the others is the placement

of the speakers — behind the
notebook under the hinge as
opposed to on either side of the
keypad — this causes a decrease
in sound volume and clarity.
Apples segregated keypad is a
little cumbersome at first, but
amazing once you get the hang
of using it. The keys are soft but
not squishy and key feedback

is decent. The adjustable
backlighting is a little excessive
but it gets the job done. When
one sees the display quality,
brightness and resolution on
the 15-inch Macbook Pro the
13-inch doesn’t look so hot
anymore. The 15.4-inch model
has a beautiful display that
appears at least 15 per cent
brighter and the resolution of

Apple Macbook Air

go against Apples
design ethos but
we’re sure this can
be improved. The
second gripe is the gap
between USB ports —it’s
too small and if you use
a USB drive with a wide
body the adjacent USB
port becomes unusable
— this is unforgivable
especially given that these
notebooks have the space for
four well spaced out ports. The
Macbook Pro 17-inch is the
only one with three ports while
the others have two each. The
17 and 15.4-inch Macbook Pros
have identical hardware but
the 17-inch model has a higher
screen resolution (1920 x 1200
pixels). The ability to switch
between the integrated NVIDIA
GeForce 9400M and the
discrete GeForce 9600GT is a
plus since you get more battery
life with the former and greater
performance with the latter.

In terms of performance
none of the Macbook Pros are
slouches and the two larger
models have very powerful
processors. Given an identical

Contact Details

Brand Company Name Phone no Web site

Acer (Gateway) Acer India Pvt. Ltd +91-80-4070 8700 WWW.acer.co.in

ASUS ASUS Technology Pvt. Ltd. +91-22-6766 8800 / 1-800-209 0365 WWW.asus.in

MSI MSI India +91-11-4175 8808 http://in.msi.com/

Dell (Alienware) Dell India Pvt. Ltd. +91-80-2506 8026 / 1-800-425 4026 www.dell.co.in

Sony Sony India 1-800-11-11-88 (Toll Free) WWW.S0NY.co.in

HCL HCL Infosystems Ltd. +91-120-252 6518 hclstore.in

HP HP India +91-124-441 7501 http://welcome.hp.com/country/in/en/welcome.html
Apple Apple India +91-80-4140 9000 www.apple.co.in

Lenovo Lenovo India 1-800-425 3353 www.lenovo.com/in

a single piece of aluminium,
in fact this is something all
the latest Macbooks share,
therefore the term “unibody”.
The Air is compact enough to
necessitate an external DVD
RW drive and even the ports
are minimal - no LAN port
and a single USB port located
on the under part of the body
accessible by lifting a small
hood-like cover. As sleek and
sexy as the Air is and the fact
that its storage subsystem is
SSD based there’s very little

13-inch Macbook Pro — this
gives them the appearance of
being even slimmer because

of the larger screen size. The
13-inch Macbook Pro is little
more than a 13-inch unibody
Macbook released in 2008 with
an SD slot and a permanent
battery. That being said it's an
exceptionally well-built and
good-looking notebook. It has a
great screen, much better than
the display on the Macbook Air.
It also sports pretty powerful
components including

1440 x 900 pixels is ideal. The
keypad layout and spacing is
identical across all the models
—a good thing.

We have two generic design
gripes with Apple and this
applies to all three Macbook
Pros. One (and we hope you're
listening Apple) the edge of
the palmrest is sharp and this
starts to hurt the wrists after
15 minutes of typing — sounds
like we’re nitpicking but this
is, in fact, super annoying.
Obviously a dull edge would

set of benchmarks we’re sure
these notebooks would be
as fast or faster than most
Windows based notebooks out
there, but an apples to apples
(pun!) comparison is just not
possible between them. What
we did notice was OS X seems
to be better when it comes
to hard drive usage and the
Macbook Pros were faster in the
file copy tests when compared
to Windows notebooks.

If you're looking to buy
an Apple based notebook we
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Apple Notebooks

Price
Warranty
Plus (+)

Minus (-)
Grand Totals (Our of 100)
Features (Out of 50)

Performance (Out of 50)

Specifications

Platform Chipset

(in MB)

HDD Size / Type
Optical Drive Type
Bundled 0S

Screen Size / Resolution

Processor Model No / Processor Speed

RAM / RAM Type / Memory Speed

Graphics Solution / Dedicated Video Memory

Rs. 74,400
1year

Exceptional build and
components

Glossy screen
55.05
23.75
31.30

Intel Core 2 Duo P8400 /
2.26 GHz

2 GB/ DDR3 /1066 MHz
nVidia MCP79
GeForce 9400M / -

160 GB / SATA
DVD RW
Mac 0S X 10.5.6

13.3 inches / 1280 x 800

Rs. 1,12,000
1year

Uber compact

All show, no go
67.42
30.95
36.47

Intel Core 2 Duo / 2.13 GHz

2 GB/ DDR3 /1066 MHz
nVidia MCP79
GeForce 9400M / -

128 GB / SATA (SSD)
N/A
Mac 0S X 10.5.8

13.3 inches / 1280 x 800

Macbook Pro 13” Machook Air Macbook Pro 15” Macbhook Pro 17”

Rs. 1,41,600
1year

Superb build, great per-
formance and screen

Pricey
72.78
3295
39.83

Intel Core 2 Duo P9700 /
2.8 GHz

4GB/ DDR3 /1066 MHz
nVidia MCP79

GeForce 9400M and
9600GT /512 MB

500 GB / SATA
DVD RW
Mac 0S X 10.5.8

Characteristics I N I I

15.4 inches / 1440 x 900

Rs. 1,57,400
1year

Superb build, great
performance and screen

Pricey
73.41

34.45
38.96

Intel Core 2 Duo P9700 /
2.8 GHz

4GB/ DDR3 /1066 MHz
nVidia MCP79

GeForce 9400M and
9600GT /512 MB

500 GB / SATA
DVD RW
Mac 0S X 10.5.8

17 inches / 1920 x 1200

(Native, in pixels)

Weight 2.04 kg 1.36 kg 2.49 kg 3.1kg

No of Ports (USB / FireWire) 2,1 1,0 2,1 3,1
Connectivity: LAN / Bluetooth / Wi-Fi(Y/N) Y/Y/Y N/Y/Y Y/Y/Y Y/Y/Y
Video ports: D-Sub / DVI / HDMI (Y / N) N/N/N N/N/N N/N/N N/N/N
Audio Ports: (Mic / Line Out / S/PDIF) Y/Y/Y N/Y/N Y/Y/Y Y/Y/Y
Memory Card Reader / Cards Supported Y / SD, MMC N/ NA Y / SD, MMC Y / SD, MMC
E-SATA (Y / N) / RJ11 Port N/N N/N N/N N/N

Additonal Connects Mini Display Port

9.5/8.25/8

Mini Display Port
9.5/825/75

Mini Display Port
9.5/825/8

Mini Display Port

Build Quality (Body / Keypad / Lid, 9.5/8.25/8

movables) (So 10)

Keypad Tactile Feedback / Key Layout & 825/75/4 825/75/3 8.25/75/4 8.25/75/4
Usabhility / Shortcut Keys (So 10)

Biometrics Login (Y / N) N N N N

Wi-Fi / Bluetooth / TouchPad On/Off N/N/N N/N/N N/N/N N/N/N

dedicated button (Y / N)

Maxxon CineBench R10 CPU score 4968 3453 6152 6182
Display Mate Colour Accuracy (So 10) 7.5 6 75 75

Webcamera / Speaker Quality (So 10) 6/5.75 4/4.75 6/7 6/7
Battery Life Test (in Minutes) 305 218 278 221

HD Movie Viewing (So 10) 7 5.25 7.5 8.25
Wi-Fi file transfer (in MBps) 4.76 4.55 4.76 4.76
DivX Encode 7.0 (sec) * 59.6 97.4 39.2 39.7

Sequential / Assorted file transfer (in MBps)  33.82 / 27.27 38.49 /36.53 36.57 / 28.52 37.57 / 28.96

* less is better
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Gaming Notebooks
2 T Y S
Model G50 M17x GX620X
Price (Rupees) Rs. 1,15,000 Rs. 1,39,000 Rs. 73,000
Warranty (Years) 2 years 1year 2 years
Plus (+) Gglod config, reasonably port- Very powerful config Affordable gaming solution
able
Minus (-) Crysis scores Bulky, expensive Not future proof
Grand Totals 63.03 79.70 54.78
Features (Out of 40) 28.10 29.37 23.78
Performance (Out of 60) 3493 50.33 31.00
featwres [/ ! 1 |
Component Specifications
Processor Model No Core 2 Duo P8600 Intel Core 2 Extreme Q9300 Intel Core 2 Duo P8400
Processor Speed 2.4 GHz 2.5 GHz 2.26 GHz
RAM / RAM Type / Memory Speed 4 GB / DDR2 / 800 MHz 4096 / DDR3 / 1066 MHz 4096 / DDR2 / 800 MHz
Chipset PM45 nVidia MCP79 Intel PM45
Graphics Solution NVIDIA GeForce 9700M GT nVidia GeForce GTX 260M x 2 (SLI) Nvidia GeForce 9600GT
Video Memory Type / Dedicated Video Memory Size GDDR3 /512 MB GDDR3 /1024 MB x 2 GDDR3 /512 MB
HDD Size / Type 320 GB, SATA 320 GB, SATA 320 GB, SATA
Optical Drive Type DVD RW Bluray Reader/DVD RW DVD RW
Bundled 0S Vista Home Premium Vista Home Premium Windows Vista Home Premium
characteristics [ ! ! |
Screen Size 15.4 inches 17 inches 15.4 inches
Screen Resolution (Native) 1440 x 900 pixels 1920 x 1200 pixels 1280 x 800 pixels
Weight 3.3kg 496 kg 2.7 kg
No of Ports (USB / FireWire) 4,1 4,1 3,1
Connectivity: LAN / Bluetooth / Wi-Fi (Y / N) Y/Y/Y Y/Y/Y Y/Y/Y
Video ports: D-Sub / DVI / HDMI (Y / N) Y/N/Y Y/N/Y Y/N/Y
Memory Card Reader (Y/N) \ Y Y
E-SATA (Y / N) Y Y N
Type of Memory Cards Supported SD, MMC, xD, MS Pro SD, MMC, xD, MS Pro SD, MMC, xD, MS Pro
Inbuilt webcam (Y / N) Y, 2 MP Y Y
RJ11 (Y /N) N N Y
Additonal connects - Display Port, 2 x headphone out Surround out
Extra Accessories provided ASUS gaming mouse (MX518) - Gaming bag
Build Quality: Body / Keypad / Lid, movables (So 10) 75/75/ 675 8.5/8.5/8.75 75/65/7
R N A R
Keypad Tactile Feedback / Key Layout & Usability / Shortcut 775/8/6.75 8.5/8.25/75 7.25/75/ 6.25
Keys (S0 10)
Biometrics Login (Y/N) N N N
Wi-Fi / Bluetooth / TouchPad On/Off Switch or Button (Y/N) Y/N/Y Y/N/N N/N/N
performance | | ]
PC Marko5 Overall 6426 8589 5673
CPU Score / Memory Score 6126 / 5133 8059 / 5496 5839 / 5129
Graphics Score / HDD Score 7598 / 5342 14086 / 5308 6783 / 5352
SiSoft Sandra 2009 Pro Memory Bandwidth 5.39 Gbps 6 GBps 5.1 GBps
3D Mark 2006 (CPU Score / Overall Score) 2143 / 6656 3722 /13637 2102 /5638
Maxxon CineBench R10 (CPU Score) 4910 9914 4729
Display Mate Colour Accuracy Test (Avg) (So 10) 6.25 6.5 6.5
Battery Life Test (Minutes) 85 71 91
Wehcam Quality / Speaker Quality / HD Movie Viewing (S010) 6.5/6.5/ 6.5 7/875/8 6/6/6
DivX Encode 7.0 (.VOB to .Divx) (in seconds) * 57.2 42 66.3
File transfer Test (Sequential / Assorted) (in MBps) 25.30/20.22 2393 /2096 23.34/18.50
WiFi Performance Test 7.0 (in Mbps) 41 48 39
Wi-Fi 100MB Assorted File Copy (in MBps) 5.56 7.69 4.55
Doom 3 / Company Of Heroes: Tales Of Valor (fps) 133.2/ 62.3 220.4 /1039 110.2 /51.2
STALKER Clear Sky / Crysis (fps) 21.8/32 52.1/45 16.3/26
* Less is better
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The magic of RGB LEDs
Very few displays use RGB LED
technology but the advantage is a colour
gamut that approaches 100% of the

Dell sued for $4 million
Dell paid $4 million to settle a dispute
pending since 2008 against them for

Laptop test

deceptive business practices

Adobe RGB colour space

HOW WE TESTED

We segregated notebooks into
the following categories and
subcategories:

Desktop Replacements

a. Desktop replacements up to Rs.
40,000

b. Desktop replacements between
Rs. 40,001 and Rs. 60,000

c. High-end desktop replacements
(above Rs. 60,000)

Ultra Compacts

a. Low power ultra compacts

b. Ultra compacts

Corporate Notebooks
Apple Notebooks

Gaming Notebooks

These categories need no
explanations and four of them
are simply based on usage
patterns. We'd like to test Apple
notebooks alongside other
laptops but unfortunately most
Windows based benchmarks we
use have no OS X counterparts
meaning an apples to apples
(pardon the pun!) comparison
just wasn't possible.

In terms of features we looked

at and graded these notebooks

Apple Macbook Pro 15-inch

recommend the Macbook Pro
13-inch priced at Rs. 74,400

— good value for money and a
very well built, great looking
piece of equipment. If you want
something really powerful

we recommend the Apple
Macbook Pro 15.4-inch — class-
leading hardware and sublime
looks and built, though its
pricey at Rs. 1,41,600.

BUSINESS NOTEBOOKS:
Tie and Suit,

ready to boot

We've often asked ourselves

— what makes a business
notebook? Obviously something

from every conceivable angle
including the their hard drive
size, type of optical drive,
number of USB and FireWire
ports, video connects, memory
card reader, presence of E-SATA
and even their weight. We also
rated the build quality of each
notebook and the ergonomics,
layout and feel of the keypad.
The usability and tracking
accuracy of the trackpad was
also rated. Presence of dedicated
shortcut keys for common
functions like multimedia
controls, Wi-Fi on/off, Bluetooth
and trackpad disable/enable was
also scored.

In terms of performance
we ensured a clean install of
Windows Vista by uninstalling
unnecessary software from these
notebooks, but used the bundled
OS itself. So if a notebook came
with Windows XP preinstalled,
we used that. System Restore
and indexing were disabled
before testing. All battery saving
features were disabled and the
notebook connected to the
mains at all times except during
the battery test (for obvious

compact, since businessmen

on the go like to travel light.
Something that’s rugged and
not too flashy — businessmen
want productivity and usability
more than pizzazz. Obviously
performance, since time is a
luxury few corporate users have.
Backup software and other
office productivity related tools
are a must as well since the

key to effective productivity is
prevention of delays. Therefore a
good business notebook should
have all these features.

The four corporate-
oriented products we received
certainly seemed to meet
all the parameters set. HPs
ProBook 4410S was the first
candidate up for test. It’s got a
nice textured finish on the lid
and the dull maroon colour is
really smart looking. Inside the
notebook is a mix of glossy and
matte black. It's compact and
light but a little on the thick
side. The keypad is segregated
with a little less spacing that
what Sony uses and owing to
this the keypad is more usable
—a solid plus for HP. The 4410S

reasons). A disk defragmenter
was run on each notebook prior
to testing and we used latest
versions of ATi and NVIDIA
display drivers.

PC Mark Vantage and 3D
Mark Vantage are a little too
taxing for many notebooks
whose specifications are not
up to the latest desktop PC
hardware so we used earlier
versions. PC Mark05 is our
generic benchmark of choice
because it has one of the
most complete benchmark
suites from testing the hard
drive page file performance,
to office related benchmarks,
flash player performance, web
page rendering, game and 3D
testing and application startup.
It has got to be one of the most
comprehensive benchmarks
around. 3D Mark 2006 was
used to get an idea of the
graphics and CPU subsystems
performance. SiSoft Sandra
2009 Pro was used to get an
idea of memory bandwidth.
CineBench R10 gives a good
indication of a CPUs rendering
performance. DisplayMate

comes with a complete backup
and recovery suite from HP
meaning your data is always
safe. It’s got a very mediocre
display in terms of colour and
while businessmen don’t need
colour accuracy and contrast

it would be nice to have a
slightly better screen. The
trackpad works well and the
Wi-Fi shortcut switch is usable.
To be honest this ones price
surprised us — we expected it to
be well in excess of Rs. 50,000
but HP makes it available for as
little as Rs. 40,000 — a

solid buy for someone

Video Edition was used to

judge the quality and colour

capabilities of each notebooks
display. Finally Performance
Test 7.0s inbuilt Wi-Fi test was
used to judge the performance
of the wireless component with
theoretical data transfers. We
hooked up a desktop PC using
RJ45 connectivity to a wireless
router and used this to connect
to the each notebook for all
wireless testing.

Our real world tests consisted
of subjective tests for movie
watching, web camera quality
and inbuilt speaker quality. DivX
Encode 7.0 was used to encode
a 100 MB .VOB file to DivX and
this was used to test the CPUs
encoding capabilities. Sequential
and assorted tests were done for

judging the storage subsystems

performance. For gaming
performance we used Doom

3, one of the most scalable

and hardware sensitive games
around. For gaming notebooks
we also used three other newer
games — Crysis, S.TA.LKE.R Clear
Sky and Company Of Heroes:
Tales Of Valor.

name suggest (i.e. Elite is higher

than Pro) the 2530P is meant

for the corporate with deeper

pockets. It's even smaller

with a 12.1-inch display. The

lid has a brushed aluminium

finish and this goes well with

the grey-black body. The

notebook is quite compact

but feels sturdy. HP states

the use of certain materials

that increase reliability even

in dusty conditions and this

notebook is built to withstand

wider variations in temperature.
Their DriveGuard
technology that

looking at a solidly protects the hard
built, compact, no frills drive in case of a
notebook. sudden impact is
The OCTOBER 2009 also incorporated
other HP on this model. The
notebook processor is an Intel
was an SU9300 — this series is
EliteBook known for its ultra low
2530P. power consumption. An
As the IBM-style track point is also

HP ProBook 4410S

included although to be
honest hardly anyone uses
one these days. The trackpad
is small but works well and
tracking is accurate and lag
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Fastest SSDs on earth
Pliant technologies, a little known
manufacturer Drops Bombshell
“Lightning” SSD With 180k IOPS,

Targeting the no-man’s land between netbooks
and notebooks the AMD Neo CPU along with ATi
graphics allows for a powerful solution with a very

Laptop test

500/320 MB/s Read/Writes

slim and compact footprint

free. The keypad is
well designed and the keys
are excellently spaced. A small
fingerprint scanner is provided
on the right side of the
palmrest to allow biometrics-
based login. The tested battery
life is good — just over four
hours — enough to keep you
productive over most domestic
flights. Priced at Rs. 99,000
plus tax the EliteBook 2530P
is expensive, but those who
appreciate its subtle talents will
shell out.

The Sony Vaio SR46GD
is Sony’s answer to the
businessman wanting
something on a shoestring, if
Rs. 74,900 can be considered a
shoestring. However, this is as
low as they corporate series of

notebooks is likely to be priced.

The SR46GD is heavier than
its sibling and the entire body
is made of some fibre-based
compound that isn’t rigid. It's a
good-looking notebook based
on the attractive cylindrical
design (Sony speak for the
circular section connecting the
base and the lid). The keys are
not well designed at all and the
gap between keys is too much
and the keys themselves too
small. In fact this is one of the
worst designed keypads we've
come across. Obviously if you

use it long enough

you will get accustomed
to it; but the two days over
which we used this notebook
had us running for cover.
There are five usability modes
activated via five shortcut keys.
These usability modes change
the operating environment
according to your needs and
the application shortcuts
available in each mode can be
configured.

The Core 2 Duo P8700 and
Radeon HD 4570 are both
pretty powerful solutions.

The Wi-Fi switch is very
conveniently located and

the activity indicators on

the notebook are optimally
positioned — Sony has their
ergonomics spot on. The
trackpad is accurate but there is
slight lag, however the tracking
surface is well designed and
doesn’t slip or grip too much.
If its features appeal to you and
you cannot spend any more
than 74,900 this is a decent buy
and certainly looks a little more
upmarket than the HP 4410S,
understandable really since it
costs nearly double.

If you are looking for
something really classy
however, and don’t mind
shelling out big (really big!)
then check out the Sony Vaio

VGN-Z48GD — the echelon

of upwardly mobile in Sony’s
books. Their ‘Z’ series are
hardcore business notebooks
— sleek, feature-rich and
expensive. The Z48GD has
256 GB worth of SSD under
the hood. And that’s not all,
further inspection revealed
two SSD drives of 128 GB each
configured in RAID 0. We
figure these drives themselves
would cost Rs. 50,000 if not
more. On the outside the
Z48GD is ultra slim and really
light. The display used is a
WLED and the lid is very slim
as a result. Since it looks much
smaller than the HP 4410S we
were surprised to see it had a
display as large as 13.1-inches.
The body is built of carbon
fibre — rugged although there is
noticeable flex. We're told this
is normal and doesn’t affect
durability in the least. Even the
lid seems flexible and we were
initially concerned about its
flex leading to damage of the
display. Sony reassured us that
this sort of flex is intentional
as using hard material for the
lid cover would actually risk
cracking of the LED-based LCD
inside. This is because LED-
backlit LCDs are apparently
much slimmer than regular
LCDs and therefore prone to
damage i.e. cracking.

But wouldn’t

flexing the lid also

lead to cracking

of the display inside?

Oh well, we couldn’t get
answers for everything. The
famous Sony Stamina Mode is
present and can be used at the
flick of a toggle switch. This
allows shifting between stamina
and performance modes which
internally switches between
Intel integrated graphics and
NVIDIAs GeForce 9300M
giving you either extended
battery life or more video
performance. Unlike its

earlier avatars that required a
Windows restart this version of
Stamina Mode makes do with
just shutting down all running
applications and switching
modes causes your screen

to blank out momentarily as
the graphics adapter changes.
Sadly the keypad is still a pain
to work with thanks to tiny, ill

spaced keys. The trackpad is
also small and a little cramped
but tracking is good. Still you
will want to invest in a wireless
mouse to get the best out of
this notebook.

In terms of performance this
notebooks storage subsystem
blows everything else away,
as expected with the striped
SSD drives. It also has a very
powerful 2.8 GHz Core 2 Duo
(P9700) processor and this,
coupled with 6 GB of RAM
and a 64-bit OS (necessary
to address more than 4 GB
of RAM) makes the Z48GD
a potent performer in a
diminutive package. A real
pocket rocket, and priced
likewise too — Rs. 1,49,900 is
not cheap; but then this level
of pedigree rarely is. It’s our
Best Performer award winner on
account of it’s superb all round
performance.

- Sony Vaio VGN-Z48GD

OCTOBER 2009

ULTRA COMPACT
LAPTOPS:

He ain’t heavy, he’s my
ultra compact!

By definition an ultra compact
notebook is one that is
lightweight and small. This
necessitates a small screen size;
not more than 13.3-inches.
Anything smaller than
11.1-inches and it becomes a
netbook. Of course an ultra
compact notebook can also
be a business notebook, since
the very term ultra compact

is generic and doesn’t specify
suitability to a particular
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Desktop Replacements up to Rs. 40,000

sang ]

Model Aspire 5536 Aspire 57382 K501J

Price Rs. 29,099 Rs. 30,999 Rs. 33,900
Warranty 1year 1year 2 years

Plus (+) Looks good Looks good Good CPU

Minus (-) Keypad build Keypad build horrible trackpad
Grand Totals (Out of 100) 54.46 58.83 52.83

Features (Out of 55) 36.62 4091 33.77
Performance (Out of 45) 17.84 1793 19.06

Specifications

Processor Model No / Processor Speed AMD Athlon X2 QL-64 /2.1 GHz Intel Dual Core T4200 /2 GHz Intel Core 2 Duo T6400 / 2 GHz
RAM / RAM Type / Memory Speed 2 GB / DDR2 / 667 MHz 2 GB / DDR2 / 800 MHz 4 GB / DDR2 / 667 MHz
Platform Chipset AMD M780/K11 Intel GL40 Intel PM45

Graphics Solution / Dedicated Video Memory Radeon HD 3200 / 256 MB Intel GMA 4xxx / - Intel GMA 4xxx / -

HDD Size / Type 320 GB / SATA 320 GB / SATA 320 GB / SATA

Optical Drive Type DVD RW DVD RW DVD RW

Bundled 0S Vista Home Basic Vista Home Premium Vista Home Basic
characeristics ... { [/
Screen Size / Resolution (Native, in pixels) 15.6 inches / 1366 x 768 15.6 inches / 1366 x 768 15.4 inches / 1366 x 768
Weight 2.8kg 2.8kg 2.6 kg

No of Ports (USB / FireWire) 4,0 4,0 4,0

Connectivity: (LAN / Bluetooth / Wi-Fi) Y/Y/Y Y/Y/Y Y/Y/Y

Video ports: D-Sub / DVI / HDMI (Y / N) Y/N/Y Y/N/Y Y/N/N

Audio Ports: Mic / Line Out / S/PDIF (Y / N) Y/Y/Y Y/Y/Y Y/Y/N

Memory Card Reader / Cards Supported Y / SD, MMC, MS Pro, xD Y / SD, MMC, MS Pro, xD Y / SD, MMC, MS Pro, xD
E-SATA (Y / N) / RJ11 Port N/Y N/Y /N

Additonal Connects - - NA

Build Quality (Body / Keypad / Lid, movables) (So 10) 6/475/7 6/475/7 7/65/65
ergonomics
Keypad Tactile Feedback / Key Layout & Usability / Shortcut Keys (S010) 8.25/7.75/ 6.5 8.25/775/ 6.5 75/725/35

Biometrics Login (Y / N) N Y N

Wi-Fi / Bluetooth / TouchPad On/Off dedicated button (Y / N) N/N/N N/Y/Y N/N/N

bertormanee |

Synthetic Scores

PC Marko05 Overall 3690 3139 4571

PC Marko05 CPU Score / Memory Score 4131 / 2892 2848 /3087 5048 / 4191
PC Mark05 Graphics Score / HDD Score 2092 / 4178 1441 / 5412 1990 / 5384
Sisoft Sandra 2009 Pro Memory bandwidth 4 GBps 3.8 GBps 4.44 GBps
3D Mark 2006 (CPU Score / Overall Score) 1485 / 1261 1012 / 590 1694 / 859
Maxxon CineBench R10 CPU score 3227 2403 4067
Display Mate Colour Accuracy (So 10) 5.25 5.25 5.5

Wi-Fi Performance Test 7.0 (in Mbps) 57 56 57

Real World Tests

Battery Life Test (in Minutes) 108 227 239
Wehcamera / Speaker Quality (So 10) 6/5.5 6/5.5 35/4

HD Movie Viewing (So 10) 6.5 6.25 3.75

Wi-Fi file transfer (in MBps) 8.33 7.69 7.69

DivX Encode 7.0 (sec) * 98.3 114 70.6
Sequential / Assorted file transfer (in MBps) 20.33/16.10 19.57 / 17.45 19.98 / 19.59
Doom 3 (fps) 359 8.2 13.6

* less is better
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Aspire 4736 F82Q K401) Aspire 5810T

Rs. 34,599 Rs. 36,990 Rs. 36,990 Rs. 38,401

1year 2 years 2 years 1year

Compact and powerful Built well Built well, looks good Really sleek, built well
weak graphics Weak CPU Horrible trackpad CPU weak

52.10 51.60 52.77 5490

35.52 34.93 33.99 38.65

16.58 16.67 18.78 16.24

Intel Core 2 Duo T6400 Intel Dual Core T4200 Intel Core 2 Duo T6570 /  Intel Core 2 Solo U3500 /

/2 GHz /2 GHz 2.1GHz 1.4 GHz

3 GB / DDR2 / 667 MHz 3GB/DDR2/ 667 MHz 4 GB/DDR2 / 667 MHz 3 GB / DDR3/ 800 MHz
Intel GM45 Intel GL40 Intel GL40 Intel GS45

Intel GMA 4xxx / - Intel GMA 4xxx / - Intel GMA 4xxx / - Intel GMA 4xxx / -

320 GB / SATA 320 GB / SATA 320 GB / SATA 320 GB / SATA

DVD RW DVD RW DVD RW DVD RW

Vista Home Premium Windows XP Home Vista Home Basic Vista Home Premium

14 inches / 1366 x 768 14.1inches / 1366 x 768 14 inches / 1366 x 768 15.6 inches / 1366 x 768

2.3kg 2.59 kg 2.36 kg 2.4 kg

3,0 3,0 4,0 3,0

Y/Y/Y Y/Y/Y Y/Y/Y Y/Y/Y

Y/N/Y Y/N/Y Y/N/N Y/N/Y

Y/Y/Y Y/Y/N Y/Y/N Y/Y/N

Y / SD, MMC, MS Pro, xD Y / SD, MMC, MS Pro, xD Y / SD, MMC, MS Pro, XD Y / SD, MMC, MS Pro, XD

N/Y N/N N/N N/N

6/475/7 7/65/6.5 7/65/6.5 8.25/6.5/8.25
!/ [/ | |

8.25/775/ 6.5 75/7.25/35 75/775/3.5 8/8/6

N N N N

N/N/N Y/N/N N/N/N Y/N/Y
- !/ | |

4210 3712 4571 2099

4803 / 4147 5093 / 4117 5060 / 4174 2453 / 3258

1991/ 5015 1215 / 4764 2012 / 5066 992/ 4733

4.13 GBps 4.32 GBps 4.41 GBps 4.13 GBps

1665 / 744 992 /564 1767 / 866 657 / 602

4075 3900 4292 1514

5.25 5.75 3.75 5

35 32 60 36

107 226 228 273

5.75/4.25 4/35 4/35 5.5/4.5

5.75 4.25 4.5 5.5

5.26 3.33 8.33 5.00

71.53 72.4 95.6 153

16.68 / 16.50 19.15 / 17.56 20.30/17.17 21.64 / 20.31

18.4 17.3 14.1 127

Laptop test

Best of the Best

Ao Others Promise.
{; We Deliver !

Integrated Program for Fresh Graduates

CCIE - Security

CCIE-R &S
REIRy e LT HDFC BANK |

Congrats

Mr. Amarjit Panag CCIE # 25058
Mr. Binoy U CCIE # 24874
Mr. Mandeep Singh CCIE # 24873
Mr. Mohamed Zafar CCIE # 24739
Mr. Vasantharaju P CCIE # 24724

Courses Offered:

CCIE, CCNP, CCNA, CCSP, CCIP, CWNA,
CWNP, CWSP, CCSA, CCSE, CISSP

Well Qualified Instructors

AJAY PANDEY
B.E, MS (USA), CCIE # 14792, (Security / R&S),
CISSP # 43675, CCSE, CISM, MCSE, ASAP
SUNNY SHARMA
BCS, CCIE # 24088 (Security),
CCSP. CCNP. CWNA, CEH, MCSE.

Lab Equipped with :

91 Cisco Routers (2811, 2621 XM, 3600,
2600, 2500, 1700, 700}, 24 Cisco Catalyst
Switches (5000, 3750, 3560, 3550, 3000,
2950, 2900), Frame - Relay / ISDN, 8 Firewalls :
SonicWall, Watch guard, Cisco PIX
515 E (UR), ASA 5510, PIX 501, 3005
VPN concentrator, 4210 [PS sensor,
Nokia IP 330, Check Point, CiscoWAP/
NICs, Cisco Call Manager MCS 7825

Local Accomodation Available

We have Graduated over
7000 CCNPs & 57 CCIEs.
BANGALORE
Visit our Website :

www.topguntechnologies.com
info@topguntechnologies.com

SMS 080- 65616600
© 080-23528500/ 41277710

If you find a better Institute to do
any of these courses, Join it !
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Desktop Replacements between Rs. 40,001 and Rs. 60,000 High-end desktop replacements
Model Aspire 5738G NV48 1D 5801 IdeaPad Y550 239 Studio XPS 1640
Price Rs. 40,999 Rs. 42,999 Rs. 49,999 Rs. 50,990 Rs. 59,990 Rs. 65,900
Warranty 1year 1year 1year 1year 1year 1year
Plus (+) Good components  looks good, built  Very well built Powerful graphics  Lots of RAM Superb build quality
well solution and components
Minus (-) Euild c(|jua|ity of Slightly expensive Lacks shortcut keys poor viewing angles expensive Slightly bulky
eypal
Grand Totals (Out of 100) 60.62 53.79 57.06 58.54 4990 63.51
Features (Out of 55) 41.15 36.73 37.84 36.48 3271 3931
Performance (Out of 45) 19.46 17.07 19.22 22.06 17.19 24.20
Featwres | ] ] /| |
Specifications
Processor Model No / Processor Speed Intel Core 2 Duo Intel Core 2Duo  Intel Core 2 Duo Intel Core 2 Duo Intel Core 2 Intel Core 2 Duo P8600 /
T6400 / 2 GHz T6400 / 2 GHz T6400 / 2 GHz T6600 / 2.2 GHz 52%16400/ 2.4 GHz
RAM / RAM Type / Memory Speed (MHz) 4 GB/DDR3/800 3GB/DDR2/667 4GB/DDR3/800 4GB/DDR3/800 ?ggo/ DDR2 4 GB / DDR3 /1066
Platform Chipset Intel PM45 Intel GM45 Intel PM45 Intel PM45 Intel GM45 Intel PM45
Graphics Solution / Dedicated Video GeForce G105M Intel GMA 4xxx /- GeForce GIO5M /-  GeForce GT 130M  Intel GMA Radeon HD 3670 / 512
Memory (in MB) /512 / 512 Axxx / -
HDD Size / Type 320 GB / SATA 320 GB / SATA 320 GB / SATA 320 GB / SATA 500 GB / SATA 320 GB / SATA
Optical Drive Type DVD RW DVD RW DVD RW DVD RW DVD RW DVD RW
Bundled 0S Vista Home Pre- Vista Home Vista Home Premium Vista Home Pre- Vista Business Vista Home Premium
mium Premium mium
Screen Size (Inches) / Resolution (Native, 15.6 /1366 x 768 14 / 1366 x 768 15.6 / 1366 x 768 15.6 / 1366 x 768 14.1/ 1280 x 15.6 / 1920 x 1080
in pixels) 800
Weight 2.8 kg 2.33 kg 3kg 2.75 kg 2.35 kg 291 kg
No of Ports (USB / FireWire) 4,0 3,0 3,0 3,1 3,0 3,1
Connectivity: LAN / Bluetooth / WiFi(Y/N) Y/Y/Y Y/Y/Y Y/Y/Y Y/Y/Y Y/Y/Y Y/Y/Y
Video ports: D-Sub / DVI / HDMI (Y / N) Y/N/Y Y/N/Y Y/N/Y Y/N/Y Y/N/N Y/N/Y
Audio Ports: (Mic / Line Out / S/PDIF) Y/Y/Y Y/Y/Y Y/Y/N Y/Y/N Y/Y/N Y/Y/N
Memory Card Reader / Cards Supported Y /SD, MMC, MS Y /SD, MMC, MS Y/ SD, MMC, MS Y / SD, MMC, MS Y /SD, MMC, Y /SD, MMC, MS Pro, XD
Pro, XD Pro, xD Pro, xD Pro, XD MS Pro, xD
E-SATA (Y / N) / RJ11 Port /Y N/N Y/N N/N N/N Y/N
Additonal Connects NA - - NA - Display Port
Build Quality (Body / Keypad / Lid, mova- 6.75/4.75/7 7/675/7 85/7/8 7.25/6.5/5.75 675/675 8/8/8.25
hles) (So 10)
D B E—E— O —
Keypad Tactile Feedback / Key Layout & 8.25/7.75/ 6.5 75/ 6.5/ 6.75 75/7.25/6.75 6/75/5 7/65/25 775/7.25/ 6.5
Usability / Shortcut Keys (So 10)
Biometrics Login (Y / N) Y N N Y (face recog N N
software)
Wi-Fi / Bluetooth / TouchPad On/Off N/Y/Y Y/N/N N/N/N Y/N/N N/N/N Y/N/N
dedicated button (Y / N)
Peformance |
Synthetic Scores
PC Mark05 Overall 4953 4375 4019 5901 4593 6241
PC Mark05 CPU Score / Memory Score 5018 / 4274 4989 / 4113 4105 / 3674 5523 / 4473 5044 /4208 6002 /5146
PC Mark05 Graphics Score / HDD 3606 / 4926 1765 / 5423 2989 / 4448 7328 / 4687 2333 /5269 7448 / 5283
Si_&':il:::fg Sandra 2009 Pro Memory band- 4.67 GBps 4.27 GBps 4.44 GBps 4.7 GBps 4.57 GBps 5.14 GBps
wi
3D Mark 2006 (CPU Score / Overall Score) 1791/ 2226 1692 / 800 1209 / 2146 1972 / 6496 1699 / 939 4442 / 2077
Maxxon CineBench R10 CPU score 4084 4068 4093 4481 4086 4743
Display Mate Colour Accuracy (So 10) 6.5 5.5 6 6.25 4.75 7
Wi-Fi Performance Test 7.0 (in Mbps) 36 37 35 33 35 36
Real World Tests
Battery Life Test (in Minutes) 94 145 156 129 167 101
Webcamera / Speaker Quality (So 10) 6.5/5.5 5.25/ 4.25 55/6 6.25 /5.5 4/4 6.75/7.25
HD Movie Viewing (So 10) 6.75 4.25 6.75 5.5 4 7.75
Wi-Fi file transfer (in MBps) 5.26 5.26 3.45 3.85 5.26 5.00
DivX Encode 7.0 (sec) * 67.1 69.3 104.8 62.5 679 57.5
;.i‘egue)ntial / Assorted file transfer (in 19.06/ 19.89 19.88/17.65 21.41/ 20.11 15.17 / 14.67 21.62/21.28  25.25/23.80
S,
Do:m 3 (fps) 76.1 18.1 116.5 150.1 16.8 1373
* less is better
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IdeaPad Y650

Rs. 1,03,990

1year

Sleek, slim, feature rich

Overpriced

57.76
36.36
21.41

2.4 GHz

4GB/ DDR3 /1066
Intel PM45

GeForce GT 105M / 256

320 GB / SATA
Blu-ray Writer/DVD RW

Vista Home Premium

16 /1366 x 768

2.54 kg
2,0

Y/Y/Y
Y/N/Y
Y /Y/N

Y / SD, MMC, MS Pro, xD

Y/
NA
8.25/65/6

6/75/5
Y (face recog software)

Y/N/N

5549

6110 / 5170
3907 / 4684
5.59 GBps

2133/ 2463
4939

6.75

30

90
6.25/75
7

3.57

56.1

23.95/ 22.61

115.3

None in particular

54.40
37.66
16.73

Low power ultra compacts

Low performance
and ergonomics

44.16
29.25
14.91

Intel Core 2 Solo U3500 Intel Core 2 Solo

/1.4 GHz

2 GB/ DDR3 /800
Intel GS45

Intel GMA 4xxx / -

250 GB / SATA
N/A

Vista Home Premium

13.3 /1366 x 768

1.6 kg
3,0

Y/Y/Y
Y/N/Y
Y/Y/N

Y / SD, MMC, MS Pro, XD

N/N

8.25/6.5/8.25

8/8/6
N

Y/N/Y

2254

2457 / 3312
1039 / 5204
4.15 GBps

658 /599
1520

5

31

328
5.5/4.5

4

5.00

155.2
23.01/22.75

8.6

U3500 / 1.4 GHz
2GB/DDR2/ N/A

Intel GS45
Intel GMA 4xxx / -

320 GB / SATA
N/A

Vista Basic

14 /1366 x 768

1.5 kg
2,0
Y/Y/Y
Y/N/Y
Y/Y/N

Y / SD, MMC, MS
Pro, XD
N/N

475/525/6

5.75/5.75/3.5
N

N/N/N

2135

2443 / 3346
1156 / 4824
4.13 GBps

656 / 637
1516

4

37

286

3/45

4.75

1.85

155.1

29.07 / 20.69

9.8

Weak config

48.08
32.45
15.63

Core 2 Solo U3500 /
1.4 GHz

4 GB/ DDR2 / 800
Intel GS45
Intel GMA 4xxx / -

500 GB / SATA
N/A

Vista Home Premium

14 / 1366 x 768

1.39 kg
3,0

Y/Y/Y
N/N/Y
Y/Y/N

Y / SD, MMC, MS Pro, XD

N/N

6.75/6.5/7

7/55/45
N

N/N/N

2269
2441/ 3354
1043 / 5250
4.26 GBps

654 /631
1512

4.5

36

276

3.5/45

5

3.85

151.2

27.30 / 22.62

1.1

Tl faer Jus_ Jasus  Joel |
Aspire 3810T X400 ux3o Adamo
Rs. 31,999 Rs. 40,000 Rs. 56,000 Rs. 1,15,000
1year 2 years 2 years 1year
Very sleek, built well Lightweight Good looks, compact Sublime build quality

Expensive

43.53
28.67
14.86

Intel Core 2 Duo P8600 /

Intel Core 2 Duo
SU9300 / 1.2 GHz

2 GB/ DDR3/ 800

Intel GS45
Intel GMA 4xxx / -

128 GB / SATA (SSD)
N/A

Vista Home Premium
64-bit

13.4 /1366 x 768

2.49 kg
3,0
Y/N/Y
N/N/N
N/Y/N
N/ NA

N/N
Display Port
9.25/7/9.25

6/7/35
N

N/N/N

3725

3173/ 3376
1430 / 12735
4.22 GBps

1038 / 642
2501

4.25

30

131

25/3

2.5

5.26

103.8

42.22 / 3596

8.8

Ultra compacts

Studio XPS 1340 U6 Bamboo

Rs. 59,900 Rs. 98,990

1year 2 years

Very well built, powerful ~ Powerful and
compact

None in particular Bamboo?

58.48 58.43

37.66 40.25

20.82 18.19

Intel Core 2 Duo P8600/  Intel Core 2 Duo

2.4 GHz P8400 / 2.26 GHz
4 GB/ DDR3 /1066 4 GB/ DDR2 / 800
nvidia GeForce 9400M G Intel PM45

GeForce 9400M GT /256  GeForce 9300M GS
M

320 GB / SATA
DVD RW

320 GB / SATA
DVD RW

Vista Home Premium Vista Home Premium

13.3 /1280 x 800 12.1 /1280 x 800

2.2 kg 1.57 kg

2,1 3,0

Y/Y/Y Y/Y/Y

Y/N/Y Y/N/Y

Y/Y/N Y/Y

Y / SD, MMC, MS Pro, XD Y / SD, MMC, MS
Pro, XD

Y/N Y/Y

Display Port NA

8/8/8.25 6.5/6.5/5.75

7.75/7.25/ 6.5 75/6.5/ 675
N Y
Y/N/N Y/N/N

5856 5260

5795 / 4957 5784 / 4986
3562 / 5949 3188/ 4825
5.22 GBps 5.3 GBps
2158 / 2179 1897 /1800
4913 4656

6.5 6

39 37

108 110

6.75/ 6.25 3/45

4.5 3

5.00 4.76

53 61.1
27.41/23.36 21.68 /2092
68.5 66.6
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Corporate Notebooks

Model
Price
Warranty
Plus (+)

Minus (-)

Grand Totals (Out of 100)
Features (Out of 55)
Performance (Out of 45)

Specifications

Processor Model No / Processor Speed
(MHz2)

RAM / RAM Type / Memory Speed (MHz)
Platform Chipset

Graphics Solution / Dedicated Video
Memory

HDD Size / Type
Optical Drive Type

Bundled 0S

Screen Size / Resolution (Native, in
pixels)

Weight

No of Ports (USB / FireWire)
Connectivity: (LAN / Bluetooth / WiFi)
Video ports: D-Sub / DVI / HDMI (Y / N)
Audio Ports: (Mic / Line Out / S/PDIF)
Memory Card Reader / Cards Supported

E-SATA (Y / N) / RJ11 Port
Additonal Connects

Build Quality (Body / Keypad / Lid,
movables) (So 10)

Ergonomics

Keypad Tactile Feedback / Key Layout &
Usability / Shortcut Keys (So 10)

Biometrics Login (Y/N)

Wi-Fi / Bluetooth / TouchPad On/Off
dedicated button (Y/N)

Synthetic Scores

PC Marko05 Overall

PC Marko05 CPU Score / Memory Score
PC Mark05 Graphics Score / HDD score

SiSoft Sandra 2009 Pro Memory bhand-
width

3D Mark 2006 (CPU Score / Overall
Score)
Maxxon CineBench R10 CPU score

Display Mate Colour Accuracy (So 10)
Wi-Fi Performance Test 7.0 (in Mbps)
Real World Tests

Battery Life Test (in Minutes)
Webcamera / Speaker Quality (So 10)
HD Movie Viewing (So 10)

Wi-Fi file transfer (in MBps)

DivX Encode 7.0 (sec) *

Sequential / Assorted file transfer
(in MBps)

Doom 3 (fps)
* less is better

OCTOBER 2009

ProBook 4410S
Rs. 40,000

1year
High-quality build

lacks dedicated
graphics

53.40
38.13
15.27

Intel Core 2 Duo
T6570 / 2.1 GHz

3 GB/ DDR2 / 800
Intel GM45

Intel GMA 4xxx / -

320 GB / SATA
DVD RW

Vista Business

14-inches / 1366
X 768

2.27kg
4,0
Y/Y/Y
Y/N/Y
Y/Y/N

Y / SD, MMC, MS
Pro, XD

N/Y

7.75/75/775

7.25/7/5.75

N
Y/N/N

3770

5304 / 4147
1619 / 4333
4.5 GBps

1757 / 889

4192
4
36

120

4/35

3

3.70

67.3

22.22 /1992

13.3

Vaio VGN-SR46GD
Rs. 74,900

1year

Powerful CPU

None in particular

58.46
35.50
2296

Intel Core 2 Duo
P8700 / 2.53 GHz

4 GB/ DDR2 / 800
Intel PM45

Radeon HD 4570 /
512 MB

320 GB / SATA
DVD RW

Vista Business

13.3-inches / 1280
x 800

1.99 kg
2,1

Y/Y/Y
Y/N/Y
Y/Y/N

Y / SD, MMC, MS
Pro, xD

N/Y
NA
6/725/5.75

5.75/5.25/6

Y
Y/N/N

6637
6487 / 5316
6534 / 5726
5.25 GBps

2285 / 4170

5229
5.25

15

5/4.75

3.75

5.56

53.4

28.60/ 25.36

136

EliteBook 2530P
Rs. 99,000
1year

Compact

Overpriced

4778
34.47
13.31

Intel Core 2 Duo
SU9300 / 1.2 GHz

2 GB/ DDR2 / 800
Intel GS45

Intel GMA 4xxx / -

120 GB / SATA
DVD RW

Vista Business

Characteristics [ I A A

12.1-inches / 1280
X

1.39 kg
2,1

Y/Y/Y
Y/N/N
Y/Y/N

Y / SD, MMC, MS
Pro, XD

N/Y

7.25/7/ 675

75/7/575

Y
Y/N/N

ptomance | |

1961
1828 / 1805
1054 / 3935
2 GBps

649 / 446

1562
4

37 49 42
1 248 162

35/3

2.75

5.56

327.6
13.62/12.79

14.3

OCTOBER 2009

L [ - [ A

Vaio VGN-Z48GD
Rs. 1,49,900
1year

Excellent configura-
tion, ultra compact

Just the price

65.37
34.24
3113

Intel Core 2 Duo
P9700 / 2.8 GHz

6 GB / DDR3 /1066
Intel GM45

Intel GMA 4xxx and
GeForce 9300M / -

256 GB / SATA (SSD)
DVD RW

Vista Business
64-bit

13.1-inches / 1600
X 90

1.49 kg
2,1

Y/Y/Y
Y/N/Y
Y/Y/N

Y / SD, MMC, MS
Pro, XD

N/Y
NA
6/725/5.75

55/4/6

Y
Y/N/N

8749
6548 / 5196
3858 / 29275
5.65 GBps

2550 / 2286

6427
6

6/4.25

7

5.26

46.1

14733 /104.22

80.8

audience. Therefore the Sony
Vaio VGN Z48GD is also an
ultra compact notebook, but
that’s not how Sony positions it.
Therefore this category includes
a variety of laptops, some

with very difference intended
uses and characteristics with
only one thing in common —
they're easy to cart around. Of
course the trade-off is generally
performance but that’s not
always the case as some of the
jousters in this tourney proved.

Dell Adamo
Beauty is skin deep
Dell’s offering is suitably
upmarket in every visual
aspect — it’s built around onyx
coloured brushed aluminium
and the chassis is rigid — sublime
build quality. There’s nothing
suave about it — the Adamo is a
blatant style statement — from
its ultra thin lid to the beautifully
crafted floating keypad with soft
backlighting that illuminates
automatically when you touch
a key. The lid mechanism is
superb. The key feedback is
soft and the keys large and very
comfortable with a slight indent
in the centre for your fingers —a
finger-sofa anyone? The trackpad
is also responsive. On a negative
note the display isn’t that bright
and colours seem slightly dull.
Its innards aren’t as impressive
although the Adamo is quite
visibly geared as a Macbook Air
competitor. It also has an SSD
drive, similar to the Macbook Air.
Battery life was shockingly
poor though at just 131 minutes,
the Macbook Air does much
better. In terms of performance
the Adamo is the proverbial
tortoise. So it’s sexy as hell...but
so is Paris Hilton. And this is
probably something she would
buy - at Rs. 1,15,000 the Adamo
is for those who want to make
style statements, and little else.
For most of us who prefer to
settle down with the girl next
door rather than the flighty
neighbourhood belle, the Adamo
proves too sinful an extravagance
to indulge. Oh! for the life of a

playboy.
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IE 8 = longer battery life?
A recent test shows that Internet Explorer 8
provides more laptop battery time than Firefox,

ARM processors scales 2 GHz
ARMs Cortex A-9 scales to 2 GHz, meaning
we could well be seeing them in the desktop

Laptop test

Chrome, and other browsers processor sphere
Dell Studio XPS 1340 performance. It’s also portable at first use. The 14-inch display is
Guts n Glory enough to be lugged around also pretty mediocre, despite the
The Studio XPS 1340 goes anywhere and it’s easy on the LED-backlighting, One plus is
the way of its larger sibling eye — the proverbial icing on the enormous hard drive — ASUS
complete with leather accents the cake. ASUS U6 thought it prudent to load the

on the bottom of the lid. It’s
distinctly upmarket looking
and feels very solid while
retaining a semblance of
compactness. The top bezel
is rather wide and although it
integrates a webcamera. The lid
mechanism is really sturdy. The
glossy black has a translucent
look to it and in places it is
where embedded LEDs indicate
touch buttons just above the
keypad. The keypad itself is
well laid out with large keys
and although not segregated in
the truest sense the edges of the
keys are slightly lower creating
the impression of a gap. The
keys are comfortable to type on
and feedback is signature Dell -
slightly soft and on the mushy
side, but key travel is good and
overall usable. People liking
the firm feedback on the Acer
notebooks will be disappointed
but it’s just a different design
nothing good or bad about it.
The trackpad is responsive but
not as exact as we’d like and its
small size is no help. In fact the
trackpad is a grouse because
after an hour of use one begins
to miss a USB mouse — a sure
sign of a less than perfect
trackpad. Trackpad buttons
are good — mushy with good
key travel and comfortable — a
relief from clicky-clacky mouse
buttons.

In terms of performance
the XPS 1340 has got what it
takes to trail with the best. The
GPU isn't particularly powerful
but it’s more than sufficient
for even casual gamers. Priced
at Rs. 59,900 (configuration
dependent of course) the
Studio XPS 1340 is a great mix
of style and

OCTOBER 2009

ASUS U6 Bamboo
When wood is good
ASUS’ U6 series represent their
efforts at extreme portability
with good performance. The
Bamboo is a special edition
notebook livered in (you
guessed it!) Bamboo. The lid is
covered in the wood as is the
palmrest and the trackpad. The
rest of the notebook is grey/
silver and looks quite exclusive
as a result. The keys are spaced
out but not segregated, similar
to the design used on the
previous generation of Dell
notebooks like the XPS M1330.
Keypad feedback and usability
is good and the U6 has a pretty
responsive trackpad although
its texture is not good as it
tends to grip your finger pad
owing to the varnished surface.
The right side of the keypad
feels a little cramped with tiny
Enter and Shift keys. Like the
Vaio Z48GD the mode switch
toggles between integrated Intel
graphics and a GeForce 9300M.
The U6 Bamboo is priced at
Rs. 98,990, and this includes a
two-year, worldwide warranty
from ASUS. We reckon this
is Rs. 15,000 more than we’'d
like for something with this
configuration although to
be honest there’s a lot of
uniqueness to the look.

Acer Aspire 3810T

A sweet deal

The 3810T looks decidedly
upmarket with its slim profile
and brushed aluminium lid.
Since it’s smaller than the
5810T it looks thicker, but the
thickness of both notebooks
is the same. It feels extremely
well built in hand and the body
is clearly well constructed.
The lid closes with a definitive
snap. The long power button
with embedded LED is stylish,
so is the silver/grey body. The
keypad is really sweet with
great spacing, very nice key
feedback — ultra usable

and very comfortable,

the keypad just

feels right.

The screen

resolution is just right for a
13.3-inch display — 1366 x 768
pixels. Brightness levels are
good but the colour quality is
very ordinary. The touch based
keys atop the keypad work
well and we like the minimalist
styling. The battery indicator is
located on the front, just below
the trackpad and its bright
orange LED is distinctly visible
but not obtrusive.

Performance wise there’s not
much grunt under the hood
so we didn’t expect much,
but this notebook isn’t about
performance. It’s about style,
portability and usability and
it meets these parameters in
spades. Quite frankly a price tag
of Rs. 31,999 is pretty amazing
— if you're looking for value
for money — you've got it! Our
only grouse is Acer overlooked
an optical drive — a shame
because this would be a killer
product with one. Sans that
however, it still manages to bag
our Best Buy award and we feel
it's well deserved. Should you
want something good enough
for most mundane tasks that
is also compact buying this is a
no-brainer. The battery life is an
amazing 328 minutes.

ASUS UX30
Lots of show, little go
ASUS UX30 s their compact, low
power offering, It's innards are
similar to the Aspire 3810T.It's a
lot flashier looking however, with
apiano black finish reminiscent
of some LCD HDTVs. It also
borrows the idea of enclosing
connectors with a small slider door
from the Macbook Air. The lid is
brushed aluminium and so is the
palmrest. ASUS chose to use the
same trackpads that the K40IJ
and K500 use —ugh! The
keypad has good
feedback but
usability is not as
good owing toa
mediocre layout that
doesn’t feel intuitive

UX30 with 500 GB worth of
storage. It’'s price was a little over the
top at Rs. 56,000 and we cannot see
anyone spending this much. Not
when the Aspire 3810T gives more
for less. If we were up to blowing
close to 60 grand on a notebook
we’'d figure the Dell Studio XPS
1340 would get anod over this in
anyone’s books.

MSI X400

When ignorance is bliss
MSI also joins the bandwagon
of people offering compact
notebooks based on Intel’'s U
series of Core Solo processors. In
general the effort

is proportionate

to the applause

and we're not

cheering much.

The X400 is

MSI X400
compact,
butit’s not well
built. The body feels like
cheap plastic and the notebooks
exterior was a let down. Inside
the textured palmrest also feels
cheap - really this is unforgivable
and we're trying to see
something good. The keypad is
also tacky, added to this the keys
aren’t well laid out. Key spacing
feels slightly off owing to the
large keys and this is not intuitive
to most peoples’ fingers, who will
be used to closer key alignments.
There’s nothing much to write

ASUS UX30

home about here and about all
that we can say that the MSI
X400 is a first effort, and better
things are sure to come out of
the mistakes made this round. At
Rs. 40,000 its one notebook you
can easily afford to missEl

Dell Studio XPS 1340

Acer Aspire 3810T
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Digital Camera Test

Corel's new Digital
Studio 2010 is touch
input enabled

Microsoft's LifeCam
Cinema is the only
wehcam to offera
widescreen 720p HD
video capture

Sho

Stars

It's getting more and more difficul

tto

impress customers. It's time to see if
this latest generation of cameras can...

oting

Rossi Fernandes
rossi.fernandes@thinkdigit.com

s competition between companies builds in times like this
where the economy is slow, and demands have already been
met by existing cameras, there’s little left that can grab the
ttention of the customer. There’s almost no one who hasn’t
bought a camera. Those who've bought point and shoots are looking
at more expensive digital SLRs. What else could point and shoot
cameras offer?
We've seen a few instances where manufacturers are already
trying to reduce the megapixel count. Obviously, with fixed
sensor sizes, there's little in terms of improvement and the higher-
megapixel-is-better-quality myth seems to have burst.
This month, we have cameras that go across categories and this
being the festive season, there's going to be something in here that
fits your budget and your needs.
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Hitachi reveals high-definition
camcorder that records videos
in Blu-ray

Fujifilm's FinePix Real 3D W1
is a dual-lens camera that
captures footage in 3D
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Canon PowerShot SX120 IS

The Canon Powershot SX120 IS is the latest version of the
PowerShot SX series which has been crowned as one of the best
point and shoot ultrazoom cameras around. This SX120 IS is
only a small upgrade over the SX110 IS that had a few issues. It's
predecessor, the SX100 IS was poorly built, that much has been
addressed in the last two models.

Alot of the features from the previous models are present in
this SX120 IS model. If you look at the specifications comparison
between the SX110 IS and the SX120 IS, there's very little that has
changed. For example, this is now a I0MP camera instead of a
9MP one. The amount of digital zoom has been increased but as a
feature it's pretty useless. Build quality is identical. The flash has to
be manually raised unlike some other cameras where the flash pops

out automatically depending on the settings and ambient conditions.

The body is almost totally plastic so even though this might seem
like a prosumer device, it's not. However, it's still better built than
most other cameras. A rubberised handgrip would've been a nice
touch.

The screen is large, though it's performance is average. It works
well outdoors but in darker areas, there's a bit of lag. Being a point-
and-shoot camera, there isn't an eyepiece to look through.

One of the features many manufacturers are adding to their
cameras is the face recognition. The SX120 uses it a lot. Along with
the usual timer functions, the SX120 has a face-timer function which
automatically first uses a timer and then clicks a photo when you
point the camera at a face. It's particularly useful for a self portrait.

Canon PowerShot SX120 IS

The intensity setting for the flash has also been available on
Canon cameras for awhile now and is useful as it integrates well with
the rest of the camera settings that are already present and used.

Canon Digital IXUS 110IS

Canon's Digital IXUS series is designed keeping in mind the kind
of user. These are more stylish models meant for those who want
a compact camera that is pocketable. The IXUS 110ISisa 12.1 MP
camera with a 4x optical zoom. The front of the camera is made
of metal and the finish is satiny — pretty classy stuff. The rest of
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Adobe releases Photoshop
Lightroom 2.5 and Camera
Raw 5.5

Nikon's hybrid projector-camera
combo starts selling

the camera isn't so special.
The 2.8-inch LCD screen is
a widescreen because of the
dimensions of the camera.

The controls at the back of
the camera have no icons or
markings except for the menu
and function buttons.

One of the killer features of
this tiny camera is the 720p
video recording capability.
Video quality is rather
impressive even in low-light
scenarios — a serious plus

Controls and the mode
selection is done using a slider
on the top of the camera. We
feel the current interface Canon
cameras use is better than
earlier versions. There's a lot
of animations and transition
effects being used in the
interface while moving from
one menu to another.

It's a camera that doesn't
have too many advanced
controls that a serious
photographer would want. This
isn't a camera aimed at such
users. You're better off with the

Canon Digital IXUS 1101S

PowerShot A or SX series of
cameras for that. Still, it would
be nice to have a few more
metal bits around the controls
and also a nicer screen. There's
also a HDMI connector so you
can connect your camera to the
TV easily.

There's one slight problem
with the metal body. It
conducts heats so you can
easily feel the heat around the
right side of the camera. This
gets irritating within minutes
of using the camera. The
other issue we find is with the
position of the flash. There's
a small slit for the flash and if
you use your left hand fingers
to hold the camera as well, it's
likely that you'll cover the flash.

Canon Digital IXUS
951S

The Canon Digital IXUS 95 IS
has a blockier design than the
pricier IXUS 110 IS. The IXUS
95 IS is almost half the price of
the IXUS 110 IS as mentioned
on Canon's site. The IXUS 95

Canon Digital IXUS 95 IS

IS comes in attractive colours.
We received a bright orange
model that, to some, looked
nice while others found it too
gaudy for a digital camera.
The finish on the body isn't as
exotic as the IXUS 110 IS.

There are a few differences
and at first, it seems like the
IXUS 110 IS is overpriced. The
interface looks a little dated
but the buttons have a nicer
feel than the IXUS 110 IS. The
SX 120 IS is a superior camera
in terms of performance
and features didn't have an
eyepiece, which this model
incorporates.

The small nifty features
like the face timer are still
present on this camera. As a
point and shoot camera, it's
very simple to use. It doesn't
have many of the features that
are expected but once again,
the IXUS series of processors
follows a different path. Canon
hasn't taken out the essentials

such as the image stabilization
features. This is a decent
camera and is probably one

of the cheapest options if you
want a really compact camera.
It's sturdy as well but just lacks
alot of features.

Canon Digital IXUs
100I1S
The IXUS 100IS at first use feels
and looks like a nicer camera
than even the IXUS 110IS. The
body shape is curved on the
edges which gives it a slightly
more compact look and it feels
better in hand at the same time.
The HDMI and USB
connectors aren't on the side
or the bottom like on many
other cameras. Instead, the
connectors have been put on
the back of the camera where
the zoom buttons would
usually be on some cameras.
The zoom is controlled by the a
trigger-style control. The mode
selection is done using a slider

H OV W E T E'S T E D s

he most importance
was given to the test
scene. A test scene
comprised of several
objects of different
colours with lots of detailed
designs and patterns on it
were setup on a table. Every
camera was tested mounted
on a tripod to ensure there
was no movement by the
person testing. The cameras
were shot using the 'Auto’
shooting mode as this is what
most users would typically
use.
The room was darkened
with the windows blinded
and all the tubelights in the

room turned off to ensure
that only the lights used for
the test setup were utilized.
There were two sets of colour
neutral lights used from either
side to illuminate the test
scene. Colour neutral lights
emit light without any kind of
tint. This ensured no bias or
mistakes during the evaluation
phase. Multiple photographs
were taken using the test
scene. There were shots

with the cameras completely
zoomed out and then fully
zoomed into the center of

the scene. The quality of

the photograph on a bad

lens deteriorates when the

maximum zoom is operated.
The same wideangle test
photograph was shot with
the flash on. This was to look
for what adverse effects a
flash would do. Every camera
comes with a different type of
lens. Some of these are better
than the others for different
kinds of photography. A good
lens on a point-and-shoot
should be able to click close-
up photos of objects, so we
used the macro mode to try
and get as close to the object
as possible and still focus. A
video was also shot under this
test scene lighting. All the test
shots were closely examined

and the set areas in each
photograph were rated.

Other than the test scene,
the cameras were used
under everyday conditions —
outdoors and indoors where
light wasn't always constant
and bright. While doing
this, all kinds of settings
and modes were selected.
Similarly, videos were also
recorded. Some amount of the
test weights were given to the
ease of use and the overall
build quality of the camera.
The quality of the screen, the
battery doors and buttons all
matter, so all these were given
scores as well.
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Pentax announces the K-x
prosumer-level dSLR camera
at approximately Rs. 31,000

Samsung releases a 5 MP
system-on-chip image sensor
for high-end mobiles
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Canon Digital IXUS 1001S

mechanism at the back which
is designed rather well. The
buttons are top notch quality
and it's a really good camera.

In features, the IXUS 110 IS
is very similar to the 100IS. The
only difference between the two
cameras is in the optical zoom
lens.

Canon PowerShot
A480

Canon’s cheapest offerings

are the A4xx series and we've
tested these cameras in the last
couple of years and it must be
said — we're impressed. This
line follows the long biscuit-
package design for a slightly

more compact and better
looking design. The A480
continues with the design. We
don’t like the control buttons
on the back of the camera.
They are simply plastic buttons
etched which gives it a really
cheap look and feel.

The camera uses two AA
batteries and the USB data
connectors lie on the side
behind a rubber door. The
other thing you notice is the
smaller screen. The resolution
doesn’t look like a lot but its
good enough for the casual
user. The user interface is
quick to react and there’s not
a lot of waiting between shots.

Canon PowerShot A480

Canon PowerShot A1100 IS

However, occasionally you see
a 'charging the flash' alert when
the batteries discharge a little.

The top of the camera has
space for your finger to rest
on the shutter release button.
It makes the camera very
comfortable to hold on to even
without a handgrip.

Manual ISO selection is
present. The interface from
older but higher-end Canon
cameras can be seen on the
A480. Overall, this is a good
camera even though we really
would like better quality in the
build of the camera.

Canon PowerShot
A1100 IS

The Canon PowerShot
A1100ISisa 12.1 MP camera
with a 4x optical zoom. The
AA batteries make the camera
a little bulky but at the same
time easier to hold. The
buttons at the back aren’t

so great in terms of feel and
quality. They are bigger than
some of the other cameras
we’ve tested. The interface is
similar to that on the A480
and both models share quite a
few features. The A480 has no
mode selection and users have

to depend on buttons and
menus to switch to them. The
A1100 IS is much simpler in
that aspect.

The A1100 IS comes with
image stabilization and that
is very helpful when you're
taking photos with zoom
or with low-light where the
shutter speed has to be slow.

Fujifilm Finepix
$1500

While all of the photography
world might be focussed on
Sony, Canon and Panasonic
for their ultrazoom camera,
Fujifilm continues to work on
their point-and-shoot camera
business. The S1500 is a

12x optical zoom ultrazoom
camera.

The interface looks really
outdated and uninspired. It's
nowhere as neat as the Canon
and Sony user interfaces.
Fujifilm also needs to improve
on the processing power
of this camera. It lacks the
processing power and it shows
while viewing one photo after
another. There's a considerable
processing time even while
deleting. While clicking a
photograph, you will notice a
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Camera facts
A camera is a lightproof box, usually fitted with a
lens that gathers incoming light and concentrates it

Aperture
The opening that determines the cone
angle and the amount of light that

Digital Camera Test

enters a camera to be directed towards the film or imaging device
OCTOBER 2009
Digital Cameras Test
Brand Canon Canon Canon Canon Canon Canon Canon
Model Digital IXUS Digital IXUS Digital IXUS PowerShot PowerShot PowerShot PowerShot
100 1S 1101S 95 1S A1100 1S A480 SX120 IS SX200 IS

Price Rs. 13,995 Rs. 18,995 Rs. 10,995 Rs. 9,995 Rs. 7995 Rs. 15,995 Rs. 22,995
Overall (Out of 100) 64.98 64.37 60.11 58.54 53.17 60.17 66.49
Features (Out of 40) 29.28 29.42 25.46 24.64 20.02 26.12 30.04
Performance (Out of 60) 35.70 34.95 34.65 33.90 33.15 34.05 36.45
Specifications

Sensor resolution (Megapixels) |12.1 12.1 10 12.1 10 10 12.1

Sensor size (in inches) 1/2.3 1/2.3 1/2.3 1/2.3 1/2.3 1/2.5 1/2.3

Sensor type ccb Cccb Cccb (o(e) Cccb ccb (o)

IS0 sensor sensitivity range 80 - 1600 80 - 1600 80 - 1600 80-1600 80 - 1600 80 - 1600 80-1600

Shutter speed range (sec) 15 - 1/1500 15 - 1/1600 15 - 1/1500 15 -1/1600 15 -1/2000 15 - 1/2500 15 - 1/3200

Burst speed 0.8 fps 0.8 fps 1.4 fps 1.1fps 0.8 fps 1.3 fps 0.8 fps

Aperture size range (F number) | 3.2 - 5.8 2.8-5.8 2.8-49 27-5.6 3-5.8 2.8-4.3 34-53

Lens optical zoom 3x 4x 3x 4x 3.3x 10x 12x

Lens (mm) 59 -179 mm 5.0-20.0mm |6.2-18.6 mm |6.2-24.8 mm 6.6 - 21.6 mm 6.0 - 60.0 mm | 5.0 - 60.0 mm

Image stabilization Yes Yes Yes Yes No Yes Yes

HDMI Yes Yes No No No No Yes

Face detection Yes Yes Yes Yes Yes Yes Yes

Best video resolution 1280 x 720 1280 x 720 640 x 480 640 x 480 640 x 480 640 x 480 1280 x 720

Frame rate 30 30 30 30 30 30 30

Display

LCD size (in inches) 2.5 2.8 2.5 2.5 2.5 3.0 3.0

LCD Resolution (pixels) 2,30,000 2,30,000 2,30,000 1,15,000 1,15,000 2,30,000 2,30,000

Battery Type Li-ion Li-ion Li-ion 2X AA 2X AA 2X AA Li-ion

Memory cards supported SD, SDHC, MMC | SD, SDHC, MMC | SD, SDHC, MMC | SD, SDHC, MMC | SD, SDHC, MMC | SD, SDHC, MMC | SD, SDHC, MMC

Dimensions (in mm) 87.0x54.5x 979 x 54.1 x 88.5 x 54.8 x 95.4 x 62.4 X 92.1x 62.0 x 110.6 x 70.4 x | 103.0 x 60.5 x 37.6

18.4 22.1 21.8 31.0 311 447

Weight (in grams) 115 145 120 155 140 245 220
Design and quality (Out of 10)

Ease of use 5.5 6.5 5.5 5.5 5.5 6.5 6.5

Button quality 7 5 7 4.5 3.5 5 5

Screen quality 5 5 5 5 5 5.5 5.5

Flash/lens covers 5.5 5.5 5 5.5 5.5 5.5 6

Quality of body 7.5 6.5 7 6 55 6 7

Battery door quality 6.5 6 6 6.5 6.5 6 7
Performance (Out of 10)

Light scene (Wideangle) 5.63 5.38 6.13 6.13 5.88 5.75 5.75

Light scene (Telephoto) 5.5 5.5 5.25 5.25 5 6 5.75

Macro scene 5.75 5.75 5.75 5.5 5.75 6 6.25

Light scene (Wideangle) 7 7 55 5 5 5 7
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usB 3.0 camera Picasa now face friendly Digital Camera Test

The first the world has seen, Version 3.5 will feature face recognition

unveiled by Point Grey can belt not only on web albums, but also on photos

out video in 1080p at 60 fps! stored on a hard drive
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Fujifilm Fujifilm Fujifilm Fujifilm Nikon Nikon Nikon Samsung
Finepix A170 FinePix F200EXR | FinePix J27 Finepix S1500 Coolpix L20 Coolpix P90 Coolpix S220 ES55
Rs. 6,999 Rs. 20,999 Rs. 7,999 Rs. 14,999 Rs. 7,950 Rs. 25,950 Rs. 8,950 Rs. 8,990
54.83 55.87 54.29 55.71 53.90 59.36 53.33 60.92
24.68 26.32 24.74 25.71 22.40 27.86 24.98 25.22
30.15 29.55 29.55 30.00 31.50 315 28.35 35.7
10.2 12 10.2 10 10 12.1 10.3 10.2
1/2.3 1/1.6 1/2.3 1/2.3 1/2.3 1/2.3 1/2.3 1/2.3
Cccb Cccb CccD CccD Cccb CccD CccD CccD
100 - 1600 100 - 3200 100 - 3200 64 -1600 64 - 1600 64 -1600 80 - 2000 80 - 1600
8 -1/1400 8-1/1500 8 -1/1400 8-1/2000 N/A N/A N/A 4 -1/1500
1.4 fps 1.4 fps 1.4 fps 1.4 fps NA NA NA 1.8 fps
29-10 33-14 29-16 2.8-64 3.1-6.7 2.8-5 3.1-59 3.2-5.8
3x 5x 3x 12x 3.6x 24x 3x 3x
5.7 -17.1mm 28 - 140mm 5.7 -171 mm 5.9 -70.8mm 38 -136 mm N/A 26 - 624 mm 35-105 mm
Yes Yes Yes NA No Yes Yes Yes
No No No No No No No No
Yes Yes Yes Yes Yes Yes Yes Yes
640 x 480 640 x 480 640 x 480 640 x 480 640 x 480 640 x 480 640 x 480 640x480
30 30 30 30 N/A N/A N/A 30
2.7 3.0 2.7 2.7 3 3 2.5 2.5
2,30,000 2,30,000 2,30,000 2,30,000 2,30,000 2,30,000 1,50,000 2,30,000
2x AA Li-ion Li-ion 4x AA 2x AA Li-ion Li-ion Li-ion
SD/SDHC SD/SDHC SD/SDHC SD/SDHC SD SD/SDHC SD SD/SDHC
93.0x 60.0 x 219 |97.7x589 x23.4 92.0 X 55.9 x 20.0 | 102.5x 73.0 x 67.8 | 96.5 x 61 x 29 114 x 83 x 99 89.5x55.5x18 |90.4x59.0x21.6
120 175 113 324 135 460 100 116
5 5 5 5 5 5.5 6
4.5 5 4.5 6.5 5.5 5.5 6 4
5.5 55 55 6 55 7 5) 7
515 4 5.5 6 5 5.5 5 6
6 7 6 8 6 6.5 75 6.5
515 515 5 7 7 8 55 6
5.25 4.5 5.25 5 5.38 5.25 4.88 6.38
4.5 6 4.25 5) 5.25 55 4.25 5.75
5 5.25 5.5 5.5 5.75 5.5 4.75 5.25
5 4.5 4.5 4.5 4.5 5 5 6
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Samsung's HZ25W ultra

zoom camera includes a
24x optical zoom lens

Samsung's newly announced L77 claims
to be the world's thinnest camera with
a 7-MP sensor and 7x zoom

considerably large delay there
as well. Surprisingly, the startup
waiting time is almost non-
existent.

The LCD display's quality
isn't so great either. The
eyepiece which also is a display
in almost all camera is really
laggy with poor refresh rates.
Quality also is bad. The image
stabilisation isn't very effective.
With the lens zoomed in,
there's still a lot of movement
and it seems the camera
corrects at the last moment
when you press down the click.

Coming back to the interface
and the usability, the menus
although not pretty,
could have been
designed a little
better. For example,
the ISO settings
aren't available in
the main menu
but accessible
using a
separate
button.

This button

also allows

you to change

the resolution and

image quality settings. The

1SO settings should have been
present in the main interface
along with the shutter speed
and aperture size settings. The
lack of the jog dial means you're
forced to press many more
buttons and browse through
many more menus for simple
tasks. On the other hand, it

has control buttons which are
wasted. There are two buttons
for the face detection and image
stabilization options which in
our opinion aren't absolutely
necessary as dedicated buttons.

In terms of the build quality,
it's actually quite good. The
buttons at the back might be
of average quality but the dial
for the mode selection is nice
and feels like one on a dSLR.
The body and the handgrip
has the rough textured feel like
SLR cameras. There's a sturdy
little slider for the power on
switch and the zoom trigger
also is designed and built well.
The camera is really tiny but
it weighs quite a bit with the
four tightly fitting AA batteries.
A slightly larger camera would
feel comfortable in-hand.

The panorama feature is a
neat feature that works well. It's
simple to use but the processing
time is quite a bit. A good feature
of Fujifilm cameras is the ability
to zoom in and out of images
smoothly whereas many other
cameras have intermediate steps
in between.

Fujifilm Finepix J27
The Fujifilm Finepix J27 is a
compact little point and shoot
camera that looks like it was
made to fit into pockets. The
size means that there's only
space for a miniature 3x optical
zoom to fit into the camera. The
controls

Fujifilm Finepix J27

buttons on the back and

the body itself are made of
plastic. It has a really smooth
finish which isn't always a nice
thing, as it makes the camera
slightly slippery to hold.

The screen is extremely
laggy with or without enough
light for the camera to focus
on. The interface is a little more
attractive than the S1500 which
we found rather appalling. Still,
there's a long way to go before
the interface becomes more

Fujifilm Finepix A170

friendly like on a Sony or a

Canon camera. The panorama

feature exists in this particular
camera as well.

The tiny USB
connector is left open
without any protection
lid or flap. Over time,
this might get clogged
with dust. There are very
few buttons at the back
of the camera. All the
options and shooting
modes can be selected by

going to the main menu.
The buttons are tiny
in comparison to other
cameras and feel cheap.
There are small display LEDs
at the back of the camera that
show the status.

The flash is located near the
centre of the camera so there's
little chance that your finger
will cover the flash. This is a
problem faced with many ultra-
compact cameras.

Fujifilm Finepix A170
Fujifilm Finepix A170is a
plastic body camera with
controls very much like the

other Fujifilm cameras. The
buttons are tiny and the zoom
is controlled by buttons instead
of a trigger-like control. The
problem is that holding the
camera is a little more difficult
with the zoom at the back. The
camera has a glossy finish but
that doesn't help because the
shape of the body itself is very
plain and simple.

The interface is also dull
and boring. All the shooting
modes have to be accessed
using the buttons instead of a
dial that could've been easily be
designed on top of the camera.
The USB connector is placed on
the side of the camera and has
no protection flap to stop dirt
from getting into the connector.
Macro performance isn't
impressive either and focussing
takes a long time as well.

Sony Cyber-shot DSC-
HX1y y

Sony's Cyber-shot DSC-HX1 is
an ultrazoom camera. The HX1
comes with a phenomenal 20x
optical zoom — a godsend for
those who need a long zoom.
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Sandisk Extreme Pro
Sandisk's new Extreme Pro CF
cards store up to 64 GB of data
and write at a speed of 90 MBps

Sony HDR-TG1

Sony's HDR-TG1 is the world's smallest full

HD camcorder

Digital Camera Test

Typically, people who want to
do wildlife photography. Built
rather well, use of metal zoom
trigger would be nice.

It has inherited most of the
features from the standard H
series from Sony. The camera has
a hinge screen that works well
but only for vertical movement.
There is no swivel to fold the
screen back on its face.

The recording supports
stereo audio recording and the
microphone is placed on the
top of the camera. The jog dial
is a feature found on dSLRs
but its also found on
ultrazoom cameras.

It can be used for
manual control as

The Sony DSC-HX1 is priced
at Rs. 29,990 and because, it
had to be sent back urgently to
Sony, it couldn't be part of the
complete test process.

Canon PowerShot
SX200 1S
Canon's PowerShot SX1xx IS
cameras impressed everyone
and we've also looked at the
SX120 IS in this test. The
camera is pretty good with just
a few tiny improvements over
the last two models. The SX200
IS is a better design than the
SX120 and features a 12x
optical zoom — pretty neat
for it's size.

OCTOBER 2009

well. The jog dial
also doubles as a
button. All these
functions bundled
together for use
with these controls
make it simpler
even in the
manual shooting
mode.
The 20x optical
zoom requires a
very good image
stabilizing feature
and the DSC HX1
does a decent job. It works
particularly well up to 8x to
10x but any more than that
and there's a lot of delay added
which makes even pointing to a
distant object a little difficult.
Sony includes a couple
of unique features that merit
mention. For example, the
smile and face detection feature
can shoot photos depending
on the intensity of the smile.
There's actually a manual
setting you can turn on for that.
The other impressive feature
is the video recording resolution
of 1440 x 1080 pixels. Video
quality is decent but not very
nice in low-light. Other than
that, the Sony proprietary
connector to the camera is
something that's very irritating.
A microUSB interface would've
been convenient. An adapter
is provided to allow HDMI
connectivity. Sony continues
to use MemoryStick as the
storage format. They're a little
more expensive than the more
commonly used SD and SDHC
cards.

Canon PowerShot SX200 IS

One end of the body has a
slight curve, this is where you
grip the camera and gives the
mock impression of a wider
grip. It also feels bulkier for
some reason and sturdier than
the SX120. The control dial at
the back could've been built
better. The other buttons have a
good tactile feel.

The side door is huge
and has the USB and HDMI
connectors there. The door
itself is held together by a
frail and flexible plastic hinge.
One of the unique and also
somewhat irritating features is
the flash unit which pops out
the same time the lens does. It
sticks out the top of the camera
by a folding hinge mechanism
and does come in the way while
holding the camera with your
left hand. There is no way to
fold the flash unit back in other
than to turn off the camera.
One of the sides has a chrome-
finish and that goes well with

the colour and shape of the

camera.

Nikon COOLPIX
P90

The Nikon
COOLPIX P90 is a
prosumer camera
or alternatively can
also be called an
ultrazoom camera.
The P90 has the
largest zoom
we've seen so
far — 24X optical
zoom (4.0 -
110.4mm). Like the
Fujifilm Finepix S1500,
this too has a good handgrip.
The buttons are all of very good
quality.

The screen hinge design is
very similar to the Sony DSC-
HX1 and only allows vertical
movement. The user interface
looks very similar to the ones
found on Nikon dSLRs. It is
very functional and lacks the

Nikon COOLPIX P90

over-user-friendliness seen on
cameras of some other brands.
The zoom trigger brings up

a help menu when you use it
in any of the camera settings
menus. Lithium-ion batteries
are used so most of the weight
is the camera itself. The jogdial
is built well just like on Nikon’s
dSLR cameras. Itisn’t used to
control the manual focussing
though.

One of the unique features
we’ve seen is the ISO sensitivity
range which can be capped.
The camera then will not cross
that limit so you never end
up with very grainy images.
Video recording resolution is
rather basic on the P90 whereas
most of the ultrazoom cameras
are aiming at the basic HD
standard — 720p.

There are some modes
where custom user settings can
be stored. There are also modes
which change the aspect ratio
of the image to fit TV screens.

Operation of the huge
zoom is silent although there
is some fine vibration. Image
stabilization at maximum
zoom isn’t too bad either. It’s
very usable but a better quality
lens would’ve really made this
shine. At maximum zoom,
there’s some quality loss.
There’s a little bit of yellow
colouration on the screen after
the photo has been captured.
On a computer screen though,
the result looks natural. The
colours are sober and there is
no overemphasis of colours.

There’s little to hate about
the Nikon P90. It’s a great
overall camera that now
moves Nikon closer to the
ultrazoom camera market at
least in India. So far, it’s been
Canon and Sony that have
mostly dominated this area.
Alittle more of quality and

performance and this camera
could’ve been a winner.

Nikon COOLPIX
$220
The Nikon P90 might
have one of the largest
optical zooms but
the S220 is one of the
smallest cameras around.
It comes in really bright
colours — we got a dark pink
one. It only has 3x optical
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Sony's limited edition digital
photo frame is made with
Swarovski Elements

The US Army is now soliciting proposals
for a 2.3-GP camera that would be used for

wide aerial surveillance

zoom but a huge 10 MP
resolution.

The screen isn’t very
impressive because of its
poor viewing angles. Visuals
immediately turn when you
move the camera from side to
side. The buttons have been
shrunk as well which is fine.
There is little space aside
from the screen that takes up
most of the area at the back.
Using and holding the camera
while shooting is difficult but
carrying is really easy as it fits
into any space that can hold
a mobile phone. It’s the same
case while going through the
menus. IU’s easy to press the
adjoining buttons. Because of
the space constraints, the USB
port has been moved to the
bottom of the camera which
also means that if you were to
use the camera on a tripod,
you have to remove it every
single time to transfer data to
the PC.

The battery door is a little
delicate and the battery size
has been shrunk down as
well. It's a 740mAh battery.

Nikon hasn’t had enough
space to place a mode
selection dial so all the menus
and options have been put
into a single shooting button
on the camera. The menus
from there on are like on a
mobile phone.

The user interface is a
slightly more user friendly
version of the one in Nikon
dSLRs.

Nikon COOLPIX L20
Nikon’s L series of cameras
are an entry-level range but
the latest L20 model seems
to have got a major facelift.
The details of the design are

similar to the L18 and L19 but

the slick and glossy paintjob
has done wonders. The

Nikon COOLPIX S220

Nikon COOLPIX L20

rest of the camera should’ve
received a similar upgrade.
The directional buttons and
especially the zoom controls
have a bad feel to them.

The back of the camera
has a slight depression to rest
your finger right below the
lens operation button.

Controls on the camera are
really basic with absolutely
no control over the aperture
size and shutter speed. The
interface and mode selection
is almost identical to the S220
model. There is no mode
selection knob on the camera.
One of the most annoying

things is that you have to press

the Scene button after you've

previewed an image. Most
cameras get you back to the
shooting mode when you press
down on the shutter button.

The camera is pretty fast in
its interface but not as much
while shooting.

Fujifilm FINEPIX
F200EXR

The Fujifilm FINEPIX
F200EXR is a much better
camera in hand than some

of the other cheaper models.
It’s built well and is a heavy
camera for its size. The
control buttons are a little tiny
and a little too flat.

The 5x zoom lens in such
a compact design makes
good sense for everyone. It's
a big step up from the 3x
optical zooms on many entry
level compact cameras. The
extended lens is twice the
thickness of the camera.

Although the performance
and feel of this camera is
better than the others, the
interface still has the same
old look that we don’t like so
much and it’s also pretty slow;
with as much as a two to four
second delay between clicking
and previewing.

There are some more
unqiue features — there’s one
where the camera takes two
photographs — one with the
flash and one without the
flash. This is great for where
you want a guaranteed good

Fujifilm FINEPIX F200EXR

Brand Contact Phone Email Web site

Canon Canon India Private Limited 1-800-180-33-66 info@canon.co.in WWW.Canon.co.in
Nikon Nikon India Private Limited +91-124-468 8500 NA www.nikon.co.in
Samsung Samsung India Electronics Pvt Ltd +91-11-4151 1234 zeon.kim@samsung.com www.samsung.com/in/
Fujifilm Fujifilm India Pvt Ltd +91-124-432 5500 contact@fujifilmindia.com www.fujifilm.in

Sony Sony India 1-800-11-11-88 sonyindia.care@ap.sony.com www.sonystyle.com
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Lucid's HYDRA 200 is a chip that
lets any motherhoard use ATi and
NVIDIA GPUs together

Vue's surveillance system
comes with two wireless
cameras and a base station

Digital Camera Test

photograph in low-light
scenarios. The ability to set
the aperture size and shutter
speed is welcomed but there’s
very limited control over it.

The USB connector isn’t the
typical microUSB and the cable
supplied with it allows you to
connect it to a USB port on the
desktop or also to a TV using
composite connects.

Samsung ES55

The Samsung ES55 is a
compact point and shoot with
a nice brushed metal finish at
the front but somewhat dull at
the back. The controls buttons
aren’t of the same quality as
the front. The OK button is so
tiny that you have to use your
fingernails at times to press it.
The screen bulges out of the
body otherwise it would've
been a much more compact
camera.

The user interface has a
very high resolution and the
fonts and menus are very
impressive. When
you go into the
mode selection and
camera settings, it’s

even more apparent. It’s one
of the most comprehensive
user interfaces of all the
cameras we've seen. Every
menu and setting has a
description at the bottom of
the screen.

Controls like these might
impress those who are used
to computers and gadgets
in general with lots of
complicated menus. Anyone
buying a camera for the first
time might not really like
this overwhelming number
of settings.

The preview and
zooming function
allows instant cropping
and trimming of the
photographs which is a neat
little feature that can be found
on some other cameras as well.

The camera also has a
Photo Help guide feature
which teaches users how to
use the camera and its features.
A simple listing of tasks is
available with the steps to

do the task. These tasks

can also be used as a

tutorial with step-by-step
instructions.
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Samsung ES55

The Roundup

We're impressed by the cameras
that we received. To start with,
the Samsung ES55 although

a cheap camera at just Rs.
8,990, it performs rather well
throughout the test. Even in last
year's test, we had a Samsung
with a really good lens. The

ES55 also matches that kind of
performance for a fraction of
the price. While all the cameras
capture great detail on the
wideangle range of the zoom,
the Samsung ES55 does well
even with the zoom lens fully
utilised. The great thing is that
it's also a compact camera, has
a great looking interface. We
give it the Best Buy award for
these very reasons.

Canon has dominated
most of the point-and-shoot
cameras tests in the past. This
time as well, the winner is a
Canon. The Canon PowerShot
SX200 IS is one of the costliest
cameras of the lot. It's not a
full-fledged ultrazoom camera
either. It performs exceptionally
well in both the features and
in the performance tests. The
camera shines in all the photo
and video tests. If we were
to rate the cameras on just
quality, the SX200 IS would
still be the winner. In terms

of specifications, it's got a
very high-resolution sensor,
a brilliant zoom lens and a
very well designed body and
controls. Even though this
is just a digital camera, the
ability to record videos at 1280
x 720 is a really nice thing to
have. If the SX200 IS is out of
your budget, the SX120
should be the next in
your list. It has a slightly
cheaper feel but it still
has a 10x zoom and all
the manual controls that
photographers crave for.
Another well
performing camera was
the Canon Digital IXUS
100 1S. Although a little
older than the IXUS 110
IS, itis a very good performer
for a really compact camera.
It's not as pretty as the Canon
Digital IXUS 110 IS but if you
want pretty, the IXUS 110 IS is
your next best option. It's only
a tiny bit lower in performance
than the IXUS 100 IS.

The Fujifilm FinePix S1500,
the Nikon COOLPIX P90 and
the Sony DSC-HX1 were the
full-fledged ultrazooms that we
got. We like the Sony DSC-
HX1 but looking at the shots
that we were able to take, it's
nothing really special in terms
of quality. It feels and functions
like the other Sony cameras
that we've tested in the past
including some of the older
H series ultrazoom cameras.
The Nikon COOLPIX P90 had
anice set of features as well
but no HD video recording
functionality. If you want a
really huge zoom lens, then
the Nikon COOLPIX P90 is for
you. El
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into one gigantic test.
We split the boards into
anumber of intelligent

categories. A category each for

otherboards are Intel and AMD was obviously
the building the first step. Next we
blocks of any segregated the motherboards
system. And there into two subcategories —

is choice aplenty for someone integrated graphics and

discrete graphics. And this is
where we made a noteworthy

looking at buying one. LGA
775-based motherboards

are still around in numbers
alongside newer Core i7 boards
and AMDs new AM3 socket-
based boards have also joined
the fray.

We received an
overwhelming number of
motherboards although a few
brands like EVGA and Palit
were missed. This time round,
we piled all the motherboards

New processors mean
new chipsets and this
in turn means new
motherboards. Here is
a look at the latest and
the greatest
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DDRS3 for Core i5
Kingston starts shipping DDR3 kits
for Core i5 processors

AMD shows off DX11

AMD demonstrates DirectX 11 hardware
running six LCD screens at once

Motherboard test

discovery. In general most
integrated graphics boards

are based on entry-level
chipsets. However, AMDs

latest 790GX/FX chipsets

are high-end offerings but

they also retain an integrated
graphics solution. Therefore
we put these boards into the
high-end segment, where they
were tested with a discrete
graphics card. Core i7 boards
were tested seperately, for their
performance is incomparable to
other platforms — obviously on
account of the faster processors
they support.

Intel Core i7
motherboards

Core i7-based motherboards
haven’t been affordable and the
cost of the board along with
the price of DDR3 memory

has put many upgraders off.
Prices have fallen, and there are
many options available as you
are about to see; although they
are all based on a single Intel
X58 chipset. These boards do
not have a memory controller,
since the Core i7 processor now
integrates the controller on its
die.

Board design and
features

While the X58 boards are

all extremely high-end and
extremely costly, there’s

a trend to be followed —
something every motherboard
manufacturer follows. The
mATX form factor means
slightly less expensive
motherboards and it’s
something that will also find
its way into compact PCs and
maybe even high-performance
HTPC systems. MSI’s X58M is
one of the few mATX format
motherboards we tested.

The BIOS on
the X58M is
thorough with
MST’s distinctive
overclocking
utility called

the Cell menu.
It allows

for accurate
overclocking
and overvolting.
Another
interesting
menu is the

If you want to know
exactly what processor board, XFX
is best for your
needs, check out the
September issue for
a detailed processor
comparison test. When placed along the
you’re done with that,
you will know which
motherboard category .y from the
you should look for

Green power menu that allows
more efficient use of power
using the CPU phase control.
There’s also a neat little reading
that displays power efficiency.
BIOS updating is also simple
using a flash drive. Just going
by features and how well it’s
designed, it’s a pretty complete
a motherboard that’s not overly
expensive at Rs. 10,500.

XFX and ZOTAC, both

XFX X58i

NVIDIA only vendors prior to
this have built boards based on
the X58 chipset. XFX calls its
board the XFX X58i. The board
is designed and built really well.

Features and BIOS layout
are good. In terms of board
layout, it’s similar to the MSI
X58M board with a similar level
of overclocking features and
thought put into
it. I's a full ATX
board and has a
cleanly routed set of
heat pipes running
from one end of
the board to the
other. Temperatures
are lower than the
MSI board. There
is plenty of space
between PCI slots
and PCle slots
which mean you won’t have
any troubles with plugging
in sound cards with a large
graphics card coming in the
way.

There is an LED poster
and dedicated power switches
on the board.
Although a great

has persisted
with the ageing
ALC888 sound
solution — a pity.
SATA ports are

side like many
other boards,

but slightly

edge of the

board which is inconvenient.
The PCle x1 slot is right next
to the first PCle x16 slot, so

no chance of setting up sound
cards there. You'll have to use
one of the other two PCle slots.
Two PCI slots seem like overkill
for a board of this generation.
One of the smaller complaints
is the XFX site design and
getting BIOS updates can be a
little annoying.

ZOTAC’s X58, is, in
comparison to the others,
not as impressive. One
problem is the lack of basic
necessary overclocking and
memory tweaking options.
One of the biggest flaws
was the lack of the memory
timing settings. If you have
low-latency, fast memory

you'll be sorely disappointed.
There is no manual option
for preventing CPU throttling
down due to power saving
features like

EIST and

stepping

options — all

these are absent

in the BIOS. OCTOBER 2009

Biostar Tpower X58

The benchmarks especially the
memory intensive ones suffered
the most. The cooling solution
used is extremely basic, but
doesn’t get very hot with an
air-conditioning unit running.
In general, it feels very cheap.
For example, the Northbridge
heatsinks shift a bit if you
touch it. Not all is bad though
— the board is lined with
solid capacitors along vital
region. Additionally, in all
fairness it is one of the
less expensive X58
boards around.

MSTI had
another board on
this platform, the
X58 Pro. Unlike the X58M,
the X58 Pro is an ATX board.

The larger board means that
there is more space between the
PCle x16 slots, but not enough
to plug in a second card in the
adjoining slot. The first x1 slot
lies right under the first x16
slot. The second x1 lies above
the x16 slot. Longer sound
cards might still have some
problem fitting in there because
of the high heat sink that lies
very close in the way.

For those overclockers or
those who might run open rigs,
there are dedicated buttons for
power, reset and also clearing
the CMOS. Right next to it are
the DIP switches that allow
quick switching and overriding
of the base clock speed. The
BIOS is also quite elaborate and
will be good enough for anyone
planning on overclocking with
cooling of the board itself the
only thing to worry about.

BioStar's TPower X58 was
next. There are LEDs for each
of the 6 SATA ports on the
side. Next to those slots is the
poster and the lit power and
reset buttons. Cooling is taken
care of by a combination of

heatsinks and heatpipes. The
overclocking menus are well
sorted out and the increments
for voltages are small and
good enough for anyone who
might want to overclock this
board.
Gigabyte’s EX58-UD3R
is an ATX form factor board
with only four memory slots.
This is a rarity as most boards
have six. Like many other
boards, the adjoining slot to
the first x16 slot and in this
case the PCle x4 slot will be
covered by the graphics card.
There are two x1 slots above
the first x16 slots, one of which
is blocked by the gigantic
northbridge heatsink. The
second slot is unobstructed.
The cooling solution is similar

DFI UT X58 Lanparty
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Next Windows Mobile

1,000 developers are already working

on the Windows Mobhile 7

802.11n finally approved
WiFi 802.11n gets approval - manufacturers
hint at 600 Mbps speeds

to the ones found in other
premium Gigabyte boards with
the bright blue panel covering
the heatsinks. The BIOS

has overclocking options
aplenty.

On the more expensive
and extreme-enthusiast
boards, the Gigabyte EX58-
Extreme, cooling is taken care
of by a similar system used
in the vanilla EX58-UD3R
board. This has the option to
add even more heat pipes and
heatsinks — but this seems
overkill. There are two heat
pipes running between the
Northbridge and the MOSFET
cooling heatsinks on the side.
The board has a mix of solid
block heatsinks as well as fine
fins. The Northbridge is also
connected to a huge flat heat
sink for the Southbridge. The
heat distribution over the board
is effective.

One of the problems is
with the placement of the
standard PCI slots. There
is one after the first two
PCle x16 slots. The PCI
slots are typically higher
than the PCle slots, so
cards with an open cooling
with a exposed fan such
as the one we were using
touch the PCI slot. Unlike
the basic X58 board from
Gigabyte, there’s a neat
little power button with the
clear CMOS placed right away
at the top-end of the board.
Most of the overclocking
features are identical to the
standard board though. There’s
also a LED poster display on
this one.

The ASUS Rampage II Gene
is the smaller version of the
Rampage II Extreme board for
Intel’s Nehalem CPUs. There
are basic heatsinks connected
using anodized pipes. On
load, they do heat up quite a
lot. This board belongs to the
Republic of Gamers family and
so it comes with the classy
Start and Reset buttons. There
is also the LCD poster which
gives the user updates on the
temperatures, voltages and
errors if any. Although this
is an mATX board, there is
enough space between the two
PCle x16 slots. The audio is
powered by a SupremeFX chip

© Gigabyte EX58-UD3R

onboard the motherboard and
not one that fits into a PCle
slot like some of the other
motherboards from ASUS.
The Clear CMOS button is
conveniently placed at the
back of the board and can

be accessed from the rear of
the cabinet. There are a host
of other features like support
CPU coolers less gap between
the retention pins than regular

MSI X58 PRO

LGA1366 and the absence
of retention brackets on one
side of the DIMM slots. The
ASUS Rampage Il Extreme
is a gigantic looking board.
Everything has the look of
extreme quality to it. There
are terminals for those who
want to use a multimeter to
check voltages on the board.
Power buttons like the ones on
the Rampage 1T Gene are also
positioned there. The heat sink
has a light on
top of it which
gives the board
a very nice look.
The power
sockets for the
optional fans
are put together
at one point so
you don’t have
cables lying all
over the place.
Intel’s stock
X58 board, the

DX58S0 comes with nothing
special to interest buyers. This
is one of the motherboard
packages to come
with a free game; in
this case, Ghost Recon
Advanced Warrior. The
Northbridge heat sink is
cooled by a flimsy light-weight
heat sink. The quick guide
manual says that attaching
the bundled fan is optional.
We think it’s a must as this
heat sink gets hot quickly and
we've seen blue screens in the
past while trying to run the
board without the fan attached
though things cool down a lot
with the fan. The Southbridge
is stable and under control at
all times. The board only has
solid state capacitors around
the CPU region. There are small
heatsinks for the MOSTETs.
Like many of Intel’s boards, this
one too lacks a PS2 port even
for the keyboard. The board
is ideal for SLI and Crossfire
because of the ample space
between the two PCle slots. The
BIOS is basic in comparison
to all the other boards in its
category. The SATA ports on
the board point upwards which
could come in the way of some
cards. Intel has tried to space
them out though.

The ASUS P6T Deluxe is
another quality board. The
quality of the processor bracket
and the back plate behind the
board are of the highest quality.
The board is heavy with a thick
copper pipe running between a
sequence of heatsinks from the
MOSFETs to the Northbridge
and ending at the Southbridge.
Cooling is very good. There are
8 SATA ports
out of which two
are SAS ports.

SAS ports are
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ASUS Rampage Il Extreme

SCSI over Serial ATA and are
meant for extreme performance
drives. There’s plenty of space
between the first two PCle

x16 slots and there are two

PCI slots in between. The
Express Gate module is also
conveniently placed in between
the PCI slots. The board comes
with a nifty little overclocking
device called the OC palm. Tt
connects to the system allowing
users to overclock and monitor
all kinds of activity on the
board and off it.

The DFI LANPARTY UT
X58-T3eH8 has a very nice
bundle. While all the other
enthusiast boards try to be
serious, this one tries to put on
a party hat image with its bright
coloured slots and fluorescent
rounded cables. A large portion
of the motherboard is covered
with heatsinks and heat fins
surrounding the heat pipes.
There’s an additional heat sink
supplied with the board if you
want to attach it to the board or
to the Northbridge heat sink.

A separate Realtek 885 audio
controller module is supplied
that has to be connected to
the motherboard using a
supplied cable without using
any PCle slots. There is no
dedicated button to clear the
CMOS. Instead, a combination
of presses with the power

and reset button is to be used
besides the usual jumpers.
Overclocking feature are
plentiful and to extreme detail.
The layout of the board might
seem a little crowded towards
the upper region near the
expansion ports, but other than
that it’s well spaced out.

Performance

The ASUS Rampage II Gene
gave us a well balanced score
list with all and scored the
number one slot under plain
performance score list. The
larger and full ATX version

of the Rampage II Gene, the
Rampage Il Extreme performed
similarly in all the tests except
in the file transfer tests. The
exciting DFI Lanparty X58
board takes the second place.
We noticed that the CPU
performance test in Crysis
fluctuated a bit across boards
while the graphics benchmark
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Facebook Lite

Facebook launches optimised version of
its well known social networking site

stayed pretty much the same.
While looking at the scores
between a Core 2 QX9650 and
the Core 17 975 processor for a
moment, we see an especially
large improvement in the CPU
intensive benchmarks such as
the DivX file conversion test
and Cinebench.

Intel Core 2 Boards
(Discrete Graphics)
The Intel LGA775 legacy

finally comes to an end. In a
year’s time, there’s no telling if
we'll still see as many LGA775
boards as we do now. The Core
i5 is finally coming in to replace
the Core 2 line of processors.

Design and features
The Gigabyte EP45-UD3R

is one of the high-end P45
boards in the market. Gigabyte
has made a name for itself
especially for its P45 boards.
The cooling solution is one

of the newer styles used by
Gigabyte with the blue badge
heatsinks and anodized heat
pipes connecting them together.
This board only has one

PCle x16 slot so this isn’t for
anyone looking for a CrossFire
solution. There are 3 PCI slots
and one PCle x1 slot under the
x16 slot. Two of the other x1
slots are placed above. There is
no x4 slot, so no x4 cards can
be put on this board. One of
the x1 slots almost touches the
heat sink and the other can be
used as long as the cards aren’t
long and touching the RAM
modules. The SATA ports point
upwards and are placed out

of the path of a PCle graphics
card. There are no fancy power
buttons or LED displays on
this motherboard.

DirectX 11 for laptops
Mobile version of AMD’s DirectX 11 chipsets
rumoured to be out this November

The Gigabyte EP43T-UD3L
based on the slightly inferior
P43 chipset supports DDR3
RAM. Like the EP45-UD3R,
this one too lacks a x4 slot. X1
slots on the other hand are in
abundance and there are also
two PClI slots. The x1 slots can
accommodate sound cards or
any other similar cards as long
as they don’t aling with the
RAM slots.

There are two isolated
heatsinks for the Northbridge
and the Soutbridge without
any interconnecting heat pipes.
They do a decent job of keeping
things under control. The good
thing about this setup is also
that the area around the CPU
is kept clear so attaching huge
heatsinks and fans is simple.

The MSI P45 Diamond is
another DDR3 motherboard
for the enthusiast. The size
of the box gives that away.
Although, it’s a high-end board,
it doesn’t match up to the style
and design of the ASUS ROG
series as such. For example, the
power, reset and CMOS clear
buttons look really cheap and
bigger, better designed buttons
would’ve been a nice thing to
have when you pay so much for
a board like this. The primary
heat sink supports water

cooling if you plan on buying
a water cooling kit. There is a
transparent panel covering the
top with provision
for water inlet and
outlet. The board
runs perfectly cool
with just the passive
cooling solution
though. This one
also happens to be
one of the brightest
boards with loads

of multicoloured
bright LEDs. There
aren’t any issues or
complaints about
the board but the
problem is that there
isn’t anything special
with it either.

MSI P45 Neo2 is based on
the P45 chipset as well but
is a slightly less expensive
board. The cooling is done by
two blocks of heatsinks one
for the Northbridge and the
other for the Southbridge, both
connected by a heat pipe. There
are two PCle x1 slots adjacent
to the first PCle x16 slot out of
which one will get obstructd by
a single slot graphics card.

The space around the
processor is relatively clear
without any heat pipes or
heatsinks in that region

MSI P45 Diamond

Motherboard test

There are no optical or SPDIF
connectors at the back either.
BioStar's TPower 145 board
comes with an add-on
heatsink and fan that
can be mounted on one
of the heatsinks on this
board. The first slot has
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Biostar TPower 145

a long queue of jumpers right
under the first PCle x16 slot
which like some of the Gigabyte
boards can block a fan on an
open card design. The jumpers
are meant for configuring the
PCle slots. Biostar has got a
good design with this board
and a lot of it has been laid
out rather well. Installing our
huge Cooler Master TX2 cooler
was hassle free. The processor
socket is placed on the extreme
top end of the board and the
heatsinks surround the area
have been cut low.
The ASUS Maximus 11

Gene is very much like

the Rampage 11 Gene

except that the Maximus

is based on the P45. The

Southbridge heat sink

is slightly banked so it

doesn’t come in the way

of the graphics card.

The memory slots have

a one-sided clip. This

is another board from

the RoG (Republic of

Gamers) range from ASUS.
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L4D2

Left 4 Dead 2 game gets
banned in Australia

Intel CULV

ASUS joins the Intel CULV processor
bandwagon for its notebooks

Installing the heat sink isn’t so
much of an issue, but the board
flexes sharply where the heat
sink is fitted. The capacitors
and MOSFETs are placed along
one side of the processor while
the other side is left relatively
free and open. The only PCle
x1 slot on this board will be
covered if the graphics card is
put on the first slot. The second
PCle slot can be used for other
cards, but it still will be very
close to the graphics card.

The two P45-based boards
from ASUS were the ASUS
P5Q3 Deluxe WiFi-AP @n and

ASUS P5Q Premium

ASUS P5Q Premium. The WiFi-
AP @n tag on the ASUS P5Q3
board denotes the inclusion of
a Wi-Fi module that supports
802.11n. Both the boards use
the ADI AD2000b sound chip
instead of the usual Realtek
ALC888. The difference in
layout is the location of the
SATA ports on the side. The
P5Q Premium has all of them
neatly stacked in a row where
as the P5Q3 has a PATA portin
between. The cooling is simpler
with a solid heat sink only for
the Southbridge with a blue
EPU badge over it. The P5Q
Premium comes with a larger
version. Both boards are well
laid out.

The MSI P43 Neo3
is a special board that
has many more PCI
slots than we've seen
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ASUS P5Q3 Deluxe

on some of the other boards
in this test. Other than the
below-par processor mounting
mechanism, it’s a decent board
with all the features including
RAID using a JMicron chip.
While all seems great with
this board, once again, we're
surprised to see a LPT and
COMM port at the back. The
only PCle x1 slot lie right below
the PCle x16 slot so adding
any more PCle cards might
be impossible. Think carefully
before buying this card. You
have to resort to the other PCI
slots for any other expansion.
Intel’s DX48BT2
shares some similarities
with the newer DX58S0O
board. Like the X58,
there are no PS2 ports.
Electrolytic capacitors are
used all across the board.
The SATA ports are also
spaced out between where
the PCle graphics cards
would normally go. Intel has
tried to project this board as a
performance board for gamers.
For example, the package
contains a fancy dog tag. The
board has built in IR support
so you can remotely control the
PC. You'll need to purchase a
remote and setup the software
yourself through.

The other X48 board we
received was the MSI X48C
Platinum. MSI calls its cooling
solution Circupipe and it is
extensive. There is a set of
three heat pipes running from
the MOSFET coolers to the
Northbridge which are then
channelled to another two
heatsinks down the
board. There are two
PCle X1 slots right next
to the primary PCle X16
slot. Three standard PCI
slots follow the second
PCle x16 slot. This
means you can easily
plug in additional LAN
or sound cards. The
CMOS reset button is
positioned behind the
motherboard. The two
buttons on the board
are for the power and
reset function. The
biggest speciality of
the board is the ability
to use both DDR2
and DDR3 modules.

The Northbridge heat sink is
pretty large with large fins and
removing heatsinks can be a
problem but obviously this isn’t
a major issue.

XFX’s nForce 790i Ultra
board uses the standard
NVIDIA reference design. The
790 chipset gets very hot and
especially so the Northbridge.
The quality of the heat spreader
isn’t so great. Thankfully, a
fan is provided which very
neatly fits on the Northbridge
heat sink. The processor is
surrounded by a range of
heatsinks and heat pipes
connecting them together.
Although this is a pretty high-
end board, there are a lot of
electrolytic capacitors used.

There are dedicated buttons
for the power and reset which
is handy. There’s also a LED
poster on the side. There are
SATA ports lined up on one
side in between the RAM slots
and the PATA connector. The
first two SATA ports are lined
up right at the bottom of the
board. The bundle is nice too.
There are narrow rounded
PATA cables and
plenty of black
SATA cables
that go well
with the colour
scheme of the
board.

ZOTAC’s
780i Supreme
board is almost
identical
to the XFX
nForce 790i Ultra SLI with
minor differences here and
there. In terms of design, the
Northbridge heat sink isn’t
as wide as the one on the
XFX 790i board. There are
solid state capacitors again
along the processor. There’s
a Wi-Fi module bundled with
the board. The cables in the
package aren’t rounded or
anything. There are molex
to SATA power converters
bundled with the board in case
you're using a really old power
supply that only came with
molex power connectors.

The Striker II NSE is ASUS’s
NVIDIA-powered high-end
for the LGA775 platform. It
uses the top-of-the-line nForce
790i SLI chipset. It looks a

lot different from the other
NVIDIA based boards we've
seen. This ROG-series board
has a good SupremeFX II add-
on module which comes with
a shield to reduce any kind of
interference that an on-board
audio chip would pickup. The
quality of the board might not
be anything spectacular as
compared to dedicated high-
end sound cards but they’re a
big step on any on-board audio
solution for sure. The board
has the provision for water
cooling although the water
block looks separated from
the rest of the heat sink and
heat pipes. The bundle comes
with pipe fittings adaptors and
screws needed to fit the water
cooling kit. It's showy looking
too — the heatsinks and fins
are contoured with strips of
metal which gives the board a
very clean look. There’s also
the glowing Republic of Gamers
badge next to the Northbridge
heat sink. The power and reset
buttons are on the board and
the CMOS reset button at the
back. Although the sides of the

Zotac 790i Ultra SLI

processors are all lined up with
heat pipes and heatsinks, most
of the area around it is kept
clear.

Performance

Even after a really lengthy
session of testing, we weren’t
expecting too many surprises
with the performance. Synthetic
benchmarks like 3DMark

and PCMark05 stayed more

or less within the expected
range. There were hardly any
variations in the video encoding
tests as well. It has to be said
that the P45 chipset generally
tops the scores. The P35 was a
stable and a one that was used
for a long time. The P45 builds
on that and is probably one of
the refined chipsets around.
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One of the cheaper P45 boards,
the Biostar TPower 145 was
one of the better performers of
the lot. Intel’s own DX48BT2
board was among the toppers
in the class as well. The biggest
variations were seen in the

file transfer tests where all the
hard drives were defragged
before the tests and yet there
were some differences. Some
difference can be attributed to
the difference in performance
experienced because of using
DDR3 or DDR2 memory.
Game benchmarks such as
S.TA.L.K.E.R Clear Sky and
Crysis were also almost identical
throughout the test.

Intel Core 2 Boards
(Integrated Graphics)
The Intel Core 2 processors
can run on pretty much any
chipset for LGA775. There
aren’t too many chipsets for
Intel processors in recent times
that provide decent graphics
processing performance. The
Intel G4x series of chipsets are
pretty identical to the P4x series
of chipsets, but they come with
an onboard graphics solution.
NVIDIA too has the GeForce
9300 range of chipset which
we've already seen in the last
comparison test. They matched
the AMD 780G and also the
NVIDIA GeForce 8200 and
8300 chipset in performance.
We looked some of the newer
Intel chipsets with onboard
graphics - the G43 and the
G41.

Features and design
These boards are really basic
boards with the most

basic of features. They

are made for those who

just want a desktop

computer for everyday

use and have no interest

in running too many

games. The Jetway

143GM1 is one of such boards
and uses the Intel G43 chipset.
The quality of heatsinks is
cheap and so is the processor
retention mechanism. There are
only two memory slots which
will let you install up to 8 GB
of memory that might seem
less as compared to some of the
other motherboards. However,
8 GB still is a lot and it should

640 GB

hard drive

Samsung spins out a 640 GB 2.5-inch

Motherboard test

Brand Contact Phone E-mail Web site

ASUS ASUS Technology Pvt. Ltd. +91-22-67668800 media_india@asus.com WWW.in.asus.com
Biostar Abacus Peripherals Pvt. Ltd +91-22-40914603 sajid@abacusperipherals.com  www.biostar.com.tw
DFI Xtreme Grafix +91-9987539043 Sudhirsmani@gmail.com www.dfi.com.tw
ECS SES Technologies Ltd +91-22-30862500 Jacques.roux@sesindia.com WWW.ecs.com.tw
Gigabyte  Gigabyte Technology Co. Ltd. +91-22-40633206 viveks@gigahyte.in www.gigabyte.com.tw
Intel NA NA NA www.intel.com
Jetway Jetway Information Co. Ltd. +91-9871191716 vsingh@jetway.com.tw www.jetway.com.tw
MSI MSI Co. Ltd. +91-11-41758808 marketing@msi-in.com www.msi-india.com
XFX Rashi Peripherals Pvt. Ltd. +91-22-67090828 response@rptechindia.com www.xfxforce.com
Zotac Aditya Infotech Ltd +91-11-46665666 sales@zotac.com www.zotac.com

be more than sufficient for
most people. The board has
an HDMI port which is a neat
thing to have.

The MSI G43M2 is another
G43 board, but this one comes
with some really unexpected
features such as the LPT and
the COM ports. On the other
extreme, there’s a FireWire
connector as well. The heat sink
is slightly larger than the Jetway
143GM1-HG. The rest of the
board sports standard features.
There isn’t anything special
about this board but at the
same time, there isn’t anything
wrong with it.

Like the Jetway [43GM1,
the ECS G41T-M2 is another
basic board and it looks like a
really cheap one. That's the first
impression you get. It looks like
a stock Intel G41 board with its
green PCB. The layout of the
board is basic. The Southbridge
has no cooling at all. The PCI
slot is placed away but there
are two PCI-E x1 slots in
between but there is only just
enough space for a card. The
SATA ports are placed in the
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Jetway 143GM1-HG

way of the PCle x1 slots so
there might be some problems
if you putin a long PCle x1
card.

The Biostar G41D-M7 is
also pretty similar to the ECS
G41 board. This board too
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doesn’t use an all solid-state
capacitor setup. There are only
two RAM slots spanning most
of the motherboard’s length.
This board is ideal for a really
cheap setup but who want
some quality. This kind of
board suites those who want a
DirectX 10 compatible board
for use with Vista for example.
Biostar like in many other
board packages

Performance
Intel’s onboard graphics
solutions have been disregarded
for the most part. NVIDIA’s
9300 chipset motherboards
have been around a while and
you can read the reviews for
those in our last motherboard
test back in November last year.
The cost of building systems
around it has been a lot more
than Intel chipsets. The Intel
G43 and G41 chipset boards
from Biostar, ECS, Jetway
and MSI didn’t
really break any
records. We see
that the G43
boards are just
a tad faster than
the G41 ones. The
difference in real
world performance
is negligible
and won’t really
produce any great
frame rates even in
pretty dated games.
The boards sure
match up with the
other high-end
boards even P45
in many of the video encoding
and file transfer tests, so if
you're building an Intel for an
extremely low budget and just
need a graphics solution built
into the board, these chipsets
will do just fine.

AMD Socket AM2+/
AM3 (Discreet
Graphics)

We talked about how most
AMD chipsets have a decent
graphics performance built
into the chipset. The AMD
790FX and 790GX are almost
identical chipsets. The 790GX
runs a slightly more powerful
version of the 780G graphics
chip. Even then, boards of

this kind are typically used by
enthusiasts and those who go
in for dedicated graphics cards.
Similarly, NVIDIA has the 780a
chipset which makes up the
higher range which makes for
great SLI-capable boards on the
AMD platform.

MST's KON2 Diamond
uses the NVIDIA nForce 780a
chipset. MSI’s heat sink design
uses the usual spiralling heat
pipes with thin heat-fins on
them. They aren’t very flimsy
but they can be troublesome
while attaching heatsinks like
we learnt. The cooling solution
works very well though. It’s
a little strange to see different
kind of RAM clips used for half
of the slots. Huge capacitors
are used all across the board.

A PCle x1 X-Fi audio card is
bundled along with the board
like the high-end ASUS models.
The power control buttons
used aren’t fancy like the other
brands either. A good thing is
the arrangement of all the SATA
ports over the length of two
SATA ports. The board package
has almost everything you’ll
need. There are the extra back
panels, SLI bridges of different
lengths and power connector
converters.

The Jetway HAO7 Ultra
belongs to the Hummer range
of boards. As compared to
Jetway’s entry-level boards,
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ASUS M4A79T Deluxe

these are just a little more
expensive but come with an
abundance of features. One of
the first things you notice is
that it’s a completely solid-state
capacitor board. There is a
colourful LED powered display
at the bottom of the board.
There’s a plastic sticker which
in place to spread the light
through the gap in the board.
Perhaps, this could have been
implemented a little better. A
switch card is provided to make
sure that the board uses the
entire PCle x16 bandwidth. The
heat sink itself is very attractive.
The heatsinks are connected
by a copper heat pipe. The

pipe is connected using a set of
multiple clips within the heat
sink so the heat exchange isn’t
as much as it could have been if
the heat pipe were completely
consumed by a block of heat
sink for example. The two PCle
x1 slots are placed right below
the first x16 slot. Although, the
first one might not be usable,
the other one will. There are
also two PCI slots below the
PCle x16 slot. This board in
terms of features is a winner for
its price. All the three display
connectivity options — VGA,
DVI and HDMI are available.
There’s also an SATA port
meant for eSATA placed right
near the back of the board right
next to the external eSATA port.
There are buttons of all the
power controls and also CMOS
clearing. With everything kept
in mind, this is a very good
board to consider.

The TA790GX A3+ from
Biostar is pretty similar in
design to the TA785GE
motherboard and is a full-
fledged ATX board instead
of a HTPC-friendly mATX

form factor
board. The
same LED sequence
based diagnosing panel is
present on this board. Like the
TA785GE, this too has all three
display connections -~ DVI, VGA
and HDMI. The SATA ports are
isolated and aren’t hugging the
side of the motherboard like on
almost every other board. If you
think of using L-shaped SATA
connectors on the motherboard
end, it won’t be possible.
It's kind of funny to see so
many features printed on the
motherboard. Everything from
the kind of slots to every single
connectivity such as the LAN,
the 7.1 audio, the DVI ports,
the Firewire connectors are
printed in large characters on
the motherboard. The power
buttons and the CMOS clear
jumper are positioned in one
corner of the board.
The ECS A790GXM-A
is another that uses the
790GX chipset. It's not really
geared as a high-performance
enthusiast board. The board
is rather decent looking
with its colourful slots and

Gigabyte MA790FXT-UD5P

a dark PCB. The positioning
of the Northbridge chip is
unconventional and slightly
towards the back-end of the
board. The onboard Qimonda

branded memory chip lies in
between it and the processor.
In terms of just features, it
matches some of the best
boards - in the BIOS and
overclocking department, not
so much. It’s very basic BIOS.
Amongst the two LAN ports
and HDMI port, lies an ancient
COMM port. The board isn’t a
fully solid state capacitor board.
The Gigabyte MA790FX5-
UD5P is a high-end board
based on the AMD 790FX
chipset. The 790FX is pretty
much the 790GX without the
on-board graphics solution.
Cooling is similar to other
boards except for
a few things here
and there. For
example, there’s
a tiny isolated
heat sink for
the SATA chip.
The package
contains back
panel for eSATA
come with molex
to SATA power
connectors and
eSATA cables as
well. This should
technically let
you use any
drive as an external drive very
easily. The space between the
two PCle x16 slots is sufficient
and there are three PCle slots.
The topmost one lies in the way
of the Northbridge heat sink
but Gigabyte has cleverly cut
out space in between so allow
long cards to be
installed.
Gigabyte’s
other AMD
powered board
the MA790GP-
UD4H board
has three PCle
x1 slots, one
of them right
next to the heat
sink and almost
unusable. A line
of USB slots on
the board are
available behind
the second PCle
X16 slot. The heatsinks are
connected by two pipes and the
blue Gigabyte SilentPipe.
The MSI 790GX-G65 comes
with the necessary cooling
setup for the board. The largest

heat sink is used on top of the
MOSFETs. The board layout
is good and there’s a good
mix of PCI and PCle x1 slots
on it. It comes packed with
plenty of features as well. The
dedicated buttons for the
motherboard controls is also a
nice thing to have. The board
is designed for overclockers
and the brochures that come
with it state it. There’s a switch
to quickly change the FSB
speed physically. A little more
cooling would have been
nicer on a board designed for
overclocking. The package we
received came with a signed

Biostar TA790GX A3+

certificate of some benchmarks
by those who run it. This is a
slightly different treatment to a
board that we've seen. It’s nice
to know that you've been sold a
well tested product.

The ASUS M4A79T Deluxe
is an AMD 790FX chipset
board. Like the P45 boards
from ASUS, this too uses the
ADI2000B chip for the sound.
The board doesn’t come with
any PCle x1 or x4 sized slots.
There are four PCle x16 slots
which can be utilized for any
other cards. The Southbridge
heat sink is rather plain but
made of copper. ASUS being
themselves have kept capacitors
out of the way of any PCI
and PCle slots. The package
contents are very basic. SATA
cables and back panels are
provided. No fancy fans or
cables here.

Performance

The boards we tested scored
almost identical performance
figures across all chipsets.
Obviously, a lot depended on
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Jetway HAO7 Ultra

the processor and the graphics
card but the motherboard
clearly wasn’t a bottleneck
anywhere. The scores seem

a tiny more consistent than
the motherboards in the Intel
LGA775. Once again, there’s
little to comment on the
performance differences.

MSI 790GX-G65

HOW WE TESTED

or the AMD boards, a
F Phenom II x4 965 3.4 GHz

processor was used. For
Intel, it was the 3 GHz Intel Core
2 Duo QX9650 and the Core i7
975 (3.33 GHz) for x58 boards.
We used Corsair Dominator
dual channel kits for DDR2 and
DDR3 modules; for the Core i7
Tri-channel kit we used Kingston
memory. Western Digital's 300
GB Velociraptor HDDs were used
on all test benches. The ASUS
GeForce 9800GTX+ was used on
the discrete graphics boards. All
the systems were powered by
Corsair's HX620 SMPS.

The staple diet of any
motherboard or any kind of
desktop performance test
has to include PCMark; which
itself contains a multitude of
tests designed to stress each

AMD Socket AM2+/
AM3 (Integrated
graphics)
This category of the
motherboards is dominated
mainly by the slightly older
but very popular AMD 780G
chipsets and now the AMD
785G chipset. The NVIDIA
8xxx series of chipsets has
been around but we
haven’t seen a lot of users
adopting it as much as
we've seen the 780G
dominate most of the
market. AMD’s 780G and
now 785G boards come
with a good onboard
solution (HD 3200 in
the case of the 780G and
HD4200 in the 785G) and
also a HDMI port which
makes them perfect for
building cheap HTPCs
that can play HD content

component. It runs a wide
variety of desktop applications
and a few graphic tests to
give a final score for the entire
subsystem. This includes
everything from the processor,
memory, hard drive, graphics
card, etc.

ScienceMark was used to
get scores for the memory
benchmarks. We expected to
see large differences between
DDR2 and DDR3 systems. The
differences in between the
DDR2 and DDR3 scores would
be more interesting though.

For just pure processor and
memory subsystem testing, a 3D
rendering benchmark had to be
used. Cinebench which is basically
a dedicated benchmark utility
based on the popular Cinema 4D
3D modelling program. Another

without breaking a sweat.
Decent AMD 780G based
boards can be found as cheap
as Rs. 3,500.

The Gigabyte MA785GM-
US2H runs on AMD’s 785
chipset. It uses the next
generation of AMD’s on-board

graphics solutions the HD4200.

It’s weird to see that Gigabyte
hasn’t gone with a fully solid
state capacitor board. Those
in the processor region are
solid capacitors while the rest
are the traditional electrolytic
ones. The heat sink on the
Northbridge isn’t very sturdy
and wobbles from side to side
a little bit. There’s always that
worry that it might not be

DVI and HDMI connectors.
The HD4200 has a big role to
play by trying to replace the
older but popular HTPC
solution chipset the 780G. This
board is of the mATX form
factor, so it’s perfect for those
building HTPCs.

Gigabyte’s MA785GPMT-
UD2H runs on DDR3 and
being an AMD 785 chipset,
it’s something people will
soon start purchasing to
build systems based on AMD
processors. Board prices will
soon drop along with DDR3
prices into a scenario similar
to what it is today - AMD
780G boards running on
DDR2 RAM. The audio chip is

MSI K9N2 Diamond

making contact with the chip
below. Most of the SATA and
PATA connectors lie on the
extreme right side of the board.
The board comes with all VGA,

processor intensive test was
WinRAR.

For a more real world test that
we would use every day, we used
a video compression program.
DivX Converter was our choice
because of its reliability. It's
something we've used for a long
time now. The standard 100 MB
VOB file was to be converted and
the time noted.

There was no simpler way to
test the hard drive performance
and the input/output
subsystem than to do huge file
copy tests on the hard drive.
We used a single 8 GB file and
then a folder with 8 GB of data
in it. Times were recorded.

The graphics benchmarks were
separated for boards with on-
board graphics and the others.
3D Mark Vantage was used for

now upgraded to the Realtek
ALC889A. The CMOS jumper is
oddly placed between the two
PClI slots. The board can be a
little difficult to use. The only

the motherboards tested with
the dedicated graphics card.
S.TALKER Clear Sky and Crysis
made up the real world games
for this part of the test.

For boards with integrated
graphics, it was older games
such as Doom 3 and Company
Heroes. 3D Mark Vantage
was replaced by the older 3D
Mark 2006. Games like Crysis
and Stalker would bring these
boards to a screeching halt.

With motherboards as
always, there's a very tiny
difference in performance
between boards using the same
chipset. Weights are given
to sections of the test and as
always performance was a small
factor. The features and design
of the board on the hand were
given higher priority.
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AMD Integrated Graphics Motherboards
Model No. :«:élns-u'rpc/ MA4A785TD-M EVO |MA4A785TD-VEVO  |TA785GE 128M |A785GM-M MA785GM-US2H
Price (Rupees) Rs. 7,100 Rs. 6,700 Rs. 6,700 Rs. 4,135 Rs. 4,800 Rs. 5,500
overall (Out of 100) 56.26 60.58 67.21 48.90 60.53 55.85
Features (Out of 70) 31.39 35.16 40.55 22.89 35.20 31.60
Performance (Out of 30) 24.87 25.42 26.66 26.01 25.33 24.25
Chipset AMD 780G AMD 785G AMD 785G AMD 785G AMD 785G AMD 785G
Socket AM3 AM3 AM3 AM3 AM3 AM3
Northbridge / Southbridge 780G / SB700 785G / SB710 785G / SB710 785G / SB710 785G / SB710 785G / SB710
Memory Type DDR2 DDR3 DDR3 DDR2 DDR3 DDR2
Max Memory Supported (GB) / No of DIMMs 16GB/ 4 16GB /4 16 GB/ 4 16 GB / 4 32GB/ 4 16GB /4
No. of SATA / IDE Ports 5/1 5/1 5/1 6/1 6/2 5/1
E-SATA Support / No of E-SATA Ports Y/1 Y/1 Y/1 N Y/2 Y/1
No of PCI Express x16 graphics slots 1 1 2 1 1 1
No. of PCI / PCI x1 / PCl x4 Slots 1/2/0 2/1/0 3/1/0 2/0/0 1/2/0 2/1/0
Multi GPU (SLI/CrossFire/N) / No of PCle Lanes N/O N/O Y/2 N/O N/O N/O
Integrated Audio Controller Y VT1708S VT1708S Realtek ALC662 | Realtek ALC 888S Realtek ALC889A
Number of Sound channels 8 8 8 6 8 8
SPDIF / Optical Port Y/Y N/Y N/Y N/N N/Y N/Y
No of LAN Ports /10/100 / Gigabit 1/ Gigabit 1/ Gigabit 1/ Gigabhit 1/ Gigabhit 1/ Gigabit 1/ Gigabit
Integrated Wi-Fi (Y/N) N N N N N N
No. of rear USB / FireWire Ports 4/0 6/1 6/1 4/0 6/1 6/1
All Solid State Caps (Y/N) N Y Y N Y Y
BIOS options
CPU voltage range (volts) N/A 1.125~1.7 1.125~1.7 N/A N/A 0.825 ~ 2.025
CPU Voltage increments 0.05 0.00625 0.00625 0.05 N/A 0.025
Memory voltage range (volts) 1.8~2.1 1.1~1.61 1.1~1.61 1.95 ~ 2.65 N/A N/A
Memory Voltage increments 0.1 0.015 0.015 0.1 0.01 0.1
Board Layout (So 10)
Region around the CPU 8 8 8 8 7 8
Location of SATA ports 8 8 8 7 7 7
Placement of Memory modules 8 8 8 8 8 7
Graphics card slot and PCI slots 7 8 8 7 7 7
Package Bundle
No of SATA / PATA Cables Provided 1/1 2/1 4/1 2/1 4/1 2/1
Mentionable Accessories Remote control |- = - o
PC Mark 05
CPU 10142 10278 10301 10220 10250 10293
Memory 6586 6365 6463 6307 6284 6578
Graphics 3372 2596 3738 3558 3417 2666
HDD 8719 8753 8761 8724 8754 8756
Overall 9341 7661 9391 9214 9235 7738
ScienceMark (Memory Bandwidth) 8242 10142 10168 9602 8609 8286
Cinebench R10 9203 11091 11142 11088 11057 11140
WinRAR 3.8 2146 2442 2401 2325 2267 2159
DivX Video Encoding (100 MB VOB) (sec) 31 30 30 31 31 31
Sequential File Transfer Test (8 GB File) (sec) 164 170 170 165 164 163
Random File Transfer Test (8 GB File) (sec) 195 187 185 191 191 190
Doom 3 FPS (800 x 600, medium detail) 55.3 60.1 60.3 57.1 55.3 5515
3D Mark 2006 (CPU / Overall) 4618 /1633 4691 / 1817 4698 /1821 4655 / 1788 4682 /1667 4652 / 1650
Company Of Heroes (1024 x 768, lowest) 409 43.4 43.5 40.8 34.6 39.6

PCle x1 slot is too close
to the heat sink and it

the x16 slot for any sound

great with its dark gray

heatsinks. The board does get
pretty hot with the benchmarks
running. The SATA ports on
the sides are solid and divert
the connectors away from the
cards. There is only one PCI
slot and two PCle x1 slots one
above and below the PCle x16
slot. The heat sinks although
close to the PCle x1 slot but
it's been cut out keeping

in mind x1 cards. Being an

cards. Any more PCle
x1cards or x4 cards are out
of the question. There’s a
basic overclocking switch
positioned next to the
Northbridge. There are also
dedicated chunky buttons
for the power, reset and
clear CMOS functions.

The ECS A785GM-M
is a really compact mATX
board. The board looks

looks like a close fit for

any card. The two slots
other than the PCle x16

slot are the PCI slots.

The Southbridge is just a big
block of metal.

The MSI KA780G is a very
basic looking board yet it packs
in a lot of features. The 780G
board comes with three PCI
slots and a PCle X1 slot above
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Jetway PN78VM2-LF
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Upan oPMT | pN7gVMR-L KA7806 GeForce 8200
Rs. 7,500 Rs. 2,975 Rs. 7,500 Rs. 3,100
57.58 46.40 54.92 45.32
32.32 23.88 30.87 21.44
25.26 22.52 24.05 23.88

AMD 785G NVIDIA GeForce 8200 | AMD 780G NVIDIA GeForce 8200
AM3 AM3 AM2+ AM2+

785G / SB710 GeForce 8200 780G / SB700 | GeForce 8200
DDR3 DDR2 DDR2 DDR2

16 GB / 4 4GB /2 8GB/ 4 8GB/4
5/1 6/1 5/1 6/1

Y/1 N Y/1 N

1 1 1 1

2/1/0 2/1/0 3/1/0 2/1/0
N/O N/O N/O N/O
Realtek ALC889A |Realtek ALC662 Realtek ALC888 | N/A

8 6 8 N/A

N/Y Y/N N/Y Y/N

1/ Gigabit 1/ Gigabit 1/ Gigabit 1/100 Mbps
N N N N

6/1 4/0 6/0 4/0

Y N % N

0.825 ~ 2.025 0.8~ 1.55 N/A 1.25~1.35
0.025 0.025 N/A 0.05

0.75 1.74 ~ 2.46 1.8~27 2.0~2.2
0.05 0.05 N/A 0.1

7 s 7 8

7 6.5 8 7

8 7 8 7

8 8 8 8

N/A 1/1 1/1 1/1

10349 10230 10246 10273

6413 6023 6044 6205

2963 2328 2399 2623

8731 8856 8778 8884

7998 7164 7493 7412

9343 8253 8072 9462

11141 11047 11041 11063

2197 2204 2199 2301

30 31 31 31

166 195 165 164

186 202 195 196

59.1 19.8 57.5 62.4

4706 / 1780 4530 /1322 4665/1642 4542 /1422
44.6 33.4 39.8 389

AMD 785 board, it supports
Hybrid Graphics. The Hybrid
Graphics allows both on-board
graphics and dedicated PCle
card to work in tandem. ECS
has introduced eJIFFY which
works similar to ExpressGate
and allows a quick access to a
mini operating system. There
is a LED poster for error codes
and the buttons for power
functions and CMOS clear
buttons right next to it. There

is no floppy drive connector on

this motherboard. It’s a great

HTPC board.

The ASUS M4A785TD-M
EVO is the mATX version of
the larger AMD 785 board
from ASUS — the ASUS

M4A785TD-V EVO. The biggest
difference is the additional PCle

x16 slot and the standard PCI
slot. Nothing at the back of the
panels has changed between
the two boards. The layout of

Motherboard test
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the boards2 has
changed quite a
lot as well. They
both come with
128MB Sideport memory. The
larger M4A785TD-V EVO also
comes with a larger heat sink.
Both the motherboards have a
more attractive blue heatsink
winged design that makes them
look like some of the most
elegant looking designs around.
No fancy copper pipes
running around all over
the place here. Express
Gate is a common feature
on both boards. The
ATX version has coolers
for the
MOSFETs
while the
cheaper
mATX
board
doesn’t.
Package
bundles are
no different
either.

Once again,
it’s good to see brands like
Biostar come up with boards
based on new chipsets so early
for sale in India. The AMD
785G version of their board
is called the Biostar TA785GE
128M. The heatsinks for the
Northbridge and Southbridge
are both very thin. Unlike the
ASUS 785 boards that require

Gigabyte MA785GM-US2H

ASUS M4A785TD-V EVO

DDR3, Biostar’s
TA785GE runs on
DDR2 memory
which makes it
a cheaper alternative for those
who are on a tight budget for
building a system. The only
missing component is the
HDMI connectivity. There are
LEDs on the board which can
be used to identify problems

ASUS M4A78-HTPC/RC

with the board. A small table on
the motherboard itself explains
errors for the combination of
those status LEDs. Even the
front panel pins control pins
have been clearly marked.
The back has a panel which
prevents flexing of the board.
The ZOTAC GeForce 8200
comes with a thick Southbridge
heat sink which is mostly a
big chunk of metal. It covers a
big area but it still gets really
hot in no time. A fan would do
wonders for this board but it
would mean changing the heat
sink a little bit. The layout of
the board is unconventional.
The 24-pin power connector is
placed towards the back end of
the board. This means that the
thick cable will run by close to
the CPU fan. As a competition
to the 780G, this mATX board
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AMD High-end Graphics Motherboards

Model No. M4A79T Deluxe | TA790GX A3+ |A790GXM-A MA790FXT-UD5P |MA790GP-UD4H HAO7 Ultra 790GX-G65
Price (Rupees) Rs. 14,850 Rs. 6,395 Rs. 6,390 Rs. 14,990 Rs. 9,900 Rs. 5,500 Rs. 9,000
Overall (Out of 100) 66.27 60.73 56.61 65.48 61.73 62.00 65.84
Features (Out of 70) 4091 35.52 31.43 40.47 36.06 36.37 40.65
Performance (Out of 30) 25.36 25.21 25.18 25.01 25.67 25.63 25.19
Chipset AMD 790FX AMD 790GX AMD 790GX AMD 790FX AMD 790GX AMD 790GX AMD 790GX
Socket AM3 AM3 AM2+ AM3 AM3 AM2+ AM3
Northbridge / Southbridge 790FX / SB750 |790GX / SB750 |790GX / SB750 |790FX / SB750 790GX / SB750 790GX / SB750 790GX / SB750
Memory Type DDR3 DDR3 DDR2 DDR3 DDR2 DDR2 DDR3
MaxMemory supported (GB) / No of 16GB/ 4 16GB/ 4 32GB/4 16GB/ 4 16GB/ 4 8GB/4 16GB/ 4
No. of SATA / IDE Ports 5/1 6/1 6/2 6/1 6/1 4/1 5/1
E-SATA Support / No of E-SATA Ports Y/1 N/O N/O N/O N/O Y/1 Y/1
No of PCI Express x16 graphics slots 4 2 2 2 2 2 2
No. of PCI / PCI x1 / PCI x4 Slots 1/0/0 2/2/0 2/2/0 2/3/0 2/3/0 2/2/0 2/2/0
Mult] GFU Support (SLI/CrossFire/N) /No |y ; 4 /2 /2 /2 v/2 /2 v/2
Integrated Audio Controller Realtek 1200 Realtek ALC888|Realtek ALC888S |Realtek ALC889A |Realtek ALC889A Realtek ALC888 Realtek ALC889
Number of Sound channels 8 8 8 8 8 8 8
SPDIF / Optical Port Y/Y 0/0 N/Y Y/Y N/Y Y/N N/Y
No of LAN Ports / 10/100 / Gigabit 1/ Gigabit 1/ Gigabit 1/ Gigabit 2 / Gigabhit 1/ Gigabit 1/ Gigabit 1/ Gigabit
Integrated Wi-Fi (Y/N) N N N N N N
No. of rear USB / FireWire Ports 6/1 4/1 6/0 8/2 4/1 4/0 6/1
All Solid State Caps (Y/N) Y Y N Y Y Y Y
BIOS options
CPU voltage range (volts) =iy 0.02 ~1.26 NA 0.825 ~ 2.025 0.825 ~ 2.025 0!SEN55] il = 155
CPU Voltage increments 0.0125 0.02 0.02 0.025 0.025 0.025 0.0125
Memory voltage range (volts) 1.5~25 1.66 ~ 2.84 NA Default + 0.75 Default + 0.75 1.7 ~2.85 1.5~2.42
Memory Voltage increments 0.02 0.02 0.01 0.05 0.05 0.05 0.05
Board Layout (So 10)
Region around the CPU 8 8 8 7 7 7 8
Location of SATA ports 7 7 6.5 8 8 7 8
Placement of Memory modules 7.5 8 8 7 8 8 8
Graphics card slot and PCI slots 7 8 8 8 8 8 8
Package Bundle
No of SATA / PATA Cables Provided 3/0 4/1 2/1 4/2 4/1 2/1 4/1
Accessories - - - - - Switch Card Molex to SATA power x2
PC Mark 05
CPU 10282 10271 10266 10291 10366 10277 10262
Memory 6210 6288 6152 6481 6795 6797 6136
Graphics 23353 13500 14695 14929 15201 14573 14832
HDD 8803 8760 8806 8745 8835 8771 8717
Overall 10097 9917 10109 10367 10275 10376 10145
ScienceMark (Memory Bandwidth) 9064 9616 8358 6905 9779 9493 8788
3D Mark Vantage
CPU 37184 35584 35927 36578 36778 35952 36780
GPU 6959 6756 6958 6956 6990 6917 6952
Overall 8734 8471 8715 8722 8764 8667 8720
Cinebench R10 11134 11094 11056 11150 11162 11074 11104
WinRAR 3.8 2363 2371 2210 2293 2388 2352 2248
DivX Video Encoding (100 MB VOB) (sec) |31 30 30 32 30 30 31
Sequential File Transfer (8 GB File) (sec) [163 166 161 165 170 161 165
Random File Transfer (8 GB File) (sec) 193 186 188 190 192 189 189
STALKER Clear SKy (1280 x 1024, low) 79 76.1 78.2 80.1 799 79 78.5
Crysis (CPU - 1024 x 768, low) 68 61 64 68 67 64 67
Crysis (Graphics - 1280 x 1024, high) 45 42 44 44 44 44 45

would be a great HTPC board
but it comes with no HDMI
port. The only PCle x1 slot
would be useless because of the
first PCle x16 slot.

This entry-level Jetway

PN78VM2-LF runs on the

GeForce 8100 chipset yet packs
a punch for its low price. Even
though it’s a basic board, a big
metal plate at the back ensures
the board doesn’t flex. There

are the solid-state capacitors

in the important regions of the
board. The heat sink is made

of thin gauge aluminium but it
works rather well for this chip.
There’s also a HDMI port built

into it which makes this board
ideal as a base to build a HTPC
on. The only PCle slot is above
the primary x16 slot. The high
heat sink completely comes in

the way of the slot.

100| Digit | October 2009 | www.thinkdigit.com




OCTOBER 2009

OCTOBER 2009

Integrated Graphics Core 2 Duo Boards
Brand Biostar ECS Jetway MSI
K9N2 SLI Platinum |K9N2 Diamond Model No. G41D-M7 G41T-M2 143GM1-HG G43M2
Rs. 7,500 Rs. 9,500 Price (Rupees) Rs. 2,800 Rs. 3,585 Rs. 3,300 Rs. 6,400
66.01 66.23 overall (Out of 100) 4473 44.62 53.89 44.15
39.44 40.99 Features (Out of 70) 19.86 19.04 28.26 18.45
26.57 25.24 Performance (Out of 30) 24.87 25.58 25.63 25.70
AMD 750a SLI NVIDIA 780a SLI Chipset Intel G41 Intel G41 Intel G43 Intel G43
AM2+ AM2+ Socket LGA775 LGA775 LGA775 LGA775
750a SLI 780a SLI Northbridge / Southbridge G41 / ICH7 G41/ ICH7 G43 / ICH10 G43 / ICH10
DDR2 DDR2 Memory Type DDR2 DDR2 DDR2 DDR2
Max Memory Supported (GB) / No of DIMMs 8GB/2 8GB/2 8GB/2 4GB/2
e el No. of SATA / IDE Ports 4/1 4/2 6/0 4/1
6/2 6/2 E-SATA Support / No of E-SATA Ports N/O N/O N/O N/O
Y/2 Y/2 No of PCI Express x16 graphics slots 1 1 1 1
2 3 No. of PCI / PCI x1 / PCI x4 Slots 1/0/0 1/2/0 1/0/0 2/1/0
2/1/0 2/1/0 Multi GPU Support (SLI/CrossFire/N) / No of N N N N
PCle Lanes
v/2 Y/3 ; Realtek
- - Integrated Audio Controller Realtek ALC662 ALC662 Realtek ALC888 Realtek ALC888
Realtek ALC888 Creative SB X-Fi Xtreme
8 8 Number of Sound channels 6 6 8 8
N/Y N/N SPDIF / Optical Port N/N N/N Y/N N/N
1/ Gigabit 2 / Gigabit No of LAN Ports / 10/100 / Gigabit 1/ Gigabhit 1/ Gigabhit 1/ Gigabit 1/ Gigabhit
N N Integrated Wi-Fi (Y/N) N N N N
4/1 a/1 No. of rear USB / FireWire Ports 4/0 4/0 4/0 4/1
v v All Solid State Caps (Y/N) N N N N
BIOS options
14518 Default ~ 1.8 CPU voltage range (volts) N/A N/A N/A N/A
0.025 0.025 CPU Voltage increments N/A N/A 0.05 N/A
19~24 1.8-~25 Memory voltage range (volts) NA N/A 1.85 ~ 3.285 N/A
0.05 0.05 Memory Voltage increments 0.1 N/A 0.03 N/A
Board Layout (So 10)
8 7 Region around the CPU 8 8 8 7.5
75 7 Location of SATA ports 7.5 75 8 8
8 8 Placement of Memory modules 7.5 75 8 8
8 8 Graphics card slot and PCl slots 6.5 7 7.5 7
Package Bundle
4/2 6/1 No of SATA/ PATA Cables Provided 1/1 1/1 2/0 1/1
. . - Accessories - - - -
Dvi-to-HDMI con- | X-Fi Extreme Audio
verter, USB/Firewire card, USB/Firewire
bracket, SLI bridge, |bracket PC Mark 05
CPU 9575 9573 9636 9658
Memory 6037 6091 6235 6280
10258 10273 Graphics 3283 3405 2750 2705
6228 6236 HDD 8714 9923 8824 8835
20022 14710 Overall 7681 7727 6686 6686
8808 8627 ScienceMark (Memory Bandwidth) 5691 5798 6050 6012
12306 9985 CINEBENCH R10 (CPU) 11778 11658 11393 11750
9584 9795 WinRAR 3.8 1818 2086 2124 2063
DivX Video Encoding (100 MB VOB) (sec) 32 31 31 31
36475 35818 Sequential File Transfer Test (8 GB File) (sec) |180 163 172 179
7056 6912 Random File Transfer Test (8 GB File) (sec) 194 193 210 193
8838 8659 Doom 3 FPS (800 x 600, medium detail) 18.1 19.4 17.5 17.4
11054 10998 3D Mark 2006 (CPU / Overall) 3961/ 854 4036 / 855 4015 / 1142 4134 /1130
2251 2393 Company Of Heroes (1024 x 768, lowest) 23.03 22.6 269 28.2
30 30
171 166 rather respectable scores Some of the boost is from the a similar. With dropping
194 233 across all fields. They also game benchmarks while the prices, these boards along
78 79 have the advantage of being biggest contribution comes with the older AMD 780G
68 7 cheaper than equally well from memory benchmarks and although slightly slower in
A 43 performing boards for the file compression benchmarks. graphics benchmarks are
Intel platform which is why in The ASUS M4A785TD-V EVO comparable with the rest of
Performance general AMD based systems leads the charts overall for the benchmarks. Prices too

are much lower than better
performing AMD 785G boards.

So, what'’s the best?

We have a clear leader in every

sheer performance. NVIDIA
hasn’t released any more AMD
chipsets in the meantime. The
GeForce 8200 boards from
Jetway and ZOTAC present

For boards with onboard
graphics solutions, the
performance can be a concern
for some. The boards available
for AMD processors have

are suggest for those who are
on a really tiny budget. We see
anew trend this time around
where AMD 785 boards leave
the older AMD 780 behind.
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Intel Discrete Graphics Core 2 Duo Boards
Model No. Maximus Il Gene  |P5Q Premium 3;%3@”:'“"9 striker Il NSE TPOWER 145 EP43T-UD3L
Price (Rupees) Rs. 17,850 Rs. 18,250 Rs. 17,900 Rs. 19,750 Rs. 7950 Rs. 6,700
Overall (Out of 100) 70.92 76.57 79.27 68.73 70.33 62.10
Features (Out of 70) 44.33 50.25 53.05 43.48 44.04 36.14
Performance (Out of 30) 26.59 26.32 26.22 25.25 26.29 25.96
Chipset Intel P45 Intel P45 Intel P45 AMD 790i SLI Intel P45 Intel P43
Socket LGA775 LGA775 LGA775 LGA775 LGA775 LGA775
Northbridge / Southbridge Intel P45 / ICH 10R  |P45 / ICH10R P45 / ICH10R 790i SLI P45 / ICH 10R Intel P45 / ICH 10
Front Side Bus Speed (MHz) 1600 1600 1600 1600 1600 1600
Memory Type DDR2 DDR2 DDR3 DDR3 DDR2 DDR3
Max Memory Supported (GB) / No of DIMMs 16 GB/ 4 16 GB/ 4 16 GB/ 4 8GB/4 8GB/4 8GB/4
No. of SATA / IDE Ports 7/1 10/1 8 /1 6/1 6/1 6/0
E-SATA Support / No of E-SATA Ports Y/1 Y/1 Y/1 Y/2 Y/2 N
No of PCI Express x16 graphics slots 2 4 3 3 2 1
No. of PCI / PCI x1 / PCI x4 Slots 1/1/0 2/1/0 2/2/0 2/1/0 2/2/0 2/4/0
Multi GPU Support (SLI/CrossFire/N) / No of PCle Lanes|Y Y Y Y Y N
Integrated Audio Controller SupremeFX X-Fi ADI AD2000B ADI AD2000B SupremeFX I Y Y
Number of Sound channels 8 8 8 8 8 8
SPDIF / Optical Port N/Y Y/Y Y/Y Y/Y Y/Y Y/Y
No of LAN Ports / 10/100 / Gigabit 1/ Gigabit 4 / Gigabhit 2 / Gigabit 2 / Gigabit 1/ Gigabit 1 / Gigabit
Integrated Wi-Fi (Y/N) N N Y N N N
No. of rear USB / FireWire Ports 6/1 10/1 6/1 6/1 6/0 8/0
All Solid State Caps (Y/N) Y Y Y N Y Y
BIOS options
CPU voltage range (volts) 0.85~2.4 0.85 ~ 2.10 0.85 ~ 2.10 11~24 o205 @5~ 20
CPU Voltage increments 0.00625 0.00625 0.00625 0.025 0.05 0.00525
Memory voltage range (volts) 1.8~34 1.8 ~3.08 1.5~278 1.5~3.1 1.888 ~3.7 1.1~2.76
Memory Voltage increments 0.01325 0.02 0.02 0.02 0.05 0.02
Board Layout (So 10)
Region around the CPU 8 7.5 7.5 8 8 9
Location of SATA ports 9 8 8 7 9 8
Placement of Memory modules 9 7.5 7.5 7 8 7
Graphics card slot and PCI slots 8 7 7 7 7 7
Package Bundle
No of SATA / PATA Cables Provided 4/1 8/2 8/2 6/2 6/1 1/1
Accessories LED poster Cooling fan ‘é\géfi'n?gnftaegna' If-aErEgg[S)tri%Ce%(;(“ng Cooling fan -
Audio card
PC Mark 05
CPU 9658 9671 9658 9624 9662 9641
Memory 6641 6646 6630 6534 6580 6523
Graphics 15370 15381 15567 20103 15373 15062
HDD 8850 8820 8851 8292 8778 8859
Overall 9501 9413 9484 8995 9407 9349
ScienceMark (Memory Bandwidth) 6746 6897 6688 6623 6679 6524
3D Mark Vantage
CPU 38132 38918 38582 36857 37157 37112
GPU 6976 7078 7001 6984 6967 6978
Overall 8766 8898 8802 8759 8743 8755
Cinebench R10 11711 11502 11847 11701 11828 11721
WinRAR 3.8 2570 2557 2530 2121 2518 2334
DivX Video Encoding (100 MB VOB) (sec) 29 32.2 33.1 32 30 30
Sequential File Transfer Test (8 GB File) (sec) 172 171 162.8 174 175 179
Random File Transfer Test (8 GB File) (sec) 192 189.1 193.3 202 196 198
STALKER Clear SKy (1280 x 1024, low) 80.7 81.1 81.2 78 78.8 78.7
Crysis (CPU - 1024 x 768, low) 69 85 84 72 73 72
Crysis (Graphics - 1280 x 1024, high) 45 45 42 45 45 45

category — it’s for you to decide
the budget you have and what
you need from your system.
For the Core i7 processors, we
strongly believe that the ASUS
Rampage Il Extreme is the

board to go for if price isn’t an
issue. At Rs. 28,500, it’s a lot
to pay for a board and it takes
the budget of an Intel Core i7
system very high. The Biostar
TPower X58 shockingly is the

next in the line. It might not
come with too many fancy
audio card modules but is a
really solid board for its price.
This board just like any other
enthusiast board has features

not just on the board but also
in the BIOS and in the way the
board is laid out. It matches the
smaller version of the Rampage
11 Extreme — the Rampage 11
Gene. Going away from the
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EP45-UD3R DX48BT2 P43 Neo3 P45 Diamond  |P45 Neo2 X48C Platinum (790i Ultra nForce 780i SLI  (790i Ultra SLI
Rs. 13,000 Rs. 11,500 Rs. 5,500 Rs. 10,800 Rs. 6,300 Rs. 10,500 Rs. 22,000 Rs. 11,500 Rs. 16,000
6591 61.20 57.68 72.56 64.69 66.35 6214 65.42 63.15

40.01 35.16 31.82 46.61 3896 4034 4034 40.27 41.39

2590 26.04 25.86 25.95 25.73 26.01 21.80 25.15 21.76

Intel P45 Intel X48 Intel P45 Intel P45 Intel P45 Intel X48 NVIDIA 790i SLI [NVIDIA 780i SLI__ [NVIDIA 790i SLI
LGA775 LGA775 LGA775 LGA775 LGA775 LGA775 LGA775 LGA775 LGA775

Intel P45 / ICH 10R Intel X48 Intel P4S/ICH — intel P45 /1CH  |Intel P45 /ICH | intel xa8 / ICH9R 790 s 780i SLI 790i SLI

1600 1600 1600 1600 1600 1600 1600 1333 1600

DDR2 DDR3 DDR2 DDR3 DDR2 DDR2 & 3 DDR3 DDR2 DDR3

16GB/ 4 8GB/4 16GB/4 8GB/4 16 GB / 4 S o)/ |sc/a 8GB/4 8GB/4

8/1 6/1 8/1 6/1 8/1 4/1 6/0 6/1 8/1

N Y/2 N Y/2 N Y/2 Y/1 N N

1 2 1 2 2 2 3 3 3

3/3/0 2/0/1 4/1/0 2/2/0 2/2/0 3/2/0 2/2/0 2/1/0 2/2/0

N Y N Y Y Y Y Y Y

Y Y Y Y Y Realtek ALC888 [N/A N/A N/A

8 8 8 8 8 8 8 N/A N/A

Y/Y Y/Y N/N N/Y N/N N/Y Y/Y N/Y Y/Y

1/ Gigabhit 1/ Gigabit 1/ Gigabit 2 / Gigahit 2 / Gigabit 1/ Gigabit 2 / Gigabhit 2 / Gigabhit 2 / Gigabhit

N N N N N N N Y Y

8/1 8/2 4/0 8/1 6/0 8/2 6/1 6/1 6/1

Y N Y Y Y Y N N N

05~ 23 1.2875~1.6 0.833 ~ 2.0175 0.886 ~ 1.8551 09111 ~ 1.888 1.25 ~ 2.025 0.5125 ~ 2.0 0.5~ 1.8 0.5125 ~ 2.0
0.00525 0.0125 0.0125 0.01 0.01 0.0125 0.0125 0.00625 0.0125

1.45 ~3.04 1.5~25 1.4 ~3.324 WO =~ 277 1.416 ~ 3.324 13 = 27/5 3= 2213 8= 203 3 = 2213

0.1 0.04 0.012 0.01 0.012 0.04 0.025 0.025 0.025

8 7 7 7 8 7 6.5 7 6.5

9 7.5 9 9 6.5 8 8 8

9 8 9 8 8 8 8 8 8

6.5 7 8 7 7 8 75 7.5 75

4/1 1/1 1/1 4/1 4/1 4/2

- - - X-Fi audio - - - Wi-fi fit, cooling fan |-

9625 9619 9661 9652 9647 9639 9627 9615 9636

6378 6482 6407 6532 6252 6308 6801 6661 6874

15375 15082 14729 14716 14738 14895 14269 14341 13626

8775 8729 8821 8812 8774 8748 8219 8270 8113

9341 9336 9256 9281 9150 9284 9122 9114 9205

6337 6482 6436 6688 6600 6706 7192 6733 6820

36420 38935 37101 36183 35575 36910 N/A 36453 N/A

6975 6962 6980 6947 6958 6983 N/A 6941 N/A

8742 8760 8757 8705 8709 8759 N/A 8703 N/A

11650 11643 11798 11759 11614 11859 11493 11795 11211

2302 2365 2321 2372 2448 2289 2474 1819 2446

30 30 30 30 31 30 32 31 31

175 175 182 180 177 172 177 175 178

194 193 192 192 200 192 200 204 210

78.4 80.2 76.9 76.9 76.8 79.2 78 80 80

70 71 70 71 72 71 77 72 74

45 45 45 44 44 44 44 44 44

scores, we like the DFT UT especially now for Core i7 . P5Q3 Deluxe WiFi @n followed board and then use the same
Lanparty X58 board as well. boards. by the ASUS P5Q Premium. DDR3 modules for a Core i5
It’s a good overclockers board For those who are upgrading : The P5Q3 Deluxe comes with or i7 processor. The MSI P45
in our opinion and the bundle to faster Intel Core 2 powered a Wi-Fi module and also runs Diamond lags a little bit behind
and design is also something systems, the best offering comes on DDR3. Those with larger these two boards but it’s also
new in motherboards and from ASUS once again —ASUS ~ ©  budgets can go in for this priced a lot lower. Biostar makes
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Model No. P6T Deluxe Rampage Il Extreme |Rampage Il Gene |Tpower X58 UT X58 Lanparty
Price (Rupees) Rs. 24,000 Rs. 28,500 Rs. 17.850 Rs. 12,500 Rs. 19,500
overall (Out of 100) 71.47 75.94 72.02 72.51 65.73
Features (Out of 70) 45.59 49.89 45.63 46.67 39.42
Performance (Out of 30) 25.88 26.05 26.39 25.84 26.31
Chipset Intel X58 Intel X58 Intel X58 Intel X58 Intel X58
Socket ‘LGA1366 LGA1366 LGA1366 LGA1366 LGA 1366
Northbridge / Southbridge Intel X58 / ICHIOR |Intel X58 / ICHIOR Intel X58 / ICHIOR |Intel X58 / ICH10R X58 / ICH10R
QPI (GT/s) 6400 6400 6400 6400 6400
Memory Type DDR3 DDR3 DDR3 DDR3 DDR3
Max Memory Supported (GB) / No of DIMMs 24GB/ 6 24GB/6 24GB/ 6 24GB/ 6 24GB/ 6
No. of SATA / IDE Ports 6/1 (2SAS ports) |7/1 7/1 6/1 8/2
E-SATA Support / No of E-SATA Ports Y/1 Y/1 Y/1 Y/2 N
No of PCI Express x16 graphics slots 3 2 2 2 3
No. of PCI / PCI x1 / PCI x4 Slots 2/0/1 1/2/0 1/0/1 2/1/0 2/0/1
Multi GPU Support (SLI/CrossFire/N) / No of PCle Lanes Y Y Y Y Y
Integrated Audio Controller ADI AD2000B SupremeFX SupremeFX Y Y
Number of Sound channels 8 8 8 8 8
SPDIF / Optical Port Y/Y Y/Y N/Y Y/Y Y/N
No of LAN Ports / 10/100 / Gigabit 2 / Gigabhit 2 / Gigabhit 1/ Gigabit 2 / Gigabhit 2 / Gigabhit
Integrated Wi-Fi (Y/N) N N N N N
No. of rear USB / FireWire Ports 8/1 6/1 6/1 8/1 6/1
All Solid State Caps (Y/N) Y Y Y Y Y
BIOS options
CPU voltage range (volts) 0.85 ~ 2.1 0.85+~2.5 0.5~25 N/A 1.06255 ~ 1.6
CPU Voltage increments 0.00625 0.00525 0.00525 0.02 0.05005
Memory voltage range (volts) 1.2~19 1.51~2.5 1.51~2.5 1.5~ 2.760 1.455~2.4
Memory Voltage increments 0.00625 0.01 0.01 0.02 0.015
Board Layout (So 10)
Region around the CPU 8 7.5 8 8 7
Location of SATA ports 9 9 9 9 8
Placement of Memory modules 8.75 9 9 8
Graphics card slot and PCI slots 7.5 7 7 7.5 7.5
Package Bundle
No of SATA / PATA Cables Provided 2,1 6/1 4/1 6/1 4/0
Accessories - %ggg:gf&:gg;im‘fx' LCD poster - -
PC Mark 05
CPU 11005 11003 11011 10955 11391
Memory 10447 10248 10562 10243 9930
Graphics 15801 15637 15660 15584 22248
HDD 3914 8578 8880 8890 8679
Overall 10419 10040 10724 9899 10656
ScienceMark (Memory Bandwidth) 13959 14328 14324 14103 13882
3D Mark Vantage
CPU 43090 43918 45389 44161 45177
GPU 6936 6973 6943 6935 7042
Overall 8777 8830 8808 8787 8926
Cinebench R10 16048 15490 15917 16010 16307
WinRAR 3.8 4779 4722 4734 4752 4530
DivX Video Encoding (100 MB VOB) (sec) 20.3 18 19 19 19
Sequential File Transfer Test (8 GB File) (sec) 168.1 174 172 174 168
Random File Transfer Test (8 GB File) (sec) 194.8 191 180 181 199
STALKER Clear SKy (1280 x 1024, low) 79.5 84.9 83.3 83.7 83.1
Crysis (CPU - 1024 x 768, low) 93 83 82 82 96
Crysis (Graphics - 1280 x 1024, high) 44 45 45 44 45
its appearance once again with decent board to build a system the ASUS M4A785TD-V EVO The ECS A785GM-M is another

one that ties with the ASUS
M4A785TD-M EVO. Biostar’s
TA785GE is the cheapest
785G offering of the lot. Those
wanting to build the cheapest
HTPC or even an everyday-use

its rather inexpensive offering
— the TPower 145 at Rs. 7,950.
Those who want an Intel board
with integrated graphics should
look at the really cheap Jetway
[43GMI-HG. At Rs. 3,300, it’s a

around. It’s got a BIOS that’s
better than what the other
boards in its group had to offer.
Performance isn’t too shabby
either.

For the AMD processors,

stands at the top right ahead
of M4A785TD-M EVO. In
performance, they're almost
the same. They also happen to
be some of the cheaper boards
based on the AMD 785 chipset.
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Motherboard test

EX58-Extreme |EX58-UD3R EX58-UD5 DX58S0 X58 PRO X58M X58i X58

Rs. 21,500 Rs. 14,500 Rs. 17,500 Rs. 12,800 Rs. 12,500 Rs. 10,500 Rs. 13,250 Rs. 12,500

70.71 66.70 68.52 63.09 69.80 63.67 68.96 58.77

4474 41.10 42.74 37.16 43.99 40.73 4490 34.43

25.97 25.90 25.78 25.93 25.81 2294 24.06 24.34
- r ¢ [ [ |

Intel X58 Intel X58 Intel X58 Intel X58 Intel X58 Intel X58 Intel X58 Intel X58

LGA1366 LGA1366 LGA1366 LGA1366 LGA1366 LGA1366 LGA1366 LGA1366

:gheIIOXSS/ Intel X58 / ICH10R Intel X58 / ICH10R Intel X58 / ICH10R Intel X58 / ICHIOR |Intel X58 / ICH10R Intel X58 / ICH10R Intel X58 / ICH10R

6400 6400 6400 6400 6400 6400 6400 6400

DDR3 DDR3 DDR3 DDR3 DDR3 DDR3 DDR3 DDR3

24 /6 16 GB/ 4 24GB /6 16 GB/ 4 24GB/ 6 24GB /6 12GB/ 6 24GB/ 6

6/1 8/1 10/1 6/0 7/1 6/1 6/1 6/1

N N N Y/2 Y/1 Y/1 Y/2 N

2 2 2 2 2 2 2 2

2/1/1 2/2/1 2/1/1 1/2/1 2/2/0 1/0/1 2/1/0 2/1/0

Y Y Y Y Y Y Y Y

Y Y Y Y Y Y Y Y

8 8 8 8 8 8 8 8

Y/Y Y/Y Y/Y N /N N/Y N Y/Y Y/N

2 / Gigabhit 1/ Gigabit 2 / Gigabit 1/ Gigabhit 1/ Gigabhit 1/ Gigabhit 2 / Gigabhit 1/ Gigabhit

N N N N N N N N

8/1 8/1 8/1 8/1 6/1 6/1 6/1 4/1

Y Y Y N Y Y Y Y

0.5~19 0.5~19 0:5~19 1~1.6 0.9 ~19 09~19 N/A N/A

0.00525 0.00525 0.00625 0.0125 0.01 0.01 0.00625 N/A

13~2.6 1.3~2.6 13~26 1.5~25 1.2~2.77 149 ~2.77 1.0~1.6 N/A

0.02 0.02 0.02 0.04 0.01 0.01 0.01 N/A

8 8 8 9 8 8 8 9

9 9 9 7 8 9 9 9

9 9 8.75 9 9 8.5 9 9

6.5 6.5 7 7 7.5 6.5 7.5 7.5

4/1 2/1 4/1 4/0 4/1 4/1 4/2 4/1

Additional heat- ; Cooling fan, Ghost Recon | ; : ;

sinks Advanced Warrior disc

11096 10959 11551 11405 10981 10977 10918 10936

10502 10330 10707 9843 10268 10280 9942 10082

15817 15773 15694 14344 15640 15678 15614 15423

8879 8885 8769 8513 8842 8857 8743 8866

10078 9992 10241 10175 10047 9833 9814 10136

14070 13629 14004 14404 13943 13941 13821 13113

45582 45297 45655 43881 44669 44938 43451 43765

6941 6938 6940 6932 6938 6937 6934 6948

8808 8801 8807 8780 8795 8797 8779 8799

15873 16198 16803 15756 15852 15953 15942 15898

4697 4517 4639 4747 4747 4740 4574 4370

18 18 20.7 19 19 20.6 20 19

185 178 165.9 172 186 165.4 171 174

190 185 195.6 194 185 193.2 193 190

84.3 82.8 78.9 84.6 84.1 N/A 83.5 82.7

80 82 95 80 84 100 79 78

44 44 44 45 45 44 44 45

desktop PC should consider
it. It even uses DDR2 memory
which is extremely cheap at the
moment.

Those who want to build
systems based on the faster for
CrossFire, AMD’s 790FX and

790GX chipsets can be used.
NVIDIA too has the nForce
780a and 750a chipsets. In

our test, we see ASUS, MSI and
Gigabyte leading the charts.
The ASUS M4A79T Deluxe
which is almost at the end of its

life tops the chart. MSI’s KON2
Diamond powered by the
NVIDIA 780a chipset follows.
There are many factors that
govern what kind of system you
build and what processor you
go for. Prices will almost always

continue to fall depending

on several conditions. Once
you've decided the budget and
what processor you're going in
for. As it stands today, AMD’s
motherboard-processor make a
great low cost combo El
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Workshop

Stayinvisible.com

Gives you a list of proxy servers and
tools such as proxy checkers, IP
verifiers, and email testers for testing
whether you are indeed anonymous

Socially anonymous
According to a researcher at Worcester
Polytechnic Institute, companies can track
your surfing habits from social networking

web sites

Workshop on
Anonymous Browsing

Mohamed Rameez
readersletter@thinkdigit.com

nonymous browsing
is the process of
browsing the internet
while keeping
any personally identifiable
information secret. With the
help of the IP address, the
physical location of your
computer can be determined,
indirectly leading to the
revelation of your identity.
When you browse without
anonymous browsing tools

observer is unable to track

from the source to the user.

There are two basic methods

to browse anonymously. These

are

1.Web based proxy services
such as https://www.
snoopblocker.com.

2.VPN and proxy clients such
as Tor and Hotspot shield.

A web based proxy

service such as https://www.

snoopblocker.com works by

having a web server as an

intermediary between a user

and a web server. Users are

Google through snoopblocker

through a standard internet
service provider, your
computer is identified via an
IP address, and sends out a
request to the server on which
the web page is served. The
basic principle behind all
anonymous browsing

connected over a secure 128
bit SSL connection.

On snoopblocker.com, the
central field is where you
should type the address of the
web site you wish to browse.
After this has been done, click

on ‘surf!’ to visit the webpage.
Also, there are several fields
that you check or uncheck
depending on your needs.
eJava: Checking this enables
web deployed Java-based
applications such as Java
applets, programmes such
as stock tickers or even new
Gmail and Hotmail versions
to run through snoopblock.
However, these programmes
can gather significant
information and

displayed. However, you will
notice that to each webpage,
snoopblock.com adds a frame
on top with advertisements
on it.

The second popular method
for browsing the internet
anonymously is the usage
of virtual private network
clients such as Tor, Java Anon
Proxy and Hotspot shield.

We will look at how to install
Tor, which is available for

hence compromise
on your
anonymity.

e Javascript:
Javascript is
required to run
most modern
web pages. The
drawbacks of
enabling this are
similar to that of
enabling Java.

* Cookies:
Cookies enable
the webpage to
perform certain
essential web-
based functions
such as keeping

the user signed
in at all times and
remembering his
browsing record. However,
some malicious web sites
post cookies known as
tracking cookies, which
gather information about your
activities.

o Active X : Allows

tools is the routing of
communications through
a third server that is
committed to protecting
the identities of the end
user. Hence, anonymous
browsing is basically

the art of routing web
page requests and other
packet information over
the internet over various

Microsoft active X content
to be displayed. Poses

no major threats to
anonymity buy may slow
down the loading process
due to higher bandwidth
requirements.

After ticking the
required options, entering
the required address and
clicking the ‘surf!’” button,

lines so that an external

the requested page is

Vidalia comes with added flexibility

download from www.torproject.
org as a 10-MB file. The bundle
contains four components,
namely Tor, Vidalia, Privoxy
and Torbutton.

Tor is the basic tool that
helps in setting up a VPN node
on your computer so that you
may connect to other users of
Tor for anonymous browsing.
Tor being a command line tool,
it is supplied with Vidalia, a
Graphic User Interface utility
that allows you to quickly and
easily set up Tor and get it
running.

Privoxy is a filtering tool
that monitors every web page
and other internet service
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Chrome Filter

According to its End User Lincence Aggreement,
Google reserves the right pre-screen, review,
flag, filter, modify, refuse or remove any or all

Content from any service

Private on Android

A University of Cambridge student
has come up with two apps that
allow you to browse anonymously on
Android-based phones

Workshop

request from your computer
and filters it off all personal
data, adding an extra layer of
anonymity. Torbutton is an
add-on toolbar for Mozilla
Firefox that allows you to
quickly turn anonymous
browsing on and off, without
having to go to Tor.

Privoxy and Torbutton are
optional while you will find
that Vidalia simplifies the
job of getting Tor running
to such a large extent, you
would prefer to install it.

The Vidalia Control
Panel

Once installed, the Vidalia
control panel appears in the
system tray (a yellow onion
icon while connecting, black
when not connected and
green when fully connected).
Double-clicking on this opens
the control panel.

To start Tor, one must click
the Start Tor button on the
control panel. Once clicked,
it starts connecting to Tor.
Various status messages are
displayed till the green bar
reaches full, at which point
you are completely connected
to Tor and the status changes
to “Connected to the Tor
network”. At this point,
you may start browsing the
internet and all your actions
will be anonymous.

If you have difficulty
connecting, or the progress
of the green bar is too slow,
it may be due to the fact that
your ISP requires you to use a
proxy, or you may be part of
a local area network in which
the local computers connect
to the internet through a
local proxy. If this is the case,
click on the ‘settings’ button,
go to the ‘Network’ Tab and
tick I use a proxy to
access the internet. In
the fields that appear upon
the ticking of this option, you
have to provide the proxy
information given to you by
your ISP. Tick/Untick the
remaining options as per
your preferences.

The “Use a New identity”
Button on the Vidalia control
panel changes your IP
address on the Tor network
in such a way that any

their requests. This

is a process called
relaying. This can be
done by clicking on
the “Set Up relaying”
button on the Vidalia
control panel. In the
menu that pops up,
you are given three
options. While you
can choose to remain a
passive user of the Tor
services by choosing
the first option (Run
as client only), the
second option (Relay
Traffic for the Tor

These settings make you a participating member of the
Tor network tings

new browsing/other service
request you make appears as
if it is coming from a totally
new computer. This provides
you with an added level of
anonymity.

These settings make you a
participating member of the
Tor network.

Now you know how to

enjoy anonymous browsing
using Tor. However, your role
in the Tor network is not just
limited to this. As you know,
the anonymity of Tor users

is maintained by rerouting

the communications around
the network through its
various nodes until it becomes
untraceable. You may choose
to help Tor network by making
your computer a node through
which others can route

network) makes

you a full part of the
Tor network. This
makes your computer a node
through which other users
may browse anonymously.
You are encouraged to use
this option as it is through
other volunteers like you that
you are able to utilise the Tor
network. If you choose the
second option you are given
the option of specifying what

Give us your feedback at
www.thinkdigit.com/d/oct09

type of connections is allowed
through your computer. You
may also choose to give an
anonymous email id. You
may also set bandwidth limits
on the connections routed
through your computer.

The third option, (Help
Censored users reach the
Tor network) makes your
computer an encrypted Node
of the tor network so that
anyone (Maybe an ISP) trying

to impose content restrictions
upon one of the Tor users
routed through your computer
fails in his schemes.

To view a list of computers
that are connected through
you and computers that you
connect to Tor through, click
the “View the Network” button
on the Vidalia control panel.

A word of caution
Anonymous browsing
remains anonymous only

due to the commitment on
the part of providers such as
snoopblocker.com, the various
computers on the Tor network
to keep it anonymous. Every
time you make a connection
request to these servers /
computers in order to access

a web site or a file on the
internet, these activities are
logged. However, these logs
are kept secret as a matter

of principle by these very
providers.

Many programs available
on the internet claiming
to be tools for anonymous
browsing are exactly opposite
of that - they compromise your
security and assist individuals
in perpetrating crimes such as
identity theft.

Also, the providers maintain
the services and their assurance
of anonymity only because of
a belief in the right of every
individual to have online
privacy (and commercial
interests). Any attempt at
misusing this anonymity and
freedom given to you online
for malevolent purposes
(stalking, blackmail, anything

illegal) could adversely affect
that commitment. It is also
possible for an individual

to have a court subpoena
the connection records of a
server to obtain user specific
information, if the court is
convinced that the network
has been used for illegal
purposes.

All said and done,
anonymous browsing is
mainly a boon, especially to
our oppressed brethren in
countries such as China and
the Middle Eastern ones,
where content control and

A list of all users you are connected to, and are connected to you

censoring are a very real part
of life Fll
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Drive fast

Toshiba has added a new 500 GB, 2.5-inch
laptop hard drive with a two-spindle
design that runs at 7200 rpm

Blink and you’ll miss it

That's how fast ‘Lightning’ is and that’s
the name of the new enterprise SSDs
from Pilant Technology

Backup your drive

Siddarth Raman

readersletters@thinkdigit.com

acking up your hard
drive is always advised.
A good software that
does the trick is Drive
Backup from Paragon. You can
download a trial version for free
at http://www.paragon-software.

com/home/db-express/download.

html..

After you install and register
the installation, restart your
system. As a word of caution, if
you have large volumes of critical
data, you should back it up in
phases rather than copying
all your data at once. Check
your operating system for any
infections or malware. Click on
Back up Disk or Partition to get
started. Select the Master Boot
Record (MBR) and the main
drive (C: for most users).

Check for two important
figures - the size of source, and ,
the destination location. Ensure
there is sufficient space to store
the image of the data.

The next view asks you to
select where you want to store
your image file - the backup
destination page. You may also
store the image on the drive you
are backing up. The program
excludes that location from
the backup location in order to
avoid ending up in an infinite

Simple Backup Wizard

recurrence. While recovering
the image, you should select a
different destination location.
You cannot recover the drive
from itself. It can also be stored
on computers that are available
on connected networks.

The whole backup process
takes time depending on the size
of the image. Once it’s done, click
Finish. Click on Check Archive
Integrity. Select any of the listed
archives, click next. This could
take some time depending on
the size of the archive.

Before you restore your drive,
you must specify your recovery
media. If you plan to restructure
your operating system, you need
to reboot from somewhere. On
the first screen, click on Build

Recovery Media.
You can build and store the
recovery media either on Flash

only on CD/DVD. It allows you
to add extra files and folders
(assuming you have space). Click
Next and soon your recovery
disk / pen drive will be ready

for use.

Coming to the restoration
part, reboot your system with
the disk or USB drive in place
after setting the appropriate boot
sequence from the BIOS settings.

Launch the Simple Restore
Wizard by double clicking on it.
Browse to the image you’d made
earlier. The next window allows
you to examine the properties
of your image, such as size and
available free space. Click next.
Now, choose the disk you'd
like to restore. The last page of
the recovery wizard will give
you an option to review all your

Recovering your partition - the launch screen

memory (Pen-drive) or on a CD/
DVD option; boot from USB is
the most convenient. Choose
your option, click next. The first
option is Typical. Use this if

you want to accept the default
recovery package and start
burning the disk. It will build

a Linux-based boot disk with a
minimal set of tools for restoring
your image. Advanced is available

proposed changes before
it starts destroying data. Click
next to begin the restoration
process. Hopefully, if everything
has gone on well, the progress
bar will eventually reach its end,
and you can click finish. Exit the
Wizard and restart your system.
If you have followed the correct
procedure, your current system
will be replaced with a pristine
version that you backed up. El

The welcome screen of DBE

Building Recovery Media
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Free fonts

1001freefonts.com, dafont.com and
urbanfonts.com are some of the many

sites that offer you free fonts

PC becoming slow

If you are experiencing a drop in
your PC performance, it could be
due to the number of fonts installed

Make your own font
(And more!)

Rasagy Sharma

readersletters@thinkdigit.com

ave you ever wanted

to make text appear

just like your

own handwriting,
but never found a font that
could do the trick? Is a little
personalisation all you need
to complete that card you just
designed, but all the handwriting
fonts seemed too common to
use? Here’s how to get your own
handwriting font using

The template used to create the font

First, head on to the web site
(www.fontcapture.com), click
on “Create your font now” and
download the font template
available as a PDF file. Print
this sheet and write on it with
your handwriting as directed
and then scan the sheet (use
200 dpi or higher). Save it as a
JPEG or PNG file and upload

it on the web site. Name the
font to identify it. You can then
download your own font!

1
A .
2

—lffgf—iﬁ;[w'aﬁeline

>*

Understanding parts of a font

The quality of the font
depends upon how you fill the
template sheet, so we should
keep a few things in mind. In
any piece of text (say “Digit”),
the baseline is the imaginary
line on which all the letters sit.
The uppercase letters fit between
baseline and (1) — which gives
us the cap height, whereas
most of the lowercase letters
are between baseline and (2) -
which gives us the x-height. A
few characters have ascender
and / or descender (like ‘d” and
‘g’ respectively), which may cross
the x-height.

The template has small
guide marks to roughly giving
you an idea about how high
the ascender can reach, the
baseline, and how low the

f

Ascender — |

Baseline —= |
Descender — |

Using markings in the template

descender can reach. Try and
keep the letters inside the top
and bottom lines to prevent
them from being cut off.

’Diﬂi't Digit

How x-height and baseline affect fonts

What makes a font look
different from another is how
the x-height and cap height
are varied. As evident in the
above example, the non-
uniform baseline and varied
x-height makes the font look
more like rough handwriting,
whereas uniform baseline and
nearly similar ascenders and
x-height will give the font a
smooth, pleasant feel. Also, for
making your font legible, use
a black marker / gel pen and
avoid using very thin strokes
throughout the font, though
a few elegant fonts do have
varying the stroke thickness.

After a few tries, you’ll be
able to get a font that nearly
looks like something you've
written on paper. But that isn’t
all you do with FontCapture. It
can represent alphabets using
anything that you fill in the
template sheet, which means
you can creatively use a few
characters that you don’t use
often to represent some special
symbols. In fact, you can use
your own symbols to represent

ey PLIGTT
VARV Pz’g/z'f oo 8383

What you can make using Font
Capture (Symbols/Emoticons)

Dyt f; ghx

What you can’t do with Fontcapture
(Overlapping/running hand/cursive
handwriting)

letters and send across coded
messages!

One of the main limitations
of FontCapture is the lack of
space: you can’t add fancy
frills to a character because
the template has a small fixed
space for each one of them.
Getting a running handwriting
font takes a while to master,
for which you must start and
end the characters at same
height. Also, you can’t have
overlapping characters or
even simple cursive characters
which might extend into
another character’s area,
which doesn’t leave much
room for creativity. But you
can still come up with many
interesting fonts. Possibilities
are endless! Fl
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Free Windows

Microsoft will give away free copies of
Windows 7 to chosen people in the US, during
the launch parties between October 22-29

A phone with XPerience

DIY

The xpPhone is a fully-featured, sliding QWERTY
cellphone with Windows XP as its operating

system!

Making Windows XP look
and feel like Windows 7

Want to enjoy the most talked about features of Windows 7, but don’t want to shift from good old

Windows XP? It’s time to get the best of both worlds, in only 30 minutes flat!

Rasagy Sharma
readersletters@thinkdigit.com

ven though many XP

users are still reluctant

to make the switch to

Windows 7, several
new features and innovative Ul
modifications make it nearly
impossible to resist. For all
those who still don’t want to
leave their good old XP (and
don’t want to install all their
applications all over again) there
are plenty of 3rd party software
to get the best features of
Windows 7 in Windows XP. In
fact, it won’t take more than 30
minutes to get most of them up
& running on your XP machine!

Before you get started, create

a system restore point, just in
case some application starts
acting a little funny. For this, go
to Start > All Programs
> Accessories > System
Tools > System Restore
to create one.

[00.00] Adding the
superbar

The Superbar minimises the
space taken by each application
instance by only displaying

the icon of the application and
grouping similar instances of

an application as one. You can
click on the icon to choose the
instances you want to open (Just

The new & improved Superbar in Windows 7 (Left), Superbar (with options) in XP

using ViGlance

click on the thumbnail to open it).
ViGlance doesn’t require
an installation. Just run the
software (And choose between
a few options) and you're
done. Right click on any of
the notification icons. Check
options to select animations
and other effects. You can also
drag and drop the icons, just
like you can in Windows 7.
Also, similar to Superbar, you
can pin items that might be
open so that their link stays on
the taskbar, even when they
aren’t open. Though ViGlance
at times doesn’t load the
thumbnails quickly, it surely
de-clutters your taskbar and
gives you a much more fun Ul!
If you're looking for more
flexibility or eye candy, try
out any dock software such
as RocketDock from http://
rocketdock.com/download.

SUPERBAR USING VIGLANCE

Taskbar.

7-Superbar-for-XP-104697395 ]

® Add more functionality to your Taskbar!
Link: http://www.lee-soft.com/viglance/

® Another alternative is to go for Windows 7 Superbar by Haran-
Hockey. This uses themes to change the behaviour of the Windows

[Windows 7 Superbar: http://haran-hockey.deviantart.com/art/Windows-
® Taskbaric is another small tool that allows you to show open windows

as icons on your taskbar, though it lacks other features of Superbar
[Taskbaric: http://sites.google.com/site/taskbaric/ ]

[05.00] Adding Task
switching Keys

Another feature of the
“Superbar” is that it allows you
to use combinations such as
Windows + [1] to open the first

© menu on the taskbar and so
- on. It cycles through all open

instances of the particular
application if it’s already open
otherwise starts the application.
To get this functionality, just
download ActivateByNum and
run it. It’s a small Autohotkey
script (If you use other

. Autohotkeys, you can just add
. the script as well).

Caution: One of the
problems with running both
ActivateByNum and ViGlance
together is that ViGlance
doesn’t change the order
of the taskbar items, which
means that you must not
drag the taskbar items or else

. ActivateByNum will not be able

to number the applications
correctly.

- [10.00] Splittin
1Windowspand 8

AeroPeek

With Windows 7 comes a new
set of shortcuts to arrange your
open windows. You can “snap”

. open windows to different
. edges of your screen, which

is helpful if you quickly want
to divide the screen into two
separate halves. This is done
with the Windows + Left or

. Right keys. Pressing Windows
-+ Space bar on the other hand,

displays the desktop by making
all applications transparent.
There are several applications
that allow you to get the same
functionality in Windows XP,

. but we'll just look at Windows

Split. With it’s range of options
the application is a delight

for any power user. Install the
software and check the list of
Shortcuts available. Also, it

i allows you to customise each
- split (Layout Settings) so you

can enjoy as much flexibility
as you want to. Download
this nifty app from http://
www.winsplit-revolution.com/

. download

' [15,00] Shaking off

all inactive windows
using AeroShake

Another Ul improvement that
was seen in Windows 7 is the

FOR KEYBOARD WARRIORS psss—

Keyboard switching through the taskbar with ActivateByNum
Description: Run ActivateByNum to switch to different application/
application instances by using the [Win+num] combination

Link: http://code.google.com/p/activatebynum/

Adding customizable Keyboard Shortcuts

Description: Use Autohotkey to write powerful scripts to do nearly
anything with your Windows, with just a few key press!

Link: http://www.autohotkey.com/download/
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Vaio plays spoilt-sport

Sony’s Vaio laptops will not be able to run Windows
7's “XP mode” because Sony disables the required
hardware virtualisation features on its laptops

Microsoft’s OEM charge
Microsoft recently revealed that it usually
charges around $50 for a Windows copy for a
$1000-PC built by an OEM

malke it easier to install.
http://www.deviantart.
com/download/106952053/
SevenVG_Refresh with_
Superbar by Vishal_Gupta.zip

® CAD 2009 EDITION v1.5
by Flawless: For getting
the Ctrl+Alt+Del screen in
Windows 7 style, download
this application. http://
flawless02.deviantart.com/
art/CAD-2009-EDITION-v1-5-
for-XP-132794740

® Border Skin by Komalo: This
only modifies the borders of
the applications to give it an
aero look. Though it has a
few bugs yet to be fixed, it’s
surely worth giving a shot!
http://komalo.deviantart.
com/art/Border-Skin-Aero-
Glass-0n-XP-119640021

Using the [Win+Right/Left] combination to place application on half the screen.

PowerToys from
Microsof

TweakUI allows you to change
many features that are generally
not available to customize in
Windows XP. Similarly, there’s a
Power Calculator for advanced
calculations (which beats even
the Windows 7 calculator in
functionality!).

PowerToys for XP: http://
www.microsoft.com/windowsxp/
downloads/powertoys/
Xppowertoys.mspx

Use the Windows + Space combination to hide applications and show the desktop

replacing is manual, so a
little time consuming. http://
dopeysneezy.deviantart.
com/art/Windows-7-
Complete-109505907

AeroShake feature. What it

does is simple: shake the active
window (the one you're using)
and it hides all other windows.

to Windows Vista, and there’s a
plethora of software and themes
available to give you a Vista or
Windows 7 like looks.

Shake it again and the windows
are back to where they were.
AeroShake software (Autohotkey
script) for XP does the same!
Pretty nifty replacement of the
Windows + [D] key used to

hide all windows, in case you
just want to hide other inactive
windows. And being another

Here are a few of the popular

themes, each offering a few
special features. There are also a
few complete “Transformation
Packs”, but they’re known to
have bugs and are at times
difficult to get rid of, so you
should probably avoid them!

Remember to first patch the

® Scven VG Theme by Vishal
Gupta: A very popular theme
by Vishal Gupta, who also
runs a blog with a lot of other
tweaks for Windows users
(http://www.askvg.com/).
Different parts of the themes
are available as setups, which

These were few of the several
third-party applications
available that bring the best
features of Windows 7 to your
Windows XP. Choose the
ones you need and enjoy the
pleasure of Windows 7 while
using Windows XP! Fl

AutoHotKey script, it take
very little RAM too. You can
also customize a few options
to choose number of shakes
and behaviour with Extended
displays.

uxtheme.dll file before installing
these new themes. Download
UXTheme Patcher from http://
www.softpedia.com/ (Search for
UX Theme, followed by your XP
Service pack number).

® Windows 7 Complete by

[25.00] Skinning your
Windows

This is something that need
not be covered in detail, as
Windows 7 looks pretty similar

DopeySneezy: A complete
theme replacement, with a
replacement utility to allow
you to backup all the system
files you need to change. But

SHAKE OFF INACTIVE WINDOWS

they all were.

Shake_1.3.exe

Use AeroShake to hide all the windows except the one you're using, by
merely shaking the titlebar. Shake it again to bring them back to where

Link: http://cache.gawker.com/assets/images/gawker/2008/11/Aero_

Using Powertoys like Tweak Ul & PowerCalculator to get more out of Windows XP
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Tips & Tricks

Digit wishes its readers a Happy,
Prosperous and Safe Diwali

Microsoft Office
2007

g Changing the colour
scheme

To change the default colour
scheme in Office 2007, click
on the Office button at the
top left. Next, click on options
and choose the colour scheme
in the customise menu under
the Popular tab.

g Minimise/Hide the
ribbon

To minimise the ribbon, right-
click on the Quick Access
Toolbar located immediately
above or below the ribbon,
and click Minimise ribbon.
Similarly, to bring it back click
on Maximise ribbon.

g Quick access toolbar
To add more features, right-
click on the toolbar and
select Customize the Quick
Access Toolbar and choose

Getting around In

Microsoft Office 2007.........c... 73
Essential software........... 76
(017 1 5% o) o] =T SN 77
YOUTUDE ...cocrrrrrrsrerssesrersse 80

in the tools toolbar/ribbon
space, or on right clicking a
red underlined entry in your
workspace). You will now

(U] 17C] 5%l [o] =T H—— 82
Evernote 82
Google Cheat sheet........ccowen 84
Working with Sub-titles............. 86
WINAOWS 7 ..o 88

a clipboard after pasting
text/ options anywhere, this
tag allows options such as
‘keep source formatting’
and ‘match destination

formatting’.
¢ The Bullets,

tags: Appearing in Excel when
a cell encounters a wrong
formula / function, this tag
allows you to change the
properties of the cell and the
rules that govern the formulas.
* Other Miscellaneous smart
tags: Smart tags appear at
various other occasions. For
example, when you type a
name that is part of your
outlook contacts list, a smart
tag appears that allows you
to quickly insert his address,
other details, schedule a
meeting or create a mailing list.
Microsoft has also created an
API (Application Programming
Interface) for developers to
create more Smart Tags. To find
these, go to the More Smart
Tags option in the Autocorrect
Options.

Ld Create PDF and XPS
Go to tinyurl.com/ttoff and
download the executable file.

Once installed, you can
save your files as PDF or XPS
by clicking Save as.

numbering and
list smart tag:
This appears
when you

start a list /
numbered list
and Word/Excel
automatically
formats it.

It allows

for various
options such as

The Ribbon is strictly an option

from a long list of functions
in Word/Excel/PowerPoint
options.

notice small tags while you

work. Some of these are:

* The Paste smart tag:
Appearing in the shape of

numbering and
spacing.
e Error checking

Powerful options in customisation are provided through macros

g KeyTips

Within any Office
application, press [Alt]
to highlight all keyboard
shortcuts.

kd smart tags

To enable smart tags, go to Paste smart tag in action

Autocorrect Options (found

Keyboard shortcuts need not be known by heart

With Office 2007, you can save your documents as PDF and XPS files
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Q Macros

Regular Office users are familiar
with macros. These are nothing
but automation of repititive
tasks.

Click on the record macro
button in the ‘code’ toolbox
of the Developer tab. Next,
assign a name for your macro.
If you'll need this macro often,
you can add it to the Quick
Access Toolbar. To do this,
check the button in the ‘Assign
macro to’ option. Similarly,
you can assign keyboard
shortcuts by clicking on
Keyboard.

After clicking OK on the pop
ups, the macro starts recording
automatically.

You can perform your
required operations such as
inserting a table to a specific
format or performing spell
check. Only keystrokes and
mouse clicks are recorded.
Text that you type in the
workspace aren’t recorded
while recording a macro.

Q Document inspector
Click on the Office button and
then select the prepare menu.
The document inspector is a
handy new tool that ensures
that the office document /
spreadsheet / presentation
does not have any unwanted
personal / privileged
information such as footnotes
and references. The Prepare
menu also provides for various
other security features such

as digital rights management,
encryption and content
management.

Q Shortcuts

There are some useful
keyboard shortcuts that you
can use in Office 2007.
[Ctr1]+[1]-Single-space all
the lines in selection
[Ctri]+[2]-Double-space all
the lines in selection
[Ctr1]+[5]-1.5-space all the
lines in selection
[Ctri]+Space-Toggle
AutoCorrect
[Ctr1]+[Del]-Delete the
word to the right of the cursor
[Ctr1]+Backspace-Delete the
word to the left of the cursor
[Ctri]+[Shift]+[8]-Toggle
hidden characters that

Digit | October 2009

mark spaces, carriage returns,
etc.

[F7]1-Run a spell check
[Shift]+[F7]-Use the
Thesaurus.

Word 2007

EJ Styles

Instead of manually formatting
each line in Word, you can

use styles. The advantages

are numerous. Recognising
each line for what it stands

for in the document (heading,
subheading, etc), and utilising
the styles option allows you to

headings of different formatting
selectively included. What is
more, Word 2007 comes with
Quick Style sets, found on the
styles toolbar again, which
makes adopting styles to your
document even easier.

Ld Building blocks

By using building blocks,

you can create the bulk of a
document using frequently
used and predefined content
such as headers and tables.
This way, you can save time
by copying content from other
documents.

Publish to your blog directly from Office 2007

quickly change the formatting
for a specific group of lines (eg.
increase subheading sizes by

1 point). Word comes with a
default set of styles, all of which
can be quickly modified to your
preference. Another advantage
of this feature is that once you
are done with your document,
you can go to the Table of
contents menu, found in the
References tab on the ribbon
and quickly make a table of
contents. The table of contents
can be customised with

‘insert’ tab. First, you need to
create quick parts. This could
be a logo, table or header. In
the menu that pops up, click
‘save selection to Quick Part
Gallery’, and then add a name
and description. Once you are
done, all you need to do is click
on the Quick Part you wish to
insert.

Q Blogging

Yes, the complex formatting
that would often take hours

on a blogging page, can now
be performed in Word posted
directly. Click on the Office
button and go to Publish >
Blog. On your first post, you
will have to select your service
provider such as blogger or
Windows Live. If your provider
is not on the list, enter the URL,
and details of the APL

Excel 2007

kd pivot table and charts
A Pivot table automatically
extracts meaningful information
from the data within it. For
example, the maximum and
minimum values in each row/
column, average, etc.

Complex data analysis is simple with Pivot tables

To access building blocks,
select the ‘text’ menu bar in the

Creating a document is as simple as dragging and dropping components

| vol 9: 74

After you have entered your
data fields, for example, a list of
salesmen and their respective
sales, select the data and go to
the Insert tab and select Tables
and click on PivotTable. In
the pop-up window, choose the
base data for your pivot table.

Q Conditional formatting
In the Home tab, click on the
conditional formatting button
in the Styles menu bar. Here,
you have various options such
as greater than / less than, top
10 and top 10 percentage. You
can also choose highlighting
depending upon the range of

| www.thinkdigit.com
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What took many lines of formulae earlier is now confined to a button

values in the cell.

Q Charts

Create a chart as before, by
going to the Insert > Charts
Menu bar. Now, on the chart
that you have created, add
trend lines by right-clicking

on the line and clicking add
trendlines. You may further
right-click the trendlines and
choose to format them, as you
can do with the axes. To format
the chart area or vary shading
and scales, right-click the chart.

PowerPoint 2007
Q SmartArt Graphics

To see how this works, go to
the SmartArt Button found
in the 1llustrations menu
bar in the Insert tab. You

U Advanced effects

Effects such as bevelling a
surface, which required a
separate designer in previous

A few clicks can extend your battery life

especially in the emphasize
category. To view these, go to
Animations > Animations
> Custom Animation > Add
Effects > Emphasize. You
can select options such as glow

Some effects that would take a professional designer earlier can now be done in

PowerPoint with a few clicks

With SmartArt, illustrations finally got smart

have a wide range of options
from cycles to hierarchies to
processes that you can add

to your document. Once you
select any object, an outline art
is added to your presentation.

presentations, can be
performed easily in PowerPoint
2007. To view these options,
go to Design > Themes >
Effects. Office 2007 also has
updated effects in animation,

in and lightbulb which were
unavailable in previous versions
of Office.

kd presenter view
To utilise this option, plug in an
extra monitor to your computer

and go to the Monitors
menu bar in the Slide Show
tab on the ribbon. Select the
Use presenter view option.
Go ahead, fool around and
master the art of real time
presentations.

Miscellaneous Office
2007 applications

Q Optimising to save
Power

If you're using a laptop or

a tablet PC and would like

to optimise your power
consumption, go to Tools >
Options. In the Others tab,
select the appropriate level of
performance/battery life.

kd shared Notebook with
OneNote 2007

OneNote is Microsoft’s way

of collaboration. To enable
this feature, go to Share >
Live Sharing session. You
may choose to host or join an
already hosted notebook. In
the earlier case, you will have
to specify the password to your
notebook while in the latter

Collaborate with Microsoft Office 2007
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case, you will have to enter the
IP address/URL of the other
notebook too. Once joined,
OneNote synchs the notebook
being used by the host to all

the connected computers, after
which modifications made
anywhere are made dynamically
viewable to all users.

Q Speeding up picture
manager

In Windows XP, go to
c:\Documents and
settings\<username>\
local settings\
application data\
Microsoft\OIS.

Open oiscatalog.cag using
a text editor such as Notepad
and delete any line pointing to
aremote location.

Vista users, go to Cz\
Users\<yourusername>\
AppData\Local\Microsoft\
ols.

Your Office Picture Manager
should now start in ajiffy.

Essential Software
Tips for some of the software
we provide on our DVD, in the
Essentials section.

Foxit Reader

Foxit Reader is a free, light
weight and feature-rich
substitute for Adobe Reader.
It may not have In addition to
typical PDF readers, features
such as adding notes and
creating links within a PDF
document are also available. If
you are unable to download,
you can also find it on this
month’s Digit DVD.

Switch between a rich format with images to a plain unformatted text

Q Removing the Ad

bar

You can disable the Ad bar
that appears on the upper
right corner by right-
clicking on any Tool Bar
and uncheck Advertisement.
This option is not accessible
through the menu bar.

Q Extracting Text

With Foxit Reader, extracting
text is much easier. Click

on the Text Viewer icon (a
pair of glasses on a paper) or
use the keyboard shortcut
[Alt] + [9]. This removes
all images and formatting
from the PDE. You can now
read your PDF in plain text
and even copy text [Ctr1] +

[C] from here. To revert back The different text editing tools present in Foxit Reader

to normal mode, press [Alt]

+ [91.
Q Taking a Snapshot

Foxil’s snapshot utility is as
effective as the Text viewer. To
activate the Marquee select tool,

Take screenshots within Foxit itself

Digit | October 2009

press [Alt] + [7]. Click and
drag the mouse to select the
area you want to copy it to the
clipboard.

‘ Q Adding text to the
© document

After extracting text and

Add text to a particular place in the file
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images, Foxit also lets you to
add text notes. To add text go
to Comments on the menu bar
and then click on the Insert
Text tool. Double-click on the
caret to type additional text.
You can also add floating
text, with or without a border.
To do this, go to Comments
> Typewriter Tools and
click on Typewriter Tool for
text without a border. Use the
Textbox Tool for adding text
with a border.

g Highlighting text
To highlight text in Foxit, use
the Highlighting tool in Favorite
Tools or select the Highlight
Text Tool from the Comments
menu bar. Click and drag the
text you want to highlight. If
you repeatedly highlight the
same text, the colour of the
highlight intensifies.

If you don’t want to
highlight, or want to highlight
something and want a different

Use different shapes to help you along your work

point, you can insert objects
such as arrows to your text.
You will find these in the
Drawing Markup Tools under
the Comments menu bar. The
tools range from lines, arrows,
different geometric shapes to
a very variable cloud tool that
changes shape with each
click. Try them out, you might
find it quite fun to use. You
also have an eraser tool, so
that you can erase the parts
you don’t need.

WinRar 3.80

WinRar, also a regular of our
DVD essentials, is a much
used tool by one and all for
archiving data and also as
data compression utility.

Q Adding Password

To password-protect your
files, right-click on your file
selection and select the option
Add to archive. Navigate to
the Advanced tab and click on

Set Password. Here you will

be asked to enter the desired
password twice. You also have
the option to encrypt the file
names for security or personal
reasons. Click OK to create the
archive. You will need to enter
a password to open individual
files.

Q Creating a self
extracting archive

To create a self extracting
(SFX) archive, or one that is
automatically extracted to a
folder, select the option Create
SFX archive and click on OK.
When you try to open this file,

Create an SFX archive for your data

instead of showing you the data,
it will directly ask you for the
path so that it can extract the
files there. Also the archive will
have a slightly different icon
and will have an EXE extension
instead of the default rar.
Similarly, to convert an

type of marking system,
use the Underline text tool
or the Squiggly Text Tool.
These are also located in
the Comments menu bar.

Q Adding Notes

You can add notes around
the document using the
Note Tool. Unlike the text
tool, notes can be moved
around and their colour
can also be changed.

g Markup Tools

existing RAR archive

into an SFX archive, go

to Tools > Convert
archive to SFX in the
menu bar. Click on OK at
the next dialogue box and
your SFX archive is ready.

g Splitting files

To split a file, first add
your file selection to an
archive. Select the option
Split to volumes,
bytes and enter the
desired individual file size,

If you need added
emphasis on a particular

Secure your archive by adding a password

and click OK. This will start
the archiving and splitting

View your CPU performance with the WinRar benchmark utility

process. Make sure that you
have done the right calculation
for bytes or else you will end
with with many small split up
files. To open the archived file,
just click on the first part of the
file and extract it.

g Benchmarking your
processor

For those of you who follow
our comparison tests, you
would have noticed that we

log the scores of the WinRar
benchmark as well. This
WinRar benchmark allows you
to measures the performance of
how well your CPU compresses
and decompresses data in kBps.
To use this yourself, just go

to Tools > Benchmark and
hardware test and view the
results. You can compare these
results to the results we obtain
to check how well your system
is performing.
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Q Cropping a video
There are two ways to
crop a video in VLC. You
can either use preset
crops based on aspect
ratio, or go to Video >
Crop from the menu bar
and select the one you
want to use. To precisely
crop your video, open the
Effects and Filters menu.
Select the Video Effects
tab and then select the

You can either sharpen or the blur the video with these settings

VLC1.0.1

VideoLan player is another tool
on our DVD essentials and is

a convenient video playback
software. The latest version is
1.0.1.

g Video adjustments
With VLC, you can adjust hue,
saturation, brightness, gamma
values of a video especially if it
is poorly shot. Go to Tools >
Effects and Filters from
the menu bar and navigate to
the Basics tab

can adjust Sigma levels if you
think the video is blurry.
Similarly, you can also add
blur to your video. Go to Video
Effects and click on the Image
Modification tab. Here, not
only can you add blur, but
also effects such as gradients,
waves and water effects. Just
click on the option you want
to try and the video changes
simultaneously. You can also
add noise to the video from this
settings window.

under the Video
Effects and check
Image Adjust.
This unlocks the
scroll options

to change the
settings. Now use
the scroll bar to
change the colour
settings.

Under the
same settings
menu, you can
adjust the video
sharpness. Check

Sharpen and you  Create precision crops using VLC and watch the changes

simultaneiously
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Magnify or zoom on to a particular part of the video

between Quarter, Half, Original
and Double. By default, the
video is set at original. If you
want to zoom in on a specific
part of a video, then it’s back

to the Video Effects tab in the
Effects and Filters settings.
Once there click on the
Geometry tab and put a check
on Magnify/Zoom. When you
enable that option, you will see
a small box, similar to a picture
in picture box, visible on the
VLC player’s screen. If you click

Move the blocks to solve the puzzle

Crop tab. Here, you can crop
the video based on pixels and
individually crop off parts of
the top, bottom, left and right
in real time.

Q Zoom and Magnify
Similar to Cropping, the zoom
function also has two modes
that you can use. The first
way is to go to Video > Zoom
from the menu bar and select

| vol 9: 78

and drag that small box, the
video will focus on that part
of the video. To magnify, just
increase or decrease the Zoom
bar, located below the Magnify
box. This is useful if you want
to Magnify or Zoom in on a
particular area within a video,
which could be a painting or a
person.

Q Play a puzzle

| www.thinkdigit.com
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You can convert any video clip
into an interactive puzzle. VLC
changes your video into blocks
and shuffles them around, while
you need to join the pieces
together to get the video back to
its original format. Open the
Video Effects tab and go to

plugins.htm and download iv_
formats.zip that contains the
RIOT plug-in. Once installed,
modify the images you plan to
use for the web. Click on the
Save for
Web option under File in the
menu bar.

Geometry. Put a check on
Puzzle game, and start

playing.

Q Creating a video

wallpaper

VLC has the feature

to use the DirectX
capabilities of your
graphics solution and use
it as a video output mode.
First, get rid of your
existing wallpaper. Go to
Tools > Preferences
from the menu bar and
click on Video on the

left. Select DirectX Video
Output from the drop
down list displayed next
to Output and click on
Save. Now start up a
video and go to Video on
the menu bar and click

Next, select between
JPEG, GIF and PNG.
Under JPEG, you can
use the quality slider
to increase or decrease
the quality of the image.
Under GIF, you can adjust
the slider to change the
colours from 2 to 256
colours and you also
have the option to save
it as an interlaced image.
With PNG, there are no
sliders to adjust, but you
can change the Colour
reduction by selecting it
from the drop down.

With JPEG and GIF
images, you have the
option to compress the
image you are about to
save. For this, click on
the Compress to size
button towards the right

on DirectX Wallpaper. side of the window. Input

. the value of the size you
IrfanView The paint want (in kB) and click on
The next essential software  gjzjog most ~ OK- RIOT automatically
we are going to give you of us are makes changes to the
tips and tricks about is familiar quality for JPEG, and

IrfanView, one of the most  yith
simplest and fastest image
explorers available. We're

not going to tell you about the
basics that are possible with
IrfanView, but instead we're
going to tell you about some
things you could do with
IrfanView, that you ordinarily
wouldn’t use a software

colours for GIF and

will give you an

outcome with the
desired size.

There are two viewing panes,
one displays the original image,
while the other displays the
optimised image. The area
between the two holds buttons

The pattern made with the Emboss tool in Irfanview

Create really funky designs with the Swirl effect

for zoom, actual view, fit to
window and in-place compare.

Q Abstract patterns

You can create abstract patterns

or images by using various
filters in IrfanView. You

like IrfanView for.

Q RIOTing with
IrfanView

RIOT stands for
Radical Image
Optimisation Tool and
is a very useful plug-in
for IrfanView. With
this plug-in you can
optimise images for the
web. Basically, when
you save an image,
you can choose saving
options and also the
file size. Go to http://

can either use an existing
image or create a new one.
Go to Edit > Show
Paint dialog from the
menu bar to see
IrfanView’s paint tools.
Create a new image by
pressing [Ctri] + [N].
Select the Rectangle Tool
and set the foreground
colour to white. Set the
pixel width to about 5
pixels. Next randomly
create rectangles of different
shapes around your canvas.
After that apply the Emboss

www.irfanview.com/

The RIOT interface when you click on Save for Web

filter by going to Image >

Effects > Emboss. Now use
the Sharpen filter. To do this, just
press Shift + [S] anumber of
times ll you see a pattern form.
Next for a bt of finishing, you can
go to Image > Effects > Oil
Paint to smoothen out the edges.

You can try different filter
combinations or colours and
create these abstract patterns of
your own.

Two other effect filters we
are fond of are the Twirl and
Swirl effects. We’ve found an
interesting way to use these
with a similar method as
mentioned above. Instead of
using a single white colour,
use different colours for
different rectangles and fill the
canvas. Next, go to Images >
Effects > Effect Browser
and select Swirl or Twirl, and
your artwork is ready!
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YouTube

Here’s a quick list of tricks that
could jazz up your YouTube
experience.

Ld Warp

If you're tired of seeing all linear
frames, here’s a cool trick called
Webview — or “Warp Speed’ - to
get you literally bouncing. Go to
http://www.youtube.com/
warp_speed and click on any of
the video thumbnails you see.
The page now occupies the full
screen and all the video links

Satellite videos

Thumbnails are for the squares

turn into floating balls,
hovering over a dark
background.

Move the mouse to hover the
cursor over a particular circle
and other related videos burst
out for your reference, with the
first one in the centre. Besides,
a tag appears too — this time
in a speech balloon - to show
you what the video is all about.
Click on any one of them for
the video player to appear and
watch your favourite video in
anew mode. Similar videos

are colour coded - the circles
around them are of the same
colour — and every time you
click on a different kind of
video, a dot of the same colour
appears on the top left corner
of the screen. Videos you have
watched are connected by
lines as a quick review of your
viewing history.

Q High quality videos

To watch videos in high quality
modem either click on the ‘HQ’
button under the video you're

Those that are available
would usually carry the HD
option button under the video
screen anyway. If the button
is coloured red, you're already
watching HD. Alternatively, you
could add &fmt=22 to the URL
for the HD view. This increases
the resolution to 1280x720,
H.264 video @ 1024Kbps; audio
@ 44.1KHz, 232 kbps stereo.
Do any of these and the display
will switch to a wider screen,
better resolution (true 720p high
definition) and crisper sound. If

Use the drop down menu

Played videos are linked

watching, or add &fmt=18

to the URL in the address

bar above. This increases the
resolution to 480x360, H.264
video @ 512Kbps; audio @
44.1 KHz, 128 kbps stereo. The
resolution, however, is 480p or
less. Although HQ is not the
same as HD (High Definition),
the new HQ feature allows you
to view any video at optimal
quality if you just change the
settings. Click on ‘Accounts’ in
the drop-down menu under you

User ID (top-right of the screen).

Click on Playback Setup and
choose the option which says

1 have a fast connection.
Always play higher-
quality video when it’s
available’.

to change your settings

you want to watch only those
videos uploaded in HD, the new
interface makes it even easier
now. Just click on the Videos
link on the top left of the
YouTube home page, and then
click on the link which says HD
in the top centre of the page.
This will open a grid view of all
the popular HD quality videos
available for view.

Q Making your YouTube
channel look great

If you have a YouTube channel,
you can spice it up with a few
steps. After signing in to your
YouTube account, click on
Account > My Account > My
Channel > Channel Design.

Get your hyperlinks to fly
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This opens the Edit Your
Channel page.

Click on Themes and
Colors and choose from any of
the preset themes provided
above. Click on the new theme
link, give your new theme a
name, click on the Choose
File button for Background
Image, upload a picture from
your computer and Save
Changes. Bingo, you've got a
new background.

Q Video annotations
You can now add comments to
your videos. When you play

speech bubble (a comic book-
style text bubble), a note (a text-
box) or a spotlight (a highlighted
area which displays text when
the mouse hovers over it) to the
video.

You could choose to seek and
freeze the frame you want to
attach the annotation to before
you use the editor. Once you
click on one of the buttons, the
annotator toolbar appears in the
middle of the screen with more
options. You could type in the
text you want to add, edit or
delete earlier annotations, add
an annotation link or change its

For HD videos only

one of your videos, you'll see
the Annotations Editor button

above the video player. The

+ button that appears on the
bottom- left of the screen gives
you three options of adding a

How to get to your channel

Add or edit comments using this

colour. You can drag or resize

Personalize your channel with your own wallpapers.

Try http://backgroundtube.com/ which lets you download images from

a whole range of theme categories from ‘Abstract’ to ‘Sports’. Upload
the picture to your channel and don't forget to change the colour coding
according to parameters provided by the web site.

text boxes to different locations
with the click-and-drag action of
the mouse.

You could change the time
and duration of every tag. By
default, every tag appears at the
point in time that you attach it
and then hangs around for 5
seconds before disappearing.
You could change this by
feeding in the start and end
times in the H:MM:SS.s format
(Hour:Minutes:Seconds:Millise
conds) to make it visible for as
long as you want.

Annotations, by default,
pop up once they're published.
The Menu button at the
bottom of the video player
could be used to turn them
off. You could click through
Account > MyAccount >
Playback Setup >

Deleting an annotation is easy

Q Active sharing

A great way to let friends,
contacts and other YouTube
members know what you've
been watching is by enabling
the Active Sharing feature

Annotations and
uncheck the box
which says Show
annotations.

You could delete
all the annotations
by simply clicking on
the delete button

in the pane on the
side of your video
player when you view it in My
Account > Annotations and
then Publish the changes you
have made.

Sometimes annotations can
interfere with your viewing even
when you’re watching someone
else’s videos embedded on
other sites. A simple way to
disable these is to append the
code &iv_load_police=3 to
the video’s embed code.

The tools for annotations are cantered for convenience

which you can do by changing
settings in your account. Just
click on the History button on
the top right of the YouTube
homepage and click the Start
Active Sharing button at the

&5 Active Sharing is OFF | Start %mwe Sharing ‘

Share your video viewing habits with
Active Sharing

bottom right of your screen.

This will now

allow people to see
your User ID next
to the video you're
watching in real
time — and about
twenty-five other
people who may be
watching the video
simultaneously.
Your viewing history
of the last half hour

Block annotations by unchecking the box

will also be a part of
your Channel page.
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Ultra Explorer
Although Windows Explorer
manages your files to an
adequate level, other tools give
you added functionality and a
higher level of operability. One
such software is UltraExplorer.
«Installation

UltraExplorer is available as a
free download and is light on
resources.

sFunctionality

Ultra Explorer’s functionality
is similar to the usual Explorer.
You have the usual options to
navigate one level up, go back
or move forward. The bar at the
bottom gives you the file count,
size and other details.
eNavigation

Double-click anywhere to

go one level up. The Folder
window on the left is similar

to Windows Explorer.
UltraExplorer also has multi-
tabbed browsing. To do this,
goto File > New Tab or use
the keyboard shortcut [Ctrl]
+ [T].

sList/View window

To enable this, go to View

> Windows > List View
Window. This helps you see the
changes you are making within
the destination window from
the source window (eg. a move
operation). You can now keep
tab on both.

Favourites window

There’s also a Favourites
window that you need to enable
in a way similar to the List/
view window. You can drag and
drop the most commonly used
programs or folders into the
side dock.

eIndexing service

Using UltraExplorer’s indexing
service, you can create real-time
filters. The Filter Window
(View > Windows > Filter
Window) allows you to create,
filter in and filter out (filter

all similar matches out of the
list) search options. It’s fully
customisable with extensions
(eg, MP3, TXT) and wildcard
options. If you want to search
for a file that starts with A and
ends with T and is a JPEG, you
can run a search for a*t. jpeg.
For one character, use ?, while
* is the wildcard for multiple
characters, or view only folders.
eDrag and drop search
UltraExplorer seems quite
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Some of the features seen need to be enabled.

pleased with the drag and drop
option. If you want to sort out
only MP3 files, and you're too
bored to create new filter or
type in *.mp3, simply drag

an MP3 file on to your Filter
Window and UltraExplorer will
do the rest.

*DropStack window

If you're transferring files from
multiple locations and the
destination is the same, you
would have to open all the
windows, either laboriously
drag and drop each one, or

Cut and Paste. The DropStack
serves as a temporary location
for all your file operations. Drag
files on to the drop stack and
then you can batch process
operations on them. The scope
for utility is excellent

Filter.It's simpler and more
utilitarian when compared to
the Filters Window. The Drives
toolbar gives easy access to all
mapped drives. It also allows
easy access to USB drives, CD
drives and other externals
connected to it.

If you're familiar with
Windows, you'll know
the different view modes -
Thumbnails, List, Details, Icons
are common.

The number of ways
to enable these modes is
numerous. The most obvious
isView > Column Mode. It is
similar to the Treelist view, but
allows you to view the folders
and subfolders horizontally.

Each window can have a

different colour and font. If you
plan to use the software more
extensively can use extra plug-
ins, get shell extensions, custom
theme their environment by
giving a different skin to every
toolbar (Tools > Customize)
and several other minute
tweaks. You can use the
Windows + [E] key to access
UltraExplorer. To do this, go to
Tools > Shell Extensions
> Win+E hook.

What is interesting to
observe is how much utility
they’ve managed to pack in a
mere Explorer.

Evernote
Evernote allows you to take
notes and synch your notes

(zipping together files
in different regions,
batch conversions
and mass transfers are
typical examples).
Viewer window
The Viewer window
lets you preview the
file before opening.
This is extremely
useful for small text,
binary, HTML or
media files. It opens
pictures, text files,
PDFs, MP3s and AVI
files.

*Quick filter bar

To activate the quick
filter bar, go to View >

Toolbars > Quick Evernote’s web interface
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between your PC, Mac and
mobile phone. Evernote is
limited to a 40 MB storage
space per month, but works
across various mobile platforms
such as iPhone / iPod Touch,
Blackberry, Palm Pre and
Windows Mobile.

Q Managing notes

By default, your username

is considered as a notebook
where your notes are stored.
You can also create multiple
notebooks for office and
holidays. This lets you organise
your data better.

Tags is another way to
classify your notes, images,
tweets, web clips or audio clips.
You can manually add a tag
when saving a note, or select
the tag you have created from a
drop down list.

Q Web clipping with
Evernote

Go to Evernote.com and click on
Downloads. Next click on Web
Clippers located on the left side

Write out notes with the Ink Mode
of Evernote

of the web page. Drag the Clip
to Evernote button onto the
browser link bar located just
below the address bar to use the
web clipping feature.

You can now select anything
from images, text, links or
audio and create a note with
them. To add notes, click and
drag the text or select the
image that you want to make
anote of. Click on the Clip to
Evernote browser button. After
you login, add a title for the
note, create or add a tag to the
note, and also add some text if
needed. Click Done and your
note will be stored and can be
accessed from anywhere.

Login and create a new note instantly

Taking and highlighting screen shots with Evernote

Q Taking a snapshot

To use the snapshot feature,
press [Prt Scr], which creates
a cropping tool. Adjust the

boundaries of the clip and click
on the Evernote logo to save
the image to your notes. To
highlight something within the
image, hit [Prt Scr] a second
time, and you will be able to

highlight anything within that
image using a pen tool. Press
[Prt Scr] again to adjust the
image borders. To save this as a
note, either click on the logo or
just hit [Enter]. To discard the
clip, just press [Esc].

Q Notes using Twitter
Follow myEN on Twitter. You
will receive an email to link
your Twitter and Evernote
account. Once that’s done, all
you need to do is tweet myEN.
Just use @myEN and your
tweet will be saved as a note.

kd Evernote on the iPhone
Once you login to the Evernote
application on your iPhone,

you can capture photos that
becomes a note. You can also
record audio, take iPhone
screen captures and turn them
into notes. To take a photo, tap
the option Snapshot. To create a
note, tap on Text. Similarly, tap
Voice to create an audio clip.

Q Creating notes

You can either type out a note
or use the Ink mode to scribble
the note out. To create a new
text note use [Ctr1] + [0] or

Evernote interface on the desktop

Using Evernote on the iPhone

[CtrI] + [9] for Ink mode.
Click on the star shaped button
on the Ink mode toolbar to
enable auto shape mode. Auto
shape straightens out lines and
curves to give a sharper written
text.
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Google Search

Campe————fweion |

Google Cheat Sheet

[ampe — lrcior |

Apples OR Oranges Any one of the number listed m_Mars Mass of the heavenly body
“Apples and oranges” Exact phrase r_Moon Radius of the heavenly body
Apples -Oranges Without a particular word Pi Value of any constant

Site: www.thinkdigit.com

Searches within the site

Cache: www.thinkdigit.com

~Tech Blogs Looks for items similar and related
to "tech”
+Orange Excludes synonyms and plurals from

the search

Searches Google's cache of the site

intitle: digit

Apple *** Orange

A number (here, 3) of words be-
tween the two words

Pages with names containing “digit”
in the title

allinurl: forum

Search with the word forum in the
url

2+2 Add two numbers safesearch: pornography Academic material, safe search

2 plus 2 Add two numbers Link: www.thinkdigit.com Sites that link to a site

2-2 Subtract two numbers Info: www.thinkdigit.com  Information about a site

2 minus 2 Subtract two numbers Related: www.thinkdigit.com Sites related to the specified site
2*2 Multiply two numbers -inurl:html -inurl-html Searches for the format in the index
2/2 Divide two numbers “index of” *.(format) of files

2% of 2 Finds out a percentage of a number +the/+if Forces inclusion of words otherwise
212 A number raised to another omitted during search

12 Kmph in Mph

Unit conversions

filetype: .mp3/.pdf/.avi

Google Reader

Searches for the particular formats

Gmail 8 Next file
Shortcut Function [K] Previous file

[C] Compose mail Spacebar Move downwards

[0] Open mail [Shift] +Spacebar Move upwards

[X] Select mail [N] Select next file

[S1 Star mail. Press repeatedly to cycle stars. [P] Select previous file

[1] Report spam [S] Adds star to file

[N] Next mail [Shift] +[S] Shares current file

[P] Previous mail (M] Toggles “read” state

[K] Next conversation (1] Add tags to file

[J] Previous conversation [Shift] +[A] Mark all as read

[R] Compose reply [Shift]+[X] Expand/collapse a folder

[A] Reply to all [Shift] +[O] Open current file

[F] Forward mail [G] + [A] Goes to "All tems”

[U] Return to Inbox (or refresh) [G] + [S] Goes to “Starred Items”

[Tab] [Enter] Sends message [/1 Quick guide to all shortcuts

[Y] + [O] Archive current mail, go to next

[G] + [A] Go to "All Mail” YouTube

@1+ 15 Go to“Starred Ml
[G] + [C] Go to contacts Spacebar Pasue/Play video

[G] + [D] Go to Drafts Right Arrow Fast Forward

[G] + [1] Go to Inbox Left Arrow Move back

/ Go to search box Up Arrow Increase volume

[Esc] Removes cursor from the current field Down Arrow Decrease volume

[Enter] Opens mail, expansion toggle for con- [F] Full Screen

el ell [Escape] Return to regular view
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Google Docs

[Ctri]1+[A] Select all

[Ctri]1+[B] Bold

[Ctrl]+[C] Copy

[Ctrl]1+[D] Copy down (used in combo with Shift +
arrow keys)

[Ctrl] +[E] Center alignment

[Ctri]+[F] Find and replace

[Ctri]1 +[G] Find next

[Ctrl] + [Shift] + [G] Find previous

[Ctri]+[1] Italicize

[Ctrl] +[J] Full justify

[Ctri]+[K] Insert link

[Ctrl] +[L] Left alignment

[Ctri]+[M] Insert comment

[Ctri]+[M] Insert new slide

[Ctrl] +[P] Print

[Ctri]1+[R] Right alignment

[Ctrl] +[R] Copy Right (used in combo with Shift +
arrow keys)

[Ctrl]+[S] Save

[Ctri]+[U] Underline

[Ctrl] +[V] Paste

[Ctrl]+[X] Cut

[Ctrl]+[Y] Redo

[Ctrl] +[Z] Undo

[Ctrl] +[End] Go to last cell in data region

[Ctrl] +[Home] Go to first cell in data region

[Ctrl] +Left Arrow Go to left-most cell in data region (cur-
rent row)

[Ctrl] +Right Arrow Go to right-most cell in data region

(current row)

[Ctrl]+Down Arrow

Go to bottom-most cell in data region
(current column)

Blogger
[Shortcut _[Function
[Ctrl] + [B] Bold
[Ctrl] + [1] Italic
[Ctrl] + [L] Blockquote
[Ctrl] + [Z] Undo
[Ctrl] + [Y] Redo
[Ctrl] + [Shift] + [A] Add hyperlink (@a=href)
[Ctrl] + [Shift] + [P] Preview

[Ctrl]+Up Arrow

Go to top-most cell in data region (cur-
rent column)

[Ctrl]+[Page Down]

Move to next worksheet

[Ctrl] +[Page Down]

Move to previous worksheet

[Ctrl] + [Shift] +[F] Full screen

[Ctrl] +[Shift] +[L] Bulleted list

[Ctrl] +[Shift] +Spacebar Insert non-breaking space
[Ctrl]+Spacebar Remove formatting
[Ctrl]+[1] Header style 1

[Ctrl]+[2] Header style 2

[Ctrl]+[3] Header style 3

[Ctrl]+[4] Header style 4

[Ctrl] +[5] Header style 5

[Ctrl]+[6] Header style 6

[Ctrl]+[7] Toggle numbered lists
[Ctrl]+[8] Toggle bulleted lists
[Ctrl]+[9] Change list dialog

[F2] Edit active cell

[Enter] Move to next cell in column
[Esc] Cancel cell entry

[Shift] +[Enter] Move to previous cell in column

[Shift]+[Page Up]/[Page
Down]

Extend the selection up/down one
screen

[Ctrl] + Spacebar

Select entire column

[Shift] + Spacebar

Select entire row

[Shift] + arrows

Manual select

[Page Down]

Move down one screen

[Page Up] Move up one screen

[Shift] +[Tab] Move to previous cell or row
[Ctri]+[.] Superscript

[Ctri]+[,] Subscript

[Tab] Move to next cell or row

Google Maps

Arrow Keys Pan in the particular direction
Numpad arrow keys Pan more in the particular direction
[=] Zoom In

[-] Zoom Out

More Google Services

http://labs.google.com/
: sets

‘ Check these out

Find sets based on your inputs

http://www.google.
- com/holidaylogos.html

An archive of all special Google logos

http://www.google.

Trends and insights

[Ctrl] + [D] Save.as draft : com/intl/en/press/zeit-

[Ctrl] + [P] Publish : geist/index.html :

[Ctrl] + [S] Save  http://www.google. Thirsty for information? Google has the :

[Ctrl] + [G] Indic script transliteration : com/googlegulp/ COMELS I e
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Working with subtitles

ince the advent of the

video culture, many

have felt the need to

manipulate subtitles for
their videos.

Q Synching subtitles

One of the most common
reasons why subtitles may be
out of synch is a simple delay.
This is a relatively easy problem
to fix. The second cause of
subtitles being out of synch
has to do with the frame rate.
The frame rate of the movie
and that of the subtitles does
not match. This causes the
subtitles and the movie to go
at different speeds. In such a
case even if the subtitles and
the dialogues start at the same
time, towards the end of the
video you may get a delay. The
third is a combination of these
two reasons. This is when the
process of scaling comes into
the picture.

kd solutions

The easiest fix for mismatching
subtitles is to search for the
exact file name with date

and other meta data (such

as “1 CD”, [2008], 700MB).
Often, this should give you
the subtitle file you're looking
for. The operations described
below are performed using

an easy to use subtitles
manipulation software known
as Subtitle Workshop4.

Q Delay in subtitles

When you start playing a video,
note the exact time when the
first dialogue starts. Next note
the instant when the first
subtitle appears. The difference
between the two timings is

the delay. For example, if the
subtitles start appearing around
two seconds before the actual

dialogues then you need to add
a delay of 2 seconds. Similarly,
you may need an advancement
(negative delay) of -2 seconds.
To add delay, open the subtitle
file by going to File>Load
Subtitle or [CtrI] + [O].
Next go to Edit > Timings

> Set delay. From the drop
down list, change to either
positive (+) or negative (-)
delay and enter the delay in
milliseconds.

Q Mismatching
framerates

To find out the framerate of a
particular video file open it in
VLC player and go to Tools
> Codec Information or
[CtrI] + [J]. Then open
the corresponding subtitle
file for that video in Subtitle
Workshop4. On the top panel
of the interface, switch the
Mode to Frames from the
drop-down menu. You will
have options such as 23.976
fps. Choose the appropriate
one. Click File > Save to
save the changes on to the
same file. Note that the time
stamp will not get affected
with this change and that the
subtitle format must depend
on framing to keep time.

g For synchronising

To synchronise using scaling,
you will have to open both the
video file as well as subtitle
file in Subtitle Workshop. Go
to Video > Open to open the
video. Go to File > Load
Subtitles for adding subtitles.
The subtitle entries are
displayed in the bottom panel
of the screen. To synchronise
mismatching subtitles the idea
is to fix on two synchronising
points. One point is the time
when the first line is spoken
and the other is the point

SOME COMMON SUBTITLE FORMATS s—

SubRip (SRT) : By far the most
common text-based subtitle
format. It doesn't support rich
formatting or metadata. It allows
for precision of up to 1 millisecond
MicroDVD(SUB) : A text-based
that keeps timing based on
framings
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SubViewer(SUB) : This format
supports metadata. Accuracy is up
to 10 Milliseconds. This format is
YouTube friendly

RealText (RT) : An HTML-based
format that allows a certain
amount of text formatting.

at which the last dialogue is
spoken. Scroll to the point

on the video where the

first dialogue is spoken (eg.
4:25). Next select the subtitle
that should appear at that
point. Now go to Video >
Synchronisation > Mark as
first sync point or hit [Ctrl]
+ [1]. Go to the point on the
video where the last dialogue
is spoken and simultaneously
select the last subtitle entry.
Hit [Ctr1] + [2]. The
application will now ask you if
you wish to synchronise as per

of the duration of the first CD.
Now select all subtitles [Ctrl]
+ [A] and hit [Ctr1] + [C]
to copy the same. Open the
CD1 SRT and scroll down to
the last entry. Hit [Ctrl] +
[V] to paste, and then save the
changes in a new file which will
have the combined subtitles

Q Adding subtitles
Subtitle Workshop also allows
you to add subtitles to your
own video. In doing so, there
are a few terms we need to
understand viz. Show, Hide and

Duration. Show is the point
at which the subtitle will
appear. Hide is when it will
fade. And the duration is the
time-period for which it will
remain on the screen. To add
subtitles click File > New.
Next load your video. The
best way is to pause video
where you want the subtitle
to appear, hit the [Insert]

Sync subtitles

the reference points. Click Yes.

Q Combining subtitle files
At times we get subtitle files
that are meant for two CD
video files, while the video file
that we have is a single CD
700 MB .Avi. What do you do
in such a case? The quick fix
solution is to apply a delay
(equal to the duration of the
first CD) to the second subtitle
file. The long term fix is to

try and combine the two files.
Let’s consider the files to be
SRT. Open the CD2 SRT file in
Subtitle Workshop. Add a delay

key and begin typing the
subtitle script. Increase
duration and then move on
to the next dialogue and hit
[Insert] a new subtitle entry
with the corresponding time
stamp will be created. You
can also change the position
of the subtitles by using the
vertical scroll bar on the left
of the video window. Similarly
colour, bold, italics formatting
options are available. Once you
are done click on File > Save
As. The application supports
almost all known subtitle
formats. Choose a file type that
supports the formatting you
have added (if any).

Adding subtitles to a video
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RoboForm
You go to a web site that you
haven’t visited in a long while
and try as you might, you just
can’t login. You try the four or
five password and username
combinations that you have,
but not one works. You can
make your browser remember
your passwords. But is it really
safe? And what if you want to
have access to your information
from another computer.
RoboForm is a tool that
lets you manage all your
login information as well as
automatically fill out those
pesky and usually cumbersome
registration forms. It comes in
both a downloadable as well
as online version. The online
version is better suited to keep
passwords synchronised across
different machines.

[00.00] Download
and install RoboForm
Head over to www.roboform.
com/download to download the
application. The application
interface is through a tool

bar that integrates with IE or
Firefox. During the installation,
it will ask if you want it to

be installed for all users and

if you want the adapter for
Firefox. Check or uncheck

the box accordingly. You will
also be prompted to enter a
master password. Once this
password is entered, you don’t
need to remember any further
passwords. The RoboForm
installation wizard will also ask
you to specify the time interval
at which this password should
be purged from cache. The
default is after 120 minutes of
inactivity.

[6.00] Make
Passcards

Roboform saves login
information in the form of
passcard. Each passcard
contains the username, URL
and password for a particular
web site login. To create a
passcard, simply login to a web
site normally. Roboform will
prompt you to save the login
into as a passcard. Change the
passcard name (if you wish)
and click Save. The passcard
even automatically clicks the
submit button so now, once

you launch your

browser, you simply

need to click the passkey
through the toolbar and it logs
you into the web site with a
single click.

[12.00] Fill forms

and Close’ button. To
create another identity,
go to ldentity > New

Identity in the identity editor.

Once you've saved the data, go
to any page with a form and
Roboform will automatically
prompt you to fill it with a

RoboForm remember it.

[25.00] Create
SafeNotes

Regular post-it notes are seen
by all. With SafeNotes you
can have a digital equivalent
of regular post-it notes with

Creating a passcard

To start filling forms
automatically you will first have
to set up Form Filling. Click
“Setup Form Filling” button

on the tool bar. You will first

be asked to enter your name
and country. The geographical
information is important to
configure information such

as phone numbers and area
codes. The next step is actually
filling out information in the
Identity Editor. This takes some
time, but think of it this way -
you're only going to be doing

it once. Also, you can fill in as
much or as little info as you
want. There are tabs for credit
card, address, business and
even custom info where you
can enter your own fields. Once
you're done, click the ‘Save

single click.

[21.00] Generate
random passwords
Since RoboForm remembers
passwords for you, a by
product of this functionality
is that you can use random
passwords. They will be
gibberish, but you don’t have
to remember them. Password
Generator creates random
passwords of any length.
Randomness of generated
passwords makes them
harder to compromise. To
generate a password, click
on the “Generate” button in
the tool bar when you're on a
registration page. Click fill to
enter the password and make
anormal passcard to have

Entering info in the identity editor

password protection. To

create a new SafeNote go to
RoboForm > SafeNotes

> New. Assign a title to the
note and select which folder

it should be saved in. Type in
the text box and click ‘Save
and Close’ when done. The
notes can be accessed through
the RoboForm button via a
breadcrumb type of navigation.

[28.00] Setup
Roboform Sync

We need access to passwords
from multiple computers; be
it your office PC, notebook or
home desktop. To achieve this
RoboForm syncs passwords
and data files with its servers.
These are encrypted by AES
encryption with your Master
Password as the key. To sync
your RoboForm data you

will have to install an add-on
known as GoodSync. Click on
the Sync button in the toolbar
and it will prompt you to
install the add-on. Click Yes
to install. You will also have
to register with RoboForm
online (online.roboform.com/
signup). Once your account

is registered, sign into it by
clicking on the Sync button.
RoboForm will now sync data
with its servers. To get access
to the data and passwords

on another computer, simply
install RoboForm on that
machine or access the web
interface at https://online.
roboform.com.
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Tips & Tricks

Windows 7
g AppLocker

AppLocker is a new Windows
7 feature that ensures users

on your PC only run the
programs and applications you
specify. You can easily block

into problems booting the OS
later on. Go to Control Panel
> Backup and Restore >
Create a System Repair
Disc, and let Windows 7
build a bootable emergency
disc. If the worst happens
then it could be the only way
to get your PC running again.
Startup Repair scans your

Safeguard your data from unauthorised

access

other users from accessing
executables, Windows
Installers, scripts, a specific
publisher or path.

Go to the Run dialog box
and type Gpedit.msc.

Then go to Computer
Configuration > Windows
Settings > Security
Settings > Application
Control Policies >
AppLocker. Right-lick on one
of the options (executables,
installers, or script ) and create a
new rule.

AppLocker also lets IT
personnel control what
applications users can run on
workstations.

Q Startup repair

If you've downloaded
Windows 7, it’s a good idea
to create a system repair disc
straight away in case you run

computer for the problem
and then tries to fix it so your
computer can start correctly.
Though it can't fix hardware
failures such as a failing hard
disk or incompatible memory
, Startup Repair does a

good job at fixing certain
problems, such as missing or
damaged system files.

CJ Use Sticky Notes

You can use Sticky Notes to

write a to-do list, jot down a

phone number, or anything
else that you'd use a pad of
paper for. To write a note using

With sticky notes you’ll no longer
forget your tasks

a tablet pen, simply
start writing on the note
where you want the ink
to appear.

Launch StikyNot.
exe from the Run Dialog
box (You can even
type notes in the Start
menu search box) and
then type notes at the
keyboard. Right-click a
note to change its colour,
and click the + sign on

Backup and restore saves you a lot of time

the note title bar for additional
notes. Press [AlIt] + [4] to
close the note windows (your
notes are automatically saved).

Q Calibrate your display

The colours you see on your
screen varies widely depending
on your monitor, graphics cards
settings, lighting and more.
Fortunately, Windows 7
provides a Display Colour
Calibration Wizard that helps
you ensure that colours are
represented accurately on your
screen and everything looks
crisp and sharp.
Click Start (or

someone. Choose the option
depending on your need.

Q Restore the Quick
Launch Toolbar

Alot of Windows Vista and

XP users will find the absence

of a Quick Launch toolbar in
Windows 7 annoying because you
sort of get used toit. It is disabled
by default but it only takes a
moment to restore it back.

Open the “Run” dialog box
by pressing Windows + [R]
and type gpedit.msc

On the left hand
pane, Navigate to User

press the Windows
key) and type dcew in
the “Search programs
and files” box to start
the Display Colour
Calibration Wizard.
Alternatively, you

can go to Control
Panel > All
Control Panel
Items > Display
and click on
“Calibrate Colour”
from the left pane

of the window.

Q Other mouse gestures

With mouse gestures in
Windows 7, instead of right-
clicking a Taskbar icon to
access the jump list, you can
left-click and drag upwards

to smoothly call it up. In
addition, clicking and dragging
down the address bar in
Internet Explorer will open the
browsing history.

Q EasyConnect

With Easy Connect in
Windows 7, offering help or
getting help is just a few clicks
away. You can use Windows
Remote Assistance to invite
someone to connect to your
computer and assist you, even
if that person isn’t nearby.

To access Easy Connect,
type Troubleshooting in the
Start Menu and then select
Get Help from someone you
trust. You would now get the
option to offer your help to
someone or get help from

Windows 7 now lets you calibrate your screen

Configuration, Administrative
Templates, and Start Menu and
Taskbar.

Double-click on the “Show
QuickLaunch on Taskbar” in
the right pane.

Select Enable, Click on
Apply and then press Ok.

Right click on Taskbar select
Toolbar > New toolbar.
Navigate to C:\Users\(user
name)\AppData\Roaming\
Microsoft\Internet
Explorer. Select the Folder
“Quick Launch” and click on
“Select Folder”.

Now You should see Quick
Launch Toolbar on Taskbar.

To make it look like it would

in Windows Vista, right click
the taskbar, uncheck “Lock

the Taskbar”, and you should
see the Quick Launch toolbar,
probably to the right. Right-
click its divider, clear Show Text
and Show Title to minimise the
space it takes up. Complete the
job by right-clicking the bar
and selecting View > Small
Icons for the true retro look.
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Q&A

Safe browsing
Mozilla to check Firefox add-ons in
an effort to close security holes

Opera update

The final build of Opera out with
added improvements such as
Turbo and easy tab management

Your questions, our answers

All your computer niggles and nags are dealt with here!

. Weird problem
with PC going to sleep
I have a PC running an Intel
Pentium 4 3.06 GHz processor,
512 MB DDR1 RAM, installed on
an Intel D865GSA desktop board.
A few days back, the mother-
board has been going into sleep
mode as told by my friend and
dealer. So, | have replaced the
motherboard and memory. Now,
I run a Biostar G31D-M7 hoard.
I’'ve also had to replace my 512
MB DDR1 RAM with a 1 GB stick of
DDR2 RAM.

I've installed Windows Vista
Ultimate on my machine. When
| was using my machine with
the old configuration, it didn’t
support Windows Aero, but now
it is working rather well. Now the
problem that I'm facing is that
sometimes my system doesn’t
start properly and it hangs
during start-up. If | restart it by
pressing reset button, it doesn’t
respond and locks up again at
start-up. | have to leave it idle for
some time. After that, it starts
properly otherwise | have to
repair my operating system using
the installation DVD. The same
problem occurs when | play a
game like Virtua Cop. After play-
ing a while, the PC shuts down
automatically and then, suddenly,
the start-up problem occurs
again.

| want to know why these
start-up problems are occurring
over and over again. What is
the solution for this and what is
this problem of board going into
sleep mode? | also want to use
Windows XP within Vista through
VMware. Will my machine allow
me to do so?

S.D. Sharma

The problem you're facing
could be because of a poor
power supply. If you haven’t
reinstalled Windows, then
maybe the older drivers are
causing some problems. Try a
fresh install and download the
latest drivers from the internet.

I hope your power supply is
perfectly fine. If it's more than a
couple of years old, you should
try using a different power
supply from a friend to see if
that’s the problem. Also, check
for loose connections - RAM and
power cables specifically.

If nothing works, it could
be a bug in the

even then. If it does, it could

be a problem with the LCD
display. Otherwise, it could

be a resolution problem. Try
reinstalling the graphics drivers.
If nothing works, you have no
other choice but to take it to
your local service centre to get
it fixed.

motherboard
which can

be fixed by a
BIOS update.
Look up for the
manufacturer’s
site for a list of
bug fixes. Be
extremely careful
if you go ahead
with flashing
the BIOS. You

wmake Y

Be a part of the first ever community created
Digit Fast Track. You get to collaborate,
create and control everything from the cover
to the contents. Post your troubleshooting
queries and answer those already posted
within the wiki. For more information,
www.thinkdigit.com/digitosp

can damage the
board.

1 GB of memory is a little
t00 less for Windows XP to run
within VMware. It’s worth trying
but another GB of memory
would definitely help

Laptop display
problems
Some two to three days back, |
noticed a slight problem with my
laptop’s LCD. Just at the bottom
of the screen, near the taskbar
where the shortcut icons and
time are generally displayed,
I could see a thin line blinking
across the LCD. It frequently went
on and off and then remained for
seconds. Could you please tell me
what it is and how to rectify this
problem?
My system configuration is:
HP Commercial 6530s, Intel Core
2 Duo CPU T5870 2 GHz, Windows
Vista Home Premium, 3 GB RAM.
I am far away from the service
centre.
Noklam Bisai
Arunachal Pradesh

Try opening up an image
in full screen or play a movie
at full screen. See if that line
keeps flashing and showing up

Bad sectors on

hard disk drive
I have an Intel Core 2 Duo PC with
a 320 GB hard drive and 2 GB
RAM. My hard disk has developed
bad sectors on it. | want to know
whether this is bad for my drive.
Can these sectors be fixed or
not? What is a bad sector? What
does it mean and what causes
them to occur?

Pawan Maurya

A'bad sector is a small
portion on the hard disk that
has suffered some damage and
is therefore unusable. The bad
sectors will not cause you harm
in day to day operation. The
scandisk utility marks the bad
sectors so that the operating
system skips them and no data
is written there. As for causes - it
can be physical damage during
the manufacturing process itself
or wear and tear or just faults
that show up randomly.

You can try fixing the
problem by right-clicking on
the hard drive with bad sectors
in Windows Explorer. Click on
Properties and click the Tools
tab. Under error checking, click
“Check now”. Check the box

that says “Scan for and Attempt
Recovery of Bad Sectors.” Click
on Start. If there are physical
bad sectors, the only fix to

give the drive for repairs or
replacement.

CPU usage is
always too high
My computer specifications are:
Intel Core 2 Duo E8400
MSI radeonR4850
MSI P45 Neo motherboard
800 Watt PSU

My PC is taking too much
time to boot. When | play FIFA
09, the game lags and the CPU
temperature rises to 65C. The
CPU usage is also too high at
some 50 to 56 per cent when
there’s nothing running on the
PC. Is this caused by some kind of
malware or virus?

Shreyan Mohapatra

Yes, it could be malware.
In the task manager, look at
what application is using the
most CPU resources. Sort by
overall memory consumption
and also CPU utilisation Also,
look for services or applications
that are taking up lots of
memory. Try closing those. If
that doesn’t work, uninstall
your motherboard and graphics
card drivers and reinstall them.
The last option would be to
try scanning the system for
malware.

. Is this the right
time to go in for a
graphics card?

I need suggestions regarding

Get Help Now!

E-mail us your computing
problems along with your contact
details and complete system
configuration to sos@thinkdigit.
com, and we might answer them
here! Since we get many more
mails per day than we can handle,
it may take some time for your
query to be answered. Rest
assured, we are listening!
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Q&A AMD adds more cores

Six-core AMD Phenom Il processors to

Win Mo ready to go

Windows 6.5 mobile handsets start

lining up for release

be out sometime next year

Dirt 2 will be one of the first games to run on DirectX 11

purchasing a graphics card. |
am about to buy a mid ranged
graphics card in the month of
September. | have read in Digit
that Windows 7 is going to be
released very soon and DirectX 11
games will be coming at the end
of the year.

So, should I buy my graph-
ics card in September or should
I buy it after the release of
Windows 7? Will DirectX 11 games
have compatibility problems?

| have been reading Digit
magazine for the past four
months. It is a very nice maga-
zine. Whenever | read it, | come
across terms like oveclocking,
SLI, CrossFire, HTPC etc. | don’t
know what the above mentioned
terms mean. Can you tell me?

Bharat Razdan

One or two DirectX 11
games might be out this year
but the big lot will only come
next year. It's not wise waiting
for those games and then
buying a DirectX 11 card. The
performance of those games on
mid ranged cards is yet to be
seen. You can go for a sub-Rs.
10,000 card for now and then
upgrading to something better
when the time is right and there
are plenty of DirectX 11 games
around. There is no shortage of
good DX9 games to play in the
meantime.

Overclocking is running a
component such as a processor,
graphics card, and memory
faster than what it’s meant
to. For these components, it’s
usually increasing the core
speed or the memory speed.

SLIis a standard used by

NVIDIA based motherboards
that let you use the power of two
or three cards by connecting
them together using a SLI-
bridge. CrossFire works in the
same way but is designed by
AMDY/ATI for their cards.
HTPC s a term used for
Home Theatre PC. They are
just like any other PC but
they are built with low power
components that require little
cooling and run quiet.

Graphic card

problem
| own a GeForce 8500GT graphic
card. | recently installed a fresh
copy of Windows XP on my PC
infected with virus. I installed
the drivers for the graphics card
and after the reboot, it showed
a black screen with the mouse
pointer. | tried restarting the
computer, but it shows up the
same thing. Also, the audio hard-
ware is not working, even after |
installed the drivers.

Len

You could try uninstalling
the drivers through the
Windows Safe mode and see if
it still boots up with the blank
screen. Try downloading an
older version of the drivers as
well. Also, try using the disc that
was provided to you with the
card. Try the same thing with
the audio hardware. You could
also try using Windows Update
to download the drivers for you.

DVD drive
problems
My system specifications are as
follows.

Processor: Intel Pentium 4 2.80
GHz

Memory: 1 GB DDR 2

Standard VGA graphics adaptor
250 GB hard drive

Moser Bear DH-22A8S DVD drive
Windows Vista Ultimate 32-bit

Over the last few days my
DVD/CD ROM drive has been
unable to read or write any
discs. Whenever | insert a disc,
the following message appears -
“Insert a disc”. Can you help me
with this problem?

Also please suggest a 19-inch
LCD monitor and a midrange
graphics card for the upcoming
release of Windows 7.

Bijesh

The DVD drive has most
likely worn out as they often do
after two years or so. You should
take it over to the vendor for
repair or replacement if it’s still
under warranty.

Look for the Samsung
SyncMaster D190S and AOC
F19. They should be between
Rs. 6,500 and Rs. 7,500. You
can easily find 22-inch monitors
around Rs. 10,000 and Rs.
12,000. Your current PC will run
Windows 7 just about okay. A
graphics card might let you run
the fancier Aero theme. Your
memory is more important.
Upgrading to 2 GB will help.

If you are thinking of playing
some games as well, then we
recommend you to upgrade
your entire system. If not, a
cheap GeForce 8400GS or
9400GT from Palit, ZOTAC or
POV will be sufficient.

Laptop
overheating problems
I have a Dell Studio XPS 13 (Intel
2.4 GHz, 4 GB DDR3 RAM, 320
GB hard drive) that heats up to
about 79 C while playing Call

of duty 4. Is this temperature
normal for a laptop? When I'm
not playing and just surfing the
web, the temperature stays at an
average of 50C.

I've tried to overclock my fan
but according to users on vari-
ous forums, the PC BIOS does
not permit this. I'm thinking of
buying a cooling pad but are
there any other solutions to cool
down my laptop?

Amon Pereira

A temperature of 79 Cis
quite high for the laptop but
as long as you’re not getting
stability issues, it should be
okay. The only way to cool
things down is to use a laptop
cooler like you said. You could
take the laptop to Dell and see if
they can service it and clean up
the insides for you. There could
be alot of dust clogged in the
heat sinks or the fan might be
running slower.

Registry problem
My PC configuration is as follows:
Processor: Intel 2.8 GHz Dual core
Motherboard: Intel D945,
80 GB hard drive, 1GB memory,
XFX 9400GT 512MB

I run Windows XP SP2.
Whenever | try to open up Task
Manager or Registry Editor, it
says that it is disabled by your
Administrator! | formatted my
PC twice but there has been no
change in the problem. I also
can’t run games like Street
Fighter 4 at the minimum resolu-
tion. At first, when I install the
game, it runs properly but when |
restart my PC, it starts giving me
errors that Visual C++ has failed
to load the floating module. It
also happens with games like
Crisis Warhead and Delta Force
Xtreme 2.

Laptop coolers can help maintain temperatures
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Q&A

OEMs like Google
Sony systems to ship with Google
Chrome browser

Joinin

Digit Open Source Wiki launches -
www.thinkdigit.com/digitosp

Your PC is most likely
infected by a virus. There are
many worms and viruses that
disable the registry editor and
task manager. The only easy
solution is to use an antivirus
to remove it. If the games you
mentioned require some Visual
C++ runtimes, you'll have to
download those and install
them if they are corrupted.

Data recovery
query
I have an Intel Core 2 Duo proces-
sor, 250 GB hard drive and 2 GB
RAM. My hard drive crashed and
I recovered data using Stellar
Phoenix. | am a MCA student and
this data is very precious to me.
For some reason, file recovered
with formats such as JPG, PDF,
RAR and ZIP aren’t opening. It
says unsupported type or version.
Even EXE files run but it show a
command prompt window and
closes instantaneously. | checked
the properties for the files but
everything seems okay. I tried
different operating systems such
as Windows XP, Windows Vista
and Linux. I also tried different
registry and system diagnostic
tools but nothing seems to work.

Vikram Paliwal

Data recovery isn’t perfect
every single time. So while
software might be able to
recover most of the data, there
are always bits of pieces of the
files that aren’t intact. This
might be fine for documents
but executables and archives
won’t open with the least bit of
corruption of missing data. The
bad news is that it might not
be possible to recover the files
accurately.

You could try contacting
Stellar or some of the other
physically data recovery
services. They might be able to
recover data from the drive but
remember that it could be very
expensive.

Windows XP
problems
My PC configuration is:
Intel Core 2 Duo E4600
Gigabyte S2C 945 GCM mother
hoard
2 GB DDR2 RAM
160 GB Hitachi HDD
Samsung DVD writer
Intex cabinet with 450 W SMPS
Viewsonic 19-inch TFT with only
D-Sub connector

I have Windows Vista and XP
installed on my system.

Speedfan has a built-in drive health feature that displays basic statistics about

the drive

1. Whenever | boot in XP,
Windows runs fine but when |
boot into Windows Vista, the
monitor goes blank randomly for

Stellar Phoenix is a general data recovery software
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a fraction of a second but other-
wise, it works fine.

2. My HDD activity light flick-
ers without any program running
and its operation is noisy too.
Also my operating system fails
every now and then.

3. Is a 450 watts power
supply enough if I add one more
hard drive and a graphics card?
Also, suggest a mid-range graph-
ics card for my configuration.

Paramijit Saggu
Chandigarh

Windows normally flashes
the display just before it boots
into the desktop. It shouldn’t
cause any serious problems.
The hard drive LED flickering
could be because of a highly
fragmented hard drive. Try
defragging the drive sometime.
If the hard drive is really old, it
could be some issue with the
drive. Try running a diagnostic
tool or use Speedfan’s internal
drive diagnosing feature.

The 450W PSU will run an
additional hard drive easily.
Whether it runs the graphics
card depends on the kind of
card itself. A basic entry-level
card like a GeForce 8400GS




Icy cool

Some overclockers are apparently making
their own thermal paste using diamond dust
And reportedly the cooling is remarkable

Dragon Ball Z: Sagas
The first Dragon Ball Z game to be released on a
non-Japanese console, the Xbox

Q&A

Startup viruses can be disabled by using the Windows msconfig tool

won’t be a problem but a
slightly more powerful card
might. A mid-range graphics
card would be a Radeon
HD4850 or a NVIDIA GeForce
9800GTX. Prices are around Rs.
7,000 - Rs. 9,000 depending on
the make.

OcC fail error

| have a problem with my
computer. Whenever it boots, it
displays an error message with a
note “OC failed. Please press F10
to change options on OC Fail”.
Can you tell me what it means
by OC Fail, and will it harm my
system? After continuing and
hooting, the 0S is erratic, the
mouse movement is jerky and
the desktop won’t respond. What
can | do?
My computer configuration is:
Intel Pentium D820, Intel 945GV
motherboard, 512 MB RAM, 80
GB HDD, Windows XP SP2. It’s a
HP Compaq DX2280.

Athreya Rao

The error OC fail
means overclocking failed.
Overclocking is forcing the
Processor or memory to rumn
faster than the default speeds
that it's supposed to. Get into
the BIOS by pressing the Del
key when that error shows up.
Reset settings to defaults. Save
and reboot. It should work but

you might have to change some
settings such as the boot order.

About my PC

| have the following queries to be

solved by you. I have Kaspersky

Antivirus 2009 licensed up to

January 25, 2010. Whenever

| start my computer, it says

“C:\WINDOWS\system32\

config\win.exe”, then it

says make sure that you type the

name correctly, and try again.
Nilash Pritish

The error with Cz\
WINDOWS\system32\
config\win._exe thatyou're
getting is because of a virus. The
virus might have been removed
by the antivirus but Windows
still tries to run it every time
it boots. You can remove this
startup entry by clicking on
Start > Run. Type mscontfig.
Look for an entry under Startup
for win.exe and delete it.

Overheating
problems
Digit’s Q&A section is one of the
most interesting sections of the
magazine. My PC configuration is:
Processor: Core 2 Duo E4600, 4
GB Transcend RAM, Palit GeForce
8600GT, 250 GB SATA hard disk,
LG DVD-RW and HCL 700SFL
monitor.
My problems are:

When | installed Vista 64-bit
on my PC, the DVD drive does not
respond very well. It won’t open
DVDs and the Autoplay feature is
also disabled. It shows the basic
preparation screen for the blank
disk. Also, when | play games like
GTA 4, | think my graphics card
gets hot and the temperature
rises to around 65C.

Give me an idea of how I can
cool that. I have four fans in my
cabinet. How can | direct them
for proper air flow?

The DVD drive might
be having some problems.
Typically drives go bad after
around two years or so. Check
to see if the drive works fine

outside Windows or in any
other operating system or
system.

Four fans are much more
than enough for the case as
long as two of those fans are
pulling in air and the other
two are blowing out air. The
graphics card temperature of
65C isn’t very high as well so
there’s nothing to be concerned
about.

Error at Windows
startup
I have an Intel core 2 Duo 6300
1.86 GHz processor powered
by 1.5 GB ram and 160 GB hard
drive with a GeForce NVIDIA
7300 GT PCI graphic card with
XP installed. Whenever | log
in any user account, | get an
error “Windows cannot access
SVCHOST.EXE. You may not
have appropriate permission
to access it”. This error started
when | removed this file as it
was affected by a worm. How
do I fix this file and the error?
| have attached a screenshot of
the error.

Gurleen Singh

The missing file isn’t the
SVCHOST.EXE that Windows
has. It’s a virus or worm that
was removed. The missing link
is the reason you are seeing
this error. First, make sure that
the file has been deleted from
the hard drive. Then, open up
msconfig from the Start >
Run window. Go to the Startup
tab and disable or delete
the entry that points out to
SVCHOST.EXE. £l
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Recession ends

According to several reports, the global
recession has finally ended. However,
employment figures would grow gradually

Digit web awards

For more on social and business
networking and job portals, read the
Digit weh awards special

Tech@Work

Changing lanes

post recession

An insight on improved job search techniques

Rishi Das

Co Founder and CEO,
CareerNet Consulting
readersletters@thinkdigit.com

ith the global
economic
downturn
subsiding,
the next two years or so are
expected to usher in a recovery
phase, there is a silver lining
amid the dark clouds on the
horizon that hints at better times
just round the corner. Markets
are slowly going in the growth
phase and instead of the usual
pink slip news, companies have
gradually started hiring. This
situation is ideal for job seekers
who were in staying put during
the downturn and are now
looking for new opportunities.
However, it will be best to take
the next career decision while
keeping the following aspects in
reckoning before making your
golden leap.

Industry
introspection

Analyse whether your current
industry is going to grow
slow or boom post recession.
If the answer lies in the prior
category, search for similar or
enhanced roles that align in
industries expected to grow
in the near future. Actively
research and map your career
graph in two or more high
growth industries and select
the one that better aligns to
your interests and strengths.

Select a promising
organisation

The recent downturn has
distinctly bracketed companies

in to three categories — non
serious, serious but unhealthy,
and serious and healthy. While
the first category is already

out of business, the second
category of companies is
grappling with the reality of the
situation. However, the clear
winners are the companies
who are serious and are with

a healthy business model.
Companies with sound growth
strategies, cost optimisation
solutions, steady cash flow

is underway. Companies
diversify to reduce their risk
and consolidate their market
leader positions. Effectively,
before committing your
services to any organisation
find answers to a list of
questions such as market
positioning of a company,
pre- and postrecession growth
cycles, employee perspectives
and the business potential of
the company. This will give a
clearer picture if the company

cycles are the ones that have
been able to weather the storm.
These are the ones to be looked
at as a potential employer.
However, be wary of companies
that have massively laidoff
resources during the recession.
In any business environment,
employee layoffs are essentially
a function of business
restructuring and people
performance. Nevertheless,
there have been
several layoffs due
to poor cash flows
and unplanned
growth. It’s wise to
stay away from such
companies.

We also witness
a slew of M&As as
a lot of business
consolidation

is well structured and
functionally sound to usher to
the next orbital of growth.

Actuate continuous
learning

The onset of recession made
us understand the importance
of continuous improvement of
our skills. During recession a
majority of finishing schools
witnessed huge rush of

applicants from both junior and
senior industry professionals.
Don’t wait for the next
recession to up-skill yourself.
Continuous learning to up-skill
is a key and is sure to add value
in the long term career path of
an individual.

Widen your job
search channels
Break away for the traditional
job search channels such as
job boards and newspapers.
Test the strength of your
network and actively use social
networking sites for assistance
from your old friends and
colleagues. This will help
you tap hidden job markets
and employee references
add weight to your resume.
Moreover, you will be privy to
more intricate details about
the company, job profile and
the culture of the firm. From
a compensation point of
view, individuals can expect a
15 - 25 per cent rise in their
compensation if they go in
for a job change. However, it
will be advisable to look at
the stock option plans more
seriously now as the markets
have bottomed out and will
only grow from here.

This downturn has set up
a lot of different benchmarks
in the industry. It has forced
companies and individuals alike
to be pragmatic in good as well
as bad times. Though, no one
can claim to know the future or
know what will unfold in the
time to come, it will be best for
employees to tread the path
of continuous learning, taking
right decisions on career and
keep themselves abreast with
upcoming industry trends. El
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Pricewatch

1 42 The latest prices of components
for you

To protect and serve

Agent 001 goes cabinet and power supply hunting, specifically for HTPC and high-end applications

Agent(001
agent001 @thinkdigit.com

childhood friend of mine recently

upgraded to a GeForce GTX

260 graphics card after much

ersuasion. When we opened his
cabinet to install it, I was horrified at the
signs of rust. Then we discovered his system
would not boot after adding this card. T
immediately suspected the power supply,
especially when I noticed it was a non-
branded 400 watt unit and his older GeForce
7300GS would work fine. Thus began the
hunt for a new cabinet and power supply.
Since HTPCs are super hot, HTPC

cabinets are also the in thing and most
vendors will be quick to point you to one.
I recommend these cabinets with caution
- sure they’re compact but the cheaper
ones are tacky and the cooling system
woefully inadequate, unless you're building
something based on the Atom platform. The
attraction is the diminutive size, which some
people will kill for — an unobtrusive cabinet
to be tucked away behind furniture with
a42-inch LCD TV getting all the glory is a
much sought after scenario. With shopping
for HTPC cabinets do consider the better
brands — their cabinets are built better
and smarter (by the latter I refer to better
cooling), and generally expansion support
is better. Brands like CoolerMaster and
Antec have some good models albeit pricier
than other offerings in the market. Check
out the Antec Fusion Remote Black, priced
at Rs. 10,400. For the price you get a fully
functional remote unit that works with the
cabinets built in LCD display for a hands-free
HTPC experience. The cabinet is built very
well and cooled via two 120mm fans. An
Antec 430-watt power supply available for
Rs. 4,100 would be an ideal companion. Not
only is it rated at above 80 percent in terms
of efficiency but it's also very suitable for
high-end HTPC applications. CoolerMasters
Media 260 is also available for Rs. 8,100 and
this is a really spacious case but available
without power supply. Corsair’s
VX400 is a good PSU for this case
available for Rs. 3,800. If you're
looking for an ultra cheap HTPC
chassis look at the Zebronics
Cube, available without a power
supply for Rs. 2,500 - it’s obviously

not as feature rich as the others mentioned
above but for some affordable cannot be
beaten.

For those looking at high-end rigs for
gaming or generally powerful PCs we
recommend larger, tower-type cabinets. By
high-end I mean a quad core processor, 2-3
hard drives, 4 GB of RAM and a graphics
card in the range of Rs. 15,000 or above.
You can opt for a steel based chassis or
one made of aluminium. The latter resists
corrosion and that is why I recommend it.
Steel cases without proper treatment tend
to rust around the edges and this gradually
worsens, especially if you live in a coastal
region or any area with higher humidity.
Cooling is also important; just having four
and five fans isn’t sufficient. The case should
have good airflow. Sometimes wrongly
placed fans can create cross currents of air,
which is not good for cooling. You want the
flow of air to be regular and strong and in
general cool air should be sucked into the
case from the front and possibly the sides
and blown out through the rear. A couple of
fans on the top of the case do not harm since
they assist the process of exhausting air out.
Cabinets that create a turbulence of air inside
them are no good for cooling. Fans are of
equal importance and most manufacturers
offer very cheap fans with their cases. For
someone blowing a lakh on a souped up

gaming rig I recommend buying your
own fans. Look at brands like

g

g

2

=

CoolerMaster, Antec, Scythe and NMB.
Larger fans are better for although their rpm
is lower than a smaller fan they will actually
move more air and silently owing to the
larger diameter of the fan blade. The figure to
look at when shopping for fans is their CFM
rating indicating the cubic feet of air they can
move in a minute, the higher this rating the
better the fan. Of course the higher the rpm
the noisier the fan - keep in mind.

If you really want something that is big,
looks good and built of aluminium, therefore
light and resisting corrosion look at the
CoolerMaster ATCS 840 - a superlative
case with very good cooling (it actually has
3 x 230 mm fans!). Priced at Rs. 15,000
the ATCS 840 represents the pinnacle of
a high-end cabinet and supports liquid
cooling solutions and up to 6 hard drives
with no problems whatsoever. The intake
fans also have dust filters - goodbye to
regular cleaning. The Antec 1200 is priced
at Rs. 13,000 and is another superb gaming
chassis albeit not built of aluminium and
without dust filters for the fans. This may be
an issue for someone living in a dusty area,
but in general I advocate the use of dust
filters since even regular cleaning does not
guarantee protection from a gradual rise in
temperatures. This is because dust slowly
works its wicked magic on fans inside the
case and on components reducing their
speed by gradually eroding their bearings.

If you must buy something good and costly
make sure it has dust filters since intake fans
attract a lot of dust.

If you are going for a powerful dual GPU
system like something based on a GTX 260
SLIL I recommend Corsairs HX 750 priced at
Rs. 8,500. For single high-end graphics cards
opt for Corsairs TX 650 priced at Rs. 6,500.

For a basic system I recommend a cabinet
like CoolerMasters Elite 330 priced at Rs.

2,500. If you want something a little

more powerful in terms of cooling
and of course something that looks
better, CoolerMasters 690 is also
available for Rs. 4,000. A good
power supply for any generic
PCis Corsair’s VX 450 —
priced at Rs. 3,800. If you
want to really squeeze it opt
for a VIP Gold 400 watt,
priced at Rs. 2,100. I don’t
recommend cheaper power

supplies.. Bl
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CM UCP900 goes gold

CoolerMasters UCP 900W Silver which
we tested has a new revision, the UCP
900 is now available with a 80+ Gold

rating

Silverstone Raven
The Raven is a unique concept with the
motherboard mounted at a 90 degree tilt from

Agent 001

regular cabinets meaning the connectors stick out
from the top. Pretty unique, and works well too

E | want to buy a S60 based mobile
phone & my budget is 15,000. It should
support 3G, should have good music qual-
ity, should support maps and also should
be well build. candy bar or slide either of
them will do. I would prefer a Nokia device.

Prabal chowdhury
AR suggest looking at Nokia’s 5800
Xpress Music. It’s a touch screen based
device and should serve your needs as it
has all the features you need.

E I’'m going to buy a new desktop PC.
Please recommend best gaming configura-
tion I can get in Rs. 30,000. Also please
keep in mind of AMD Phenom Il processors.
Yadwinder Paul Singh

AR 30,000 is a small budget for a
gaming PC. If you are willing to play the
latest games at lower resolutions and
lower levels of detail this budget will just
about do, especially since you want
everything including a monitor.

I recommend taking a close look at
our Killer rigs section. Look at our Basic
Rig for Rs. 21,350. Now simply add in a
graphics card like the GeForce 9800GT
and for Rs. 9,000 extra, you are covered
for a very nice gaming rig for Rs. 30,000

E | want to buy DELL TFT monitor

weather | should buy 18.5 inch i.e. E1910H

or 19 inch i.e. 1909W. Can | buy 18.5 inch?
Rishab Garg

PN There will be hardly any difference
between an 18.5-inch and a 19-inch in
terms of what you see. Rather opt for a
22-inch display if you budget permits you,
as these are hardly Rs. 3000 to 4000 more
than a 19-inch monitor.

E I am a Photographer & Videographer
by profession. Presently | am using Adobe

Premiere 6.5 for my video projects and the
system configuration is as follows: AMD
Athlon X2 5200+, Asus M2N-MX SE
Motherboard, 2*512MB DDR2 RAM,
2*250GB Seagate HDD in RAID 0, Sony
DVDWriter, iBall Cabinet and LG 17-inch CRT
monitor. Now | am planning to upgrade to
a new configuration with Adobe Premiere
CS3 as my video editor. Please suggest me
the best hardware configuration within a
budget of Rs. 60,000.
Manoj
Sky Digital Studio

X vou configuration is indeed a weak for
CS3. Normally I would suggest a Core 2
Quad system but I'm going to give you a
Core i7 since after we extensively tested
these CPUs in our test lab, we found them
to be superb for any kind of 2D image
editing and 3D rendering. I am not
recommending peripherals like keyboard
and mouse as any brand is good enough
depending on your usage. You already
have a monitor and I recommend you use
that for now, as high-end LCDs are costly.
I refrain from suggesting cheaper LCDs
like the 19-inch and 22-inch ones

Category Component Price

CPU Core i7 920 14,500

Motherboard | MSI X58 Pro / Bi- 12,500
ostar Tpower X58

RAM Kingston DDR31x | 5,000
3 GB (1333 MHz)

Hard Drive WD Caviar Black 7,000
Edition 1 TB

Graphics Card = ZOTAC GeForce 6,000
9600GT

Power Supply | Corsair VX550 5,500

Cabinet CoolerMaster Elite = 2,500
330

DVD Writer LG G55n 1,400

TOTAL PRICE Rs.

54,400

available now since they will not suffice
for anyone needing accurate colours.
There is one recommendation - Dells
2209WA - this is an IPS panel and for Rs.
16,000 is your best bet for a great
monitor.

@ I want to buy a cell phone. My budget
is Rs. 13000. | figured out Nokia 5630
Xpress music and Sony Ericsson w595.
Please suggest something. | don’t want any
other brands.

Naveen Kumar
AR totally depends on what you are
looking at. If you want better music
quality T recommend the Sony Ericsson
w595. If you're looking for a Symbian
based device with better application
support then look at the Nokia. Either
way you can’t go wrong with your choice.

@: | have Intel Core2 Duo 2.2GHz, 3 GB
memory, Intel D945 Board & Radeon
HD4650 Graphics card. | want to know that
will this hardware support games devel-
oped on cryengine3 like Crysis 2. If no
please suggest the upgrade.

Sarang Bokil
PN This card will definitely not be able to
play Crysis 2, especially since it barely
runs Crysis. You cannot buy a card today
for a game being released in the future. If
you want the fastest card available today,
it is the NVIDIA GeForce GTX 285. ATI’s
Radeon HD 5870 is also headed for the
market soon. I suggest you hold your
horses a bit and hang on to your cash for
the next 3-4 months. Things are going to
get more interesting with DX 11 cards.

@ please tell me the difference between
core 2 duo and quad core and which is
better. Guide me to buy a best laptop rang-
ing between 45k and 55k, which can be
used in college with bulk storage good
performance of network net systems and
good processing speed.

Pratyush Rai
PN A Core 2 Duo is a dual core processor
based on Intel’s Core architecture which
the term quad core is generic and refers to
a processor with four cores. There are
many quad core processors available. The
Core architecture-based equivalent is the
Core 2 Quad. They also have a Nehalem
based quad core called the Core i7
processor, this family also has many
models. AMD also has their Phenom and
Phenom II processors, which are quad
core. I recommend the Acer 5738G, we
tested it and it’s powerful enough with
very good performance for its price,
which is Rs. 40,999. F1
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NILLER RI1UVO Multimadia oo gam
B Multimedia cum gaming rig = Rs. 80,700

everything you will ever need to build your MUltra high-end PC / Gaming rig = Rs. 1,52,200
own PC. whatever your budget.
HARD DISK CABINET
MONITOR Seagate 250 GB 7200.11 / Rs. 1,900 Zebronics Antibiotic / Rs. 2,100
ViewSonic VA1928wm / Rs. 8,200 M Seagate 1 TB 720011/ Rs. 5,200 M CoolerMaster 690 / Rs. 4,400
W AOC 2230fm / Rs. 14,000 M\Western Digital Velociraptor 150 GB M CoolerMaster ATCS 840 / Rs. 12,000
MDell S2409W / Rs. 15,000 /Rs.9,900 or Western Digital 1 TB

Black Edition / Rs. 6,800

POWER
VIP 350 Watts / Rs. 850

M Corsair TX 650 / Rs. 6,500

M CoolerMaster RealPower Pro
850W / Rs. 11,200

GRAPHICS CARD
None
M Zotac GeForce GTX260 / Rs. 15,000
BZOTAC GeForce GTX 295 / Rs. 29,000
MOTHERBOARD
ASUS NVIDIA 7025
M2N68-AM / Rs. 2,250
BASUS P5Q / Rs. 8,500
BASUS P6T Deluxe

/ Rs. 21,000
MOUSE
SPEAKER Logitech 3 button scroll / Rs. 300
None M| ogitech MX518 / Rs. 1,300
M Altec Lansing MX 5021 MRazer DeathAdder / Rs. 2,500
/ Rs. 6,500
M| ogitech Z5500 KEYBOARD
/ Rs. 14,000 Logitech Multimedia / Rs. 400
M Logitech G15 / Rs. 4,400
M| ogitech G15 / Rs. 4,000
SOUND CARD
None / NA
W ASUS Xonar DX / Rs. 3,700
B ASUS Xonar DX / Rs. 3,700
MOUSE
NLOGITECH 3 BUTTON SCROLL / RS. 300
NLOGITECH MX518 / RS. 1,300
NRAZER DEATHADDER / RS. 2,500
CPU
AMD Athlon XP 6000+ / Rs. 2,850
Mintel Core 2 Duo E8400 / Rs. 8,200
Mintel Core 17 / Rs. 14,600
RAM

2 x 2 GB DDR2 800 MHz (Kingston Value) / Rs. 2,500
M2 x 2 GB DDR2 800 MHz (Corsair XMS2) / Rs. 3,000
M2 x 3 GB DDR3 Corsair Dominator 1066 MHz DDR3/ Rs. 9,000



Price watch

Motherboards
ASUS M3N78-EM Rs. 4,300 November 2008 AM2+ 1 6 4
ASUS P5Q Deluxe Rs. 14,900 June 2008 LGA775 2 6 6
ASUS P5Q-PRO Rs. 9,650 LGA775 2 6 6
ASUS P5Q-E Rs. 11,350 LGA775 2 6 8
ASUS P6T Deluxe Rs. 20,975 october 2009 LGA1366 3 6 8
f‘;eusf g:‘:‘f“g’ranfgr')' Extreme o 26,000 October 2009 LGA1366 3 6 6
ASUS Rampage Il GENE  Rs. 16,450 october 2009 LGA1366 2 6 6
ASUS M4A79T Deluxe  Rs. 13,050 October 2009 AM3 4 5 6
GIGABYTE EX58-UD5 Rs. 16,950 October 2009 LGA1366 3 6 8
Gigabyte GA-EP45-UD3R  Rs. 8,900 LGA775 1 6 8
ﬁ'DGAﬁ_?YTE EEELE = Rs. 9,100 October 2009 AM2+ 2 6 4
Gigabyte GA-EX58-UD3R  Rs. 14,250 LGA1366 2 6 8
MSI X58 PRO Rs. 11,300 October 2009 LGA1366 3 7 6
MSI P7N Diamond Rs. 15,200 LGA775 4 6 6
MSI X58 Eclipse Rs. 20,250 LGA1366 3 10 8
XFX nForce 790i Ultra Rs. 21,050 October 2009 LGA775 3 6 6
Zotac 780i Supreme Rs. 14,500 LGA775 3 6 6
Zotac nForce 750a Rs. 6,500 AM2+ 2 6 4

Digital Cameras

Model Market Price Tested in Sensor Optical Zoom LCD Screen Size
Canon Powershot SX120 Rs. 14,995 October 2009 10 MP 10x 3.0 inches
Canon IXUS 100IS Rs. 12,999 October 2009 12 MP 3X 2.5 inches
Canon Powershot A480 Rs. 7,499 October 2009 10 MP 3.3x 2.5 inches
Canon A11001S Rs. 9,499 October 2009 12 MP 4x 2.5 inches
Canon IXUS 95IS Rs. 10,500 October 2009 10 MP 3X 2.5 inches
Canon SX200IS (BEST Rs. 21,500 October 2009 12 MP 12x 3.0 inches
PERFORMER)

FujiFilm FinePix F200 Rs. 17,999 October 2009 12 MP 5x 3.0 inches
FujiFilm FinePix S1500 Rs. 12,500 October 2009 10 MP 12x 2.7 inches
Kodak C140 Rs. 4,999 8 MP 3X 2.4 inches
Nikon P90 Rs. 23,995 October 2009 12 MP 24X 3.0 inches
Nikon Coolpix L20 Rs. 7,750 October 2009 10 MP 3.6X 3.0 inches
Nikon $220 Rs. 8,500 October 2009 10 MP 3x 2.5 inches
Olympus FE25 Rs. 5,995 10 MP 3x 2.4 inches
Panasonic FS4 Rs. 6,750 8 MP 4x 2.5 inches
Samsung ES55 (BEST BUY) Rs. 6,990 October 2009 10 MP 3X 2.5 inches
Sony HX1 Rs. 29,800 October 2009 9 MP 20x 3.0 inches
Sony S930 Rs. 7,800 10 MP 3X 2.4 inches
Sony H20 Rs. 17,500 10 MP 10x 3.0 inches

External HDDs

Model Market Price Capacity Interface Warranty (Years)
Seagate Freeagent GO Rs. 5,150 500 GB usB 5 years
Seagate Freeagent GO Rs. 3,250 250 GB usB 5 years
Maxtor One Touch 4 Mini Rs. 3,200 250 GB UusB 5 years
Transcend StorelJet Rs. 2,725 160 GB USB 2 years
Western Digital MyPassport Rs. 2,850 160 GB usB 3 years
Western Digital MyPassport Essential Rs. 4,100 640 GB usB 3 years
Western Digital MyPassport Studio Edition Rs. 7,800 1TB USB, FireWire, eSATA 3 years
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Price watch

Model Market Price Tested In Socket Speed FSB L2 Cache
AMD Sempron 140 Rs. 1,950 September 2009 AM2+ 2.7 GHz 2000 MHz HyperTransport 1MB
AMD Athlon X2 5200+ Rs. 3,200 November 2008 AM2+ 2.7 GHz 2000 MHz HyperTransport 1MB
AMD Athlon X2 7850 BE  Rs. 3,350 September 2009 AM2 2.8 GHz 2000 MHz HyperTransport 2 MB
AMD Athlon Il X2 250 Rs. 4,100 September 2009 AM2+ 3 GHz 2000 MHz HyperTransport 2 MB
AMD Athlon Il X2 550 Rs. 5,450 September 2009 AM2+ 3.1 GHz 2000 MHz HyperTransport 1MB
AMD Phenom X4 9650 Rs. 6,025 November 2008 AM2+ 2.3 GHz 3600 MHz HyperTransport 2 MB
AMD Phenom Il X3 720 BE Rs. 7,500 September 2009 AM3 2.8 GHz 2000 MHz HyperTransport 1.5 MB
AMD Phenom Il X4 810 Rs. 8,350 September 2009 AM2+ 2.6 GHz 2000 MHz HyperTransport 2 MB
AMD Phenom Il X4 920 BE Rs. 9,650 AM3 2.8 GHz 3600 MHz HyperTransport 2 MB
AMD Phenom Il X4 945 Rs. 12,075 September 2009 AM2+ 3G Hz 2000 MHz HyperTransport 2 MB
AMD Phenom Il X4 955BE Rs. 13,100 September 2009 AM3 3.2 GHz 2000 MHz HyperTransport 2 MB
Intel Dual Core E2200 Rs. 3,000 September 2009 LGA775 2.2 GHz 800 MHz 1MB
Intel Dual Core E5200 Rs. 3,375 September 2009 LGA775 2.5 GHz 800 MHz 2 MB
Intel Core 2 Duo E7400 Rs. 5,900 September 2009 LGA775 2.8 GHz 1066 MHz 3 MB
Intel Core 2 Duo E8400 Rs. 8,850 September 2009 LGA775 3 GHz 1333 MHz 6 MB
Intel Core 2 Quad Q8200 Rs. 8,650 September 2009 LGA775 2.33 GHz 1333 MHz 4 MB
Intel Core 2 Quad Q8400 Rs. 8,750 September 2009 LGA775 2.4 GHz 1066 MHz 8 MB
Intel Core 2 Quad Q9400 Rs. 12,100 LGA775 2.66 GHz 1333 MHz 6 MB
Intel Core 2 Quad Q9550  Rs. 12,601 LGA775 2.83 GHz 1333 MHz 12 MB
Intel Core i7 920 Rs. 14,900 September 2009 LGA1366 2.66 GHz 4.8 GT/s QPI NA
Model Market Price Tested in Size Resolution Contrast Ratio  Response time
Acer V203H Rs. 7,250 20-inch 1600 x 900 10000:1 5ms
ASUS VM193D Rs. 6,850 19-inch 1440 x 900 800:1 5ms
BenQ E2200HD Rs. 9,950 21.5-inch 1920 x 1080 1000:1 5ms
Dell 19909W Rs. 6,800 19-inch 1440 x 900 1000:1 5ms
Dell S1709W Rs. 7,200 17-inch 1440 x 900 600:1 8 ms
Dell S2409W Rs. 14,750 24-inch 1920 x 1080 1000:1 5ms
LG 177WSB Rs. 6,300 May 2008 17-inch 1440 x 900 700:1 8 ms
LG W1942T Rs. 6,900 19-inch 1440 x 900 700:1 5ms
Samsung 2033 Rs. 7,250 20-inch 1600 x 900 15000: 1 5ms
Samsung 733NW Rs. 6,550 17-inch 1440 x 900 1000:1 8 ms
Samsung 943NWX Rs. 7,500 19-inch 1280 x 1024 1000:1 5ms
ViewSonic VA1918WM Rs. 6,600 19-inch 1440 x 900 1000:1 5ms
VIEWSONIC VX2255WMB Rs. 12,500 May 2008 22-inch 1680 x 1050 1000:1 5ms
ViewSonic VX2240W Rs. 9,900 22-inch 1680 x 1050 1000:1 2 ms

Graphic Cards

Model Market Price Tested in Core Speed Type of memory Memory

EVGA 9600GT Knock-out Rs. 6,650 November 2008 700 MHz GDDR3 512 MB

Power Color HD4850 Rs. 6,600
Power Color HD4670 RS, 4,650

August2009  625MHz GDDR3 512 MB
August2009 750 MHz DDR3 : 1024 MB

Palit GeForce 9400 GT Super “Rs. 2,525 ~ August 2009 550 MHz i GDDR2 i 1024 MB

Palit Radeon HD 4870 SONIC : Rs. 13,500 : October 2008 : 750 MHz : GDDR5 : 512 MB

Palit GeForce GTX 260 'Rs. 1,0750 : : 650 MHz : GDDR3 : 896 MB

Palit GeForce GTX 275 ‘Rs. 1,3900 i i 633 MHz i GDDR3 i 896 MB

XFX GeForce 8600 GT Rs. 3,150 . . 540 MHz . GDDR3 . 256 MB
ZOTACGeForce GTS250 Rs.9250 . 738MHZ GODR3 . 1024MB
ZOTAC GeForce GTX 285 Rs. 26,000 Feb 2009 648 MHz GDDR3 1024 MB
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A beautiful platform, side-scrolling
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Pimp My Gadget

Kumar Jhuremalani
Siddharth Parwatay
kumar.j@thinkdigit.com
siddharth.parwatay@thinkdigit.com

ou've just bought yourself a shiny

new mobile phone or you might

have just assembled a new PC and

we're sure you are happy with it.
But there is always a feeling deep down
inside that something is missing, there is
something that makes you feel that this
new gadget or device is not completely
yours. We believe you, this feeling is
present in almost all of us - the need to
personalise or customise everything we
own. Be it a mobile phone, a computer or
even something as small as a flash drive,
we need it to be unique and different from
the one owned by the average Joe. So what
can you actually do to make your gadget
more like you, well that's what we’re here
to tell you.

There are many things that you can
customise, but what we’re focusing on here,
is all about our gadgets and other technology
products. Even so, the few of us who admit
to geekdom, will not shy away from wearing
that attitude on tshirts, shoes, etc. so there’s
a bit about that too along the way.

You must have heard of the show called
‘Pimp my Ride’, where all the bling is added
to a person’s car, well we’re talking about

TO SKIN A CAT

We had a word with Eshan P Paarekh,
Director of SkinJam, and found out what it
was all about.

Could you explain what SkinJam is to
our readers?

SkinJam! Is about personalisation and
protection of your gadgets. More gadget
lovers will be amazed by the great concept
of SkinJam's custom made high quality skin
wrap service.

What made you bring this unique and
interesting idea to the Indian market?
We thought that SkinJam is a very good
idea for us because something like this

has never been introduced in India. As it is
a very creative thing to do and also helps
people to personalise their gadgets.

What are the products that you have
made skins for up until now?

We have done it on all kinds of cell phones,

pimping your gadgets, read on to find out
more.

The easiest thing to do for small
handheld devices is to attach accessories
to them. These could vary from small
keychains or lanyards that can be attached
to mobile phones. If you notice, most
pen drives now days come with a small
attachment option, you could easily use this
to attach a lanyard of your choice, which
makes the device different from the others
available and at the same time makes it easy
for you to identify.

Hello Kitty lanyards have become quite a craze
these days

For mobile phones, another option is
buying a funky external cover, but again,
these are sold in bulk, so you might come
across a random person with the same
cover as you.

Other than mobile phones and flash
drives, portable gaming devices such as
the Nintendo DS and Sony Playstation

laptops, PSP, cigarette lighters, and pen
drives.

Do you give customers a chance to
submit their own designs or is it always
designs set by you and your staff?

We have more than 350 designs in our
shop and the customers can select from
that.

How much does SkinJam charge for this
unique service?

We charge Rs. 700 — Rs. 1,000 for the cell
phones and for PSP and laptops it is Rs.
1,800.

Can your skins be delivered to a person’s
home, where he can apply it to his
gadget on his own, or will he have to
visit your store?

We do not give the skins in hand to any
customer. The customer will give us their
gadget and take it back modified after 2-3
hours. We do the procedure in our shop.

Portable (PSP) are becoming quite popular.
Personalising these devices would definitely
require a bit more than just key chains or
lanyards. There are places where you can
buy and replace the entire body of these
devices. There are two uses for this, first you
could save the original body from the usual
rough handling and scratches and use it
later, or do the reverse by using the device
completely, and when bored change the
body, which in both cases offers protection.
To further customise a PSP or DS, there is
something even better you could do - skin
it. No, we don’t mean peel the skin off your
device, but instead, put on a fancy new skin
that personifies your individuality. These
skins are available in sticker format and

are made specifically for these devices, so
there’s no cutting of any sorts needed, it’s
just a simple sticker, but looks great and
you won’t be able to know the difference.
One might even think that it is the natural
design of that device.

Choose from a very extensive list at decalgirl.com

Not only can you skin just the PSP and
DS, but there are a range of devices such as
mobile phones, mp3 players, video game
consoles and even laptops. The web site
www.decalgirl.com offers skins for specific
products and the entire range is listed on
their site. Again, there is a small chance that
the same skin might be used by someone
else, and you will lose out on the entire
personal and unique look that you are going
for. Well, don’t be disheartened, decalgirl.
com also offers customers a chance to get
templates and design their own skins, but
these templates can be used only for the
products listed there. To take this one step
further, there are some stores that offer even
more personalisation by adding crystals and
gems to gadgets. You might have seen some
celebrities on the television walking with a
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A MacBook that has gone through SkinJam

mobile phone covered in diamonds; well,
you can have that done to your phone to.
Just visit the store called SkinJam, located
in Mumbai and Bengaluru, and you can get
this done. You have more of an option to
personalise considering the fact that there is
no limit to certain models that you can have
a skin added to, in comparison to decalgirl.
com where you have to stick to the models
present on the site.

There is a chance you can even get a
skin for your PC cabinet which will look
uber cool. The main drawback here is that
you can’t do it yourself and the designs are
mostly fixed, but you can see the employees
of the shop work on your gadget, good
for the people who don’t want to get their
hands messy.

Customising a digital camera is also possible now

Alright, enough about the small devices,
what about adding that custom feel to
your best asset? Stop thinking too much,
all we're talking about is your computer,
which most of us geeks would have
understood right away.

One of the best ways to start off your
customisation experience is by modifying
your cabinet. Those of you who have deep
pockets and don’t mind spending quite a
bit can just buy the most expensive cabinet
out there which will be unique in a way, as
not many people will actually spend that
much on it. But, for the rest of us who fall
under the value segment will need to look
for other means to satisfy our thirst for
customisation. The customisation we're
talking about is case modding, which
started as a hobby for some, who have
now turned it into a profession. We spoke

INSIDE THE MIND OF A CASE MODDER

We also got in touch with Waseem Yusuf
and found out what drove him to this
extreme profession

What made you take up Modding as a
profession?

Since childhood, I've always been
fascinated by computers. I saw a
computer for the first time when I was in
3rd standard and there was instant love
between the two, which has been growing
ever since. So as my love for computers,

I wanted to try something different. It all
started as experimentation with my PC and
the results have been pretty impressive!
Slowly I started modding my friends’
computers and finally took it up as a
profession. Though I believe modding is a
way of expressing oneself and not exactly a
profession, every mod is like a work of art.
Did you start with a normal job and then
just realised that it's not for you?

I was a trainer at NIIT for Java and .NET.

I'm basically very creative, so teaching
programming language was quite boring
for me. I decided to start my own business;
as I said, my love for computers have always
been there all my life and slowly I realised
this is what I wanted to do in life.

In the initial phase when you started,
were you just good at it, or did you
practice a lot before opening up shop?

Initially, it was a little tricky to do it, but

once I got the hang of it it was much easier.
Modding isn't just about cutting sheets and
placing cooling fans. Each mod is unique and
requires different skills. This makes each mod
special in its own way. Like I said, modding

is like art.

Where do you draw your inspiration or
ideas for each unique mod?

I get inspired by a lot of things such as

The phone covered with expensive crystals - toys
for the rich and famous

to Waseem Yusuf, a 21-year old B.Com
graduate who has converted his hobby of
case modding into a profession and has
also started his own web store.

Where does one start with case modding,
well firstly we’d suggest you purchase a
fairly priced cabinet that you know you're
going to use to mod, and won't feel sad even
if something were to it in the process. This
point is also agreed by Yusuf, who himself
found modding tricky when he first started.

Case modding, doesn’t necessarily have

colours or cars/bikes. But modding is a way
of expressing oneself and so I try to get
inspiration from who I am.

Do you mod anything other than PC
cabinets? (eg. Xbox360s, PS2s, PS3s, etc)
We haven't tried modding consoles, but yes
it's a great idea to mod one's consoles to
make them unique.

What are the tools that you use for
modding?

We use some basic tools such as Dremel,
Drill, Spray Paint, Hole saw, Jig saw, Double
Sided Tape, Laser Cutting, Laser Etching.
Every mod requires use of different tools;
hence, at times not all of these tools come
into use. More than the tools one needs
the skills. Jobs such as etching the Logo

on the acyclic sheet require highly specific
machines.

How easy is it to obtain these tools?
These tools are used in many other industries
and can be obtained from most hardware
shops. Modding is more about skills,
creativity and one needs to concentrate &
put in a lot of effort. I have always believed
in quality and to get the best quality one
needs to be precise in his work. And to get
perfection, the quality of tools used matter
alot.

To read the full conversation we had with Yusuf visit
http://www.thinkdigit.com/d/97843
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Facebook keeps growing
Facebook claims to be the largest social
networking site as it has 300 million
active users online per month from
around the world

Leap of faith

A shoebox sized robot is being
delevoped by the US military that can
leap over obstacles over 25 feet and
can navigate with the use of GPS

to mean that you need to cut a piece of your
cabinet, a nice paint job for your cabinet is
also considered a mod. Yusuf specialises

in glossy paint jobs and side panel cuts

for various clients. He has now moved on
to modifying cabinets keeping a theme in
mind. One of the mods he has done was for
the CEO of Vodafone India.

Once you have cut and put a shiny coat
of paint on your cabinet you can add more
class by using custom made fan grills and
also customise the internal hardware of the
computer. If you have a transparent side
panel, you might want to show off what’s
inside your cabinet. You can replace all
the normal cooling fans within the cabinet
with fans with LED lights or separately
install LEDs to highlight your hardware.

Cutting the cabinet is just the basics of
case modding, but how much further can
that go. Well, a couple of years ago Team
Digit had done an extreme monster mod
and fit an entire computer into the case of
a CRT monitor. Not only that, but at that
time we moulded out a monster. Check out
the link to get a blast from the past.

Some of the really risky things that have
been done by people are completely cutting

up motherboards so that they can fit into
the unique designs created and even create
transparent casings for hard drives with
LEDs lined on the inside, something we
have yet to try.

A complete overhaul is also a possibility
once you have a particular theme or
concept in mind. Check out some of the
crazy mods below that really inspire us to
do something insane.

One of the greatest expressions of
product customisation - though on the
non gizmo side - is in the form of custom
t-shirts. You can say a lot to the world at
large by just wearing a slogan, picture or
sketch. It’s the literal form wearing your

attitude. For a long time when it came to
zany, smarty or eyebrow raising t-shirt prints
the only option was the Tantra retail brand;
famous for their collection of one-liners. But
why go by someone else’s creation, when
you're more of a wise guy yourself? And
certainly, why would you want to wear one
of those boring brands that make unwitting
promotional signboards out of you. Custom
designed T-shirts are a way to express your

Check out the Digit Extreme Mod Project at
http://www.thinkdigit.com/d/40962

individuality. With custom T-shirts you
can make a statement by wearing a T-shirt
that says “di9it inside” or even profess
undying love for your favourite band
through pictures or lyrics. You even have
the option of being as fabulously offensive

A case mod made completely of Lego

Who says computers can’t have wheels?

Oh no! the Incredible Hulk ripped out my PC

Believe it or not, but there’s a PC in that guitar

An extreme Doom 3 cabinet
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More WiFi

The next generation Wi-Fi technology,
802.11n, has finally been approved

as the standard, even though it was
conceived seven years ago

Power of the sun
Students from Tuft University and
the Boston Architectural College have
created a house that runs completely
on Solar Energy

A corny design from tshirts.in

or fantastically tongue-in-cheek witty as you
want.

There are many websites that have
entered the fray to offer custom T-shirts
among other customised stuff like mugs,
mouse pads and stickers. A class of web
sites in this segment are primarily photo
printing web sites such as zoomin.com that
also let you print photos on T-shirts. Then
there are dedicated personalisation web
sites like early entrant myntra.com and
several others including pringoo.com and
dilsebol.com. The last category of T-shirt
web sites do allow you to submit your own
designs but for shopping on the fly you
need to bank upon the hundreds of crazy
designs already created by their designer
communities. Let’s have a look at some of
the web sites and what they have to offer.

myntra.com is by far India’s largest
on-demand consumer products
personalisation brand. The web site is easy
to navigate and their after sales service is
excellent. For customising products the
web site has a nice applet which lets you
add text and upload your own images
while showing an instant preview. The
user-generated designs and one-liners
are not as snappy as some of the other
players but there is certainly quantity.

You have loads and loads of categories
and thousands of designs to choose from.
Look for the Digital world and Nerd
categories under Life. The pricing too

is reasonable. Head over to myntra.com
for a clean shopping / gifting experience
and look out for their collaborative

offers. pringoo.com is yet another custom
design franchise offering you pretty much
everything including custom T-shirts,
stickers and even chocolate wrappers
powered by Cadbury’s. The designing
applet works really well but doesn’t offer
as many fonts as Myntra. The community
generated designs are especially witty. The
“computer age” and “gaming” categories
have nice designs. We found one that says

Some inkfruit designs

“PC Problem? Date a geek” and others that
are too raunchy to even mention! Dilsebol.
com really has nothing to offer that's worth
writing home about. The design tool is
very buggy, while browsing through other
designs is painful. The only thing worth
mentioning was the option to modify
pre-existing designs. Now we come down
to the last category of web sites that allow
you to submit designs into the general pool
of designs, but if the design is ever to see
the front of a T-shirt it needs to be really
good and hence approved. The benefit of
this is that you get access to a set of really
high quality designs and a vibrant active
designer community. In this space we have
tshirts.in, inkfruit.com and bluebustees.
com. tshirts.in may not look all hot a site
but has some really nice designs.

The slogans are insanely funny and the
t-shirts quite affordable. inkfruit.com has

T-SHIRT PRINTING TECHNOLOGY

We were quite curious to know more
about the actual technology that enables
printing on T-Shirts. What are the different
processes? Which one is more suited for a
particular cloth or colour scheme etc. So,
we met Mr. Mukesh Bansal, CEO of Myntra.
com for some insights into this field.
There are currently four types of printing
technologies being used. Screen Printing
is a more traditional type of technology. It
is used for printing T-shirts in bulk where
you have only a fixed number of colours.
If there are are four colours a screen will
be printed for each of the colours. Only
the part that is treated gets transferred
with a run of each screen. That way there
is a limitation of six to eight colours. So,

in this type of printing you need bulk for
the economies of scale to apply, otherwise
one T-shirt will cost you Rs. 5000 which

is not very practical. For printing single
T-shirts one of the technologies available
is sublimation. This can work only work

by far the most artistic designs and actual
photographs of T-shirts being worn. We
quite liked some of the Pac man and Tetris
prints. Being the sentimental geeks that we
are the first thought they evoked was “now
that’s cool”. Then there are noteworthy
vector art creations. The web sites offers its
designer community several competitions
and prizes. So if you feel you have it in
you, be a prosumer and submit your own
designs.

Next up bluebustees.com has two
very disparate and interesting categories
for browsing, viz. Parents Approved and
Parents NOT Approved. Without going
into details the category names should
give you a fair idea of what you can expect
in each. So go ahead create your own or
choose designs that speak to you and
express yourself. We're pretty sure you'll
turn a few heads. [l

for poly-cotton T-shirts. The design is first
printed on paper with a special ink, which
doesn't get absorbed on the paper. Then
the paper is heat-pressed on the cloth so
the colour gets absorbed on the cloth. The
finish comes out good but this is limited to
white polycottons. At the most very light
colours. Then there is something called
DTG (Direct to Garment) Printing. This is
basically a modified inkjet and can work
on any kind of surface. It supports 32 bit
colour printing. The machine pretty much
also looks like an inkjet printer. Lastly there
is Print and Cut which is used for intricate
designs. In this form the design is first
printed on a special media and the outline
is cut before being heat pressed onto the
fabric. Vendors need to make a choice
between these technologies depending

on the formulation of design; whether it
consists of a photograph, slogan, or vector
graphics etc. and the type of fabric and
colour that was chosen.
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Aditya Madanapalle
aditya.madanapalle@thinkdigit.com

rine is a 2D platformer that is part of an :
emerging trend of the gaming industry to }
revisit it’s roots, and re-think the whole idea :
of 3D gameplay. Trine is based on a robust

physics engine, that encourages players to think

of creative ways to overcome obstacles using their

surroundings.

There are three characters that the game starts

with. Pontius, a Knight, Zoya, a thief, and Amadeus,

a magician. The souls of these three heroes are

combined into a single entity as the three reach out

to grab an artifact at the beginning of the game:

At this point, there is a charming exchange of

words between, which only surfaces in the chapter

transitions. From then on, the player can switch to

any of the characters during the gameplay to use the

abilities unique to these three heroes. The magician

can conjure up boxes to overcome obstacles, the

knight is for melee combat using a sword, and the

thief uses a grapple hook to swing across chasms,

and a bow for ranged combat. Later on into the game,

the heroes get additional abilities, but these are too

few and far between for the development angle to

be engaging. The magician gets the ability to draw

up planks and floating triangles. The thief can use

multiple arrows, and arrows tipped with fire, and the

knight eventually gets a very powerful hammer, Some

levels require the player to light torches, which Zoya

can achieve with fiery arrows, and Pontius with his

blade. The Wizard is however, useless, as he does not

know the fireball spell, which Zoya points out.

The levels are very detailed and beautiful, and

the story follows a typical fantasy template of an evil

power overcoming a kingdom. Traveling through

the platformer, looking at the intricately detailed

surroundings is a pleasure, a pleasure heavily marred

by the seemingly endless number of skeletons that

spawn and try to hamper your progress. What would

have been a great tourist adventure has been turned

into a cute little inappropriate nightmare. The ¢combat

soon becomes repetitive, and enduring the combat d]

is a pain. There are a handful of new enemies that

show up, spiders that spit venom and vampire bats p— ;T [T Jl——

that fly out and bite you when disturbed. The range

of enemies is very limited, and relies on numbers

rather than Al or creative use of weapons. There are a

few boss monsters in between, but the novelty soon

wears off. A frog with crystal amour on its back, and

a giant skeleton, are the only boss monsters that

you actually fight against. Sometimes, you kill 4 boss

monster by dropping it into a void, and at other times

you have no choice but to simply evade it. Later on in

the game, the boss monsters are actually easier to kill
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Game review

TiheliiselofCobia

Faiyaz Shaikh

readersletters@thinkdigit.com

xperiencing G.I. Joe again after all these years, reminds us of
those days when we would setup elaborate battlegrounds in
our rooms, using common household items, to pit G.L Joe
action figures against Cobra Command action figures. Now,
a couple of decades later, when we picked the latest game based in
the G.I Joe universe, the feeling was one of nostalgia and mirth at
the ignomity of two well-equipped power hungry groups fighting for
control over the world. It all reeks of unrelenting military machismo,
where even a female G.1. is a Joe.

The Factions

Like most war stories, G.I. Joe: The Rise of Cobra has two parties:that 3

are at each other’s throats and then there is a weapons manufacturer.
The weapon’s company in this story goes by the namie:of MeAR.
and it is developing warheads for the U.S. Army (G.I: joe)- (]S s
simultaneously selling some nifty nanotechnology to:a: gmq'g'o :
fighting to bring a new world order (Cobra). So the stage. eled

is set — for most part of the game, you get 10 play ong'ols
the several operatives of G.I. Joe, which is a super '
division of the U.S. Army.

Theatre of War o
The game is set across the regular gamut of
of frigid, jungle and desert landscapes. Each of«
these locations has four to five missions, alon
with another locked mission. Mission objective;
are quite straight forward and they can fit into't
categories — rescue mission, search-and-destroy:.

has a fairly i 1mpresswe roster of 12 G.I. Joe characters any
characters to choose from. ’

fighters and are very handy in every mission. Heavy mfamry class
is great against vehicles and structures and the commando class
specialises in melee combat. After a mission brief, you are thrown
onto the mission map with the four locations mentioned earlier. Some
of these locations (along with their respective missions) are initially
locked and requires completion of certain other missions before they
are playable. At most points in the game, there are multiple missions
available at a time and they can be attempted in any order you choose.

Mission Directives

These missions have a primary objective that you eventually reach as
the level design is quite linear. The secondary objective is to gather
collectibles like intelligence and contacts of other G.I. Joe members.
Collecting these gives you different rewards — gathering intelligence
may unlock concept art in the game’s gallery or it may unlock another
side- mission. Locating contact of a G.I. Joe makes that member
available to be unlocked in the team roster. In addition, all of these
items also add points to your total score.

Sometimes these collectibles are behind a special door that
requires a particular class of character to open. If you find yourself
without the right class of character, there will most likely be a teleport
device somewhere in the level. Using these machines you can swap
one character for another and crack that door. There is also another
queer collective object in the form of Point Clusters, another source of

points. These are either dropped by the fallen enemies and structures
or found behind destructible object. So, for most part your focus in
going to be killing, destroying and collecting to rack up your score.
Slain enemies sometimes drop a score multiplier that remains active
for a few seconds, multiplying the score you earn during that period.
At every checkpoint in the game your total score is tallied and
reaching a certain score rewards you with precious Battle Points.
These points are used to unlock other characters in the team roster
— quite essential, as this is the only thing that really keeps the game
fresh.

On to the genocide

The mission levels are roughly divided into set piece arenas where it
is either dodge and shoot or get behind cover and shoot. You attempt
each mission with two characters playing either co-op with another

© -person or in single player mode, switching between the two with push
> ¢ Slaiuelon cEven though the game seems to give a lot of emphasis on

foot soldiers, turrets and heavy cavalry
'The game prov1des a few tricks to help

Aver tfiost of the times. This ablhty is
in the form of enemy drops or by
- ability meter by taking down targets.

enough to keep it interesting till the end. There is a constant trickle

of new playable characters, right until towards the end of the game
where you get to play as some of the Cobra characters. If you have
enjoyed games like Brute Force or even Contra, there is a good chance
you will find this one fun to play. The fun however, does not last long
and the game can be completed in eight to ten hours—maybe that’s
lengthy enough for a mindless shooter.

Despite all its flaws, this game is fun to play as it has a certain old
school charm. Unlock able characters and multiple difficulty levels
add a fair bit of replay value to the game. So, if you are a fan of the G.I.
Joe universe or are looking for a decent co-op shooter, you might want
to grab a copy now; otherwise you could wait for a price drop. d

RATINGS

Score: 6.5/10
Genre: Action, Shoot ‘em Up

Platforms: PS2, PS3, PSP, X360, Wii, DS
Developer: Double Helix Games, Backbone

Entertainment

Publisher: Electronic Arts

Distributor: Milestone Interactive Software (PS2, PS3,
PSP, Wii, DS) Redington (X360)




Digit Diary

The team deviated a bit from the regular Quake3 fare and
got onto some Warcraft3 instead. Raaabo did not join in, but
everyone irritated him by using the quotes that the units in
Warcraft3 use in the workplace. Here is a handy wc3 roleplay
guide for office use:

To complain about work: grunt “work, work” like an orc

To accept work: “Something need doing?” in a confused voice,
as an orc, or “ready to work” in an easygoing villager voice
To address your boss: use “Milord” or “Chieftain”

Asking for instructions: “I await your command.” in the gruff
voice of a Knight or “The dead stand ready” in a hoarse whis-
per of the undead or “I await your command” as an elf.
Pissed off at colleague: “Maybe you should get a strategy
guide.” or “This outfit is for the birds.”

To scare people: “Me eat dead people!” or “I like chicks that
are into bandage...” as the Undead.

Elephants do forget

While being an interesting and highly addictive flash game, there are
a few things about game design that any game developer can pick
up from this simple game. An elephant, a button, and a door... that
is almost all there is in just one level of the game. But every time you
think the game is over, you are forced to rethink that one leve. Head
over to http://tinyurl.com/m5hcmt

1337sp33k

Stay up to date with internet lingo, so you don’t wt? the next
time you are chatting with someone

Schooled: To get schooled is to learn something after a lot of
The T-52 Enryu pain and/or humiliation. Usually used after a gamer has been
is a Mecha from pwned.

another Japanese
company for clear- kekekekeke: An expression of mirth and laughter, the big
ing debris during brother of “lol” used for being awesome at a game or trolling

rescue operations. someone hard.

Movies Music Game

District 9: A refreshing take on The Green Waltz: A free album Anarchy Online: A great Sci-Fi
visitation, check out the Digit by The Dada Weatherman. We MMORPG. Jump in with the
review at http://www.think- like the tracks “Little Man” and updated installer is in this
digit.com/d/45750. “Pixel Songl”. month’s Play DVD.

How we unwind
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NEWS

The Penguin is
Growing Fat

Microsoft Windows has long been known as a bloated Operating
System. Those who use Linux, stand by how small and efficient the
Kernel is. However, in the most recent LinuxCon, Linux Trovalds,
the creator of Linux accepted that the Linux Kernel is growing to
be a bloated Operating system, and is no longer as streamlined as it
used to be. In his words, Linux is now “bloated and huge”. This was
in response to a question on efficiency posed by one of the officials
from Novell, the company that is responsible for the SUSE Linux
distro, one of the most commonly used Linux distros.

Trovalds continued to state that the reason for the bloat was
because of the tremendous lines of code added to the Kernel, and
that it was an unavoidable artefact of the pace at which the operating
system is growing. This has lead many to wonder if Linux does get
adopted on a wider scale, and does eventually become more efficient
and consumer friendly, then the chances are that Linux also will
become an Operating System with the same number of bugs and
holes as Windows.

tech art: Net.Art

NetArt is a rather strange art form, which is basically coding an
HTML page with irregular, illegible and often useless characters in
them. The lines, the letters, the numbers, radio buttons, check boxes
and in some cases, the animations used are either jarring, outra-
geous, or just simply strange. The reason why people indulge in this
art form are various and complicated. To some people who take it at
face value, it is just something unconventional and cool. To others, it
is a way of questioning the establishment of the Internet, about the
standards used by the browsers, or the design principles of websites.
Head over to http://0100101110101101.0rg to check some examples
out, but don’t linger too much, or you will get a headache.

©000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000

Escape

inbflat.net

One of those websites you must visit for the sheer novelty of the
idea. Inbflat.net has taken a number of videos from YouTube,
and arranged them in an array. The videos are of musicians
displaying their skills in different instruments. Play the videos
together, or play some of them, or play a selection at different
times to remix and create your own track. There are 20 videos
to buffer, so you will need a lot of patience or a great internet
connection for this to work smoothly though.

©00000000000000000000000000000000000000000000000000000000000

For those who came in late

Muddled by so many terms used in the mag? Here’s your short
guide to the tech lingo

Biometric: Computer interfaces that read off humans, ally
for security purposes. These can range from fingerprint recogni-
tion to Iris
are referred to as “biometric”.

recognition. Both the hardware as well as the software

, an older file transfer standard
, and later used for a range of I/O

SCSI: Pronounced as “skuz
meant for server hard driv
devices.

SAS: Serial Attached SCSI, a data transfer standard for moving
data from external devices such as hard drives and tape drives,

found ounly on high end boards.

SATA: Serial ATA - a standard interface between modern
and the storage medium, replacing the older PATA
connectors (Prallel ATA). This standard considerably redu
the number of pins.

computers

CMOS: Complementary metal-oxide-semiconductor, a proc-
ess for making integrated circuits. A CMOS sensor is a type of
integrated circuit with an array of light sensors, used in digital
cameras.

CCD: A charge-coupled device, a method in which informa-
tion collected by a chip is collected. A CCD is one of the two
commonly used types of sensors for digital photography.

F-number: The ratio of the aperture in a lense to it's focul
length. Generally, the smaller the fnumber of a lens, the better.
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Interact with forum members and give us feedback
http://www.thinkdigit.com/d/thinkdigit/oct09/
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The September winner of Green Technology
Contest was Rizwan A Salam from Trivandrum

Win! Win!
Wwin!

A brand new Hero
Electric bike — MAXI
was handed over to
Rizwan A Salam by Mr.
Suresh Babu, Legal
Manager of Marikar
Group of Companies.
Take part in the Digit
Festival Contest
and stand a chance

to win your very own
MAXI. You can also
win prizes everyday by
answering daily ques-
tions. To find out how
to participate in the
Digit Festival Contest
head over to page 141.
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